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Welcome to 
Bryce 4

Welcome to Bryce™4, the leading 3D program 
for desktop artists and animators, web design-
ers, and multimedia producers. Bryce is ideal 
for creating 3D graphics for magazines, ads, or 
virtually any illustration that would benefit 
from the powerful 3D impact of realistic per-
spective and shading.

Bryce’s easy animation features let you create 
great animations for video and multimedia. 
Bryce’s key-event and timeline-based anima-
tion lets you create incredibly realistic, fully- 
animated, 3D worlds where rivers rush 
through gorges, the sun sets over the ocean, or 
mist evaporates to reveal flocks of birds soar-
ing between mountain peaks.

Bryce can also be an invaluable tool for inter-
active multimedia. 



                  
Your Bryce package includes:

• The Bryce CD-ROM

• The Bryce User Guide

• The Bryce Quick Reference Card

• Your Bryce serial number

• A Software Registration Card

If you are missing any of these items, please 
contact your Bryce dealer, distributor, or Meta-
Creations Customer Service at (831) 430-4063.

What’s New in Bryce
The new Bryce 4 has new tools, features, and 
improvements from Bryce 3D. For those of you 
who are upgrading, the overview in the follow-
ing paragraphs provides a head start on locat-
ing, learning about, and taking advantage of 
new features in Bryce, that include:

New Sky Lab

The Sky Lab provides new and improved tools 
for creating stunning skies. It provides one-stop 
access to Cloud, Atmosphere, and Sun and 
Moon controls. Refer to “Creating Skies” on 
page 123 for more information. 

New Import/Export

Many additional image formats and object types 
are supported for import and export including 
US Geological Survey maps,(.DEM) files, and 
USGS SDTS files.  Refer to “Using Bryce with 
Other Applications” on page 417 for more 
information. 

Terrain Enhancements

Bryce 4 provides over 20 new fractal terrain cre-
ation models. 

In addition, you can perform textured terrain 
exports through the new real-time, multi-reso-
lution, Export Lab which converts Bryce ter-
rains into mesh objects for export in all popular 
3D file formats. Terrain mesh density is fully 
user adjustable and you can have instant visual 
feedback with real-time textured preview. Refer 
to “Terrains” on page 157 for more information. 

Using Bryce on the Web

Use Bryce to export both still or motion images 
to the web with embedded object links. You can 
also communicate with other Bryce users via 
BryceTalk, or go directly to Bryce-related web 
links from within Bryce. Refer to “Using Bryce 
on the Web” on page 423 for more information. 

Interactive Movie Previewing

Now, you can immediately see your Bryce ani-
mation in a preview window without having to 
render it, then play it using an external viewer. 
You can quickly generate thumbnail previews 
of your animations, preview animations directly 
within Bryce, or navigate through your anima-
tion using a storyboard style interface. Refer to 
“Animating” on page 353 for more information. 

Enhanced Rendering 

You can enhance render quality using gamma 
correction and 48 bit dithering. Lights have a 
new falloff mode for more control over how far 
light travels.  

Bryce 4 provides new and improved texture 
mapping modes, along with a new material 
shading mode to control self-shadowing of 
objects. Refer to “Rendering” on page 403 for 
more information. 
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Enhanced Screen Resolution

Since monitors do not always display a full 
range of colors, Bryce has compensated by add-
ing gamma correction so that colors are truer, 
terrains more natural, and earth tones more 
real.

Bryce also now has an automatic process called 
48 bit dithering that allows for a better display 
of gradients. Instead of distinct color bands, 
you now see a smoother transition from one 
color to the next. 

Light Editor Enhancements

Bryce 4 now provides more control over the 
way light falls. The Light Editor contains 
options for a falloff method and distance. In 
addition to gradual dimming, you can now 
choose to stop light abruptly. Refer to “The 
Camera and Lights” on page 325 for more 
information. 

New Material Lab features

Many new options in the Materials Lab let you 
apply pictures in new ways that include tiling 
and mirroring. Bryce also allows you to export 
textured terrains as Metastream files. Refer to 
“Materials” on page 189 for more information. 

Picture Editor Enhancements

You can launch Photoshop plug-ins to enhance 
or edit your 2D image map textures. In addition 
you can import more image formats than ever. 
Refer to “Working with Pictures” on page 108 
for more information. 

Preset Enhancements

You can create your own preset categories, and 
easily organize your presets. Refer to zot for 
more information. 

About Your User Guide
This user guide provides all the information 
you need to get the most out of Bryce. It will 
help you learn the application as well as serve 
as a reference as you attempt more sophisti-
cated procedures and effects.

We assume you are already familiar with basic 
Macintosh and Windows concepts such as 
menus, dialogs, and mouse operations. If you 
need more information on these subjects, or on 
the Macintosh Finder or the Windows Desktop, 
refer to the Macintosh User’s Manual or the 
Microsoft Windows User’s Guide, respectively.

The best way to learn Bryce is to read “Bryce 
Basics” on page 15 and then complete the 
“Tutorial” on page 47. The tutorial leads you 
through the process of creating illustrations 
and animations in Bryce and also explains some 
of the important concepts you’ll need to know 
in order to model and animate in 3D.

After you complete the tutorial, you are ready 
to open a new file and start building your own 
scene.

Computer graphics and three-dimensional 
modeling use special terms that are usually 
explained where they are introduced. In addi-
tion, “Glossary” on page 433 provides concise 
definitions of a number of terms.
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Conventions

The Bryce User Guide is for both Macintosh 
and Windows. By convention, Macintosh com-
mands precede Windows commands in the 
text. For example, Command/Ctrl+I, is equiva-
lent to the Macintosh Command-I and the 
Windows Ctrl+I. For simplicity, the term folder 
refers to directories as well as folders. Screen-
shots may alternate between the Macintosh and 
Windows versions. The Bryce interface for both 
platforms is identical, unless otherwise speci-
fied.

There are also several conventions used to 
identify paths to certain tools and controls. The 
convention to a menu follows the rule of the 
menu name> menu item. The convention to a 
palette follows the rule of the palette name: 
subpalette name or palette item. The conven-
tion to a palette menu follows the rule of pal-
ette name: palette menu> menu item. 

Modifier Keys

When a modifier key differs between the Mac-
intosh and Windows platform, the Macintosh 
modifier is listed first followed by a slash and 
the Windows modifier key. Option/Alt means 
Macintosh users press the Option key and 
Windows users press Alt.

Technical Support
Technical support is free* to registered users of 
Bryce 4. There are two easy ways to contact 
technical support for questions about installa-
tion, configuration, or functionality. These 
options are: web and phone support.

*MetaCreations does not currently charge for 
technical support. The only expense to you is 
the telephone call charge. MetaCreations 

reserves the right to change this support policy 
at any time.

You will find the answers to most of your ques-
tions within the pages of this User Guide.   If 
you need further assistance, you may contact 
MetaCreations Technical Support in one of the 
following ways:

Web Support

Many of the answers to your questions are avail-
able 24 hours a day on our website:

http://www.metacreations.com/support.

In addition to frequently asked questions 
(FAQs), the website provides troubleshooting 
techniques, late breaking product news, and 
other resources to help you get the most out of 
Bryce.

Phone Support

Phone support hours are Monday–Friday, 8:00 
AM–5:00 PM, Pacific Standard Time, excluding 
holidays.

Call (831) 430-4063. When you call, please have 
your serial number available and be at the com-
puter for which you need assistance.

For international support, please contact your 
local distributor. To locate the distributor near-
est to you, check the web site at:

http://www.metacreations.com/support/intl

Creative Support

You can also refer to forums and mail-lists on 
the MetaCreations website for questions about 
creative techniques.
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Bryce Overview

What is Bryce?
Bryce is a stand-alone application that allows 
you to create and animate virtual environ-
ments. 

With Bryce you can create any type of environ-
ment you can envison, from the ivory beaches 
of Tahiti to the silvery rings of Saturn. Bryce’s 
user interface contains all the tools you’ll need 
to create your environments. 

For example, Bryce includes controls for man-
aging infinite skies that let you set everything 
from time of day to the color and frequency of 
clouds.  Using the sky controls you can also set 
light direction, sun/moonlight, atmospheric 
depth haze (with intensity and color), height 
fog (with height, intensity and color), and mul-
tiple sky color components. 

You can also use Bryce controls to create a 
wide variety of objects you can use to populate 
your environment.  You can use the Terrain 
editor to create an infinite number of custom 
terrains, which you, in turn, use to create land-
scapes.

The realism of a Bryce environment is largely 
dependent on the Materials applied to the 



             
objects in the scene. Materials are complex 
combinations of textures and values. The Mate-
rials Lab lets you combine textures and channel 
values that simulate any material found in the 
real world (and a few that aren’t!).

When you have set up your environment just 
the way you want it, you can add a fourth 
dimension—time.  You can use Bryce’s anima-
tion tools to set up landscapes that move and 
materials that change over time. 

Application Overview
The Bryce Window

Bryce’s default environment consists of the 
Working window, the Control palette, and the 
Tool palettes. 

By default, the Bryce environment replaces 
your screen whenever you launch the applica-
tion. However, your operating system’s stan-
dard menus and windows are still available 
from within Bryce. 

The Working Window

The Working window displays all the objects in 
your Bryce scene. It’s the work area where 
you’ll arrange the objects and lights to create 
your environment.

The view of your scene shown in the Working 
window is taken from a “camera” that you can 
move around for different views of your scene.

The Working window also has several display 
modes that let you view am as a wireframe, ren-
dered object, or combination of both. 

Refer to “Display Modes” on page 17 for more 
information.

Nano-Preview

The Nano-Preview feature displays a rendered 
preview of your scene. As you update your 
scene, Nano-Preview shows your changes.  You 
can immediately see how your adjustments to 
object position or other properties affect the 
final look of the scene.

When you launch the application, the Bryce window 
replaces your desktop. 

The Working window displays all the objects that make up 
your scene.
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Several display options  let you control how 

your scene appears in the Nano-Preview and 
can be very helpful when you’re working on a 
complex scene.

You can also use the Nano-Preview’s preset 
viewing positions to see your scene from differ-
ent angles that help you quickly see the effects 
of your changes in 3D space.

The Memory Dots along the side of the Nano-
Preview let you store your favorite camera posi-
tions. 

Refer to “Using the Nano-Preview” on page 24 
for more on working with the Nano-Preview.

View Control

View Control lets you adjust the view of your 
scene without moving the camera..

Using this control you can see your scene from 
the top, bottom, left, right, front or back. You 
can also set your scene to continuously rotate 
so you can see it from any angle. Refer to “View 
Control” on page 9 for more on using the View 
Control.

Camera Controls

Camera Controls change the position of the 
camera specifically along the X, Y, and Z axes. 
The Camera Trackball lets you move the camera 
in any direction, and along any axis. 

The Nano-Preview window shows a small rendered 
version of your scene. As you change the scene, the display 
updates to show your changes.

The View Control lets you control how you see your scene.
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Refer to “Camera Controls” on page 9 for more 
on moving the camera.

Render Controls

Render Controls let you render your scene to 
see all the materials and lighting effects you 
added. 

The center button starts the rendering process 
and the other buttons control rendering 
options. Refer to “Rendering a Scene” on 
page 410 for more on rendering.

Text Display Area

The area just below the Render Controls is 
reserved for momentary display of text informa-
tion. This area identifies the names of interface 
elements as you pass your cursor over them as 
well as displaying information about total num-
ber of polygons in a scene and current control 
settings. 

The Tool Palettes

Bryce uses a series of palettes to manage tools 
and controls—the Create palette, Edit palette, 
Sky & Fog palette, Advanced Display palette, 
Selection palette, and Animation controls. 
These palettes let you create objects, edit 
objects, create skies and fog, control the display 
of your scene, select objects, and animate 
objects. 

Beside the title of each of the three palettes, 
along the top of the interface, is a small triangle 
which opens the different Preset Libraries 
available in Bryce.

The Create Palette

The Create palette contains tools for creating 
infinite planes, terrains, stones, primitive 
shapes, derivative primitives, 2D picture 
objects, and lights.

The Triangle icon for this palette opens the Pre-
set Objects Library. Refer to “The Create Pal-
ette” on page 100 for more on the Create 
palette.

Use the Camera controls to adjust the position of the 
camera.

The Render controls let you render your scene as a 2D 
image.

The Text Display Area displays the name of items in the 
user interface as you pass your cursor over them. This area 
also displays information about tool settings.

The Create palette contains tools for creating all the types 
of objects you can use in a Bryce scene.
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The Edit Palette

The Edit palette contains tools for editing 
object materials, resizing, rotating, reposition-
ing, aligning, and randomizing objects. The 
Edit Terrain Object tool accesses the Terrain 
Editor, which lets you design and adjust terrain 
objects. 

The Triangle icon for this palette opens the Pre-
set Materials Library. Refer to “Transforming 
Objects” on page 285 for more on the Edit pal-
ette.

The Sky & Fog Palette

The controls available on this palette let you 
add shadows, fog, and haze, and also set the 
altitude, frequency, and amplitude of clouds. 
The palette lets you control the color of clouds 
in your sky and the position of the sun and 
moon. 

The memory dots along the side of the palette 
let you store your favorite sky and fog settings. 

The Triangle icon for this palette opens the Pre-
set Sky & Fog Library. Refer to “The Sky & Fog 
Palette” on page 124 for more on the Sky & Fog 
palette.

Advanced Display Palette

The Advanced Display is not visible in the main 
interface. It only appears when you pass the 
mouse over the right side of the Working win-
dow. After you’re finished working with the pal-
ette it gradually fades away so that it does not 
clutter the screen.

The Advanced Display palette contains tools for 
controlling the display of the interface and 
enabling/disabling the Nano-Editor and Plop 
Render features. You can also control the reso-
lution of the Wireframes preview, zoom in and 
out, enable or disable wireframe shadows, 
access different shaders, and set underground 
and depth cues. Refer to “Viewing Your Scene” 
on page 25 for more on using the Advanced 
Display palette tools. 

The Animation Controls

The Animation controls lets you set up key 
frames and edit the timeline of your animation. 

The Edit palette contains tools for transforming objects 
and accessing the Editors.

The Sky & Fog palette contains tools for creating the 
environment of your Bryce scene. The Advanced Display palette contains tools for changing 

the Working indow display. 

The Animation controls display the timeline of your 
animation.
11 Bryce 4



            
It also contains controls for previewing your 
animation, adding and deleting key frames and 
accessing the Advanced Motion Lab. Refer to 
“Setting Up an Animation” on page 357 for 
more on using the Animation controls.

Selection Palette

The Selection palette contains tools for select-
ing specific types of objects in your scene.  You 
do not see this palette in the default Working 
window. To view it, you must use the Time/
Selection Palette toggle at the far bottom right 
of your Working window to swap the Animation 
controls for the Selection palette.

Using the palette tools, you can select objects 
by type, by group or family. Refer to “Selecting 
Objects” on page 30 for more on selecting 
objects. 

The VCR controls available in this palette let 
you cycle though the selections and enables 
Solo mode. Refer to “The VCR Controls” on 
page 32 for more on using the VCR controls. 

The Editors

Bryce has several editors that let you do every-
thing from creating terrains to editing the 
speed of animation. Each editor is like a sepa-
rate room in Bryce. When active, the editor 
takes over the interface, completely replacing 
the Working window.

The Terrain Editor

The Terrain Editor is where you’ll create all the 
terrain objects in your scene. The editor con-
tains tools for painting and refining terrain 
objects. 

The Terrain Editor also has a real-time preview 
so you can see the effects of your changes 
instantly.

Three tabs in the Terrain Editor let you switch 
between the various terrain creation tools:

• Elevation provides access to the terrain 
generation and editing tools.

• Filtering lets you adjust the filter curve for 
a terrain. By adjusting this curve you can 
make subtle changes to the topography of 
your terrain.

• Picture lets you use 2D pictures to create 
terrains. 

Refer to “The Terrain Editor” on page 158 for 
more on the Terrain Editor.

The Selection palette contains tools that let you set objects 
by type or family.

Use the VCR Controls to cycle through all the objects in 
your scene and activate Solo mode.

The Terrain Editor lets you create any type of landscape 
using the preset tools and paint brush.
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The Materials Lab

The Materials Lab is where you’ll create the 
materials to apply to your objects. By combin-
ing up to four texture components on the mate-
rials grid, you can create incredibly complex 
surfaces that can bring your scene to life.

There are two types of materials you can create: 
Surface materials, which define the surface 
properties of an object, and Volume materials, 
which define the properties of an object’s vol-
ume as well as its surface. Refer to “The Materi-
als Lab” on page 227 for more on the 
Materials Lab.

When you’re creating a Volume material, the 
settings available in the Materials Lab change. 
The settings that appear let you set up the volu-
metric properties of the material. Refer to 
“Understanding Volume Material Channels” on 
page 193 for more on Volume materials.

The Advanced Motion Lab

The Advanced Motion Lab lets you fine-tune 
your animations. After you’ve created your key 
frames, using the Animation controls, you can 
use the tools available in this lab to control the 
speed at which objects move along a motion 
path, adjust the position of key frames, and pre-
view your changes.The Materials Lab lets you create different types of 

materials by combining texture components on the 
materials grid.

When you’re creating volume materials the settings in the 
Materials Lab change. Some of the surface material 
settings are replaced by volume effects settings.

The Advanced Motion Lab lets you refine the action in 
your animations. Use the Velocity Curve editor to create 
different velocity effects and the Hierarchy area to control 
when object transformations occur.
13 Bryce 4



         
There are three areas within the Advanced 
Motion Lab that let you edit specific aspects of 
your animations: the Time Mapping Curve edi-
tor, the Hierarchy List and the Sequencer.

The Time Mapping Curve editor lets you create 
a time mapping filter which alters how the time 
in your animation is mapped to actual time.

By adjusting the shape of a time mapping curve 
you can create different velocity effects. Refer 
to “Time Mapping Curves” on page 371 for 
more on velocity curves. 

The Hierarchy List area lets you see how 
objects are linked and grouped within your 
scene. Although you can’t change the hierarchy 
of your scene in this area, it can be a valuable 
visualization tool.

The Sequencer lets you see where key events 
were recorded for all of an object’s properties. 
Using this area you can control exactly when 
object transformations occur. Refer to “Proper-
ties in the Sequencer” on page 355 for more on 
the Sequencer.

The Bryce Preset Libraries

Bryce has several libraries of presets that can 
make creating scenes easier. There are three 
main preset Libraries available in Bryce: the 
Preset Objects Library, the Materials Presets 
Library, and the Sky & Fog Preset Library. You 
can use the objects library to add pre-made 
objects to your scene. Refer to “Using the Pre-

sets Object Library” on page 119 for more on 
the Preset Objects Library. 

The Materials library lets you add a wide variety 
of materials to your objects. Refer to “Using the 
Preset Materials Library” on page 232 for more 
on the Preset Materials Library.

The Sky & Fog Preset library contains pre-
made skies that you can add to your scene to 
quickly create an environment. Refer to “Using 
the Preset Skies Library” on page 155 for more 
on the Preset Sky & Fog Library.

The Menu Bar

The Bryce menu bar contains three menus: the 
File menu, the Edit menu, and the Objects 
menu. These menus provide access to several 
Bryce functions and editors.

The display of the menu bar depends on the 
state of the application. When the application 
interface snaps to the edges of your Working 
window, the menu bar is hidden until you pass 
the pointer over the menu bar area.

The Preset Object Library contains a variety of 3D objects 
you can use in your scene.
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Bryce Basics

Overview
This section describes how to perform most of 
the basic functions in Bryce and how to set up 
the application.



Setting Application 
Preferences
By setting application Preferences, you can 
customize Bryce to suit the way you work. You 
do not have to restart Bryce to make these 
changes take effect. 

Application Preferences are set in the 
Preferences dialog. 

To set the application’s launch state:

1 Choose Edit menu> Preferences. The 
Preferences dialog appears.

2 Enable either Launch to Previous State or 
Launch to Default State.

Launch to Previous State launches Bryce 
using the settings from your last session.

Launch to Default State launches Bryce 
using the default settings.

To save Images used in a scene with a file:

1 Choose Edit menu> Preferences. The 
Preferences dialog appears.

2 Enable Image with Scene Open/Save.

With this option enabled, Bryce will 
automatically open or save a PICT or BMP 
file (PICT/BMP files are automatically 
appended with the extension), along with 
your scene file, every time you open or save. 
In most cases, this option should always be 
selected.

To control new object placement:

1 Choose Edit menu> Preferences. The 
Preferences dialog appears.

2 Enable either Create Objects Within View 
or Create Objects at World Center.

Create Objects Within View places newly 
created objects within the camera view, 
rather than at world center.

Create Objects at World Center places 
newly created objects at world center, 
regardless of whether they will be visible in 
your current camera view. 

Setting Up the Bryce 
Window
When you first launch Bryce, the interface 
snaps to the edges of your Working window. 
The menu bar is hidden until you pass your 
cursor over it and other applications are hidden 
behind Bryce. This setup lets you work with an 
uncluttered desktop.

The Preferences dialog lets you set the opening state of 
the application and customize it.
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To maximize the Bryce window:

1 Pass the cursor over the right side of the 
Working window. The Advanced Display 
palette appears.

2 Click the Interface Max/Min tool. 

3 Click the tool again to switch to a standard 
window.

Setting Up the Working Window 

Before you start working in Bryce, you may 
want to set up how objects are displayed in the 
Working window. These display modes can 
help you when you’re arranging objects and 
can also speed up your redraw time.

Display Modes

The Display Mode tool, at the bottom-right 
corner of your Working window, toggles 
through the three possible display modes. 

To switch between display modes:

1 Click on the Display Mode tool in the 
corner of the Working window.

This button is only visible when you pass 
your pointer over it.

2 Click the button until you’re in the desired 
mode.

There are three modes available:

• Wireframe Display shows all objects as 
wireframes.

• Bitmap Display shows a rendered scene. 
The display automatically switches to 
this mode whenever you click the 
Render button.

Use the Interface Max/Min tool to increase or decrease 
the screen coverage of the Bryce window.

In Wireframe Display all objects are shown as 
wireframes.

In Bitmap Display all objects are displayed as rendered 
objects.
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• Wireframe/Bitmap Display lets you edit 
wireframes while simultaneously 
viewing your rendered image behind 
them.

This mode is most useful when you have a 
partially-rendered image and want to 
improve the results. If you switch to this 
mode, you can move your wireframe 
objects relative to the rendered image 
behind them in order to accurately judge 
the results of your change.

To toggle between modes:

• Press the Esc key. 

The Esc key will toggle between the last 
Wireframe mode you selected (Wireframe 
or Wireframe/Bitmap) and Bitmap mode. 

Flat Shaded Preview Mode

This preview mode is only available if your 
system contains hardware that supports 
OpenGL. 

When this mode is active your objects appear 
as flat shaded solids, without materials, instead 
of wireframes, and you can see the effects of 
light sources on object surfaces.

To display objects in Flat Shaded Preview:

• Hold down the mouse button over the 
Display Mode button and choose OpenGL 
from the menu.

Wireframe attributes

When you’re in Wireframe mode, there are 
several options you can set to make the display 
more helpful. Disabling some of these options 
may speed up drawing time.

To set Wireframe attributes:

1 Make sure you’re in Wireframe mode. Click 
the Display Mode tool until the display 
switches to Wireframe.

In Wireframe/Bitmap display, all objects are displayed 
as wireframes, but with the rendered image in the 
background.

In Flat Shaded Preview display, all objects are displayed 
as flat shaded solids.
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2 Drag the Depth Cue control up or down. 
Drag up to increase the intensity of the 
depth cueing effect and drag down to 
decrease it.

When depth cueing is active, the 
wireframe appears lighter the farther it is 
from the camera.

If you hold down the Control key/Ctrl+Alt keys 
and click on the Depth Cue icon, Bryce will turn 
both anti-aliased wireframes and depth cueing 
on or off simultaneously.

3 Click the Wireframe Shadows button to 
turn shadows on or off.

Shadows are designed to help you 
determine object placement in your scene. 
For this reason shadows appear even when 

there is no ground plane or when the 
object is below the ground plane. 

This feature may slow down your system when 
working with a complex scene on slower 
machines.

4 Click the Underground On/Off button to 
hide or show underground lines.

When underground lines are hidden, any 
portion of a terrain or object that is 
positioned below ground level will not be 
visible in your wireframe scene. This is 
useful for easy visualization and 
composition. However, you might overlook 
an object that is hidden underground.

When depth cueing is active, objects appear lighter the 
farther they are from the camera.

You can use wireframe shadows to help you determine 
the placement of objects in the scene.

When underground is enabled, objects that are 
positioned below the ground plane are not visible in the 
scene.
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5 Click the Resolution tool and choose 
Static, Selected, or Motion. Then choose a 
resolution for the wireframe mode.

Static is the resolution of the wireframe 
when the object is not moving and not 
selected. The resolution is affected by what 
is entered.

Selected is the resolution of the wireframe 
when the object is selected.

Motion is the resolution of the wireframe 
when the object is being moved.

Window Backgrounds

The background texture of the working window 
can add a great deal to the overall look of the 
interface. It makes it easier to see wireframes 
and selected objects.

To select a background texture:

• Click the Background Paper button and 
choose a background from the menu. 

Adding a background texture may slow down 
some machines. If you need more speed for any 
reason, select No Texture, and you will get a sim-
ple, clean background with no texture.

To select a background color:

1 Click the Background Paper button and 
choose Select Color from the menu.

2 Use the color picker to select a color.

Using the Bryce Interface
The Bryce interface can be completely 
customized. If you want to, you can tear apart 
the interface and reposition any palette, or you 
can choose to hide the entire interface and 
leave only the working window visible.

To move a palette:

• Hold down the Spacebar and drag the 
desired palette to a new location.

To reset a palette to its original position:

• Hold down the Option/Alt key and the 
Spacebar, then either click on a palette or 
choose Edit menu> Reset Palettes to reset 
all palettes to their default positions.

To hide the Bryce interface:

1 Press Command-Tab/Ctrl+Tab. All the 
palettes disappear and your image appears 
at the center of your work space.

2 Press Command-Tab/Ctrl+Tab again to 
display all the palettes.

When you break the interface apart, you can see all the 
palettes at the same time. You can move these palettes 
anywhere in the Bryce window.
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To display individual palettes:

1 Press Command-Tab/Ctrl+Tab to hide the 
interface.

2 Press the key combination for the palette 
you want to display:

• Command-1/Ctrl+1=Create palette

• Command-2/Ctrl+2=Edit palette

• Command-3/Ctrl+3=Sky&Fog palette

• Command-4/Ctrl+4=Control palette

• Command-5/Ctrl+5=Selection palette

• Command-6/Ctrl+6=Display palette

Displaying Text Information

The Text Display area at the bottom of the 
Control palette displays a great deal of valuable 
information about the interface and statistics 
for your scene. 

During rendering, the Text Display area 
displays projected and elapsed time estimates. 
This estimate does not include the time for 
anti-aliasing. The total time, including anti-
aliasing, will be calculated and displayed in the 
Render Report.

When you’re working in the Timeline or 
Animation controls, the Text Display area 
displays the current time.

To display information about the interface:

• Pass the pointer over any interface 
element.

The name of the element is displayed. In 
some cases, the element’s current settings 
are also displayed.

To display statistics about the objects in 
your scene:

1 Switch to Wireframe display using the 
Display Mode tool.

2 Pass the pointer over the working window.

•  If no objects are selected, the Text 
Display area displays a count of all of 
the objects in your scene, as well as a 
total polygon count. 

• If an object is selected, the Text Display 
area displays object and polygon counts 
for the selected object.

To display information about rendered 
images:

1 Switch to bitmap display mode using the 
Display Mode tool. 

If you have not rendered your image, the 
working window is blank.

2 Pass the pointer over the working window. 

The Text Display area shows the file size.

Displaying/Hiding Palettes

To keep the interface uncluttered, many of 
Bryce’s palettes and toolbars are hidden when 
you first launch the application. Some palettes 
are hidden behind other palettes.

To display different palettes:

• Either click on a text button above the 
Working window or press the key 
combination for the desired palette:

• Command-1/Ctrl+1=Create palette

• Command-2/Ctrl+2=Edit palette
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• Command-3/Ctrl+3=Sky&Fog palette

• Command-4/Ctrl+4=Control palette

To display hidden palettes:

• Pass the cursor over the edges of the 
Working window, or 

• Press the key combination for the hidden 
palette you want to display:

• Command-6/Ctrl+6=Display palette

Displaying Submenus and Pop-
up Dialogs

Wherever you see an inverted or sideways 
triangle icon in the interface, it indicates that 
there is a menu or other item available that 
contains options pertinent to the item closest to 
it. For example, in the Create palette, there are 
triangle icons next to each tool in the palette. 
These triangles access the additional options 
for the tools.

To display a submenu:

• Click the triangle icon.

Working with 
Documents
Before you can create a Bryce environment you 
need a document. A document can be either a 
blank scene or an existing file that you’re going 
to edit. 

Creating an Empty Scene

When you create a blank scene, Bryce opens 
the Document Setup dialog which lets you 
specify the aspect ratio and dimensions of the 
new scene.

To create a new document:

1 Choose File menu> New. The Document 
Setup dialog appears.

2 Enter values in the Document Resolution 
fields.

This is the absolute size of your working 
space expressed in pixels. You can enter 

The triangle icon next to a tool or text button indicates 
that there are more options available for the element.

Click the triangle icon next to a tool to access additional 
options.

Use the Document Setup dialog to set tahe resolution 
and aspect ratio for your image.

a.
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any values you like here, though it’s 
recommended that you not exceed your 
available screen space if you can avoid it. 
You can work small and render large if you 
need to. The values in the Aspect Ratio 
fields will update automatically as needed.

3 Enter values in the Document Aspect Ratio 
fields.

These fields represent the Document 
Resolution as a ratio. Depending on the 
type of work you are doing, it may be more 
convenient to enter values here rather than 
in the resolution fields above. For instance, 
many video formats, as well as the standard 
13” screen, are 3:4 aspect ratios. 

The values in the Document Resolution 
fields will update automatically if you 
change the aspect ratio.

4 Enable the Constrain Proportions button if 
you want to preserve the current aspect 
ratio as you adjust the resolution.

5 Select a Render Resolution from the list. 

This resolution sets the absolute size of 
your rendered image, expressed in pixels as 
a multiple of your document size. 

You may be working at Bryce’s default size 
as you build your scene, but you may then 
wish to render that scene four times larger 
for print or four times smaller for a web 
page. Rather than resetting your document 
resolution every time you render, impacting 
your wireframe workspace, you can simply 
set a separate size for rendering. Think of 
Document Resolution as input, and 
Render Resolution as output.

The default resolution is 480 x 360, and the 
default aspect ratio is 4:3.

To set up a new document using presets:

1 Choose File menu> New Document. The 
Document Setup dialog appears.

2 Click one of the preset aspect ratios 
displayed along the right side of the dialog.

These presets are aspect ratios for many 
useful document types. The pixel values 
that are placed in the Document 
Resolution fields are either absolute (as in 
Legal or Letter) or based on your available 
screen resolution (as in Maximum 
Recommended or Square).

Opening an Existing File

Bryce can open any file created in  any previous 
version of Bryce (Mac or PC).

To open an existing file:

1 Choose File menu> Open. 

2 Use the dialog controls to locate and open 
your file.

Merging scenes

You can merge two Bryce scenes using the 
Merge command. When you use this command 
the scene you open is merged with the 
currently open scene. Objects from the scene 
you’re opening are placed in your current 
scene, at the same absolute coordinates that 
they previously occupied.

To merge two scenes:

1 Choose File menu> Merge. A dialog 
appears prompting you to save the current 
scene.

2 Click Save. The Open dialog appears.
23 Bryce 4



3 Use the dialog controls to locate the file 
you want to merge and click Open.

The file you selected is merged with the 
current scene.

Holding down the Option/Alt key while per-
forming this function will merge only the sky 
from the incoming scene.

Working in a Scene
Displaying Your Scene

The display of your scene is controlled by the 
display mode you selected when you set up the 
Working window. You can also control how 
individual objects are displayed and how your 
scene is displayed in the Nano-Preview.

Changing Object Display

You can change how your objects are displayed 
using the Object menu commands. Changing 
the object preview can greatly reduce redraw 
time in a complex scene. The Object’s preview 
does not affect how the object renders.

To display objects as boxes:

1 Choose Object menu> Show Object as 
Box.

This command displays any selected 
object, objects, or group as box(es). This is 
useful when you just want to work with the 
object’s position, but don’t need more 
details. 

Keyboard Shortcut: Command-B/Ctrl+B.

To display objects as wireframes:

• Choose Object menu> Show Object as 
Lattice.

Use this command to change objects 
shown as boxes back to wireframes. 

Keyboard Shortcut: Command-L/Ctrl+L.

Using the Nano-Preview

The Nano-Preview is where your object is 
displayed before you render it. The preview can 
display your scene from a number of different 
angles without affecting the position of the 
camera. 

To display your scene from different angles in 
the Nano-Preview:

• Click the triangle icon below the Nano-
Preview and choose a preset display angle. 

The Nano-Preview displays a rendered preview of your 
scene.

Click the triangle icon to access the display angles for the 
Nano-Preview.
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The view of your scene does not change in 
the Working window.

To set Nano-Preview options:

• Click the triangle icon below the Nano-
Preview and choose a display option:

• Sky Only previews only your sky 
settings.

• Full Scene previews your actual scene. 
This is the default setting for the Nano-
Preview.

• Wireframe Only previews your 
wireframes only, as opposed to a 
rendered preview. 

• Auto Update will automatically update 
the preview render with every single 
change you make during your session. 
In most cases, this is a godsend, giving 
you almost immediate feedback after 
any action. On slower machines, or 
when working with highly complex 
scenes, you may wish to deselect this 
option.

With this option deselected, you’ll need 
to click in the Nano-Preview window to 
update the render.

• Select either Fast Preview or Full 
Rendering to adjust the quality of the 
rendered preview. With Full Render 
selected, every pixel is raytraced and 
anti-aliased. Fast preview mode skips 
pixels to achieve faster updates. This 
may cause small objects to be partially 
or completely missing.

Using the Movie Preview

In addition to viewing still images in the nano-
preview window, you can use the same window 
to see a small version of your animation, 
without having to leave Bryce.

See “Previewing Animations” on page 363. for 
more information.

Viewing Your Scene

When you’re creating an environment in Bryce, 
your scene can quickly become rather large. 
You may not be able to see the entire landscape 
in the Working window. Bryce has several tools 
that can help you see every inch of your new 
world.

Orthogonality and Views

When you view a scene from the side, front, 
top, or bottom using the Camera, you’ll see 
certain amounts of perspective distortions. 
These distortions can make precise visual 
alignments difficult. 

For instance, if you have a dozen cubes in 
different locations, and go to Top View to place 
them on top of one another, you will find it very 
difficult. Cubes further from the camera would 
be slightly smaller than cubes close to the 
camera, resulting in a confusing array of lines. 
The more complex the scene, the more 
confusing and difficult this kind of alignment 
becomes.
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To solve this problem, Bryce uses a perspective-
free, drafting board kind of view in which like-
sized objects far away appear exactly the same 
as those up close.

This perspective-free view is called an 
orthogonal projection. In Bryce, all views other 
than your Main View (that is, Top, Bottom, 
Right, Left, Front, and Back) are orthogonal 
projections. They are not generated by the 

camera, and so do not contain the perspective 
distortion that would necessarily come with a 
camera view. 

As a result, Camera controls do not work in 
these views. You can navigate within the 
orthogonal views using the Zoom and Pan 
tools.

If you press the Render button while in an 
orthogonal view, Bryce will quickly set up the 
camera position you need and render your 
image. There may be slight differences between 
what you see in the wireframe projection and 
what you see in the rendered image, as a result of 
the added perspective distortion in the rendered 
image. 

Zooming In and Out

In Bryce there is a difference between moving 
the camera and using the zoom tools.

When you move the Camera, you’re moving in 
3D space. When you use the pan and zoom 
controls, you’re transforming a 2D projection of 
your 3D scene—your camera position does not 
change.

When you use the Zoom tool, you are 
essentially making the 2D projection larger or 
smaller. Your camera position in 3D space does 
not change.

To zoom in:

• Click on the Zoom In tool.

Bryce scales the 2D projection of your 
scene larger, creating the illusion of 
zooming into your 3D scene; your camera 
position remains unchanged.

Keyboard Shortcut: Command-plus/
Ctrl+plus.

If you viewed objects from above through a real-world 
camera, the perspective distortions would make 
alignment or placement difficult.

Bryce uses an “orthogonal projection” of your objects to 
eliminate perspective distortion.
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To zoom out:

• Click the Zoom Out tool.

Bryce scales the 2D projection of your 
scene smaller, creating the illusion of 
zooming out of your 3D scene. Your camera 
position remains unchanged.

Keyboard Shortcut: Command-minus/
Ctrl+minus.

To zoom into an area:

• Hold down Command-Spacebar/
Ctrl+Spacebar and drag a marquee around 
an area of your scene.

Your cursor changes to a Zoom tool, and 
Bryce centers and scales up the area in the 
marquee to fit your window. 

To zoom out of an area:

• Hold down Command-Option-Spacebar/
Ctrl+Alt+Spacebar and drag around an 
area. 

Bryce scales down your entire scene to fit 
within the area your marquee selected.

To zoom numerically:

1 Double-click the Trackball in the Control 
palette. The Camera & 2D Projection 
dialog appears.

2 Enter a value in the Scale field.

The default value is 100%.

To reset the zoom value:

• Press the Option/Alt key and click the 
Zoom tool.

The view of your scene resets to 100%.

Panning

Panning works exactly like zooming. When you 
use the Panning tool, you are moving a 2D 
projection of your scene right and left, up and 
down, in front of the camera. Your camera 
position in 3D space does not change. 

To pan your scene using the Pan tool:

• Drag over the Pan tool in the direction you 
want your scene to move. 

To pan your scene using the Spacebar:

• Hold down the Spacebar and drag in the 
direction you want your scene to move.

To pan numerically:

1 Double-click the Trackball in the Control 
palette. The Camera & 2D Projection 
dialog appears.

2 Enter a value in the Horizontal field.

The default value is 0.

3 Enter a value in the Vertical field.

The default value is 0.
27 Bryce 4



Using Fly-around View

You may have noticed a tiny circular icon above 
and to the right of the Views icon. If you click 
here, you will change from your current View to 
a special motion view, or Fly-around View.

This view enables you to get a sense of context 
in your Bryce world. If you’re working close to 
the ground, or stuck in the midst of a clump of 
trees, or you’ve lost a cube you know you 
created a half an hour ago, you can use the Fly-
around view to see your entire scene all at once.

In Fly-around view, Bryce positions the Camera 
on an imaginary monorail track above and away 
from your scene such that you can see the 
whole scene from all sides as the camera moves 
around it.

To switch to Fly-around view:

• Click the Fly-around view icon next to the 
View control. The View control icon 
changes to the Fly-around control icon.

To switch back to Camera view:

• Click on the Fly-around view icon again.

To rotate the view of your scene in Fly-
around view:

• Move your mouse in the direction you want 
to rotate. The scene rotates in the direction 
you drag.

To zoom in and out in Fly-around view:

• Hold down the Command/Ctrl key.

To pause the Fly-around:

• Press the Spacebar.

To end the Fly-around and save Fly-around 
position:

• Press Return/Enter. The view switches 
back to Camera view and the last Fly-
around position becomes the new Camera 
View.

Keyboard Shortcut: Command-Y/Ctrl+Y.

Using the View Control

Bryce lets you view your scene from several 
preset positions; Main, Top, Front, and Side, 
Bottom, Right, Left, and Back. All theses views 
with the exception of the Main View are special 
Orthogonal projections which allow 
perspective-free views well-suited for 
alignment operations.

The View control is an interactive way of 
cycling through the various preset views. The 
current position of the View control indicates 
the view you’re seeing in the Working window.

In Fly-around view your scene rotates so you can see it 
from a number of angles.
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To switch views using the View control:

• Click or drag the Views control until you 
reach the view you are looking for. 

Every time you click the control Bryce 
displays a different preset view.

To switch views using the View control menu:

• Click the triangle icon next to the View 
control and select a view option:

• Camera View: select this option to view 
your scene as the Camera sees it, based 
on the Camera’s current location and 
orientation.

• From Top: select this option to view a 
perspective-free orthogonal projection 
of your scene as seen from above (based 
on absolute world coordinates).

• From Right: select this option to view a 
perspective-free orthogonal projection 
of your scene as seen from the right 
(based on absolute world coordinates).

• From Front: select this option to view a 
perspective-free orthogonal projection 
of your scene as seen from the front 
(based on absolute world coordinates).

• From Left: select this option to view a 
perspective-free orthogonal projection 
of your scene as seen from the left 
(based on absolute world coordinates).

• From Back: select this option to view a 
perspective-free orthogonal projection 
of your scene as seen from behind 
(based on absolute world coordinates).

• From Bottom: select this option to view 
a perspective-free orthogonal projection 
of your scene as seen from below (based 
on absolute world coordinates).

• Director’s View: select this option to 
view your scene from the perspective of 
a director sitting outside the scene.

To switch views using the keyboard:

• Select a preset view shortcut:

• Camera View=1 

• Top View=2

• Right View=3

• Front View=4

• Director’s View=~

To reset the view of your scene:

• Click the triangle icon next to the View 
control and choose Reset Views, or

• Press the Option/Alt key and click on the 
Views icon.

This option resets your View to Bryce’s 
default setting.

The View Control lets you select from different views of 
your scene.
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Selecting Objects

Before you can perform any type of editing or 
transforming operation on an object, you need 
to select it. Besides selecting objects using the 
cursor, Bryce’s Selection tools let you select 
objects by type or family. You can also cycle 
through all the objects in your scene.

To select an object:

• Click on any object. A selected object’s 
wireframe will appear red,
or

• Drag a marquee around the object.

To select a number of objects:

• Drag a marquee around a number of 
objects.

To step through all the objects in your scene:

• Press the Tab key until the object you want 
selected appears in red. 

To select all objects:

• Choose Edit menu> Select All, or

• Press Command-A/Ctrl+A.

To select an object within a group:

• Hold down Control and click the desired 
object.

To deselect all:

• Choose Edit menu> Deselect All, or

• Click anywhere outside the selected area. 

To add objects to a selection:

• Hold down the Shift key while selecting 
the object. 

To remove objects from a selection:

• Shift-click the selected object.

To select obscured objects:

1 Hold down the Shift key and select 
through the obscuring object. All objects 
underneath the cursor and behind the 
frontmost object will be selected, or

Drag a marquee around the objects.

2 Hold Cntrl/Cmd and click an object to 
select or deselect. Use shift to select 
multiple objects. 

You will see a list of all objects under the 
pointer. This lets you not only view the 
selection status of all the listed objects, but 
change it as well. This aids in dealing with large 
scenes. 

The Selection Palette

The Selection palette is hidden behind the 
Animation controls in Bryce’s default state. The 
palette is divided into two sections: select by 
type tools and the VCR controls.

The Selection palette has tools for selecting objects in 
variety of different ways.
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To display the Selection palette:

• Click the Time Selection Palette toggle in 
the lower right corner of the Working 
window. The Selection palette appears. 

Selecting By Object Type

The Select by Type icons let you select all the 
objects in your scene that are of a particular 
type. For instance, if you click on a sphere here, 
Bryce will select all spheres and sphere-
derivative objects in your scene. 

All of the selection controls below respect the 
previously-described Shift-click techniques for 
multiple selections and deselections.

The following tools are available:

To select a specific object by type:

• Hold down the cursor over the tool for the 
type of object you want to select and 
choose the name of the object from the 
menu that appears.

You must first name objects, if you want 
them to appear in this menu. Refer to 
“Naming Objects” on page 101 for more on 
naming objects.

To select objects by family:

• Click the Families tool and choose the 
name of the family you want to select from 
the menu.

You must first name a family if you want it 
to appear in this menu. Refer to “Families” 
on page 310 for more information.

Click the Time Selection Palette toggle to switch 
between the Animation and Selection palettes.

Selects all Infinite slabs.

Selects all Water, Cloud, and 
Ground planes.

Selects all Terrain objects.

Selects all Stone and Mesh 
objects.
Selects all Symmetrical Lattice 
objects.
Selects all Torus objects.

Selects all Spheres, Ellipsoids, 
and Squashed Spheres objects.

Selects all Cylinder, Tuboid, 
Squashed Cylinder, and 
Stretched Cylinder objects.
Selects all Cube, Brickoid, and 
Stretched Cube objects.
Selects all Pyramid objects.

Selects all Cone, Stretched Cone, 
and Squashed Cone objects.
Selects all 2D Disk objects.

Selects all 2D Face and 2D PICT 
objects.
Selects all Radial Light objects.

Selects all Spotlight objects.

Selects all Square Spotlight 
objects.
Selects all Parallel Light objects.
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To select Mesh objects:

• Click the triangle icon next to the 
selections palette and choose Select Mesh.

To select Path objects:

• Click the triangle icon next to the 
selections palette and choose Select Path.

To select Group objects:

• Click the triangle icon next to the 
selections palette and choose Select 
Group.

To select all objects except a specific type:

1 Click the tool for the object you want to 
exclude from the selection. All the objects 
of that type are selected.

2 Click the triangle icon in the Selection 
palette and choose Select Inverse from the 
menu.

To select all the objects in your scene:

• Click the triangle icon in the Selection 
palette and choose Select All from the 
menu.

The VCR Controls 

The VCR controls let you step through the 
various selection tools and activate Solo Mode.

To display the VCR Controls:

1 Click the Time Selection Palette toggle in 
the lower right corner of the Working 
window. The Selection palette appears.

2 Pass your cursor over the right side of the 
Selection palette. The VCR Controls 
appear.

To step forward and backward through the 
object types in your scene:

1 Click on the larger forward arrow to step 
forward through object types within the 
current scene. The first object of its type is 
selected.

2 Click on the larger backward arrow to step 
back through object types. 

If you watch the Select By Type icons, the 
object type you are stepping to will 
highlight momentarily.

To step forward and backwards through the 
object in a selected object type:

1 Click on the smaller forward arrow to step 
forward through each object of the type in 
a selection. 

For example, you can use the large arrows 
to step to the first sphere created in your 
scene, and then the smaller arrows to step 
through all other spheres in your scene.
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2 Click the smaller backwards arrow to step 
backwards through each object of the type 
in a selection. 

One advantage to making selections with this 
technique is that you can select objects within a 
Group. Simply clicking on a Grouped object will 
not necessarily select the entire group; using the 
VCR controls to select within a Group allows you 
to reposition objects, or assign textures to objects 
within a Group without having to first Ungroup 
them.

To step sequentially through every object in 
your scene:

1 Click the triangle icon in the Selection 
palette and choose Alternate VCR Mode.

2 Click the larger backwards or forwards 
arrow.

To step sequentially through families:

1 Click the triangle icon in the selection 
palette and choose Alternate VCR Mode.

2 Click the smaller backwards or forwards 
arrow.

To temporarily remove all unselected objects 
from the scene:

1 Select an object.

2 Click the Solo Mode button in the center 
of the VCR controls. The button color 
changes to red.

In Solo Mode, you can only edit the 
selected objects; all the other objects 
remain in place but uneditable.

If you’re working on a very complex scene, 
Solo Mode speeds up your work 
significantly as Bryce does not have to 
calculate and draw extraneous wireframe 
objects.

Editing Your Scene’s Contents

Bryce supports several of the basic editing 
features you find in most applications. You can 
cut, copy and paste objects between the 
clipboard and your scene. 

Cutting and Pasting Objects

To cut and paste an object:

1 Select an object.

2 Choose Edit menu> Cut, or
Press Command-X/Ctrl+X.

The selected item is removed from your 
scene and placed on the clipboard.

3 Choose Edit menu> Paste, or press 
Command-V/Ctrl+V.

To copy and paste an object:

1 Select an object.

2 Choose Edit menu> Copy, or press 
Command-C/Ctrl+C.

A copy of the selected item is placed on the 
clipboard.

3 Choose Edit menu> Paste, or press 
Command-V/Ctrl+V.

Copying and Pasting Materials

Using the Copy/Paste Material commands, you 
can edit an object’s material without affecting 
the object.
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To copy and paste an object’s material:

1 Select an object.

2 Choose Edit menu> Copy Material, or 
press Command-Option-C/Ctrl+Alt+C.

The selected item’s material is copied to 
the clipboard.

3 Choose Edit menu> Paste Material, or, 
press Command-Option-V/Ctrl+Alt+V.

Copying and Pasting Matrices

Using the Copy/Paste Matrix commands, you 
can copy information about an object’s 
location, size and orientation values to the 
clipboard and then paste them onto other 
objects.

To copy and paste an object’s matrix:

1 Select an object.

2 Choose Edit menu> Copy Matrix or press 
Option-C/Alt+C. 

The selected object’s matrix is copied to 
the clipboard.

3 Select a different object.

4 Choose Edit menu> Paste Matrix or press 
Option-V/Alt+V.

To delete a selected object:

1 Select an object.

2 Choose Edit menu> Clear or press the 
Delete/Backspace key.

Duplicating and Replicating 
Objects

When you duplicate an object, Bryce creates an 
exact copy of the object and places it in exactly 
the same position as the original. When you 
replicate an object, Bryce creates a new object 
and applies the last set of transformations to it.

To duplicate an object:

1 Select an object.

2 Choose Edit menu> Duplicate or press 
Command-D/Ctrl+D.

To replicate an object:

1 Select an object.

2 Choose Edit menu> Replicate or press 
Option-D/Alt+D.

A new object appears at a size, location and 
orientation based on the last set of 
transformations. For example, if you select 
an object, drag it to a new location and 
then select Replicate, a new object is 
created at the same distance from the 
original. 

To replicate objects numerically:

1 Select an object.

2 Choose Edit menu> Multi-Replicate or 
press Command-Option-Shift-D/
Alt+Shift+D.

The Multi-Replicate dialog appears.

3 Enter a value in the Quantity field.

This value sets the number of duplicates 
you want to create.

4 Enter X, Y and Z values in the Offset fields.
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Offset values are expressed in a range from 
0 to 99999 Bryce units of measure (refer to 
“Bryce Units” on page 282 for more on 
Bryce units). The default value is zero.

5 Enter X, Y and Z values in the Rotate 
fields.

Rotate values are expressed as degrees, 
with a range of 0 to 999. The default value 
is zero.

6 Enter X, Y and Z values in the Scale fields.

Size values are expressed as a percentage 
of current size, with a range of 0 to 9999%. 
The default value is 100%.

The Quantity value entered in this dialog sets the 
number of duplicates created when you use the 
Replicate command.

Undoing Operations

The Undo and Revert to Saved commands let 
you erase the effects of changes you made to 
your scene.

To undo the last operation:

• Choose Edit menu> Undo or press 
Command-Z/Ctrl+Z.

To redo the last operation:

• Choose Edit menu> Redo.

To revert to the last saved version of your 
scene:

• Choose File menu> Revert to Saved.

All unsaved changes are discarded.

The Marker Pen

The Marker Pen turns your screen into a white 
board. When you’re using the Marker Pen, you 
can draw anywhere in the Bryce environment 
without affecting your scene. One key click 
erases all the marker pen lines.

To draw with the marker tool:

1 Click the Marker Pen tool or press the M 
key.

2 Drag it anywhere on your screen.

To erase marker pen lines:

• Click the Marker Pen tool again or press 
the M key again.

Saving and Closing
The Save command lets you save your work in a 
convenient location for later use. Since your 
scene files can quickly become large and 
complex, you should save your work often.

Saving Files

To save a file:

1 Chose File menu> Save. The Save dialog 
appears.

2 Use the dialog controls to choose a 
location for your work and click Save.
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To save a file under a different name:

1 Chose File menu> Save As. The Save 
dialog appears.

2 Enter a new name and/or location in the 
fields provided and click Save.

3 A copy of your work is saved, leaving the 
original intact. 

If the Image With Scene Open/Save preference 
is selected, Bryce saves both the scene data and 
the rendered image when it saves the file.

Closing

When you close the application, a dialog 
appears asking you to save your work. 

To close Bryce:

• Choose File menu> Quit or press 
Command-Q/Ctrl+Q.
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4  

Animation in 
Bryce

Animation Overview
Animation is the process of adding a fourth 
dimension to your scene—time. To create an 
animation, you arrange a scene then record 
your movements or transformations of objects 
over time. Bryce creates a motion path from 
your recorded movements and then generates 
an animation. 

You can animate almost anything in your 
scene:

• the motion of objects, lights, and the 
camera

• object size and shape

• object materials

• terrain objects

• sky properties



The Animation Process

Animation is a cooperative process between 
you and Bryce. You set up the arrangement of 
objects and scene settings, and then you adjust 
those settings over time. Bryce steps in and fills 
in the gaps between adjustments. When you 
play the animation, motion is created.

The steps to creating an animation are as fol-
lows:

• Create objects using the Create tools or the 
Terrain Editor.

• Build a scene by arranging and 
transforming objects, lights and 
the camera.

• Adjust the position, orientation or scale of 
objects. Each time you make an 
adjustment, you create a key event which 
indicates a point where an object property 
was changed.

• Adjust the shape or placement of the 
motion path.

• Adjust the speed at which the object moves 
along the motion path using the Advanced 
Motion Lab.

• Render the animation as a movie file. You 
can render the animation as a QuickTime/
AVI movie file or as a set of frames.

Animation Tools
Bryce 3D’s animation tools are designed to help 
you quickly and easily animate the properties of 
your scene. 

Animation Controls

The animation controls let you record an ani-
mation and preview it in the Working Window. 

You can also use the controls to change the cur-
rent time or move to different points in time.

The Animation controls appears in three areas 
in Bryce:

• The Working Window

• The Materials Lab

• The Terrain Editor

• The Sky Lab

The tools have basically the same function in 
each area. The only difference is that controls 
in the editors let you create key events for the 
properties associated with the editor. This 
means that in the Terrain Editor you can only 
add key events for terrain objects, and in the 
Materials Lab you can only add key events for 
material properties.

The Timeline

The Timeline is a graphical representation of 
time. The darker gray area within the Timeline 
represents the current length of your anima-
tion. 

Use the animation controls to record and preview your 
animation.

The Timeline indicates the length of your animation and 
the current time.

Timeline
Time/Selec-
tion Palette 

Time Dots Animation Preview 
controls

Key frame 
controls

Timeline

Working Area Current Time Indicator
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The green colored section of the timeline rep-
resents the length of the Working Area. The 
Working Area can be used as a visual guide to 
help you isolate portions of your timeline. 
When you render the animation you can 
choose to render the entire timeline or just the 
Working Area. This is also the only area that is 
previewed when you use the animation preview 
controls.

The Current Time indicator lets you move to 
different points in time. This is the main tool 
you’ll use to create animations. Every time you 
want to add a key event, you move the Current 
Time indicator to a different point on the time-
line.

Animation Preview Controls

The Animation Preview controls let you move 
between the key frames in your animation.

The larger buttons move to the beginning and 
the end of the animation. The smaller buttons 
move to the next and previous key frames. 

Using the Movie Preview

In addition to viewing still images in the nano-
preview window, you can use the same window 
to see a movie preview. Used this way, the movie 
preview window provides a simple, quick, way 
to see a rendered version of your animation 
without having to leave Bryce.

See “Previewing Animations” on page 363. for 
more information.

Time Dots

The Time Dots let you save positions on the 
timeline. You can use the dots to quickly jump 
between areas of the timeline you’re working 
on.

Key Frame Controls

The Key Frame controls let you add and delete 
key frames in your animation. 

The Key frame indicator is only active when the 
current time is at a key frame.

The Add Key frame (plus) button lets you add a 
key frame. When you are in Camera View, with 
nothing selected, Add frame automatically key 
frames the camera. In Director’s view, it does 
not. It also keys the sky.

In Auto-Key mode, Bryce automatically adds 
key frames for you, but when you disable the 
mode, you’ll have to use Add Key frame to add 
key frames at points in the timeline.

The Delete Key button deletes the current key 
frame event or a specific type of key event. In 

Use the Animation Preview Controls to move between key 
frames in your animation.

PlayTo Start To End

Previous Key frame Next Key frame

Stop

Use the Time dots to quickly move between saved positions 
along the timeline.

Use the Key Frame controls to add and delete key frames 
from the timeline.

Key frame Indicator

Add frame Delete frame
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the Working Window, deleting a key event 
deletes all the frames at the current time. In the 
editors the Delete Key button only deletes key 
events for the properties associated with the 
editor.

Animation Options

The triangle icon to the right of the animation 
controls, displays Auto-Key Framing option 
menu. This menu lets you turn the animation 
system on or off. 

When the animation system is enabled, every 
change you make to the scene is recorded as a 
key event. Changes can include things like 
moving an object, changing a material, or 
changing the shape of a terrain.

When the animation system is disabled, your 
changes are not recorded. To record a key event 
you have to use the Add Key Frame button. The 
animation system is enabled by default.

This menu also contains the following:

• Ticker Marks lets you select from frame or 
time options. 

• Play mode lets you choose Once, Repeat, 
or Pendulum.

• Time display is either SMPTE or Frame.

Time/Selection Palette Toggle

The Time/Selection Palette toggle lets you 
switch between the Animation controls and the 
Selection palette. 

Advanced Motion Lab Button

The Advanced Motion Lab button opens the 
Advanced Motion Lab.

The Advanced Motion Lab

The Advanced Motion Lab contains tools that 
let you control the detailed properties of your 
animation. You can use the lab to view object 
hierarchies, remap key events and adjust the 
position of key frames on the timeline.

Use the triangle icon to access the animation options menu 
which lets you enable or disable the animation system.

Use the Time/Selection Palette toggle to switch between 
palettes.

Use the Advanced Motion Lab button to enter the 
Advanced Motion Lab.
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Hierarchy List Area

The Hierarchy List Area displays the scene’s 
hierarchical structure, including links, and 
groups. You can view all the hierarchies 
expanded or just the parent objects in the 
scene. You can also expand an object’s listing to 
show all of its properties. 

The Sequencer

The Sequencer lets you see the key frames 
recorded for each property within an object. 
Each property has its own timeline track. Key 
frames are displayed as white marks on the 

timeline. The current time is indicated by the 
Current Time bar. 

The Sequencer lets you see where in time a 
change in an object’s property occurred and 
edit the position of that event. Different types 
of objects have different properties. 

A scene contains more than just objects. You 
can expand the Hierarchy List to also display 
the properties for your scene’s sky and the cam-
era.

The Advanced Motion Lab lets you control the speed of 
objects along a motion path and the placement of key 
frames on the timeline.

SequencerHierarchy Area

Preview AreaTime Mapping Curve Editor

The Sequencer lets you control the placement of key events 
on the timeline.

Each Object listed in the Hierarchy List area can be 
expanded to show the timelines of any transformations 
applied to it.

Key frame

Hierarchy List Object Timeline

Current Time Bar
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The display buttons along the left side of the 
hierarchy area let you hide or display an object 
in the animation preview. This can help you iso-
late objects in a complex scene.

Time Mapping Curve Editor

The Time Mapping Curve editor lets you con-
trol the length of time between key events. 
Each property listing in the Hierarchy List has 
its own time mapping curve. 

The curve acts like a time filter which remaps 
the time in your animation. Depending on the 
shape of the curve, the events in your anima-
tion may take longer to complete, or may all 
occur very rapidly.

A time mapping curve can speed up events 
while slowing down others. You can even 
reverse the action in your animation. Refer to 
“Time Mapping Curves” on page 371 for more 
on working with Time Mapping Curves.

Preview Area

The Preview Area contains tools that let you 
preview your animation.

The Preview Area has three parts:

• The Animation Preview area displays a 
wireframe preview of your scene. Any 
changes you make in the Time Mapping 
Curve editor or the Sequencer are updated 
to this area.

• The Preview VCR controls let you play the 
animation like a movie. You can stop, play, 
move forward one key frame, or back one. 
The far right button renders the scene.

• The Preview Display Controls let you zoom 
in/out of the preview, switch between 
Camera View and Director View, pan the 
preview and reset the preview. 

Use the display buttons to hide or show objects in the 
animation preview.

The Time Mapping Curve editor lets you remap the time in 
your animation.

The Animation Preview area lets you see any changes you 
make to the timing and velocity of objects.

Preview Controls

Animation Preview

Preview VCR Controls
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Animation Features
Bryce has several special features that let you 
add extra effects to your animations:

• Time Mapping Curves

• Animating Transformations

• Animating Materials

• Animating Terrains

• Animating Skies

Time Mapping Curves

Time Mapping Curves are graphical representa-
tions of the time mapping filter. The filter 
remaps the time in your animation, so that the 
events that occur at specific times in your ani-
mation occur differently in actual time. 

By adjusting the shape of the curve, you can 
control how fast events occur. When you create 
a sharp jump in the curve, you speed up the 
events in your animation. When you flatten the 
curve, you slow down key events.

Each property of your scene can have a differ-
ent curve, so you can have key events occurring 
at different speeds.

Refer to “Time Mapping Curves” on page 43 for 
more on Time Mapping Curves.

Animating Transformations

When you’re in Auto-Key mode, every transfor-
mation you apply to an object is recorded as a 
key frame. 

In the Hierarchy area you can see where the key 
frames for these transformations appear in the 
timeline. By moving these key frames you can 
control the order in which transformations are 
applied. For example, you can take an object 
that grows larger and then moves left, and turn 

it into an object that moves left and then grows. 
Several animation techniques, like squash and 
stretch, can be simulated using transforma-
tions. 

Refer to “Animating Transformations” on 
page 43 for more on animating transformations.

Animating Materials

The Materials Lab has its own set of animation 
tools that let you animate material properties. 
You can animate almost any property or texture. 

When you’re animating between textures, 
Bryce interpolates between patterns and colors 
over time. You can have a rocky terrain turn into 
a desert during the course of your animation.

Refer to “Animating Materials” on page 388 for 
more on animating materials.

Animating Terrains

The Terrain Editor has a set of animation tools 
that let you animate a terrain over time. You can 
animate the shape of the terrain, or the filtering 
effects like Erosion or Mounds. 

Using these tools, you can create a terrain that 
changes shape as time passes.

Refer to “Animating Terrains” on page 396 for 
more on animating terrains.

Animating Skies 

The Sky & Fog palette and the Environmental 
Attributes dialog have a number of controls 
that let you set the properties of your environ-
ment. By changing these properties over the 
course of an animation, you can animate your 
environment. For examples, you can make 
clouds move, or gradually change the time of 
day.
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Refer to “Animating Skies” on page 393 for more 
on animating skies.

Managing Your Project
Storyboarding

If you are attempting anything other than a 
brief animation, it’s a good idea to create a sto-
ryboard first. A storyboard is a series of drawn 
images showing the key actions in an anima-
tion. The storyboard helps you quickly work 
out the animations viewpoint, framing and 
composition. Because you’re just sketching, it’s 
easy to make changes and other arrangements. 
Your work on the storyboard will give you an 
idea of the types of objects you’ll need to model 
and how to arrange the scene.

You can make sample storyboards by drawing a 
series of horizontal screen outlines on a sheet 
of paper, using a 4 to 3 aspect ratio (ratio of 
width to height). Draw the screens as large as 
necessary, and leave a block of space for the 
narration or description. You can also purchase 
cartooning storyboards at art supply stores.

Storyboard Preview

You can see a storyboard preview of your ani-
mation. See See “Previewing Animations” on 
page 363. for more information

Simplifying Your Scenes

In general, the 3D scenes you create for anima-
tion need not be as complex as a typical illustra-
tion scene. The viewer’s eye tends to be drawn 
toward motion and foreground elements. Static 
objects and background elements are scanned 
only casually.

By reducing unnecessary detail, you can reduce 
rendering times dramatically and keep the size 

You can use a storyboard to help layout the action in your 
animation. 
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of your scene files manageable. When prepar-
ing a scene for animation, keep the following 
guidelines in mind:

• Refine your animation. Keep the objects as 
simple as possible. Detail is usually lost in 
an animation.

• Use fewer objects, and limit the number of 
reflective and transparent objects.

• Use the minimum number of lights 
required to achieve an effect. Additional 
light adds significantly to the rendering 
time.

• Limit the number of objects with complex 
materials.

• If a complex model remains in the 
background for the duration of the 
animation, try substituting a simpler 
version.

• If your Camera View remains unchanged 
for an entire scene, consider rendering a 
still image with just the scene’s 
background elements. Then use this image 
as a backdrop and animate only the 
foreground elements. This technique 
requires some planning to make sure that 
shadows and transparent objects don’t give 
the “trick” away.

Rendering Without Compression

If you are not pressed for hard disk space, it 
usually makes sense to render your animation 
without compression. This ensures that you’ll 
have a high quality copy of the animation to 
work with. 

Working from your uncompressed original, you 
can save copies, experimenting with various 
compression settings until you are satisfied 
with both the image quality and playback rate.

An animation compressed multiple times 
degrades significantly, so you should always 

render without compression if you intend to do 
any postprocessing in another application.

Motion and Timing 
Principles
As an animator, the most important skill you 
can master is the ability to portray motion con-
vincingly, whether it is intended to be realistic 
or exaggerated and cartoonish. No matter how 
good a 3D modeler you are, the timing of the 
events in your animation are of paramount 
importance. 

Many of the principles of timing and motion 
developed by cell animators apply to 3D anima-
tion with Bryce as well. Many of these princi-
ples apply especially to character animation, 
but most are useful for any subject matter. For 
more information, you can refer to one of the 
many excellent books on cartoon animation.

Squash and Stretch

Squash and stretch are animator’s terms for the 
exaggerated redistribution of an object’s mass 
as it moves or shifts positions. Squash and 
stretch portray the qualities of elasticity and 
weight in a character or an object. 

Think of a bouncing rubber ball. As it falls it 
stretches; as soon as it hits the ground it is 
squashed. If the ball failed to change shape, the 
audience would interpret it as a solid, rigid 
mass. 

You can accomplish squash and stretch in 
Bryce by transforming the object at different 
points in time.
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Lag and Overlap

When an object moves from one point to 
another, not everything has to move at once. 
For true-to-life movement, action that is sec-
ondary to the main activity can lag and overlap. 
For example, when you animate swirling curves, 
the cubes at the top would swirl faster than 
those at the bottom. In Bryce, an object’s hier-
archy can be used to create these effects. 

Arc vs. Straight Line Movement

Character motion appears more realistic if it 
follows an arc or curved path instead of a 
straight line. Most objects affected by gravity 
also follow curved, rather than straight trajecto-
ries. 

Bryce’s motion paths can be used to create any 
type of trajectory.

Secondary Motion

Secondary motion adds realism and credibility 
to a scene. A character turning his head to stare 
at something in disbelief shouldn’t just turn his 
head; his jaw should drop and his eyes should 
blink as well. The viewer focuses on the main 
action, but registers the secondary motion as 

supporting it. Bryce’s Advanced Motion Lab 
gives you enough control to manage even the 
finest details of your animation, so you can add 
this kind of secondary detail.

Exaggeration

Exaggerating an action emphasizes it, making it 
more prominent. For example, if intrigue is 
called for, have a character sneak instead of 
walk. 

If you want your animation to resemble footage 
from a hand-held camera, give your camera an 
exaggerated bobbing motion. Virtually any type 
of action can be exaggerated to get an idea 
across.

Timing

Timing is as important in animation as it is in 
any dramatic form. Consider the difference 
between an abrupt stop and a gradual slow-
down. Each conveys a completely different 
impression. In general, a motion that continues 
at the same pace lacks interest and seems 
unreal. 

If you are trying to animate realistic character 
action, act out the sequence yourself, timing 
how long each pose is held and how long each 
action takes with a stopwatch. 

Timing is one of the most difficult aspects of 
animation to master. The key events you define 
at different points on the time line need to be 
synchronized with those that came before and 
those that follow. Fortunately, you can use the 
interactive nature of computer animation to 
fine-tune your timing. Test your animation fre-
quently by previewing it in the Working win-
dow or by dragging the Current Time indicator 
back and forth between key events. Adjust the 
event’s position in the Advanced Motion Lab 
until you’re satisfied with the timing.

This ball’s bouncing motion is exaggerated by deforming 
its shape so that it stretches as its descending and squashes 
when it hit the surface.
46 Animation in Bryce 



5  

Tutorial

Welcome
Welcome to the Bryce tutorial. This tutorial 
introduces you to all the major features and 
functions of Bryce. The main goal of this 
tutorial is to teach you the basic techniques 
you’ll need to know to create incredible 
landscapes and environments.

There are two separate tutorials: a basic 
tutorial that shows you how to create a terrain, 
customize the sky, and create a body of water. 
The“The Advanced Tutorial” on page 62 
teaches you how to create a more complex 
environment and how to create an animation. 

Each section of this tutorial is self-contained, 
so you can start from any point. For example, if 
you need to know about positioning the 
camera, but already know how to create skies, 
start the tutorial at the Camera lesson. All the 
files necessary for completing the lessons are 
provided for you on the Bryce CD-ROM. 
Bryce files have a BR4 file extension.



To help you follow along, every lesson contains a 
section called “The Story So Far,” which summa-
rizes the procedures and techniques that have 
been covered in the previous lessons. A section 
called “What You’ll Need” tells you where to 
locate files that will help you complete the lesson.

Getting Started
Before you start any project in Bryce, it’s 
probably a good idea to become acquainted 
with the unique Bryce interface.

The first thing you’ll want to do is configure the 
window to best suit how you work.

To configure the Bryce environment:

• Launch Bryce.

The Bryce window appears and fills the 
entire screen.

This is a great way of working as it removes 
all the clutter from your desktop and gives 
you clear access to all of Bryce’s tools. 

• Click a palette, then hold the Spacebar 
while you drag it to a new location.

To keep the Bryce interface as uncluttered as 
possible, some toolbars are layered on top of 
each other and others are hidden when you 
first start the application. 

To display layered palettes:

• Click the text buttons at the top of the 
Bryce environment. The active palette’s 
title appears highlighted.

Some tools are hidden because you won’t need 
them regularly, so they appear only when you 
need them and then they disappear again.

To display hidden palettes:

• Move your cursor over the right edge of the 
Bryce window. 

Along the right you’ll find the Display 
palette.

Most of Bryce’s tools have several options that 
extend their function. Whenever you see a 
triangle next to a tool, you know that there are 
more options available.

Tip
When you place the cursor over a 
control, the name displays in the 
lower left corner of the window.

The active palette’s title appears highlighted.

Hidden palettes appear when you pass your cursor over 
them, then they slowly disappear.
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To display option menus:

• Click the triangle icon. The option menu 
appears.

Now that you’re familiar with how to access the 
tools in Bryce, you can set up a new document. 
Refer to “Using the Bryce Interface” on page 20 
for more on using the interface.

Lesson 1: Setting Up a New 
Document

When you set up a new document, you’re 
defining the size of your working space in 
pixels. The larger the resolution, the larger your 
working space. The resolution you choose 
depends on what type of scene you want to 
create. 

To help you decide on a resolution, Bryce 
provides several presets aspect ratios for the 
most commonly used types of documents. 
Refer to “Setting Up the Working Window” on 
page 17 for a complete discussion of 
resolutions and aspect ratios.

To set up a new document:

1 Choose File menu > New Document. The 
Document Setup dialog appears. (If you 
have an existing document, you are 
prompted to save it.)

2 Click the Photo preset. The Resolution and 
Aspect Ratio fields update automatically. 

If your monitor is set to a lower resolution, 
you may need to choose a different preset. 
Try Standard if Photo is too large for your 
screen. 

3 Click the checkmark icon (also referred to 
as the OK icon) at the bottom of the dialog 
to accept your changes and exit the dialog.

Now that you have a document, you can start 
creating a scene. When you’re working through 
the tutorial, it’s a good idea to start with a blank 
scene at the beginning of each new section.

A triangle icon next to a tool indicates that there are 
more options available.

Use the Document Setup dialog to set the resolution and 
aspect ratio of your scene.
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Lesson 2: Positioning the 
Camera

When you first create a file you’ll be viewing 
the scene through the Director’s View. In this 
view, you can see all the objects in the scene 
including the camera.

The other main view is called the Camera View, 
which is the view as seen through the camera. 
You can switch between the two views to get a 
different perspective on your scene.

When you’re working on setting up the 
composition of the scene, you can use any of 
the Views such as Camera View or Director’s 
View to reposition or transform objects.

To switch between views:

• Click the triangle icon beside the View 
Control icon and choose Director’s View 
from the menu.

• Toggle between the views by clicking the 
icon (either a director’s chair, or a camera).

As you work on the scene, you may find that the 
camera object is somewhat distracting. To avoid 
this, you can hide the camera in the scene. 

To hide the camera:

1 Click the camera in the scene. 

2 Click the A icon (Object Attributes button) 
that appears next to the camera’s bounding 
box. The Camera & 2D Projection dialog 
appears.

3 Enable the Invisible option. Click the OK 
icon. 

This option only hides the camera in the 
current file. It remains hidden until you 
show it again.

To unhide the camera:

• If you are in Camera mode, double-click 
the Trackball and select unhide invisible. 

• If you are using the Director’s View, select 
the camera and it automatically unhides.

In this lesson you’ll use the Director’s View to 
view and arrange objects. The controls for 
positioning the camera are the same, whether 
you’re positioning the Director’s View or the 
Camera View.

There are four controls you can use to position 
the camera: the Camera controls, the Trackball, 
the Preset Views and the 2D Project and 
Camera dialog. Most of these tools are located 
on the Control Palette.
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Refer to “Setting Up the View of Your Scene” on 
page 328 for more on these tools.

When you reposition the camera, you’re 
changing the view of the scene, not the position 
of the objects.

To start this lesson, you’ll need to open a file 
with some objects in it.

To open the camera lesson file:

1 Choose File menu > Open.

2 On the CD-ROM, locate the file Manual 
Tutorial: Camera: Camera Scene and click 
Open.

To reposition the camera using the Camera 
Controls:

1 On the XZ control, drag the Z arrow down. 
The scene moves towards you. 

The cursor turns into an axis indicator 
when you move over a tip of the control.

2 On the XY control, drag the tip of the Y 
arrow up.

The objects should now be easier to see, but 
you can adjust the camera again to get a better 
angle on the scene. 

To reposition the camera using the Trackball:

1 Click the center of the Trackball and drag 
to the right. The scene rotates to the left.

The camera is now in an almost perfect 
position to view the scene. You can place the 
camera in a precise position by moving it 
numerically.

When you move over the tip of an arrow in the Camera 
control, the cursor turns into an axis indicator.

Your scene should look like this when you’re done using 
the Camera controls.

Use the Trackball to rotate the camera around the scene.
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To reposition the camera numerically:

1 Double-click the Trackball. The Camera & 
2D Projection dialog appears. 

2 Enter Position X=24, Position Y=15, 
Position Z=-10, Rotate X=0, Rotate Y=-30, 
Z=0

3 Leave the remaining values at their 
defaults.

4 Click the OK icon to apply the changes to 
the camera.

Now that you can see your objects, you can 
select and reposition them.

5 Close the file. Since it is a lesson, you don’t 
need to save it unless you want to.

Arranging Objects in the 
Scene
The Basic Tutorial

A 3D illustration depends heavily on the 
arrangement of the objects in the scene to 
create a specific look or feel. 

When arranging a scene, you should remember 
that you’re working in 3D space, meaning that 
your object can be viewed from any angle. You 
should take all of these angles into account 
when you ‘re arranging objects—an 
arrangement that looks good from above may 
not look so good from the back and so on.

The lessons in this section will help you learn 
how to add, position and transform objects to 
create a 3D illustration.

The Story So Far

Before starting this lesson, you should have 
your document set up and know how to access 
the tools and palettes in Bryce.

What You’ll Need

To complete these lessons you’ll need some 
objects to arrange. These objects have been 
placed in the Preset Objects Library for you. 
Other than that, all you’ll need is a blank scene.

Adding Objects
If you have started with the default settings and 
see the Animation controls along the bottom of 
the screen, click the Selection Animation 
toggle at the bottom right corner of the screen 
to toggle to the Selection Palette. (You can also 
use the S key to toggle between the two modes.) 

This palette allows you to select various objects 
in your scene prior to resizing, rotating, 
repositioning or applying material properties to 
the selected object.

When you apply the values you entered in the Camera 
& 2D Projection dialog, the view of your scene should 
look like this. 

The Selection palette. 
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At the top of the screen you’ll see the words 
Create, Edit, and Sky & Fog. When clicked, 
they bring up different palettes described 
below.

The Create Palette

Click Create, then click any of the objects in the 
Create Palette to place that object in your 
scene.

Placing the mouse pointer over the different 
objects displays the name of the object at the 
bottom left of the screen. Try moving the mouse 
pointer over these object to familiarize yourself 
with them.

The Edit Palette

Click Edit to display the Edit Palette. In the 
Edit Palette you will be using three of the tools: 
Resize Rotate and Reposition.

Bryce uses three axes to Resize along, Rotate 
about and Reposition along. They are labelled 
X,Y and Z. The X axis runs from front right to 
back left into the scene. The Y axis runs 
vertically top to bottom in the scene The Z axis 
runs from front left to back right into the scene. 

The Sky and Fog Palette

Click Sky and Fog to display the Sky and Fog 
Palette. The Sky and Fog Palette allows you to 
edit the various components of a sky preset or 
even to design your own. 

Lesson 1: Creating Terrains

Let’s begin by creating a scene which contains 
mountains, a sky, a ground plane and a desert 
lake. 

To create a terrain:

1 Create a terrain by clicking Create to 
display the Create Palette, then clicking the 
Terrain Object in the Create Palette. 

The terrain appears in your scene (This is 
labelled by Bryce as Terrain 1). Note the 
Nano Preview image shows the terrain 
rendered in the default colors. Your scene 
in Wireframe mode should look like this: 

The Create palette. 

The Edit palette. 

The Sky and Fog palette. 

Terrain 1. 
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2 Click the Object Attributes button to 
display the Object Attributes box, and 
notice that the name of your first terrain is 
Terrain 1. (The Object Attributes button is 
at the top of the buttons associated with 
the selected object’s bounding box.)

3 Click the OK icon at the bottom right of 
this box to exit, we will return to the 
Object Attributes box later on.

4 With the terrain selected (outlined in red) 
click Edit, and use the Reposition tool to 
move the terrain into the rear left of your 
scene. 

As you move the mouse pointer over the 
arms of the Reposition tool a small tag 
appears telling over which axis you are 
positioned. 

5 Place the cursor over the upper X (left) arm 
of the tool, then click the tool and drag to 
the left. The terrain will move along the X 
axis towards the rear of your scene. 

6 Place the cursor over the upper Z (right) 
arm of the tool, then click and drag to the 
right. 

7 Repeat this process as needed until the 
terrain is in the position shown below. 

The terrain looks very small now so we need to 
resize it. 

To resize the terrain:

1 With the terrain still selected, click the 
center of the Resize tool, then drag to the 
right to increase the size of the terrain. 

Notice that as you resize the terrain it 
appears to disappear below the ground 
plane. This occurs because the terrain is 
resized evenly about it's center. 

2 Click the Land Selection button (located at 
the bottom of the vertical row of buttons to 
the right of the terrain). 

The terrain repositions on the 
groundplane and the arrow button 
disappears. 

3 Resize the terrain until it looks something 
like the image below. 

To add a second terrain:

1 Click Create, then click the Terrain Object 
to add a second terrain. Then reposition it 
until it is positioned and sized as shown 
below. 

Positioning a terrain. 

The terrain so far. 
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2 Note that this terrain (Terrain 2) is further 
back than the first one. 

3 Click the Render button and you should 
see results similar to the image below. 

To switch back to Wireframe mode:

1 Move the cursor just to the right of your 
image area and the Advanced Display 
Palette appears. 

2 Near the bottom of the palette is the 
Display Modes button. When you place the 
cursor over this button, the words Display 
Modes appear at bottom left. 

3 Click this button once to return to 
Wireframe display mode, or click the 
Escape key to toggle between the modes.

Lesson 2: Adjusting the Terrain

Notice that the terrains (mountains) look a bit 
peaky and not very natural as a result. This can 
be corrected in the Terrain Editor. 

To load the Terrain Editor:

1 Select Terrain 2 and click the Editor button 
(the E button located in the vertical list of 
buttons associated with the selected 
terrain object). Your screen is overlaid by 
the Terrain Editor.

A second terrain. 

A rendered terrain. 

The Display Modes button. 

Display Modes button
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2 Click the Smoothing button twice, then 
exit the Terrain Editor by clicking the OK 
icon. 

3 Select Terrain 1 by clicking it; it becomes 
red. 

4 Click the Editor button to display the 
Terrain Editor, then click the Smoothing 
button once. 

5 Exit the Terrain Editor by clicking the OK 
icon, then render by clicking the Render 
button. 

6 Your image should look like the one below.

Lesson 3: Applying Textures

Now we will apply a material to the mountains 
and the ground plane. The ground plane is the 
grid in the foreground which appears by 
default whenever you start a new project. It is 
an infinite plane in that it extends to infinity 
along the X and Z axes (You'll be introduced to 
finite planes later in this manual).

To apply a texture:

1 Click the Display Modes button to return 
to Wireframe display mode. 

2 Click Terrain 1 to select it. 

3 Hold down the Shift key on your keyboard 
and click Terrain 2; still holding the Shift 
key down click the Groundplane (Plane 1). 

All three objects are selected and outlined 
in red. 

4 Make sure the Edit Palette is showing (click 
Edit if needed) and click the triangle icon 
next to Edit. 

This displays the Material Presets selection 
panel. On the left side and you'll see 
Planes and Terrains. 

5 Click Planes and Terrains and another 
selection of preset materials appears. 

6 Click Desert Rock. 

A red border appears around your selected 
material. 

7 Click the OK icon at the bottom right of 
this panel to return to your scene.

 If you look at the Nano Preview window 
(top left) you'll see that the material has 
been applied. 

Smoothing the terrain. 

Both smoothed terrains. 
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8 Click the Render button and your image 
should look like this. 

Creating the Sky
The Story So Far

Before starting this lesson, you should know 
how to create a terrain.

What You’ll Need

To complete these lessons you’ll need an 
existing terrain. If you’ve been following this 
tutorial from the beginning, you can use your 
existing file. Otherwise, you can use the preset 
file provided for you. The file is called Basic 
Tutorial Finished Terrain and is located on the 
CD-ROM in the Manual Tutorials folder.

Lesson 1: Adding a Sky Preset

Now let us add a sky preset to the image. 

To add a sky preset:

1 Click Sky and Fog, then click the triangle 
icon next to Sky & Fog. 

A selection of sky presets appears. 

2 Click to select Jet Stream. 

3 Exit Sky & Fog if you want to render at this 
point.

You can do a render now if you like, by 
clicking the Render button. Let’s modify 
the clouds to change the appearance of the 
scene.

4 Click the words Sky & Fog and to the right 
of the Sun Position Trackball you'll see the 
Sky Memory Dots, and underneath you'll 
see a triangle icon. 

5 Click the triangle icon, then deselect the 
option Cumulus Clouds by clicking it. 

The check mark should have disappeared. 
The original sky preset had both cumulus 
and stratus clouds in it and by deselecting 
one you changed it to a completely 
different sky.

6 Now render your scene by clicking the 
Render button, and you should see 
something like this. 

Lesson 2: Adjusting the Sky

Now we'll tweak the image a bit more. 

The terrains after texture has been applied. 

A modified sky. 
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To adjust the sky:

1 If needed, click the words Sky & Fog to 
display the Sky & Fog Palette. 

Move the mouse pointer over the 
thumbnail pictures across the top of the 
screen and note the wording that appears 
in the bottom left. Locate the one called 
Haze. 

2 Click the Haze thumbnail picture, then 
you'll see the figure 1 appear at the bottom 
left, this is the Haze value. 

3 Drag the Haze value to the right and this 
figure will increase. Increase the haze value 
to 17. 

Note that dragging to the left will reduce 
the value. 

4 Render your scene again and notice how 
the increased haze value has separated the 
two mountains appearing to push the 
farther terrain further back in the distance. 

You should now see something like this. 

Creating a Body of Water
The Story So Far

Before starting this lesson, you should have an 
existing terrain. The previous lessons taught 
you how to create a terrain and customize a sky 
preset.

What You’ll Need

To complete these lessons you’ll need an 
existing terrain. If you’ve been following the 
tutorial from the beginning, you’ll have an 
existing file. Otherwise, you can load the preset 
file Basic Tutorial Finished Sky provided for 
you.

Lesson 1: Preparing the Landscape

The area in the foreground needs some interest 
added—how about a body of water such as a 
lake. What we'll do is “dig” a hole in the ground 
and add some water. This requires the use of a 
boolean operation, you will learn about these in 
detail later in the manual. 

In this tutorial, we'll use a Negative boolean 
operation to cut out a hole in the ground plane. 
A Negative boolean operation requires a 
Positive object (or a Positive group of objects) 
and a Negative object. When these are grouped 
together the shape of the Negative object is cut 
out of the Positive object. Objects can be given 
Negative or Positive attributes in the Object 
Attributes box.

To set the landscape as a positive boolean 
object:

1 Click the Selection Animation toggle (in 
the lower right corner) to switch to 
Wireframe mode. 

A hazy sky. 
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2 In Wireframe mode select one of the 
terrains. 

3 Then while holding the Shift key down 
select the second terrain and the ground 
plane. 

All three should now be highlighted in 
red. 

4 Click the Object Attributes button (A 
button) to display the Objects Attributes 
box, then click Positive. This sets each one 
of the selected objects to Positive. 

5 Exit the Object Attributes box by clicking 
the OK icon. 

To group the terrains:

1 Click the Group button (the G button in 
the vertical list associated with the selected 
objects) to group the three objects Terrain 
1, Terrain 2 and Plane 1 together in a 
Group called Group 1. 

2 With Group 1 still selected, click the 
Objects Attributes button, then set Group 
1 to be Positive. 

3 Exit the Object Attributes box by clicking 
the OK icon. 

Lesson 2: Creating the Interior of 
the Lake

Next create a third terrain—Terrain 3 and apply 
the same Desert Rock material as you used 
before. Refer to “Lesson 1: Creating Terrains” 
on page 53 to create the terrain and “Lesson 3: 
Applying Textures” on page 56 to apply the 
texture.

This terrain needs to be rotated through 180 
degrees about the X or Z axis, to create the 
interior of the lake. 

To rotate an object:

1 Click Edit, then the Rotation control. Move 
the mouse pointer over the X or Z axis 
rotation ring. 

2 Hold down the Shift key (this causes the 
rotation to be carried out in 45 degree 
increments), then click and drag 
horizontally on the rotation ring. 

You’ll see the angle of rotation displayed at 
the bottom left of your screen. 

3 Drag until you see either 180 or -180. The 
terrain will now be upside down and your 
screen should look like this. 

4 With Terrain 3 still selected, click on the 
Object Attributes button to display the 
Object Attributes box, then click Negative. 

It is now a negative boolean object. This 
means that Bryce will “cut” this shape from 
the terrain.

5 Exit by clicking the OK icon. 

You'll notice that the Terrain 3 wireframe is 
dotted since it is now Negative. 

An inverted terrain. 
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6 Lower Terrain 3 until the square base 
(which is now on top) is just above the 
ground plane. 

7 Click Edit and use the Reposition tool to 
position it along the Y axis. 

8 Your screen should look like this. 

To group the terrains:

1 With Terrain 3 still selected, hold down the 
Shift key and click one of the other 
terrains to select Group 1 together with 
Terrain 3. 

2 Click the Group button. 

3 When you render now by clicking the 
Render button, you will see a hole has 
appeared in the ground plane. 

It looks a little on the small side for a lake 
though, more a pothole. Let's make it 
bigger. 

4 Return to Wireframe mode by clicking the 
Selection Animation toggle found in the 
lower right corner of the Bryce window, 
then click the Terrain icon in the Selection 
Palette at the bottom of the screen. Keep 
the mouse button depressed. 

5 You’ll see Terrain1, Terrain 2 and Terrain 3 
listed—select Terrain 3. 

Terrain 3 should now be the only selected 
object. Although it is part of a group this 
terrain can still be repositioned, resized 
and rotated singly. 

6 With Terrain 3 selected, use the Resize tool 
to make it bigger and the Reposition tool 
to fine tune the positioning. 

Watch the Nano Preview to check the 
effect you're creating. When you lower the 
terrain, keep the square bottom above the 
ground plane otherwise the hole will 
disappear. 

Positioning the inverted terrain. 

A hole in the ground plane. 
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7 When you've adjusted the size and 
position of the hole you should see 
something like this after rendering. 

Lesson 3: Filling the Lake

Now we'll fill the hole with water. 

To fill the lake:

1 Click Create to display the Create Palette. 

2 Click the Water Plane icon. 

A water plane appears with a random water 
material applied. It covers the whole of 
your image up to the bases of the 
mountains—this is another of those infinite 
planes. 

3 Click Edit to display the Edit Palette, then 
click the triangle icon next to the word 
Edit. 

This displays the Materials selection panel. 

4 Select Waters & Liquids then choose 
Waves of Reflection (third row down, three 
from left). 

5 Click the OK icon to exit the Materials 
selection panel.

6 With the water plane still selected use the 
Reposition tool to lower the plane along 
the Y axis until it is just below the ground 
plane. 

7 Now render and you will see results that 
look like this. 

This concludes this beginners tutorial and 
shows how a basic landscape scene is 
constructed in Bryce. This tutorial has only 
touched on a very small fraction of the controls 
and procedures available in Bryce.You could go 
further with this image by adding some rocks to 
the foreground, perhaps some vegetation all by 
following the basic Create, Size, Rotate, 
Position and Apply Material. 

Try different water materials for the water plane 
and different terrain and plane textures. A 
different sky perhaps—in Bryce the variations 
are literally endless. 

An enlarged hole in the ground plane. 

A filled lake. 
61 Bryce 4



The Advanced Tutorial

Part 1: Creating and 
Importing Objects
In the first part of this tutorial, you will create 
an interior scene of a building with vaulted 
ceiling. The centerpiece of this room is a 
mirrored sphere that you’ll import. Then, you’ll 
place lights to light your scene. In the next part, 
you’ll animate the camera to fly through the 
scene.

The Story So Far

Before starting this lesson, you should know 
how to use Bryce’s tools to create and adjust 
objects, and how to position and move the 
camera. Refer to the previous sections of this 
tutorial for review if needed. 

Launch Bryce, and choose File menu > New 
Document. Set the file to the size of 480x360.

What You’ll Need

To complete these lessons you’ll create most of 
the objects you’ll need to use.

Creating the Interior Scene 

In this series of lessons, you will construct a 
building out of Bryce primitives. You’ll use 
Bryce’s edit controls to change their size, 
position and rotation as needed to make the 
building. You’ll also use booleans to carve one 
piece out of another. Then, you will work with 
basic scene organization using Bryce’s Family 
controls.

Next, you will add an object of interest to your 
building by placing a sphere on a pedestal. 
Then you will light the interior of your scene. 

In Part 2 of the tutorial, you will animate the 
camera to fly through the building and create 
an animation. You’ll work with pre-production 
animated-scene planning, planning your 
animation timeline, setting keyframes, and 
animating your camera. You’ll also learn some 
steps to tweak your camera path.

Creating the Roof
Lesson 1: Creating a Vaulted 
Ceiling

This building is fairly easy to create. While 
creating it, you will become familiar with the 
create and edit controls of Bryce, as well as 
review the use of booleans. 

Notice that the order used to create objects in 
Bryce, doesn’t match how those objects would 
be created in the real world. In this example, 
the roof is created first, and later the walls are 
added underneath.

To create the roof of the vaulted ceiling:

1 Click Create to switch to the Create Palette.

2 Click the Create Pyramid icon.

The Create palette. 
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A pyramid appears in your scene. 

Next, adjust the pyramid’s size so that it is 
flatter overall by reducing its height.

3 Click Edit to switch to the Edit Palette. The 
Edit Palette appears.

Move the cursor over the top of the Resize 
tool. The cursor changes to a Y and the tool 
changes to enlarge toward the top.

Click the top of the Resize tool and hold 
down the Shift key. (This makes the object 
change size by regular increments.) Slowly 
drag to the left. The pyramid will snap to 
half its previous height.

Next you’ll proportionately enlarge the 
pyramid. This time, work directly with the 
object’s handles in the scene window.

4 Place the cursor over the upper right 
corner of the object’s bounding box, next 
to the Object Attributes button (the A 
button). The cursor changes to a 
proportional resize.

Click there and hold down the Shift key, 
then drag to the right. The pyramid snaps 
to larger sizes. Drag for one snap, then 
release the mouse. Next, drag for three 
more snaps. 

A pyramid displays. 

The Edit palette. 

The pyramid before the height change. 
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The pyramid is enlarged, and should 
extend off the right edge of the scene 
window. 

Next, you’ll use the arrow keys to nudge its 
position to a more central place in the 
scene.

5 Press the left arrow key four times. The 
pyramid moves so that the entire object 
can be seen in the scene window.

Lesson 2: Converting a Pyramid

The next task is to duplicate the pyramid and 
convert it to a sphere. Eventually the sphere 
will be “cut out” from the pyramid using a 
boolean operation. 

To duplicate the pyramid:

1 Choose Edit menu > Duplicate. A second 
pyramid appears in the exact place where 
the first one is.

Click the double arrows at the top right of 
the Edit Palette. A set of Bryce pyramids 
appears. Drag to the left until the sphere 
primitive is highlighted. 

Release the mouse. The pyramid has 
changed to a sphere.

Lesson 3: Resize the Sphere

To cut the sphere out of the pyramid, its size 
needs to be changed, and its position adjusted 
slightly. This time you will resize the object 
using another one of Bryce’s edit controls: the 
3D Transformation dialog box.

The enlarged pyramid. 

The highlighted sphere primitive. 

The converted pyramid. 
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To resize the sphere:

1 Click the triangle next to the Resize tool, 
then select 3D Transformations from the 
list. A dialog box appears. 

The bottom row of options are for 
changing the object’s size. Size is expressed 
as a percentage of the current size. To 
enlarge the sphere horizontally without 
affecting the height, you will enter new 
values for the X (width) and Z (depth) axes 
and leave the height (Y) axis unchanged.

2 In the numerical boxes for size for the X 
and Z axes, enter 125 (for 125%). Click the 
OK icon to exit the dialog box. The sphere 
expands slightly on the horizontal axis 
while remaining unchanged in height.

Next, adjust the position of the sphere so 
that it cuts out portions of the pyramid, 
leaving the four corners intact as a roof 
support. To more easily see what you are 
doing, change your view of the scene to 
front.

3 On the Controls Palette, choose View 
Controls menu > Select From Front. The 
scene changes so that you are viewing the 
objects from a straight horizontal view.

In the next step, you will move the sphere 
down.

4 Place the cursor over the top of the 
Reposition tool on the Edit palette. The 
cursor changes to a Y. Hold the Shift key, 
click, then drag to the left. The sphere 
drops so that it is half hidden under 
ground. Release the mouse.

3D Transformations dialog. 

The View options From Front. 
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Next you will lower the sphere a bit more 
(without using a key constraint) until the 
next “rung” of the wireframe is aligned 
with the ground level.

5 Click the top of the Reposition tool again, 
then hold the Shift key and drag to the left 
slightly until the wireframe is aligned with 
the ground. You may have to do it two or 
more times to get the alignment exact. The 
sphere should now look like the one 
shown below.

If your scene doesn’t look like the one shown, 
select the pyramid, and zoom in twice by 
clicking the Zoom in button located on the 
lower section of the Display palette (to the right 
of the Working Window).

Lesson 4: Cut Out the Roof with 
the Sphere

The next task is to carve out the under side of 
the roof with the sphere by using a boolean 
operation. For this, change back to the 
Director’s View.

To cut out the roof:

1 Click the triangle next to the View control, 
then choose View Options menu > 
Director’s View from the Control palette. 
The view icon changes to a Director’s 
chair, and your scene changes to the 
perspective you had when you started this 
tutorial.

Now, assign boolean properties to your 
objects. The sphere is selected, so we’ll 
start with that.

2 Click the Object Attributes button next to 
the sphere’s bounding box. The Object 
Attributes dialog box appears. 

Under the title, Sphere 1, the button for 
Neutral is selected. That is the default for 
all Brycean objects. 

Lowering the sphere. 

The converted pyramid 
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3 Click the button next to Negative. Click the 
OK icon to exit the Object Attributes 
dialog box. The sphere’s wireframe 
changes to dotted lines.

Next, make the pyramid positive.

4 Select the Pyramid by clicking it. Its 
wireframe turns red. 

You could use the Object Attributes dialog 
box to make the pyramid positive.However, 
Bryce has an easier way. 

Simply type P (for positive). The wireframe 
doesn’t change; its line is still solid. You can 
check the Object Attributes dialog box to 
confirm that the change occurred if you want.

Lesson 5: Creating a Group

To make the boolean effect work, you must 
group the objects together. The pyramid is 
already selected. Add the sphere to your 
selection. 

If the Selection palette isn’t displayed, click the 
Selection Animation toggle, or type S, to switch 
palettes.

To group objects:

1 Press the Shift key, which allows you to 
add to the selection. Then, on the 
Selection Palette (below the Working 
Window), click the Select Sphere icon. 
The sphere’s wireframe is red as well as the 
pyramid’s.

If the Animation palette is displayed, click 
the Selection Animation toggle at the 
bottom right corner to toggle to the 
Selection palette, or type S.

2 Group the objects by clicking the Group 
button located next to the selected object’s 
bounding box.

The bounding box changes slightly, with 
diagonal insets at each corner. This 
indicates that the object is a boolean group. 
In addition, the G button disappeared, and 
a U button took its place. (The U stands for 
Ungroup.)

Setting an object to negative. 

Tip
To make an object negative, type 
N. To make it intersect, type I. To 
make it neutral, type the letter O. 

Setting an object to negative. 
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3 Render the scene to check your 
handiwork, by clicking the Render button. 
Your scene should look like the scene 
shown below.

Creating a Family Group

You have now constructed the ceiling of this 
building. Before moving on, however, a bit of 
housekeeping is in order. Since you will be 
adding new objects to your scene, now is a good 
time to name this group and assign it a unique 
family name and wireframe color.

To create a family group:

1 Press the Esc key to switch back to 
wireframe mode. The wireframe of your 
scene appears.

2 Click the gray Family button underneath 
the Object Attributes button. The Family 
dialog box appears. The gray color is 
selected and the Default Family name 
displays at the bottom of the dialog box.

3 Click the bottom left color (maroon). The 
text display now reads Family 21. Type the 
words Boolean Roof. The text changes.

4 Click the OK icon to exit the Family dialog 
box. The dialog box disappears, and the 
Family button has changed to the maroon 
color. 

5 Deselect the object by clicking the 
background of the image. The wireframe 
has now changed to maroon instead of 
gray.

The family name and color now displays 
under the families menu. You can check 
this out.

6 Locate the Select Families icon on the 
Selection Palette. Click the icon and a 
menu appears. Notice that one of the items 
there is the family you just created, 
Boolean Roof. Select that item on the 
menu. Your group, the boolean roof is 
selected again. (Note: the other family 
besides the Default Family, Family 17, is 
the family color for the camera which is 
always present in your scene.)

The results so far. 

The Family dialog box. 

The Select Families menu. 
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7 Save your scene file and give it the name 
Rendered Boolean.

A copy of the scene file at this stage is located 
on the Bryce 4 CD-ROM in the Manual Tutorial 
folder. It is called Rendered Boolean.

Building the Walls
In this next section, you will create walls for 
your roof using the cube primitive. Before 
doing so, however, you will need to move the 
roof up so that the walls can fit underneath.

What You’ll Need

If you are continuing from the previous step, 
ensure that your scene file from the previous 
section is open. If you are beginning this 
tutorial from this point, open up the scene file 
called Rendered Boolean, located in the 
Manual Tutorials folder on the Bryce 4 CD-
ROM. 

Lesson 1: Moving the Roof

To move the roof up:

1 If needed, select the Group by clicking it in 
the scene window. The wireframe turns 
red.

2 Press the Page Up key 6 times to move the 
object up. The bottom of the pyramid is 
aligned to the horizon.

3 Click the Object Attributes button to 
access the Object Attributes dialog box. 
Change the settings for Position on the Y 
axis to 36.86. 

Moving the roof. 

Note
If you do not have a keyboard 
with a page up key, here is an 
alternative way to move the group 
up. 

The Object Attributes dialog box. 
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Lesson 2: Creating the Walls

You are now ready to create walls to go 
underneath your ceiling with the arched 
cutouts. The Cube primitive will be the basis of 
your walls.

To create walls:

1 On the Create Palette, click the Create 
Cube icon. A cube appears in your scene.

With so many objects in the scene, assign 
this cube to its own family right away.

2 While the newly created cube is still 
selected, click the family color button to 
access the Family dialog box. Change its 
color to an unused color and type the word 
Wall in the text entry field. The family 
color is changed.

3 Look at your scene from Top View by 
choosing the Control Palette, View 
Options menu > From Top. The scene 
changes to top view.

You can zoom in on your view to make the 
wireframes bigger. 

4 Click the Zoom In tool on the Advanced 
Display palette (the Zoom In tool is the 
magnifying glass with a + .) The Advanced 
Display palette is a hidden palette located 
to the right of the Working Window. Move 
the cursor over it to display it.

The view grows larger, with the selected 
cube object in the center of your scene 
window. 

Creating the walls. 

Tip
Another way to see your scene 
from top view is to use a 
keyboard shortcut. Press the 
number 2. (  ` or ~ is Director’s 
View, 1 is Camera View, 2 is Top 
View, 3 is From Right, 4 is From 
Front) 

View from the top. 
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Lesson 3: Adjusting the Wall Size

Notice that the cube’s bottom edge is aligned 
with the pyramid’s edge. The group’s edge 
extends beyond that, due to the size of the 
sphere, but the edge that you want to work with 
is the pyramid. So the cube is aligned on the 
outside edge. However, it needs to be made 
wider to match the pyramid’s width, and 
narrower in depth so that it does not occupy so 
much of the pyramid’s interior. We’ll start with 
this size change.

To adjust the wall size:

1 Place the cursor over the top center point 
of the bounding box. The cursor changes 
to a Z, indicating that Bryce is ready to 
work with the object along the Z axis. Click 
there, and hold down the Shift key, then 
slowly drag to the left. The cube snaps to 
half its depth. Release the mouse. Repeat 
this step, to shrink it to half its depth again. 

The wall is thin enough; now it’s time to 
make it wider.

2 Place the cursor over the right center point 
of the bounding box. The cursor changes 
to an X. Press the Option or Alt key (this 

will resize the object from the center). 
Press Shift and click, then slowly drag to 
the right. The cube widens by set 
increments. By the fourth snap, it matches 
the width of the pyramid. Release the 
mouse and keys.

If needed, nudge it into position so that it 
aligns correctly. 

Lesson 4: Duplicate the Walls

You now have one wall. Duplicate this wall to 
create the one opposite.

To duplicate the walls:

1 Duplicate the cube by choosing Edit menu 
> Duplicate or by pressing Command/
Ctrl+D. A second cube appears in the same 
place; it shares the size characteristics of 
the first.

2 Press the up arrow key to move the wall to 
the opposite side. (11 to 13 taps should 
place it there.) The second wall is now 
located at the opposite end.

Adjusting the wall size. 

Widening the wall. 
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The wall could be duplicated, rotated 90 
degrees and nudged into position with the 
arrow keys, and then duplicated again and 
nudged to the opposite end. There is an 
easier way, however. 

3 Click the Select Families icon on the 
Selection palette, and select Wall from the 
list. Both walls are selected.

4 Duplicate these walls by choosing Edit 
menu > Duplicate or by pressing 
Command/Ctrl+D. A second set of walls is 
created in your scene.

For the next action you will temporarily 
group the newly created second set of 
walls.

5 Click the Group button to group the walls. 
The G button changes to a U, indicating 
that the objects are grouped. The Family 
button color is gray for Default family (as a 
new entity, it takes on the Default Family 
color and label.)

Now you can rotate this group around its 
center, which happens to be the same as 
the center of the pyramid room.

6 Click the Edit button to bring up the Edit 
Palette. Place your cursor over the 
horizontal band of the Rotate tool. The 
cursor changes to a Y. 

7 Press the Shift key to constrain rotation to 
45 degree increments. Click and slowly 
drag in either direction. The group snaps 
first to 45 degrees, and, as you continue 
dragging, to 90 degrees. Release the mouse.

8 Ungroup the group by clicking the 
Ungroup button. The U changes to a G, 
and the Family color changes to the Wall 
color.

Lesson 5: Make the Walls Taller

Before starting this lesson, switch back to 
Director’s View.

To make the walls taller:

1 On the Controls Palette, select Control 
Options > Director’s View. The view 
changes to show more depth perspective.

2 Click the Render button to render your 
scene. It should look like the image shown.

The walls are there, but they’re not tall 
enough.

3 Press the Escape key. The wireframe view 
of your scene appears.

4 Make sure the Wall is selected, then place 
the cursor over the top part of the Resize 
tool. The cursor changes to a Y.

The Rotate tool. 

The rendered scene at this point. 
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5 Press the Shift key, then click and drag to 
the right until the walls pop up to meet the 
bottom of the pyramid and align 
themselves with the horizon. 

You now have created a building with a 
pyramid roof, arched cutouts to let light inside, 
and walls all around. Congratulations! All you 
lack is a door. (It’s always something, isn’t it?)

Lesson 6: Adding a Doorway

To add the doorway, look at the scene from top 
view.

To add a door:

1 Look at your scene from top view by 
choosing View Options menu > From 
Top, or press the number 2).

The walls objects should still be selected. 
The boolean roof wireframe will be a 
hindrance. You’ll hide it using Solo Mode, 
so you can concentrate only on your wall 
objects.

2 On the Selection palette, click the Solo 
Mode button. All unselected objects (the 
ground plane and the boolean group) 
disappear, leaving only your selected 
objects and the camera.

Make the boolean doorway by duplicating 
and resizing one of the cubes so that it cuts 
a hole through the wall. We’ll put the 
doorway in the front wall.

3 Deselect the wall objects by clicking 
elsewhere in your scene window. Click the 
bottom cube object to select only it. 

4 Duplicate the object by choosing Edit 
menu > Duplicate, or Command/Ctrl-D). 
This new object will become the doorway 
object.

The doorway object needs to be made a 
little thicker than the wall it will be 
subtracting from. While you’re still in Top 
View, you will increase its depth slightly. 

5 Click the Z axis on the Resize tool. Hold 
down the Option (Macintosh) or Alt 
(Windows) key to change the size 
symmetrically. Drag a tiny bit to the right 
on the Resize tool to make the doorway 
object thicker. It doesn’t have to be much. 
The object is a little thicker than the front 
wall.

The other resize adjustment need to be 
made looking at the object from Front 
View.

6 Switch to Front View by choosing View 
Objects menu > From Front or press the 4 
key. The view of the scene changes to front 
view.

Raising the walls. 
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7 Click the X axis on the Resize tool. Hold 
down the Option/Alt key and drag to the 
left until the object is about the width 
shown. 

8 Locate the top Y axis on the Resize tool. 
Drag left to shorten the doorway until it 
looks to be about the height shown in the 
figure above.

Lesson 7: Assigning Boolean 
Properties

After the doorway object is created and sized 
correctly, assign boolean properties to it. The 
doorway needs to be cut out of the wall, so 
you’ll need to make the doorway object 
negative.

To add boolean properties:

1 Press the N key to make the doorway object 
negative. The wireframe changes to a 
dotted line.

2 Select the front wall by clicking it. The 
wireframe turns red.

Since you can’t tell from looking at the 
scene from front view whether the front 
wall or the back wall is selected, it’s a good 
idea to look at your scene from top view.

3 Switch to Top View by choosing View 
Options menu > From Top, or press the 2 
key). Your scene changes to top view. The 
front wall should be selected (and the back 
wall should not.).

4 Change this object’s properties to positive. 
Press the P key or click the Object 
Attributes button to access the Object 
Attributes dialog box, then click the button 
next to Positive. The wireframe remains 
solid.

5 Select both the front wall and the doorway 
by drawing a selection marquee around 
their centerpoints, as shown. The 
wireframes of both objects are red.

6 Click the Group button to group them. The 
G changes to a U and the family color 
changes to Default Gray.

Since this group is part of the Wall family 
of objects, it’s a good idea to assign the 
group to the Wall family. 

Creating the door. 

Creating a boolean object. 
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7 Click the Family button on the Selection 
palette to access the Family dialog box. 
Select the family for wall. Click the OK 
icon to exit the dialog box. The Family 
button changes to the Wall wireframe 
color.

Congratulations! You just carved a boolean 
doorway out of a wall. It’s time to leave 
Solo Mode and see the results in the main 
scene.

8 Click the Solo Mode button to exit solo 
mode. The rest of your scene appears.

9 Change to Director’s View. by choosing 
View Options menu > Director’s View or 
type the ` key). Your scene appears in 
perspective.

10 Click the Render button.

You may need to adjust the walls if there is 
a gap between the walls and the roof.

11 Save your scene.

Group and Grow the 
Entire Building.
You’ll be placing objects inside this building 
and eventually flying through it with the 
camera, so the building needs to be bigger than 
it is currently. When you enlarge the entire 
object as a group, the individual objects retain 
their size and position relationship to one 
another.

Lesson 1: Grouping the Building

To group the building:

1 Choose Edit menu > Select All (or 
command/Ctrl+A). All of your objects, 
including the ground, are selected. 

2 Hold down the Shift key and click the 
ground to deselect it. The selection 
bounding box encloses only the pyramid 
group and the wall objects. The Group 
button is showing.

3 Click the Group button to group these 
objects. The G disappears.

4 Press the * key two times (Shift+8). Each 
time, your group’s size doubles. So it is 
now four times what it was when you 
started. There is also an up arrow button at 
the bottom of the group of buttons 
associated with the selected object. 

The upward pointing arrow indicates that a 
portion of your grouped building is 
underground. In this case, when you 
doubled its size, it enlarged from its center, 
so a good portion of the building is 
underground.

Grouping the building. 
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5 Click the upward pointing arrow button 
(located with the group of buttons 
associated with the bounding box of the 
selected object). The group jumps up so 
that it is now resting at ground level. 

Lesson 2: Change Your Perspective 
of the Scene

You need to adjust your perspective of the 
scene so you can see the entire building. In 
fact, if you were to render right now, you’d see 
nothing, because the perspective is from within 
one of the walls.

To change perspective:

1 Place the cursor over the Trackball control 
on the Controls palette. The cursor 
changes to double crossed arrows while 
the TrackBall changes colors. 

2 Click and drag the Trackball to the right. 
The scenes rotates counter clockwise in 
the scene window. Keep dragging until the 
blue camera wireframe is on the left side of 
the window and the center wireframe lines 

of the front and back walls line up in the 
center of the window, looking like the 
scene shown.

3 Click the Render button. You’ll see a 
diagonal streak of light running from the 
upper right to the lower left in your scene 
as the scene renders. 

You are now looking through the doorway 
of the building, but are very close. So how 
about moving back?

4 Place the cursor to the closest arrow of the 
XZ Camera Cross, located just above the 
TrackBall control on the Control Palette. 
The cross changes color and the cursor 
changes to a Z.

(If the cursor is a crosshair or an X, it’s 
because the cursor is located over a 
different part of the XZ Camera Cross 
control. Move it around until the cursor 
changes to a Z.)

5 Drag up on the XZ Camera Cross until you 
can see the entire front wall of the 
building. You may have to move the camera 
a couple of times until it reaches that 
point. 

Grouping and positioning the building. 

Changing perspective. 
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The scene should look like what’s shown 
here.

To see the entire building, we have to move 
things down. There are two possibilities: 
one is to use the camera controls to move 
the Director’s View higher. That will move 
the building down. But it will also look at 
the scene from a higher perspective. 

The other alternative is to pan the scene 
down with the Pan tool. It will not change 
the perspective of the scene, merely show 
more of what’s higher.

6 For this lesson, use the camera controls.

7 Render the scene.

8 Save your scene and call it Grouped 
Building.

Sphere on a Pedestal
The next step of this tutorial will have you work 
with an already existing scene file and merge it 
into the one you are creating.

The Story So Far

If you are continuing the tutorial, you should 
have created a building with a roof, walls, 
doorway, and are ready to add the centerpiece. 

What You’ll Need

If you are starting at this point, open the file 
called Grouped Building, and you’ll soon 
merge the file called Pedestal Merger. Both files 
are located on the CD-ROM in the Manual 
Tutorials folder.

Lesson 1: Merging an Existing 
Scene

To merge another scene:

1 Select File menu > Merge. An Open dialog 
box appears. 

Use it to find the scene file you want to 
merge into your current scene.

2 Navigate to the Manual Tutorial folder on 
the Bryce 4 CD-ROM. Select the scene file 
called Pedestal Merger and click the Open 
button. The Wireframe for the merged 
scene appears in your scene, and is 
selected.

Changing your viewpoint. 

The merged scene. 
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3 Render the scene. There is now a pedestal 
with a mirrored sphere on it. There are 
lights in the scene as well. 

Lesson 2: Adjusting Lights

The merged objects should still be selected. In 
this next section, you will make slight 
modifications to the lights and use Bryce’s 
tracking controls to make the lights always 
point at certain objects. To make it easier, you’ll 
need to temporarily rid your scene of 
extraneous objects. 

To adjust lights:

1 Click the Solo Mode button on the 
Selection palette to change to Solo mode. 
The ground, walls and building objects 
disappear, leaving only the two lights and 
the pedestal and sphere. 

2 Click away from the objects to deselect 
them, then select the lower light.

The fourth button down (in the group of 
buttons associated with the selected object) 
is the Tracking icon. 

3 Click the Tracking icon and drag from it to 
the sphere object. While your mouse 
button is still pressed, whatever object is 
underneath the mouse turns blue. When 
the sphere turns blue, release the mouse. 
The light is now set to track the sphere.

4 Drag the light so that it is located above 
and to the left of the sphere. The light 
remains pointing at the sphere.

5 Click the Land Selection button (the Down 
arrow button located in the group of 
buttons associated with the selected 
object). The light snaps to the ground, 
pointing toward the sphere from this 
position.

6 Select the light that is located above and to 
the right of the pedestal. The wireframe 
turns red.

7 Drag from this light’s Tracking icon to the 
tall cylinder. The tall cylinder turns blue. 
Release the mouse.

The rendered scene. 

The scene in Solo mode. 
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8 Drag the light down and to the right 
slightly.

9 Click the Solo Mode button to exit Solo 
Mode. The rest of your scene appears.

10 Render and save your scene.

In the next tutorial, you’ll animate your camera 
to fly through the scene.

Part 2: Animate the 
Scene:
In this second part of the building tutorial, we 
will animate the camera to fly through this 
scene. You may start with the scene file you 
were working with before, or you may use the 
scene file entitled Animation-start. 

What You’ll Need

 A stopwatch, watch, or clock with a sweep 
second hand. (Or you can count very slowly.)

Pre-Production
In this tutorial, you will go through the process 
of thinking through the creation of an 
animation where you fly the camera through 
this scene.

You’ll work on some pre-production tasks prior 
to animation. Then you will animate the 
camera, and tweak and finesse the animation, 
and conduct test renders.

Lesson 1: Pre Visualizing and 
Timing the Sequence

Let’s take a moment and think about where the 
camera should go. The pre-production and 
storyboard phase is one where you think 
through what you want to accomplish for the 
animation. We’ll take a modified storyboard 
approach where we’ll think through the camera 
path.

Up until now, however, you’ve been working 
with your scene in Director’s View and in the 
different orthogonal views. For scene creation, 
Director’s View is better. For animating you will 
use Camera View. Let’s start by locating the 
camera where the Director’s View is. 

To plan and time the sequence:

1 On the Controls Palette, choose Camera 
Options menu > Camera >> Director. 
The camera wireframe disappears from the 
scene. 

Repositioning a light. 
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The camera object has moved to the same 
location as the Director’s View, so it is now 
located at your point of view.

When you view your scene from above you 
will see the camera’s wireframe location 
has changed.

2 View your scene from Top View. On the 
Controls Palette, choose View Options 
menu > From Top, or press the 2 key. Your 
scene changes to top view. The camera is 
now located at the bottom of the scene 
window.

In this animation, the path the camera will 
take goes through the doorway, circles 
around the pedestal, then goes out through 
the archway just above the left wall. Note 
that you might have to zoom out to see the 
same view as this image.

3 On the Display palette, (to the right of the 
Working Window) click the Demo marker 
tool. Beginning at the camera’s location, 
drag the mouse to draw a path from the 
camera, through the doors, around the 
pedestal, and out the left side. Your screen 
should look something like this:

Look at the path there. How long should 
this animation last? 

Get your stopwatch, watch, or clock with a 
sweep second hand. Or, start counting very 
slowly. Envision what the camera does 
while timing the sequence. You may narrate 
the animation sequence out loud to get a 
sense of how long the clip should last. 

4 Mark the beginning time, envision the 
sequence, and then mark the end. How 
many seconds did it take?

Camera Options. 

The top view 

Drawing the path. 
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For this example, assume 9 seconds. The 
narrative goes something like this: “Start: 
Approach, doorway, close up, around, 
around, around, around, recede, roof, back. 
Cut.”

5 To make the marked path go away, press 
the space bar. The red mark disappears.

Lesson 2: Setting up the Timeline 
for the Sequence

Time line animation settings. 9 seconds. 10 
frames per second.

Now that you know your sequence will be 9 
seconds, it’s time to set it up and begin 
animating the camera. 

To set up the Timeline:

1 Choose File Menu menu > Animation 
Setup. A dialog box appears. Enter 9 
seconds in the Duration portion, and 
change the frames per second (FPS field) 
to 10. Your dialog box should look like the 
one shown.

When you exit the dialog box, the Time 
Scrubber and Current Time Indicator fills 
with a green timeline.

The green extends beyond what is visible 
in the Time Working area. Use the Scale 
tool above the right end of the timeline to 
scale the green timeline so that you can see 
it in its entirety.

2 Drag the cursor to the right at the Scale 
tool. The tick marks move closer together 
and more of them appear from the right. 
Continue dragging until you can see the 
entire green portion of the timeline.

3 If the Selection palette is showing, toggle 
to the Animation palette by clicking the 
Selection Animation toggle in the lower 
right corner of the Bryce interface, or 
pressing the S key. The Animation palette 
appears.

4 Click the triangle on the right side of the 
Animation palette, then select Auto-key if 
it isn’t already selected. 

5 Click the triangle again and select Ticker 
Marks > Every 5 Frames. A check mark 
appears on the menu. 

If your frame rate is 10 frames per second, then 
a tickmark every 5 frames is equivalent to a 
tickmark every half a second.

You now have set up your timeline in 
preparation to animate the camera. Before 
animating the camera, think about the 
placement of keyframes.

Animation Setup. 

Scaling the timeline. 

Animation palette. 
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Animate the Camera 
Lesson 1: Setting the Camera 
Trajectory

To adjust the camera’s trajectory:

Look at your scene from top view. The 
camera is located at the bottom. 

1 Click the Add Keyframe + button to add 
this initial keyframe at the beginning, if 
needed. The key highlights to a darker 
green color, indicating that there is 
keyframe information stored for that point 
in time.

2 Drag the Scrubber three ticks to the right. 
The time reading is 00:00:01.05 (for one 
second, frame 5).

You are now ready to drag the camera to a 
new position for this point in time.

3 Drag the camera to the interior of the 
room, as shown.

A blue point appears where the camera 
was just located, and a blue trajectory line 
links the first point with the new camera 
location.

The trajectory is the line along which the 
camera will move.

4 Drag the Scrubber another three ticks to 
the right. The time reading is 00:00:03.00 
(three seconds).

5 Drag the camera so that it is on the left side 
of the mirrored sphere wireframe, as 
shown. The blue trajectory follows the 
camera’s position, and a blue point is left 
in the spot where the camera was 
previously.

Note: Do not drag the camera by the blue 
handle in the center of the camera; you will 
be dragging and adjusting the actual key 
position rather than the camera itself. We’ll 
get into adjustment of the key position later 
in this tutorial.

6 Drag the Scrubber another three ticks to 
the right. The time reading is 00:00:04.05 
(four seconds, 5th frame).

7 Drag the camera so that it is on the far side 
(top) of the sphere wireframe, as shown.

Positioning the camera. 

Drag to the next position. 
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Another point appears where the camera 
was previously, and the blue trajectory 
extends to this new position.

8 Drag the Scrubber another three ticks to 
the right. The time reading is 00:00:06.00 
(six seconds).

9 Drag the camera so that it is on the right 
side of the sphere wireframe, as shown.

 Another point appears at the camera’s 
previous position, and the blue trajectory 
extends around to this new position.

10 Drag the Scrubber around another three 
ticks to the right. The time reading is 
00:00:07.05.

11 Drag the camera so that it crosses to the 
left of the path as shown.

Another point appears, and the trajectory 
extends to this new position.

12 Drag the scrubber the final three ticks to 
the right to the end of the green timeline. 
The time reading is 00:00:09.00.

Another camera location. 

Yet another camera location. 

Continuing the trajectory. 
83 Bryce 4



13 Drag the camera well beyond the 
wireframe to the left of the building, as 
shown.

Congratulations! You have just created a 
camera trajectory to animate this camera. 
At this point, you will not be creating any 
new keyframes for the camera position, but 
adjusting the ones that are already there. 

You’ll no longer need the Bryce’s Auto key 
function. To ensure that you do not 
inadvertently create a new keyframe during 
the next steps of this tutorial, you can 
deactivate the autokeyframe function.

14 Click the triangle to the right of the 
Animation palette, then select Auto key 
from the list so that it is unchecked.

Lesson 2: Pointing the Camera

Check to see what the camera does during this 
sequence by playing the sequence.

To point the camera:

1 Click the Play button. The camera moves 
along the blue trajectory while the Time 
scrubber moves from left to right.

Notice that the entire time, the camera 
faces in one direction. Next, you will make 
the camera point toward the cylinder for 
the entire duration of the sequence. In 
order to do that, you need to know the 
name for that particular object.

2 Toggle back to the Selection Palette by 
clicking the Selection Animation toggle in 
the lower right hand corner. The Selection 
Palette appears.

3 Click the Select Sphere tool. A pop-up 
menu appears. 

The options are: Select All of Type, and a 
listing of the individual spheres by number. 
The sphere that you want to point at will be 
the bottom sphere on this list. In the figure 
shown, it is Sphere 4, but the number in 
your scene may differ. Make a note of the 
sphere’s name; you will find it in a different 
pop-up menu in the next couple of steps.

4 Click the camera to select it. The camera’s 
wireframe turns red and the blue trajectory 
line appears.

5 Click the Object Attributes button. The 
Object Attributes dialog box appears (it 
says Camera & 2D Projection), but it’s the 
Object Attributes dialog box, and it’s 
accessed using the same key commands, 
and so on.

Finishing the path. 

Select Sphere menu. 
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6 Click the center tab, called Linking. A new 
panel appears with options for Object 
Parent Name and Track Object Name. 

7 Click the Track Object Name pop-up menu 
and select Sphere 4 (or whatever the 
number for the sphere you have in your 
scene). The Object Name appears.

8 Click the OK icon to leave the Camera’s 
Object Attributes dialog box. The camera 
snaps to the right to point at the sphere, 
and a gray line extends from the camera to 
the sphere.

9 Toggle back to the Animation palette and 
click the Play button. The camera moves 
along the trajectory, facing the sphere for 
the entire duration of the sequence.

You can view this sequence from the 
camera’s point of view. 

10 Switch to Camera View by selecting View 
Options menu > Camera View or by 
pressing the 1 key. The wireframe view of 
your scene changes.

11 Click the Play button to watch the 
wireframe animation. The camera flies 
through the space, all the while keeping 
the sphere at the center of the scene 
window.

12 Save your scene, and call it Animation-
RoughCam.

Lesson 3: Making Camera 
Adjustments

The camera flythrough is all at a single height, 
which is below the mirrored sphere and below 
the open arch on the left side of the building. 
However, the camera trajectory may have some 
funny little kinks in it. You can drag the points 
of the camera trajectory to reshape it.

To adjust the height:

1 View your scene from the side by choosing 
Camera View Options menu > From 
Right. Your scene changes to side view. You 
may need to zoom out in order to see the 
entire camera path. Click the Zoom out 
tool to do so.

First, you’ll adjust the camera’s height so 
that it is level with the sphere as it circles 
around it.

Object Parent and Track Object Name. 

What you should see. 
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2 Drag the point on the right up so that it is 
level with the sphere. Your scene should 
look like the one shown.

3 Drag the other handles up except for the 
first and last of the camera. Your scene 
should look like the one shown.

To continue adjusting, you will need to 
look at the scene from different 
perspectives. More adjustments can be 
made from Front View.

4 Change to Front View by choosing View 
Options menu > From Front or press the 
4 key). 

Zoom out if needed, using the Zoom out 
tool located to the lower right of the 
Working Window on the Display palette.

5 Drag the point of the camera up so that it 
forms one end of a straight line between 
the sphere and the boolean sphere, as 
shown.

Note that you might need to Zoom out here 
to see the same view as the image above. 
The dotted line of the sphere is the 
location of the open area of the arch.

When you have dragged the trajectory 
point there, the camera did not follow.  

Don’t worry, when you play the animation, 
the camera will be located with the 
trajectory.

Adjusting the height. 

Adjusting the camera view. 

Fine-tuning the adjustments. 

Additional adjustments. 
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6 Click the Play button and watch the 
camera’s movement through the sequence. 
The camera ends up located at the end 
point of the trajectory. 

Now that the camera is back on the 
trajectory, notice that the gray line between 
the camera and the sphere provides a guide 
for that straight line of sight. You can use 
the guide for other placements of your 
trajectory.

7 Move the previous keypoint up so that it is 
aligned along that gray line. Your trajectory 
should look like the one shown.

8 Go back to Camera view by choosing View 
Options menu > Camera View or press 
the 1 key). Click the Play button to see your 
animation.

Lesson 4: Smoothing the Camera’s 
Trajectory

To smooth out the Camera’s trajectory, you will 
adjust the points positions and work with the 
shape of the curve using the tangents of each 
point. To see the tangents, you will need to 
make them visible.

To display the trajectory options:

1 To display the trajectory, make sure 
Director’s view is selected. If needed, 
choose View Options menu > Director’s 
View.

2 Click the Object Attributes button to 
access the Camera and 2D Options. Click 
Animation tab. 

3 Under Trajectory Options, click the button 
for Show Always. Click the OK icon for 
Show Tangents. Exit the Camera and 2D 
Projection dialog box by clicking the OK 
icon. The camera trajectory now has gray 
lines extending from each point.

The camera’s endpoint. 

Positioning the keypoint. 

The animation tab. 
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To smooth the trajectory:

Smoothing out the trajectory works best 
when you work in Top View.

1 Change to Top View by choosing View 
Options menu > From Top, or press the 2 
key). 

You are returned to top view. But there are 
lots of items that hinder a clear view of the 
trajectory. The only items necessary to view 
are the walls and the pedestal. Since they 
each have their own family, it will be easy to 
select them and work in Solo Mode.

2 Toggle to the Selection palette.

3 Select Walls by clicking the Selection 
Animation toggle, then clicking the 
Families button and selecting Walls from 
the list. Then hold down the Shift key and 
select Family 11 to add to your selection. 
The walls and pedestal should be selected. 
In addition, the camera (which was 
deselected) still has the trajectory showing. 
It is the result of selecting Show Always 
earlier.

4 Click the Solo Mode button to change to 
Solo Mode. Many objects disappear, and 
you get a much clearer view of your camera 
trajectory and the tangents extending from 
each point. 

Any kinks in the path result from a lengthy 
tangent interfering with a neighboring 
point. Shortening the tangent will smooth 
out the trajectory line.

5 Click the camera to select it. The points 
appear. 

6 Place the cursor over the point with the 
long trajectory. The cursor changes to 
crossed arrows.

7 Press the T key (for tangent), then click and 
drag to the right. and watch the Tangent 
lines shorten.

You may also reposition points to smooth 
out the trajectory line.

8 Make any other adjustments necessary to 
smooth out the trajectory line. 

The top view. 

The trajectory path. 
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The line shown in the previous figure was 
changed by a slight repositioning of all the 
points of the trajectory except the 
endpoints. In addition, the next to the last 
point’s tangent line was lengthened. 

9 Click the Solo Mode button to turn off 
Solo Mode. The other objects reappear.

10 Switch back to Camera View and click the 
Play button to view the animation now.

You may need to click the Selection 
Animation toggle to switch back to the 
Animation palette, before clicking Play.

11 Save your scene. To see the final results, 
you can also open the file Animation-
smoothCam, located in the Manual 
Tutorials folder.

Lesson 5: Test Render

It’s time to set up a test render of your 
animation sequence. Continue with the scene 
file you have been working with, or use 
Animation-Smooth Cam scene file from the 
Manual Tutorials folder on the CD-ROM. 

To create a rough animation, you need to 
change the render size of your scene to a 
smaller image.

To create a test render:

1 Choose File menu > Document Setup. A 
dialog box appears. Change the render size 
to 0.25, as shown. Exit the dialog box. 

2 Click the Render button to test render 
your scene. The rendered image is much 
smaller.

3 Choose File menu > Render Animation. A 
dialog box appears.

This dialog box allows you to choose your 
settings for this test render. There are three 
sections to the box-- the Range to Render, 
the Compression Settings, and the File 
location (and name). 

Adjusting the trajectory path. 
Document Setup. 

Render Animation dialog box. 
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4 In the Output Module section, click the 
Edit button. A Compression Options 
dialog box appears. 

5 Uncheck the option for Keyframe every 10 
frames then click OK.

Windows users should click the Output 
Module triangle, then select QuickTime 
Move. This ensures the results are 
consistent.

6 Click the Set button. A Save dialog box 
appears, showing the location and name of 
your movie.

7 Choose the location and name of your 
movie (add the word test), then click OK.

8 Click the OK icon to exit the Render 
Animation dialog box. Your scene begins 
rendering each frame. At the end of the 
render, Bryce automatically launches the 
Movie Player application.

9 Click the Play button to watch your 
animation.

10 Switch back to Bryce and save your scene 
file. 

Congratulations! You’ve created your first Bryce 
movie! Make sure that you exit the movie player 
application before you continue the tutorial.

Fine-Tuning Your 
Animation
To finish up your animation, you will convert 
your trajectory to a path. At the beginning, you 
used keyframes to set the position of the 
camera. The trajectory is good for creating the 
physical location of the camera over the 
sequence. However, the points along the path 
tend to correspond to places, and not 
necessarily events, or velocity. 

Converting to a path will allow you to set up 
two keyframes, one for the beginning and the 
other for the end, and you can adjust the 
velocity to your heart’s content without 
worrying about placement of this physical 
keyframe at that spot. As it happens, the 
animation we’ve done so far is fairly evenly 
paced, so the potential problem is not as 
apparent here as it might become later in your 
work animating Bryce sequences. 

Lesson 1: Converting the 
Trajectory to a Path

To work on the timing and velocity of your 
sequence, you will convert your trajectory into 
a single path object. 

To convert from Trajectory to path:

1 Look at your scene from Top View.

Compression Options. 

Playing the animation. 
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2 Select your camera by clicking it. 

3 Choose Objects menu > Create Path. A 
new path object appears, occupying the 
same space and shape as the camera 
trajectory.

The path is an object type in Bryce. You 
can now link your camera to that path.

4 Select the camera again (it got deselected 
when you created the path). Click the 
triangle on the Selection Palette, and 
choose Camera to select the camera. 
(Notice that there is an option there for 
selecting paths as well.) The Camera and its 
trajectory line are selected.

5 Click the Object Attributes button to 
access the Camera and 2D Options dialog 
box. Click the Linking panel to display it. 
For Object Parent name, select Path 1 from 
the pop-up menu of your objects. Click the 
button next to Constrain to Path. Your 
dialog box should look like the one shown.  

6 Click the OK icon to leave the dialog box. 
The blue trajectory line disappears.

The trajectory line went away when the 
camera was constrained to the path. All of 
the keyframed motion information for the 
camera went away with the trajectory. 

The location information of the trajectory 
is preserved in the path, which is present 
in your scene.

7 Click the Selection Animation toggle to 
switch to the Animation palette, and click 
the Play button. The scrubber moves, but 
the camera does not.

You’ll re-set the keyframes for camera motion 
for the beginning and end of the sequence.

Lesson 2: Creating Keyframes for 
the Beginning and End of the Path

To create keyframes:

1 Click the First keyframe button on the 
Animation palette. The scrubber moves to 
the beginning of the sequence time 
00:00:00.0.

2 Click the Add keyframe button. 

3 Click the Last keyframe button. The 
scrubber moves to the end of the sequence 
time 00:00:09.0.

4 Click where the camera is located and drag 
to the right. The camera moves along the 
path.

You may have to drag several times to move 
the camera to the end. There is an 
alternative way to place the camera at the 
end of the path.

5 Click the Object Attributes button. The 
Camera & 2D Projection dialog box 
appears. 

Linking Options. 
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6 Type the number 100 in the Position box. 
Your dialog box should look like the one 
shown.

7 Click the OK icon to leave the dialog box. 
Your camera should now be located at the 
end of the path.

8 Click the Add keyframe button.

9 Check your animation, by pressing the Play 
button. Your camera should now move 
smoothly along the path.

You now have very smooth camera movement 
over a complex path, using only two keyframes.

Lesson 3: Velocity Adjustment

The last thing you will do with your animation 
in this tutorial is adjust the camera’s velocity 
along the path. To do this, you will work in 
Bryce’s Advanced Motion Lab.

Your camera should still be selected. If it is not, 
select it.

To adjust the velocity:

1 Click the Advanced Motion Lab button. 
The Advanced Motion Lab appears. 

On the bottom half, the objects and their 
timelines are displayed. The round blue 
button at the upper right of the timelines is 
the current time display. Because of the 
length of the animation, you can’t see the 
entire timeline for this sequence.

2 Drag the round blue current time marker 
to the left. The numbers and timeline bars 
scroll off to the right. Continue dragging 
left until there is no more movement. 

Camera and 2D Projection. Advanced Motion Lab. 

Adjusting the timeline. 
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Next you will scale the timeline so that 
everything shows in the provided area.

3 Drag the scale tool to the right. (It is 
located under the preview window.) The 
space between numbers decreases, and 
after a bit, the entire timeline is displayed. 
Release the mouse.

The word camera displays in Red. 

4 Click the word Camera. A number of 
camera attributes are displayed, as shown. 
Click the word Path Position.

Additionally, in the Velocity Controls 
section (also known as the Time Mapping 
curve), a diagonal line has appeared. 

Next to the window to the right is a Camera 
icon and a light icon. 

5 Click the camera icon. The green light 
appears and the display in the right 
window changes to show your scene from 
the camera’s perspective. 

See how the animation preview and the 
Velocity area work together.

6 Click the Play button under the animation 
preview window. The animation plays, 
while crosshairs mark the current time 
along the Velocity line.

You’ll use one of the preset Velocity curves 
to put a little variety in the camera motion.

7 Click the curve that matches the one 
shown. 

Adjusting the scale. 

Camera Attributes. 

The camera’s perspective. 

Velocity curve. 
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It is a slight S curve. The curve is displayed 
in the Velocity Controls section.

8 Click the Play button. The animation 
begins slowly, proceeds at a constant pace 
for a time and then slows down toward the 
end.

When the velocity curve is flatter, camera 
motion is slower. When the curve is 
steeper, the motion is swifter.

9 If you would like to try other velocity 
curves from the presets, click them and 
they’ll appear in the Velocity Controls 
section. Play the animation and note the 
differences in camera velocity. A downward 
curve corresponds to a backwards motion 
along the path. When you are through 
experimenting with the curves, click the S 
shaped curve from Step 7.

10 Click the arrow in the lower right corner to 
leave the Advanced Motion Lab. You return 
to your scene.

The Advanced Motion Lab does not have 
the standard okay and cancel buttons, 
because all velocity adjustments are live 
edits. You can’t undo them.

11 Save your scene file.

Congratulations! You are nearly there! It’s time 
for another test render.

Lesson 4: Another Test Render

Before your test render, double-check your 
render settings. 

To render:

1 Choose File menu > Document Setup.

2 In the Document Setup dialog box, ensure 
that you are rendering at the smallest ratio: 
1:0.25.

3 Switch back to Camera View.

4 Select File menu > Render Animation. 
The Render Animation dialog box appears.

Change the name of this test file to Render 
2.

5 Click the Set button. In the Save dialog 
box, add “test path” to the name. Click 
Save.

6 Click the OK icon to exit the Render 
Animation dialog box. Your animation 
begins rendering.

Final Comments
Compare the two test animations. See the 
difference in movement?

For your final render, you may render at a larger 
size, or, for more fun, try creating a Volumetric 
World to add drama to those light rays that 
enter the building through the arches.

Congratulations! You have now created a scene, 
set up your animation, created the camera 
trajectory, converted the trajectory to a path, 
and adjusted the camera’s velocity on that path. 
You have walked through a fair portion of the 
power of creating Bryce scenes and animating 
them.

For additional ideas of ways to animate this 
scene or for other tips, check out the 
BryceWorld website under the Links menu.
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6  

Creating Objects

Overview
Objects are the building blocks of your Bryce 
world. They can be used as props, to populate 
a scene, or add detail to landscapes. 

An object is the most basic item in Bryce. 
Objects can be anything from terrains to peb-
bles. In Bryce, there are several ways of creat-
ing objects. Some objects use unique editors, 
others can be created by a simple one-step 
click.

There are two main tools for creating objects. 
The Create palette, which contains tools for 
creating objects with a single click, and the 
Preset Objects Library, which contains pre-
made objects you can add to your scene.



Objects in the Scene
Every object in the scene has a bounding box. 
The box acts like a visual guide that tells you 
how much space it occupies in 3D space. It also 
provides access to a series of tools that let you 
edit an object’s attributes and placement.

The buttons around the edges let you set an 
object’s attributes.

The black points on the edges of the box are 
called control handles. These handles can be 
used to edit the object’s size and orientation. As 
you pass your cursor over the handles, it 
changes to display the type of control you’re 
selecting.

When the cursor turns into letter, it means that 
you’re over a constrain handle. The handle will 
only move along the axis indicated by the letter. 
For example, if the cursor changes to a Y, it 

means that the handle will only move along the 
Y axis. 

Dragging this type of handle usually distorts 
the shape of the object.

If the handle changes to a black square with a 
right-angle, it means that the handle can move 
in any direction, but the object will be scaled 
proportionally.

To display an object’s bounding box:

1 Create an object.

2 Select the object.

An object’s bounding box lets you see how much space it 
occupies in 3D space. 

If your cursor changes to a letter, it means that you’re over 
a constrained control handle. 

If your cursor changes to a black box with a right-angle, it 
means that you can use the handle to proportionally scale 
the object. 
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Object Preview

When you create an object, it appears as a wire-
frame in the Working window. The wireframe 
represents the structure of the object’s shape.

The wireframe preview lets you see how an 
object looks as it’s being rotated or animated 
without having to calculate and render any 
complex surface properties. The wireframe 
casts a shadow on the ground plane below it. 
The shadow can be used as a visual guide to 
help you determine the object’s position in 
3D space.

If you move the object below the ground plane, 
the portion of the object that’s below ground is 
not drawn. This can help you avoid placing an 
object outside the view of the scene. Wireframe 

shadows do not interact with light. These 
appear regardless of the light sources in 
the scene.

Both shadows and underground wireframes are 
preview options that can be turned on and off. 
Refer to “Wireframe attributes” on page 18 for 
more on these features.

Object Preview Modes

Besides wireframes, there are three other ways 
you view an object; Bounding Box, Shaded Pre-
view, and Rendered Preview.

Bounding Box

If you have a large scene and you find that it’s 
taking too long to redraw the entire scene, you 
can change the display of the objects so that 
only their bounding box is displayed.

Objects appear as wireframes in the scene. The wireframe 
gives you an idea of the object’s shape and structure. 

As you move the object it’s shadow follows it along the 
ground plane. When you have a number of objects, the 
shadows can help you see its exact position in the scene. 

If you move an object below ground, the portion of the 
wireframe that’s below the ground plane is not displayed 
in the scene. 
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You can move the box just as you would a nor-
mal object. The box can also cast a shadow.

To display an object as a box:

1 Select an object.

2 Click Objects menu> Show Object as Box.
or
Click the A icon that appears next to the 
object’s bounding box to display the 
Object Attributes dialog. 

In the dialog, click the Show as Box 
button.

To display an object as a wireframe:

1 Select an object.

2 Click Objects menu> Show Object as 
Lattice.
or
Click the A icon that appears next to the 
object’s bounding box to display the 
Object Attributes dialog. 

In the dialog, disable the Show as Box 
button.

Shaded Preview

 OpenGL mode performance is greatly increased 
from an Open GL accelerator card, but Win-
dows 95/98 and NT also support software-driven 
Open GL mode.

In this mode, objects appear as solids. The col-
ors assigned to the object are also visible. 
Object surfaces are effected by light sources. 
Materials textures are not visible in this mode. 

Rendered Preview

If you want to see what the object’s surface 
looks like or how it is affected by light gels, 
you’ll have to render it. 

The Nano-Preview shows you a small preview 
of what the object looks like rendered.

The Show Object as Box preview mode displays the object 
using only its bounding box. 

In the shaded preview mode you’ll be able to see all the 
objects in your scene as solids. 

The Nano-Preview of the object shows you a small preview 
of what the object will look like when its rendered. 
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Refer to “Using the Nano-Preview” on page 24 
for more on the Nano-Preview.

If you want to see the object at full size you’ll 
have to render it. Once it is rendered, you can 
see the bitmap preview of the object, using the 
Bitmap Preview mode. 

Refer to “The Rendering Procedure” on 
page 404 for more on rendering and “Display 
Modes” on page 17 for more on Bitmap Preview 
mode.

Primitives vs. Procedural 
Objects
Bryce’s Create palette lets you create two differ-
ent types of basic object: Primitives and Proce-
durals. 

Primitives are basic geometric shapes such as 
the sphere, cube, pyramid, torus, cone, cylin-
der, plane, and disk. These shapes can be 
thought of as primary geometric building 
blocks, from which more complex objects are 
constructed.

Primitives also have derivative groups (such as 
the ellipsoid and squashed sphere, which are 
derived from the Sphere), which allow you to 
create different shapes without having to per-
form the transformations yourself.

Procedural objects are object that require spe-
cial constructions, or “procedures,” to create. 
Procedures can include operations such as pre-
assignment of materials, randomization of 
internal parameters, or assignment of light 
properties.To see a full-sized preview of the object you’ll need to 

render the scene. 

This train is made up of primitive and primitive derivative 
objects. 

This scene shows examples of procedural objects. 
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Object Placement

When you create a new object it can be placed 
in your scene either at absolute world center or 
at an arbitrary location based on your current 
view. Object placement is determined by your 
preference setting. Refer to “To control new 
object placement:” on page 16 for more infor-
mation.

The Create Palette
The main tool for creating objects is the Create 
palette. This palette provides access to tools 
which let you create all the object types avail-
able in Bryce.

The tools on the palette represent the type of 
object they create. When you click a tool, the 
object appears in the center of the scene.

The name of each tool appears in the Text Dis-
play area as you move your cursor over it.

To display the Create palette:

• Click the Create button at the top of the 
Bryce window.

To use a Create tool:

1 Display the Create palette.

2 Click on the tool for the object type you 
want to create.

The object appears in the working window.

The Triangle icon next to the Create button at 
the top of the Bryce window lets you access the 
Preset Objects Library.

To open the Preset Objects Library:

• Click the Triangle icon next to the Create 
button at the top of the Bryce window.

The Object Attributes Dialog

The Object Attributes dialog lets you set a 
number of properties that determine how the 
object appears in the Working window.

The dialog is where you’ll set up the object’s 
name, size, orientation, placement and display 
quality. It’s most often used to numerically 
transform the object. When you’re animating 
an object, the dialog is used to control how the 
object interacts with its motion path. Refer to 

The Create palette provides access to tools you’ll need to 
create all the different types of object available in Bryce. 

As you move the cursor over the tool in the Create palette, 
its name appears in the Text Display area. 

Create Planes Create Primitives

Create Picture Objects
Create Lights

The Triangle icon next to the Create button opens the 
Preset Objects Library. 
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“Animating” on page 353 for more on animat-
ing.

The dialog is divided into three tabs: General, 
Linking, and Animation. 

The General tab contains controls for setting 
the object’s name and display attributes and 
position. Refer to “Editing Object Attributes” 
on page 312 for more on using the dialog to 
edit objects.

The Linking tab contains controls for setting 
up parent-child links and tracking. Refer to 
“Linking Objects” on page 305 for more on 
linking and “Tracking Objects” on page 382 for 
more on tracking.

The Animation tab lets you set the properties 
of the object when it is connected to a Motion 
Path. Refer to “Motion Paths” on page 376 for 
more on motion paths.

To display the Object Attributes dialog:

1 Select an object.

2 Click Objects menu> Attributes.
or 
Click the A icon that appears next to an 
object’s bounding box.

Naming Objects

When you create an object, the first thing you 
should do is assign a name to it. An object’s 
name identifies it in the Working window. 

You can select objects, by name, using the 
Selection palette. The name can also help you 
distinguish a specific object when your scene 
contains more than one object of the same type. 
Refer to “Selecting Objects” on page 30 for 
more information.

An object’s name is also used when you’re cre-
ating parent-child links and setting up object 
tracking. 

To name an object:

1 Select an object.

2 Click the A icon that appears next to its 
bounding box.

3 Enter a name in the Object Name field.

Creating Infinite Planes
An infinite plane object extends in all direc-
tions out to infinity. When you create a plane in 
Bryce it appears as a finite plane to make it eas-
ier to position, but when your scene is ren-
dered the plane extends infinitely in all 
directions. 

Though procedurally these three infinite 
planes are different, they are all considered to 
be Infinite Planes for the purpose of selecting 
with the Selection tools.

The Object Attributes dialog contains controls for setting 
the object’s name, scale, position, and orientation. 
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Water

Water planes are created just a bit higher than 
ground level. That way, if you have already cre-
ated ground and terrains, you can easily place a 
water plane into your scene and immediately 
see the terrains peeking out from the water.

To create a Water plane:

• Click the Water plane tool.

Once the plane appears in your scene you 
can edit it like any other object. Refer to 
“Editing Object Attributes” on page 312 for 
more on editing objects.

Water planes are created with a water texture 
randomly chosen from the Waters & Liquids 
Preset Materials Library. You can change this 
material by selecting a different preset or creat-
ing an new material.

To change the water plane’s Preset Material:

1 Click the second Triangle icon at the top of 
the Bryce environment. The Preset 
Materials Library appears.

2 Choose a library and material then click 
the OK icon.

Refer to “Using the Preset Materials 
Library” on page 232 for more on the 
Preset Materials Library.

Ground

Ground planes are created at ground level. By 
default, all new scenes open with an infinite 
ground plane. 

To create a Ground plane:

• Click the Ground plane tool.

Once the plane appears in your scene you 
can edit it like any other object.

The Ground plane is created with a gray color, 
as are all Bryce primitives. Once you begin 
assigning textures to objects, Ground objects 

When you add a plane object it appears as a finite object 
in the Working window.....

...but when you render the scene it extends out to infinity

Use the Water plane to add bodies of water to your 
environment.

Use the Ground plane to add ground to your environment.
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(as well as all other primitive objects) will 
inherit the texture assigned to the previous 
object.

Cloud

Cloud planes are placed much higher in your 
scene since they’re generally the highest 
objects in your environment.

To create a Cloud plane:

• Click the Cloud plane tool.

Once the plane appears in your scene you 
can edit it like any other object.

Cloud planes are automatically assigned a ran-
domly chosen texture from the Clouds & Fogs 
Preset Materials Library. You can change this 
material by selecting a different preset or creat-
ing a new material.

To change the Cloud plane’s preset material:

1 Click the second Triangle icon at the top of 
the Bryce environment. The Preset 
Materials Library appears. 

2 Choose a library and material then click 
the OK icon.

Infinite Slabs

An infinite slab is a plane object that has depth. 
An infinite plane is a plane object that has no 
depth. The plane has no effect on objects above 
it or below it; an infinite slab can affect objects 
within it. 

For example, anything you place within the 
slab’s depth will be affected by the slab’s vol-
ume color.

Slabs are usually used to create water. When 
you create a water slab, you create water with 
realistic volume. This means that if you sink an 
object into the water it will be affected by the 
colors or textures you assign to the slab’s vol-
ume.

The realistic look of a water slab depends 
almost entirely on the material you assign to it. 
The Volume color plays an essential role in cre-
ating realistic water effects. Refer to “Volume 
Color” on page 206 for more on Volume Color 
and materials.

Use the Cloud plane to add clouds to your environment.

In an infinite slab, the plane in the scene has depth that 
affects the objects within it. 
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To create an Infinite Slab:

1 Click the plane tool and choose the Water 
Slab icon from the popup.

2 Select the slab.

3 Click the A icon that appears next to its 
bounding box. The Object Attributes 
dialog appears.

4 Enter a depth value in the Size Y field and 
click the OK icon.

Creating Stones
The Stone object tool creates random, organic 
Stone shapes that can be assigned materials 
and positioned throughout your scene.

To create a Stone Object:

• Click the Stone object tool.

Stones objects are mesh based, and can be 
smoothed or unsmoothed using the Select 
Mesh dialog. Refer to “Editing Imported 
Meshes and Stones” on page 322 for more 
information.

Stones are assigned random textures automati-
cally from the Rocks & Stones Preset Materials 
Library.

To change a stone’s preset material:

1 Click the second Triangle icon at the top of 
the Bryce environment. The Preset 
Materials Library appears. 

2 Choose a library and material then click 
the OK icon.

Since Stones are essentially clumps of meshes, 
they are highly dependent on the textures 
assigned to them for their realism. For example, 
if you assign a flat texture with no bumpiness to 
a Stone, the results won’t be very Stone-like. 
Try to assign rocky textures to stones. Refer to 
“Using the Material Preview Area” on page 231 
for more on assigning textures.

Creating Symmetrical 
Lattices
A Symmetrical Lattice is a terrain object that 
has a mirror image of itself fused at its base. 
When you modify one half of the lattice, the 
corresponding changes are applied to the mir-
rored half.

The Symmetrical Lattice can be a great time-
saving tool. Instead of creating symmetrical 
shapes by duplicating and aligning two halves, 
you just need to edit one half of a lattice and 
your object is created for you. Symmetrical Lat-
tices are edited as Terrains, using the Terrain 

The popup that appears when you click the Water plane 
tool lets you choose between an infinite plane (Surface) 
and an infinite slab (Volume).

Use the Stone object tool to create randomly generated 
stones.
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Editor. Refer to “Clipping Terrains” on 
page 184 for more information.

Many advanced types of objects can be created 
using the lattice object. Any object that’s sym-
metical can be created by painting it’s shape in 
the Terrain Editor.

To create a Symmetrical Lattice:

• Click the Symmetrical Lattice tool.

Creating Primitives
Primitives are the primary geometric building 
blocks in Bryce. You can create spheres, tori, 
cylinders, cubes, pyramids, cones, discs, and 2D 
squares.

To create a geometric primitive:

• Click one of the primitive tools:

By default all primitives are assigned a flat 
gray color.

Derivative Primitives

Derivative primitives are primitive objects 
whose shape is “derived” from basic geometric 
primitives.

The hair dryer in this example was created using a 
symmetrical lattice object.

Use the Symmetrical Lattice tool to create symmetrical 
objects.

Creates spheres

Creates toruses

Creates cylinders

Creates cubes

Creates pyramids

Creates cones

Creates discs

Creates 2D faces
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Derivative primitives were created so that you 
could skip some of the editing procedures on 
most of the basic primitives. For example, 
instead of elongating a cube to make it into a 
pillar, you can just use the Stretched Cube or 
Brickiod derivatives.

To create a derivative primitive:

• Click one of the derivative primitives tools 
available:

Creating a Pict Object
A Pict Object is a 2D picture that is applied to a 
2D finite plane. The object is basically a picture 
on a frame. The Frame is a 2D plane, meaning 
that it has no depth. If you view it from the side, 
it disappears. 

Using a Pict Object is a quick way of creating 
very complex-looking objects. The only prob-
lem is that you can only view them from one 
angle, so the front of the Pict Object must 
always be facing the camera.

The Alpha channel of the object can be used to 
create transparencies in the Pict Object. 

A good way of ensuring that your 2D Pict Object 
always looks right is to have it track the camera. 
Refer to “Tracking Objects” on page 382 for 
more on tracking.

Alpha Channels and Pict Objects

The picture you use must have an Alpha chan-
nel. Refer to “Alpha Channels” on page 109 for 
more on Alpha channels.

The alpha channel of your Pict images will 
allow you to specify visible and invisible por-
tions of your picture texture.

Sphere derivatives: Ellipsoid, 
Squashed Sphere

Cylinder derivatives: Tuboid, 
Stretched Cylinder, 
Squashed Cylinder

Cube derivatives: Stretched 
Cube, Brickoid

Pyramid derivatives: 
Stretched Pyramid, Squashed 
Pyramid

Cone derivatives: Stretched 
Cone, Squashed Cone

This object was created using a 2D Pict Object....

however, if you move the camera, the 2D nature of the 
object is very obvious.
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For example, you can clip out a picture’s back-
ground so that only the main object in the pic-
ture is visible.

The shadow cast by the image will be in the 
shape of the picture’s alpha channel which 
gives a more realistic look.

To create a Pict object:

1 Click the Pict Object tool or any empty 
square to open up the Pictures dialog.

The Pictures dialog appears:

2 Click an image square to load an image.

3 If the image you want is not in the library:

• Click the Combination Load button. 
The load image dialog appears.

• Use the dialog controls to locate the 
picture you want to use and click Open.

or

• In another application, copy the picture 
you want to use to the clipboard.

• Access the Picture dialog and click the 
Paste button. 

The picture is loaded into the first image 
box and its alpha channels are loaded into 
the second box.

This is what the car image looks like with and without an 
alpha channel applied.

The Pictures dialog lets you select 2D images to use as Pict 
Objects.

When you load a new picture into the Picture dialog, the 
main image is loaded into the first box its alpha channel is 
loaded into the second box, and the combination is loaded 
into the third.
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You can invert the alpha channel by 
clicking the Invert button.

4 Click the OK icon to exit the dialog.

Bryce creates a 2D plane and maps the 
image onto it as a texture. The Pict Object 
is created with the same aspect ratio as the 
original picture.

Working with Pictures
Pictures can be used in several ways in Bryce. 
They can be used as 2D Pict Objects or as com-
ponents in materials or gels. 

When you use a picture as an object, it is 
applied to a 2D plane and appears as an object 
in the Working window. Refer to “Creating a 
Pict Object” on page 106 for more on creating 
2D Pict Objects.

When you use a picture as a material compo-
nent, the image is applied to a material chan-
nel, where its values are used to drive the value 
of the channel. Refer to “Materials” on page 189 
for more on working with Materials.

When you use a picture as a gel, the image is 
placed in front of the light and appears as a 

When you exit the picture dialog, the image is mapped 
onto a 2D plane and placed in your scene.

This is what a picture looks like when it is used as an 
object.

This is what a picture looks like when it is used as part of a 
material.
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projection. Refer to “Applying Gels” on 
page 350 for more on gels.

Alpha Channels

Every image contains a number of channels 
that store data about the makeup of the picture. 
For instance channels can contain masks, col-
ors, or bump information.

The alpha channel of an image is its first chan-
nel. The channel is a like a grayscale map that 
accompanies an image that is used primarily as 
a “mask.” Areas in the alpha channel that are 
black are ignored by the Bryce as it computes 
the picture (appearing transparent). Bryce rec-
ognizes and computes areas that are white 
(appearing opaque).

The most common use for alpha channels is to 
mask the contours of a 2D object, separating it 
from any unwanted background information. 
For instance, you may import a picture of a dog. 
If you have created an alpha channel “mask” 
describing the area of the dog as white and the 
“non-dog” area as black, then unwanted cats 
and mailmen in the original picture’s back-

ground will not be seen in your rendered 
image.

In Bryce, Alpha channels are also used when 
your picture is a component in a material. In 
this case the alpha channel can be used to 
determine everything from the bumps in a 
material to how a surface property is applied on 
an object. Refer to “2D Textures” on page 211 
for more on using pictures in a material.

If you want to use the picture in the library for 
multiple purposes, you’ll need to make sure that 
all the pictures have an alpha channel.

The Picture Library

The Picture Library stores all the images avail-
able in Bryce and can be used to catalog pic-
tures and to import pictures. You can store any 
number of pictures in the library that your sys-
tem memory and disk space will allow. 

This is what a picture looks like when it is used as a gel.

This example illustrates how the Alpha channel mask is 
used to eliminate the unwanted areas of an image.

With Mask

Without Mask
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There are two ways of accessing the Picture 
Library. The method you use depends on how 
you’re going to use the image.

To access the Picture Library from the Create 
palette:

• Click the Pict Object tool. The library 
automatically opens.

To access the Picture Library from the 
Materials Lab:

1 Select an object.

2 Click the M icon that appears next to the 
object’s bounding box. The Materials Lab 
appears.

3 Click on one of the columns in the grid to 
activate a component window. 

4 In the window, click the P button in the 
bottom-left corner. A default picture 
appears in the window.

5 Click the Pink button at the top of the 
window. The Picture Library appears.

To access the Picture Library from the Light 
Editor:

1 Select a light source.

2 Click the E icon that appears next to the 
object’s bounding box. The Light Editor 
appears.

3 Click the 2D Texture button at the bottom 
of the editor. The library appears.

Previewing Pictures

The three most prominent items at the top of 
the library are the RGB Image, Alpha, and 
Combined preview windows. The first window 

displays the current picture, the second win-
dow displays the alpha channel associated with 
the picture, and the third displays the resulting 
picture after the alpha channel is combined 
with the picture.

Picture Thumbnails

Below the three preview windows are the pic-
ture thumbnails that display a small preview of 
each picture in the library. The gray thumbnails 
represent empty slots in the library. When you 
load images, they are added to the first available 
gray slot.

If there are a large number of pictures in the 
library, you can use the scroll bar to scroll 
through all the thumbnails.

To display an image in the library:

• Click on the picture’s thumbnail. The 
picture, and its associated alpha channel, 
appears in the three preview windows at 
the top of the dialog.

The three windows at the top of the editor display the 
RGM Image, its alpha channel, and the result of 
combining the two.

The thumbnails below the preview windows represent all 
the pictures available in the library.

RGB Image Alpha 
Channel 

Combined 
Image
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Loading Pictures Into the Library

You can load pictures into the library to create 
your own custom library. Pictures can be 
loaded into any of the three preview windows.

When you load a picture into the first window, 
you’re loading only the picture’s RGB (Red, 
Green, and Blue) color information.

The picture loaded into the first preview win-
dow replaces the currently selected picture in 
the library, so you’re replacing a picture in the 
library with the picture you’re loading. If you 
want to add a new picture to the library, you 
need to load it into the Combined Image win-
dow.

When you load a picture into the second win-
dow, you’re only loading the picture’s alpha 
channel. 

The alpha channel determines which portions 
of the picture are visible and which are not. The 
areas of the picture that are transparent appear 
as a checkboard pattern.

Every picture should have an alpha channel 
assigned to it. If the picture does not have an 

alpha channel, the resulting image appears 
completely white.

If your picture doesn’t have an alpha channel, 
you can copy the image from the RGB Image 
window into the Alpha Channel window. This 
way your picture won’t appear completely 
opaque.

The Alpha channel you load does not have to 
necessarily match the image. You can create 
some interesting clipping effects by combining 
different alpha channels and images.

When you load a picture into the last preview 
window, the Combined Image window, the 
entire picture is loaded into the first empty 
thumbnail slot.

To replace the RGB information in a picture:

1 Click the thumbnail of the picture you 
want to replace.

When you load an image into the Alpha Channel window, 
the black and white alpha channel appears in the 
window.

If there is no Alpha Channel, the image appears 
completely opaque.

In this example, the image was combined with a different 
alpha channel to create a new clipping effect.
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2 Click the Load button on top of the RGB 
Image window. The Load dialog appears.

3 Use the dialog controls to locate the 
desired image and click Load.

The picture appears in the first preview 
window.

To replace the Alpha channel information in 
a picture:

1 Click the thumbnail of the picture you 
want to replace.

2 Click the Load button on top of the Alpha 
Channel window. The Load dialog appears.

3 Use the dialog controls to locate the 
desired image and click Load.

The picture’s alpha channel appears in the 
first preview window.

To load a new picture into the Library:

1 Click the picture slot in the bottom of the 
library where you want to load the new 
picture.

The Load dialog appears.

2 Use the dialog controls to locate the 
desired image and click Load.

The picture’s thumbnail appears in the 
picture slot.

Copying and Pasting Pictures

Copying and pasting in the Picture Library 
works differently for each of the three image 
windows. 

When you copy and paste into the first window, 
you’re only pasting RGB color information, so 
if you copy an image from the Combined win-
dow, only the color information is pasted into 
the RGB window. 

As with loading, any changes you make in the 
RGB Image window changes the selected 
image.

When you copy and paste into the second win-
dow, you’re only working with the Alpha Chan-
nel information, so any image you paste into 
this window will appear as an alpha channel 
image (i.e. black and white). Any changes you 
make in this window affect only the selected 
image.

When you copy an image from the Combined 
window the entire image is placed on the clip-
board. Depending on where you paste it, only a 
portion of the image may be used.

When you paste a picture into the Combined 
window, it appears as a color image with trans-
parent and solid areas. All pictures are treated 
as color. So if you paste a picture copied from 
the Alpha Channel window in this window, 
you’ll get an RGB representation of the alpha 
channel image. As well, any image pasted into 
this window creates a new picture entry in the 
library. 

The Load button displays the Load dialog which lets you 
select a picture to load into the RGB Image window.
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To copy and paste RGB information in a 
picture:

1 Click the Copy button below the RGB 
Image window.

2 Click the Paste button below the window 
where you want the RGB image to appear.

• If you paste the image into the Alpha 
Channel window, it is desaturated and 
used as an alpha channel. 

• If you paste it into the Combined Image 
window, the RGB image becomes a new 
entry in the library.

To copy and paste Alpha Channel information 
in a picture:

1 Click the Copy button below the Alpha 
Channel window.

2 Click the Paste button below the window 
where you want the Alpha Channel 
information to appear.

• If you paste the image into the RGB 
Image window, an RGB representation 
of the alpha channel is placed in the 
window. 

• If you paste it into the Combined Image 
window, an RGB representation of the 
alpha channel is placed in an empty slot 
in the library.

To create a new picture using RGB color 
information only:

1 Click the Copy button below the RGB 
Image window.

2 Click the Paste button below the 
Combined window. The RGB information 
is placed in an empty slot in the library.

To create a new picture using Alpha channel 
information only:

1 Click the Copy button below the Alpha 
Channel window.

2 Click the Paste button below the 
Combined window. The alpha channel 
information is placed in an empty slot in 
the library.

Deleting Pictures

When you delete a picture, you remove all the 
image information (including color and alpha 
channel) from the library.

To delete a picture from the library:

1 Click the thumbnail for the picture you 
want to delete. 

2 Click the Delete Pict button.

To delete all pictures from the library:

• Click Delete All.

Inverting the Alpha Channel

When you invert an alpha channel all the black 
areas become white and the white areas 
become black. This means that all the areas that 
were transparent now become solid and vice 
versa.

The Copy button places the contents of the RGB Image 
window on the clipboard.
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To invert an alpha channel:

• Click the Invert button above the Alpha 
channel window.

Picture Lists

A Picture List is a file that contains a group of 
pictures. A Picture list can be used to store all 
the pictures used in a given scene, or to store a 
series of pictures you use most often. 

You should also use a picture list to store any pic-
tures you’ve used as part of material.

There are several Pict texture List files provided 
as samples for your first excursions. 

To open a picture list:

1 Click the Open List button at the bottom 
of the Picture Library. The Open dialog 
appears. 

2 Use the dialog controls to locate the 
desired list and click Open. The pictures in 
the list appear in the library.

To save a picture list:

1 Click the Save List button at the bottom of 
the Picture Library. The Save dialog 
appears.

2 Enter a name for the list and click save. 

Name the list the same as the scene. This 
way, you can easily find the list that belongs 
to a specific scene.

Importing Objects
Bryce can open many different file formats, 
including files created in previous versions of 
Bryce. For instructions on importing files as 
well as a list of all import formats, see the 
README file on your Bryce CD ROM and 
Appendix 17 , “Using Bryce with Other Appli-
cations.”

Creating Boolean Objects
A Boolean object is an object created by com-
bining two or more objects to form a single 
object. Boolean objects are created by perform-
ing Boolean operations on a number of objects. 
You can perform three types of Boolean opera-
tions in Bryce: union, subtraction, and inter-
section. 

Bryce uses Object properties to perform Bool-
ean operations. Objects can be Neutral, Posi-
tive, Negative, or Intersecting. When you 
combine these objects in a group, the result is a 
Boolean object.

Boolean operations do not have any effect on 
Neutral objects. When you group a neutral 
object with a Boolean object, no Boolean oper-
ation is performed.

The Invert button swaps all the black and white values in 
the alpha channel.
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Neutral is the default object property. 

If you are importing objects from Bryce 2, you 
may want to change some positive objects to neu-
tral for faster rendering.

Boolean Operations

Boolean Union is performed by grouping two 
positive objects. The area that is common to 
both object is removed, creating a continuous 
object. For example, when you group two posi-
tive spheres, you get a kind of peanut shaped 
object which is the union of the two objects.

Boolean Subtraction is performed by grouping 
a negative object with a positive object. The 
area that is common to both objects is sub-
tracted from the positive object resulting in a 
positive object with negative space. For exam-
ple, when you group a positive sphere with a 
negative one, the resulting object looks like a 
sphere with a crater.

If you were to group a neutral object with a Boolean 
object, both objects would remain visible with no Boolean 
operation occurring.

Negative+Positive

Negative +Neutral

Boolean union is performed by grouping two positive 
objects
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Boolean Intersection is performed by combin-
ing an Intersecting object with a Positive 
object. The area that is common to both objects 
becomes the only visible portion of the group.

Negative or Intersecting objects must share 
space with at least one Positive object in the 
group to exhibit a Boolean operation. If there is 
no common space, Negative objects are invisi-
ble when rendered. 

A group that contains an Intersecting object 
that does not intersect with any other object in 
the group becomes entirely invisible; this is 
because the Intersecting object is intersecting 
with nothing.

You can build very complex objects by com-
pounding Booleans. Suppose you wanted to 
create a flute. You would first create the hollow 
tube by combining a positive cylinder with a 
negative cylinder, then create several negative 
spheres and group those with the tube, creating 
a simple flute. 

By compounding more Boolean operations on 
top of this simple flute you could create even 
more complex objects.

Boolean subtraction is performed by grouping a positive 
object with a negative object.

Boolean Intersection is performed by grouping a Positive 
object with an Intersecting object.

This simple flute was created by grouping a hollow tube 
with several negative spheres.
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Since Bryce performs Boolean operations using 
object attributes, you can adjust the shape of a 
Boolean object by repositioning the objects in 
the group. You can edit objects within groups 
using the Solo mode in the Selection palette. 
Refer to “Selecting Objects” on page 30 for 
more.

The final Boolean object appears only in the 
rendered image or in the Nano-Preview. You 
won’t be able to see the Boolean object in the 
Wireframe preview.

To subtract one object from another:

1 Select an object.

2 Click the A button next to the object’s 
bounding box, or press Command-Option-
E/Ctrl+Alt+E, or choose Objects menu> 
Edit Attributes.

The Object Attributes dialog appears.

3 Enable the Negative checkbox.

4 Move the negative object so that it 
intersects another object. 

5 Make sure that the second object’s Boolean 
attribute is set to Positive.

6 Select both objects and click the G button 
next to the selection’s bounding box to 
group them.

When your scene is rendered, the area 
where the two objects intersect is removed 
from the positive object.

To create an object that is the intersection 
of two objects:

1 Select an object.

2 Click the A button next to the object’s 
bounding box, or press Command-Option-
E/Ctrl+Alt+E, or choose Objects menu> 
Edit Attributes.

The Object Attributes dialog appears.

3 Enable the Intersecting checkbox.

4 Move the intersecting object so that it 
intersects another object. 

5 Make sure that the second object’s Boolean 
attribute is set to Positive.

6 Select both objects and click the G button 
next to the selection’s bounding box.

When your scene is rendered, the area 
where the two objects intersect becomes 
the only visible portion of the group.

Creating Geometric 
Paths
A geometric path is an object that acts as a 
motion path for other objects. Geometric Paths 
do not render as objects. 

You can think of these paths as railroad tracks. 
Objects can move along the track but the they 
can’t move off of it. 

This sprinkler was created using compound Boolean 
operations.
117 Bryce 4



You can control how an object is constrained to 
the path using the options in the Object 
Attributes dialog.

Geometric paths can be edited just like you 
would any other object. You rotate, position, or 
scale the path using the tools in the Edit pal-
ette. You can also edit a path by dragging its 
control points. This way can change the geome-
try of the paths as well as the trajectory of any 
object attached to it.

Geometric paths are especially useful when you 
creating motion animations, as they can help 
you create predictable and repeatable motion. 

The other great thing about geometric paths is 
that you can have more than one object 
attached to it. This can be very useful if you 
want a number of objects to move along the 
same trajectory. 

Objects that are attached to the same path can 
be animated at different rates. So, if you can 
think of the objects as different trains on the 
same track, some trains are at the beginning of 
the track, others are in the middle, and some 
are at the end. All the object attached to the 
path will have the same trajectory. 

You can also align objects differently to the 
same path. So object may appear to tilt differ-
ently as they follow the same trajectory.

Since geometric paths are objects, they can also 
be attached to other paths. Some very complex 
types of motion can be created using this tech-
nique. 

Objects attached to a geometric path can move to any 
point along the path, but they can’t move off it. So, their 
trajectory is controlled by the shape of the path.

You can attach multiple objects to the same path. The 
motion of each object on the path is constrained by the 
shape of the path. 

All the objects attached to a path have the same trajectory, 
but they can move at different rates. 

For example, this caterpillar is made up cylinders all 
attached to the same path, but they’re moving a different 
rates so it looks like the body is slithering.
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To create a geometric path:

• Choose Objects menu> Create Path.

A default-shaped path object appears in 
your scene.

To convert a motion path into a geometric 
path object:

1 Select an object with a motion path.

2 Choose Objects menu> Create Path.

A path object with the same shape as the 
path you selected is created.

To link an object to a path:

1 Select the object you want to attach to the 
path.

2 Move the cursor over the Link icon that 
appears next to its bounding box.

3 Drag the linking control handle from the 
object to path object.

Using the Presets Object 
Library
The Presets Object Library contains all the pre-
set objects distributed with Bryce as well as 
presents you add. Objects in the library are 
either 3D models or geometric paths. Refer to 
“Creating Geometric Paths” on page 117 for 
more on geometric paths.

You can place objects from the library any-
where in your scene and edit them just as you 
would any object.

To add an object from the Preset Object 
Library to your scene:

1 Click the Triangle icon next to the Create 
button at the top of the Bryce 
environment. The Object Preset Library 
appears.

2 Click on the name of a category (to the left 
of thumbnails.

For example, you can simulate the motion of the solar 
system by attaching an object on a circular path to circular 
geometric path. 

The object on the circular path would act like a moon 
orbiting around a planet which is also orbiting around the 
Sun.

Use the Preset Object Library to add 3D models to your 
scene.
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3 Click on the preset thumbnails to view 
preset names and descriptions

4 Click OK to add the selected object to your 
scene.

The Create palette does not need to be active for 
you to access the Object Presets Library. 

Adding and Deleting Preset 
Categories and Objects

You can add preset categories (such as flowers, 
trees, and rocks) or specific objects (within cate-
gories) to the preset library. The preset library 
retains all Boolean, grouping and textural prop-
erties of the objects placed within it. 

To add a preset category:

• Choose Add Category and enter a category 
name. 

To delete a preset category:

• Select the name of the category.

• Click Delete Category.

To add an object to the preset library:

1 Select the object you want to add to the 
library.

2 Click the Triangle icon next to the Create 
button at the top of the Bryce window. The 

selected object appears in the preview area 
of the Object Preset Library dialog.

3  Click a category name. The library 
switches to the category you selected. 

The new preset will be added to the 
category you select.

4 Click the Triangle icon in the bottom right 
corner of the object preview and choose a 
view option from the menu. 

Normal is the default view of your selected 
object.

Up Close displays a close-up of your 
object.

Render With Neutral Sky displays your 
object with a flat sky, instead of the sky 
applied to your scene.

5 Set up the preview of the object:

• Drag the preview area to rotate the view 
of the object.

The object preview area displays the object you selected.

Use the Triangle icon at the bottom of the preview area to 
display a list of preview options.
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• Hold down the Spacebar and drag up, 
down, right, or left to pan the object 
preview.

• Hold down Command/Ctrl and drag in 
the preview area to zoom in and out of 
the preview.

6 Click the Add button at the bottom of the 
dialog. The Add Object dialog appears.

7 Enter a name for the new preset in the 
Preset Name field.

8 Enter a description of the preset in the 
Description field and click the OK icon.

This name and description will appear 
beneath the object preview whenever the 
preset is selected. 

9 Click the OK icon. Your preset is added to 
the first available space within the current 
category.

To delete an object preset:

1 Click the Triangle icon next to the Create 
button at the top of the Bryce 
environment. The Preset Object Library 
appears.

2 Click on the preset you want to delete, or 
hold down Shift and select a continuous 
series of presets, or hold down Command/
Ctrl and select a discontinuous set of 
presets.

3 Click the Delete button at the bottom of 
the dialog. 

Importing and Exporting Preset 
Objects

Importing and exporting presets is a handy way 
to exchange custom presets with other users. 

To import a Preset object file:

1 Click the Triangle icon next to the Create 
button at the top of the Bryce window. The 
Preset Objects Library appears.

2 Select the category into which you want to 
import the file.

3 Click the Import button at the bottom of 
the dialog. The file open dialog appears.

4 Locate the file which you would like to 
import and click Import.

The contents of the file are placed into the 
first available space in the current category.

To export a Preset object file:

1 Click the Triangle icon next to the Create 
button at the top of the Bryce window. The 
Preset Objects Library appears.

2 Select the category from which you want to 
export presets.

3 Select the preset or presets you wish to 
export.

4 Click the Export button at the bottom of 
the dialog. The save file dialog appears.

5 Enter a name and location for the file and 
click Save.
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7
 Creating Skies

Environments and Bryce
A Bryce sky defines the virtual environment of 
your scene. Unlike many other 3D 
applications, Bryce’s virtual environment is 
not merely a backdrop, it is an infinite 3D 
representation of natural environmental 
phenomena.

All of the elements in your sky interact with 
each other just as they would in the real world. 
Colors in your environment interact with 
everything in your scene just as they would in 
nature. For example, red sunlight is invisible 
until it strikes an object, then the object 
exhibits red highlights. If it’s a blue object, it 
takes on a purple cast and so on.

The colors in the sky change depending on the 
position of the sun, and how much moisture 
(Haze, Fog) is present in the atmosphere. All 
this, plus natural reflection, refraction, and 
more make Bryce’s Sky & Fog palette 



responsible for a great deal of the natural, or 
supernatural, look and feel of Bryce images.

You can add even more realism to a sky by 
enabling one of the many environmental effects 
available for skies. Using these effects you can 
create night skies full of stars, or have a bright 
rainbow streaking across the roof of your 
world. One of the most spectacular effects is 
the Volumetric World effect. When this effect is 
enabled all the light in your scene appears as 

visible rays. This is similar to the effects of light 
shining through clouds on a hazy day.

Like any other scene setting, skies can be 
animated. Any property of a sky can be changed 
at different points along the animation 
timeline. When the animation plays, the sky 
property will appear to change over time. Using 
this technique, you can create a scene that 
changes from day to night, or from clear to 
cloudy. Refer to “Animating Skies” on page 393 
for more on animating skies.

The Sky & Fog Palette
The Sky & Fog palette is where you’ll set up the 
attributes of your environment. The palette 
uses visual controls in the form of thumbnails 

The objects in your scene may look incredibly realistic on 
their own...

...but when you add a sky, the scene becomes a window 
looking out into a real world.

The other-worldly look of this spaceship landing was 
created using Volumetric World.
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to help you see how changing the value of an 
attribute affects your sky.

The name of the control you’re adjusting 
appears in the Text Display area of the Control 
palette. You can also use this area to help guide 
you if you prefer numeric precision.

Each control has at least one color swatch along 
the bottom of the thumbnail. Theses swatches 
are used to set the color for a given sky 
attribute, like cloud color or fog color.

Next to the thumbnails are a series of controls 
that let you set the frequency and amplitude of 
clouds, the position of the sun or moon and 
store sky properties. You can see their effects in 
the Preview area.

Working with Sky Lab

The Sky Lab button provides access to the Sky 
Lab dialog. This dialog contains controls for 
fine-tuning environmental effects like clouds, 
rainbows, and sun and moon rings. Click the 
Sky Lab button, which looks like a cloud with a 
rainbow, in the Sky & Fog palette. to display the 
Sky Lab dialog. You can also click the triangle 
icon below the memory dots and choose Sky 
Lab from the menu.

The dialog contains three tabs:

• Sun & Moon contains controls for 
positioning the sun and moon as well as 
adding effects like rings and horizon 
illusions.

• Cloud Cover contains controls for editing 
cloud textures and setting up cloud 
animations.

• Atmosphere contains controls for 
rainbows, visible lights, and color 
blending. 

You can preview your changes in the Sky Lab 
dialog. 

The Sky & Fog palette’s thumbnails let you set values for 
sky attributes. 

The Text Area displays the name of a Sky & Fog control 
as you pass the cursor over it. When you’re adjusting the 
setting of a control, this area displays its current value.

Sky Mode

Sky Mode Options

Shadow Intensity

Fog Height

Haze Intensity

Cloud Coverage

Cloud Altitude

Ambient Color

Fog Color

Haze Color

Sky Dome Color

Cloud Color
The set of controls at the end of the palette does not have 
visual guides, but you can see their effects in the Preview 
area.

Sky Lab

Random Skies Memory Dots

Sun Color

Sun/Moon Position

Sky & Fog 
Options

Day/Night Toggle

Cloud Frequency
and Amplitude
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• To view the different preview options, click 
the downward pointing triangle at the 
lower corner of the preview area. You can 
also change the camera position in the 
preview area. 

• To change the position of the camera, hold 
the Option/Alt key and drag the preview. 
To orbit around the scene, drag the 
preview in the direction you want to move 
the view of your scene.

Working with the Sky & Fog 
palette

The Sky & Fog palette has several settings that 
you can use to control how the palette affects 
your scene and how the sun tracks your camera 
view. You can also use the palette’s memory 
dots to store settings as you experiment with 
different environmental attributes.

Using the Control Thumbnails

The thumbnails are visual guides, and they are 
also used to set the attributes of Sky & Fog 
effects.

To change the intensity of an effect:

• Drag to the left or right inside the 
thumbnail to change the intensity of the 
effect. 

To pick a color for an effect:

• Click the color bar below the thumbnail. A 
color picker appears and your pointer 
changes to an eyedropper. 

While the eyedropper is active, you can 
select colors from anywhere in your scene, 
or even different parts of the interface.

For more control after picking with the color 
picker, try Option-click/Alt+click to get Bryce’s 
second color editor, switch to HLS mode and 
adjust saturation or lightness (less saturated col-
ors can make for more realistic fog and haze 
effects), or you can enter numeric values if you 
need to precisely match specific colors.

Setting Palette Options

The Sky & Fog palette options let you link the 
palette controls directly to your scene and link 
your sun to the camera.

To link Sky & Fog attributes directly to your 
scene:

• Click the triangle icon below the memory 
dots at the right edge of the palette and 
choose Choose Auto Update from the 
menu.

• When this option is enabled, every change 
you make to the Sky & Fog palette settings 
will start a render of your scene with the 
new sky settings.

Click on the bar below the thumbnail to access the color 
picker.
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To reset Sky & Fog palette settings to their 
defaults:

• Click the triangle icon below the memory 
dots at the right edge of the palette and 
choose Reset Sky from the menu.

Saving Sky & Fog settings

The memory dots in the Sky & Fog palette let 
you store your favorite Sky & Fog settings. 
Using these dots you can safely explore many 
Sky & Fog configurations without losing your 
favorite settings along the way. Memory dots 
appear along the right side of the palette.

To save Sky & Fog settings:

• In the Sky & Fog palette, click on an empty 
dot (empty dots are gray).

All the current Sky & Fog palette settings 
are stored into the selected dot. 

To switch to a saved Sky & Fog setting:

• Click on a full dot (full dots are turquoise.) 
The current settings are replaced with the 
settings stored in the dot. 

An active dot will be turquoise with a white 
point inside it.

To reset Sky & Fog settings to default:

• In the Sky & Fog palette, click the 
uppermost memory dot. This dot always 
appears full.

To delete a saved Sky & Fog setting:

• Option-click/Alt+click on a full 
Memory Dot.

The uppermost dot cannot be cleared.

Memory dots are saved with the scene, but not 
between sessions, so you may want to save your 
favorite skies as presets before ending a Bryce 
session.

Randomizing Skies

Randomizing skies is a very powerful way of 
exploring possibilities you may never find any 
other way. When you randomize the sky all the 
settings in the palettes are replaced by 
randomly generated values.

To randomize your sky:

• Click on the Randomize Sky Button.

Remember, you can always return to the 
default settings by clicking on the top 
Memory Dot.

Note
Unless you have marqueed a 
small region to be updated, every 
change you make will begin a 
completely new render.

Use the Memory dots to store your favorite Sky & Fog 
settings.

Click the Randomize Sky button to randomly generate sky 
settings.
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Working with Sky Modes
The Sky modes act as the base of your sky. The 
Sky modes control lets you set the base colors 
and light tones for your environment. There are 
four modes available: Soft Sky, Dark Sky, 
Custom Sky and Atmosphere Off.

As you switch between the modes, the 
thumbnail also changes to give you a preview of 
what the mode looks like.

To select a sky mode:

• Click the Sky mode thumbnail to cycle 
through the four modes, or 

• Drag left or right inside the thumbnail to 
cycle through the modes, or 

• Click the triangle icon next to the 
thumbnail and choose a mode from the 
menu.

Sky Modes

Soft Sky is the default state of the sky. It 
features softer shades of blue and lighter tones.

Darker Sky is a darker version of Soft Sky. It 
uses darker shades of color and tones. This 
mode is good for creating more brooding skies.

Custom Sky lets you choose your own colors 
for the sky; this way you can create some truly 
alien environments. When this mode is 
selected, the standard behavior of colors in the 
sky with respect to sun position is disabled. 

Atmosphere Off disables the standard sky 
color behaviors, relative to sun position, and 
uses a single color for the sky. This mode is 
useful when you need to render objects against 
a simple colored (or black or white) 
background. The Sun color still affects objects 
in this mode. If you have red sunlight, for 
instance, objects in your scene will reflect red 
light.

To set custom sky colors:

1 Click the triangle icon next to the Sky 
Mode thumbnail and choose Custom Sky 

The four Sky modes control the base colors and tones used 
to create your sky.

In Custom Sky mode you can pick your own colors for the 
sky.

Solar Halo 
Color

Horizon 
Color

Sky Color
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from the menu. The thumbnail changes to 
the Custom Sky control.

2 Click the Sky Color swatch and choose a 
color from the color picker.

The Sky Color is the main sky color in this 
mode, regardless of sun position.

3 Click the Solar Halo Color swatch and 
choose a color from the color picker.

This is the color of the halo around the 
sun.

4 Click the Horizon Color swatch and choose 
a color from the color picker.

This color will in certain cases affect your 
scene below ground level if you have a haze 
setting of greater than zero. It will also 
impact the color of Stratus clouds near the 
horizon.

In most cases, this will be the least 
obviously used color in your scene; unless 
you are making outer space scenes, in 
which case this could be very useful for 
you.

To render objects against a plain 
background:

1 Click the triangle icon next to the Sky 
Mode thumbnail and choose Atmosphere 
Off from the menu. The thumbnail 
changes to the Atmosphere Off control.

2 Click the Atmosphere swatch and choose a 
color from the color picker.

3 Drag left inside the Haze control and set 
the value to 0. This setting eliminates the 
suggestion of a horizon.

Setting Sky Attributes
Once you’ve selected a Sky mode you have the 
basis for your virtual environment. All the other 
atmosphere effects you add later will interact 
with the base mode. There are two other 
attributes that affect how all the other effects 
will appear: Shadows and Ambient color.

Shadows in Your Scene

All the objects in your scene cast shadows. 
Using the Shadow control you can set the 
intensity and color of all the shadows in your 
scene.  

The shadow control is not the only control for 
shadows. The position of shadows is dependent 
on the position of the sun. Since the sky 
interacts directly with objects in the scene, the 
color of the sun also effects the color of 
shadows. 

The object’s material properties also effect the 
color of shadows. Semi-transparent or 
transparent objects with a transparency color 

Use the Shadows control to set the color and intensity of 
shadows in your scene.

As you change the value of the Shadow control, the 
brightness of shadows changes.

Shadow

Color

Shadows=10 Shadows=90
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will change the color of the object’s shadow. As 
well, volume materials can dramatically change 
the shape and color of shadows.

By default, the Clouds in Bryce do not cast shad-
ows. If you want the cloud layer to cast shadows 
on the ground below, enable the Cloud Shadows 
option. Refer to “Cloud Coverage” on page 140 
for more on this option. 

To set shadow intensity:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Drag left or right inside the Shadow 
control thumbnail. Dragging left decreases 
the intensity and dragging right increases 
it.

To set shadow intensity numerically:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Sun & Moon tab to display the 
Sun & Moon palette.

4 Click the Shadow field, then enter a value, 
or drag the slider.This field governs the 
intensity of shadows rendered in your 
image. The range is 0 to 100%, and the 
default value is 90%.

Ambient Color

The Ambient Color is the color of all the light 
that surrounds the objects in your scene. Light 
from the sun interacts with ambient color to 
produce the color for both highlights and 
shadows.

Ambient Color is used as the source color for 
material Ambience. The Ambient Color tints 
the surfaces of all objects in your scene that 
have some level of ambience. Any other color 
you apply to the object’s surface is mixed with 

Use the Shadows control to set the color and intensity of 
shadows in your scene.

The cursor changes to a two headed arrow as you drag 
over the control.

Use the Sky Lab dialog to set sky attributes numerically.
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the Ambient color to create the final surface 
color. For example, if the Ambient Color is red, 
any color you assign to an object’s surface 
ambience is mixed with red.

Refer to “Ambience” on page 197 for more on 
material ambience. 

To set Ambient Color:

• Click the color swatch below the shadow 
control thumbnail and choose a color from 
the color picker.

For realistic effects, at noon, or in the 
afternoon, ambient color should be a little 
blue to get nice blue-ish shadows. At dawn, 
you can set Ambient Color to red or pink, 
and at night you can set it to gray-blue.

Adding Fog and Haze
Fog and Haze are two atmospheric effects that 
can add realistic depth to your scene. Fog can 
make objects appear to disappear the farther 
they get from the camera. Haze can add the 
illusion of a distant horizon. The Fog and Haze 
controls in the Sky & Fog palette let you 
control the color and intensity of these effects.

Fog

Fog can add an element of sensuality, mystery, 
and even realism to your scenes. It acts like a 
thin layer of cloud close to the ground. Using 
Fog you can create the illusion of depth without 
having to add distant objects.

You can set intensity, height and color 
attributes for the fog. 

The fog acts as a global layer covering the entire 
scene. Its color and intensity are the same 
throughout the scene. 

To set the amount of Fog:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog text button.

Use the Fog and Haze controls to set the intensity and 
color of Fog and Haze effects.

Fog

Haze Intensity

Haze Color

Fog Color

Fog can create a sense of depth in your scene In this scene, 
the fog was used to add depth to the road as it moves away 
from the camera. Notice how the feeling of depth was 
created without the addition of background objects.

For example, you can see how the fog changes in these 
skies as the Fog value changes.

Fog=10 Fog=90
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2 Drag horizontally inside the Fog thumbnail 
to increase or decrease the amount of fog 
in your rendered scene. Drag to the left to 
decrease the amount of fog and to the right 
to increase it.

To set Fog height:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog text button.

2 Drag vertically inside the Fog control to 
increase or decrease the height of your fog. 
Drag up to increase the height and down 
to decrease it.

The height and amount values are displayed in 
the Text area of the Control palette as you drag.

To set Fog color:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog text button.

2 Click the color swatch beneath the Fog 
thumbnail and choose a color from the 
color picker.

To set Fog attributes numerically:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Atmosphere tab.

4 Click the Fog Density and/or Thickness 
fields then enter a value. These fields set 
the amount of fog rendered in your image. 
The range is 0 to 100%, and the default 
value is 0%.

5 Click the Base Height field, then enter a 
value. This field sets the height of fog 

rendered into your scene, assuming there 
is a value greater than zero in the Fog field. 
The range is 0 to 100%, and the default 
value is 0%. It translates the entire 
atmospheric effect up or down without 
changing the density or thickness.

Base Height provides control over density 
at low altitudes, such as in valleys. In earlier 
versions of Bryce, you had to move the 
entire scene up or down relative to the 
atmosphere.

Blending the Fog Color

Since the fog remains constant throughout the 
scene, you may get some odd looking results 
when you’re creating a sunset or sunrise. In 
these cases the sun is very close to the ground 
plane where the fog exists, so the fog should 
react to the sunlight. The Blend with Sun 
feature lets you create exactly this effect. As the 
sun approaches the Fog, the color and intensity 
of the fog changes to interact with the color of 
the sun.

In this example, the Fog is linked to the sun so you can see 
the changes in the fog color and intensity as the sun gets 
closer to the horizon.
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To link Fog color to the Sun controls:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Atmosphere tab.

4 Click the Blend with Sun button.

5 Make sure the Blend Fog button is 
enabled.

6 Enter a value in the Color field, or drag the 
slider, to set how much of the fog color is 
blended with the sun.

7 Enter a value in the Luminance field, or 
drag the slider, to set the intensity of the 
fog color when it’s blended. 

To get the best effect, set both these fields 
to 100.

Localized Fog

There may be times when you want to create 
localized pockets of fog. For this type of effect  
you’ll need to use an object with a volume 
material applied to it; this way the object looks 
like fog. The area covered by the fog is then 
controlled by the size of the object. A flattened 
sphere usually makes a good fog volume.

This technique can also be used to create visible 
smoke, or gas.

To create localized fog:

1 Display the Create palette.

2 Click the Sphere tool. A sphere object 
appears in the scene.

3 Squash and stretch the sphere, until it is 
the desired shape. Refer to “Transforming 
Objects” on page 285 for more on 
transforming objects.

4 With the object selected, click the M icon 
that appears next to its bounding box. The 
Materials Lab appears.

5 Click the Volume button at the top of the 
lab. 

6 Set up the values for channels in the 
material. Refer to “Building Materials” on 
page 230 for more on creating materials.

• Choose a cloud-like texture from 
texture components. Stratus, Cumulus 
or one of the CloudBump textures work 
well.

In this example, fog only appears around the base of the 
castle. This effect was created by applying a volume 
material to a flattened sphere object.
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• Pay special attention to the Base 
Density channel as this sets the 
transparency of your fog.

• You need to set a high value for the 
Edge Softness channel to blur the 
edges of the sphere object.

7 Click the OK icon to exit the lab.

8 In the Working window, move the object to 
the area where you want the fog to appear.

Haze

Haze is the natural effect you see when a plane 
(like the ocean) stretches out towards the 
horizon. At this distant point a different color 
appears over the horizon and light becomes 
fuzzy. 

The Haze control lets you set the intensity and 
color of the Haze effect in your Bryce scene. 

If you are upgrading from Bryce 2, you may find 
that haze is more subtle at the lower end and you 
may need to adjust the Haze setting.

With haze set to zero, your horizon will have an 
unnaturally hard edge. Also note that the Cloud 
Altitude control will affect the height of this 
band of haze. The higher the altitude of the 

atmosphere, the wider the band of haze at the 
horizon.

Haze is applied to the entire scene equally. The 
haze always appears at the horizon. 

To set Haze intensity:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Drag horizontally inside the Haze 
thumbnail to increase or decrease the 
degree of haze in your scene. Drag to the 
left to decrease the amount of haze and to 
the right to increase it.

To set Haze intensity numerically:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the button at 
the top of the Bryce window.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Atmosphere tab.

4 Click a field name then enter a value in the 
Haze Density, Thickness, and Base Height 
fields. These fields govern the amount of 
haze rendered into your scene. The range 
is 0 to 100%, and the default value is 4%.

Haze creates the illusion of a distant horizons. In this 
scene, the haze is used to create the distinction between the 
water plane and the sky.

You can see how the haze changes in these skies as the 
Haze value changes.

Haze=0 Haze=90
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Density controls density of the lower part 
of the atmosphere, and affects 
forescattering around the sun.

Thickness scales the whole atmosphere up 
or down, with the density at “sea level” 
remaining unchanged.

Base Height provides control over density 
at low altitudes, such as in valleys. It 
translates the entire atmospheric effect up 
or down without changing the density or 
thickness. In earlier versions of Bryce, you 
had to move the entire scene up or down 
relative to the atmosphere.

To set Haze color:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the color swatch beneath the Haze 
thumbnail and choose a color from the 
color picker.

Fog and Haze colors should be the same, or 
almost the same. For realism, the haze should 
be a little brighter and bluer than the fog. At 
nighttime, you have less illumination, so an 
effective nocturnal haze color could be dark 
blue-gray. 

Blending the Haze color with the 
Sun

Since the Haze always appears at the horizon it 
should change color as the sun sets or rises. 
The Blend with Sun feature lets you simulate 
this effect. When the two elements are linked, 
the haze color and brightness change 

depending on the position of the sun. This 
creates very realistic looking sunsets. 

When you’re using this feature to create 
sunsets, you should choose the haze color 
carefully so as to create a natural-looking color 
scheme.

To link Haze to the Sun controls:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Atmosphere tab.

4 Click the Blend with Sun button.

5 Make sure the Blend Haze and Blend Fog 
buttons are enabled.

6 Enter a value in the Color field, or use the 
slider, to set how much of the haze color is 
blended with the sun.

7 Enter a value in the Luminance field, or 
use the slider, to set the intensity of the 
haze color when it’s blended. 

In this example, the haze is linked to the sun. You can see 
how the color of the horizon changes as it gets closer to the 
sun.
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8 To get the best effect, set both these fields 
to 100.

Setting the Color Perspective

Color perspective is the change in color with 
distance that characterizes the appearance of 
distant scenes in Nature: Dark areas turn blue 
and light ones yellow to orange to red. In Bryce 
you can make things change any color you like 
with distance. Color perspective is half of aerial 
perspective, while the other half is the loss of 
contrast with distance. 

Color perspective controls the rate at which the 
red, green and blue components of the 
atmosphere come in with distance. In Nature, 
the atmosphere is white or a pale shade of gray. 
The blue component of that shade comes in 
faster than the green, which in turn comes in 
faster than the red. This is because the Earth's 
atmosphere scatters blue light more efficiently 
than green, and red least efficiently of all. The 
net result is that as a dark area recedes into the 
distance, it will turn blue before it turns white 
or pale gray in the far distance. Similarly, white 
areas will turn yellow, then orange, then red 
with increasing distance. The default values of  
color perspective are very delicate: If you mess 
with them, expect bizarre results!

To set the color perspective:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Atmosphere tab.

4 Click the Color Perspective button.

5 Click RGB controls to control the rate at 
which the red, green, and blue 

components of the atmosphere come in 
with distance.

Clouds in Bryce
There two kinds of clouds in Bryce: clouds in 
the environment and cloud planes. 

Clouds you add to your sky interact with the 
light in your scene. They can block out the light 
of the sun and change the color of the light that 
hits the objects in the scene. These clouds are 
infinitely distant so you cannot fly through the 
clouds in the sky. If you want to have this effect, 
use a cloud plane. Sky clouds can also cast 
shadows on the ground below.

You can change the look of the clouds by 
editing the texture used to create it. By 
changing the texture you can alter the shape 
and position of the clouds within the sky. 

The clouds in this scene were created using Cumulus clouds 
from the Sky and Fog palette.
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Cloud planes are infinite planes that act as 
objects in your scene. They cast shadows and 
can interact with other objects. 

Both types of clouds can be animated. The 
clouds in the sky can be animated by changing 
their color, position or frequency, and cloud 
planes can be animated just like other objects. 
They can also be animated using the Cloud 
Motion controls. These controls let you set 
parameters for automatically animating clouds.

Refer to “Animating Clouds” on page 394 for 
more on animating clouds.

Adding Clouds

The Sky & Fog palette provides several controls 
that set the attributes of clouds in your sky. The 
Cloud Coverage, Cloud Altitude, and Cloud 
Frequency and Amplitude controls let you set 

the general appearance of your clouds. The 
Cloud Color sets the color of the clouds.

You can add clouds to your scene in five easy 
steps:

• Select the type of cloud 

• Adjust the cloud texture

• Set the cloud coverage and color

• Set cloud altitude

• Set the frequency and amplitude of clouds

Cloud Types

There are two types of clouds you can add to 
your Bryce environment: Cumulus and Stratus. 
Cumulus clouds are generally found at lower 
altitudes and appear thicker and fluffier.

The clouds in this scene were created using an infinite 
cloud plane. Using this type of cloud, you can fly an 
airplane through the layer.

Use the cloud controls to set the attributes of the clouds in 
your scene.

The sky in this scene uses Cumulus clouds.

Cloud Cover
Sky Dome Color Cumulus Color

Cloud Height

Cloud Frequency and Amplitude
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The Stratus appear at higher altitudes and 
appear thinner and more wispy. 

To add Cumulus clouds to a sky:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the 
Sky & Fog button at the top of the Bryce 
window.

2 Click the triangle in the corner of the 
palette and choose Cumulus Clouds.

Cumulus clouds are thicker, darker clouds 
at a lower altitude. These clouds will take 
on tints of Sunlight color, Ambient color, 
or Cumulus color.

To add Stratus clouds to a sky:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the 
Sky & Fog button at the top of the Bryce 
window.

2 Click the triangle in the corner of the 
palette and choose Stratus Clouds.

Stratus clouds are bright white, thin, clean 
clouds that appear at high altitudes. These 
clouds are very responsive to Sunlight 
color and Sky Dome color, and less 
responsive to Cumulus color or Ambient 
color.

You can also choose both cloud types, or neither. 
Selecting neither cloud type creates a clear sky.

Editing Cloud Textures

Clouds in Bryce are created using a procedural 
texture with a cloud pattern. The color, 
position, size, and pattern within the texture 
determines the final look of the cloud in your 
sky. You can edit this texture using either the 
Sky Lab palette, or for more complex editing, 
you can use the Texture Editor. 

The texture used for a cloud can come from 
either the Bryce texture library or you can 
create your own.

To edit cloud texture in the Sky Lab dialog: 

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the 
Sky & Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab 
palette appears.

3 Click the Cloud Cover tab.

The sky in this scene uses Stratus clouds.

The Cloud Cover tab provides controls that let you edit the 
textures that are used to create the clouds in your scene. As 
you change a texture, the texture preview updates.
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4 Click the + or - Turbulence buttons to 
increase or decrease the amount of noise 
in the texture. 

• Increasing the Turbulence creates a 
more dense pattern within the texture.

5 Click the + or - Complexity buttons to 
increase or decrease the amount of detail 
in the texture. 

• Increasing the Complexity increases 
the complexity of the patterns within 
the texture.

6 Click the Randomize button if you want to 
choose a randomly generated texture for 
your clouds.

7 Click the three buttons to the left of the 
selected cloud type to change the colors 
used in the clouds.

8 Click the Reset button to restore the 
original settings, if you want to start over.

9 Click the OK icon to apply your changes.

To edit cloud textures in the Deep Texture 
Editor:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the 
Sky & Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab 
palette appears.

3 Click the Cloud Cover tab.

4 Click the Edit button below the type of 
clouds you want to edit.

5 Click the Edit button. The Deep Texture 
Editor appears.

The cloud texture and its components 
appear in the component windows.

If you’re not familiar with using the Deep Tex-
ture Editor you may get some very unpredictable 
results which may result in clouds that don’t look 
much like clouds. Before you start editing the 
clouds texture you may want to refer to “Tex-
tures” on page 237 for more instruction on how 
to use the editor.

6 If you want to add additional turbulence to 
the cloud texture, adjust the texture’s 
Noise:

• Click the Noise button at the bottom of 
the editor. The Noise control appears.

• Move the component indicator at the 
top of the control to the component 
you want to edit. 

• Adjust the Noise slider to increase/
decrease the frequency of the noise in 
the texture.

7 If you want to change the colors of a 
component, click one of the color 

When you open a cloud texture in the texture editor, you 
can see its components in the various windows. You can use 
the editor’s tools to completely redesign the texture or to 
alter the existing texture.

The Noise control lets you adjust the frequency of the noise 
in any of the texture’s components.
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indicators in the component window and 
choose a new color.

8 If you want to add more complexity to the 
texture, adjust its Phase:

• Click the Phase button at the bottom of 
the editor. The Phase control appears.

• Move the component indicator at the 
top of the control to the component 
you want to edit. 

• Adjust the Phase slider to increase/
decrease the amplitude of the phase.

9 If you want to change the pattern in the 
texture, apply a filter:

• Click the Filter button at the bottom of 
the editor. The Filtering control 
appears.

• Move the component indicator at the 
top of the control to the component 
you want to edit. 

• Change the filter equation and variable 
values to adjust the filter applied to 
your texture.

Filtering is a rather complex operation. Try 
experimenting with different equations and see 
what happens.

10 Click the OK icon to exit the editor.

Cloud Coverage

Cloud Coverage controls the quantity of clouds 
you can see in the sky. A high coverage means 
that there is a very dense cloud layer, and a low 
setting means that there are very few clouds in 
the sky.

Cloud coverage also indirectly controls the 
brightness of the environment. The more cloud 
coverage you have in a sky, the darker the 
environment, since less sunlight can pass 
through the clouds.

Adjusting cloud coverage changes the 
quantity of clouds but not the frequency. 
You can think of it as adjusting the volume 
on a radio without changing the station.

The Phase control lets you adjust the amplitude of the 
phase in any of the texture’s components.

The Filtering control displays a graphical representation 
of the filter applied to your texture. By changing the 
equation of the filter to the value of the variables, you can 
change the patterns within the cloud texture.

The Cloud Coverage control in the Sky & Fog palette lets 
you interactively set the quantity of clouds in the sky.

Cloud Coverage

Cloud Color
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To set cloud coverage:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the 
Sky & Fog button at the top of the Bryce 
window.

2 Drag left or right inside the Cloud 
Coverage control thumbnail. Drag left to 
decrease coverage and right to increase it.

To set cloud coverage numerically:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the 
Sky & Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Cloud Cover tab.

4 Drag the slider or enter a value in the 
Cloud Cover field. 

To set cloud color:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button.

2 Click the color swatch beneath the Cloud 
Coverage thumbnail and choose a color 
from the color picker.

Cloud Altitude

The altitude of your clouds has a great effect on 
the personality of your sky. Higher altitudes will 
result in smaller, more distant cloud 
formations, as well as a thicker band of haze at 
the horizon. Lower altitudes result in larger, 
more languorous cloud formations and a 
thinner band of haze at the horizon. 

There are two things to remember when 
working with this control. First, the Cloud 
Altitude will affect the size of your Haze band, 
if you have a haze setting greater than zero. The 
higher the altitude, the wider the haze region 
will be on the horizon. You can use this 
interaction to your benefit. 

For example, you can see how the clouds change in these 
skies as the cloud coverage value changes.

The Cloud Cover setting controls the amount of clouds in 
your scene. The range is 0 to 100%, and the default value is 
20%. 

Cloud Coverage=10 Cloud Coverage=90

The Cloud Altitude controls in the Sky & Fog palette lets 
you interactively set the height of the cloud layer in the sky.

For example, you can see how the clouds change in these 
skies as the cloud altitude value changes.

Cloud Altitude

Cloud Altitude=10 Cloud Altitude=90
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Second, remember to lower your altitude 
setting if you are creating a nighttime scene. 
Since high altitudes increase the size of the 
horizon Haze region, the sky will be too 
unnaturally bright for realistic night scenes.

To set cloud altitude:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Drag horizontally inside the Cloud 
Altitude control thumbnail. Drag left to 
decrease altitude and right to increase it.

To set cloud altitude numerically:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog text button.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Cloud Cover tab.

4 Drag the slider or enter a value in the 
Cloud Height field. 

Sky Dome Color

The Sky Dome color lets you create a color 
wash over your scenes, even if there is no 
sunlight present. This color simulates the 
natural effect that occurs when you have color 
in the sky even though the sun has set. Sky 

dome color is a great way of creating late 
afternoon or evening scenes.

For late afternoon and early evening realism, try 
using a touch of orange or yellow. This will cre-
ate a cast of color over your entire scene, regard-
less of the position or color of the sun or moon.

To set Sky Dome color:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the color bar beneath the Cloud 
Altitude control thumbnail and choose a 
color from the color picker.

Frequency and Amplitude

The Frequency and Amplitude control lets you 
set the types of cloud formation you’ll see in 
your sky. By combining these two controls you 
can change your clouds from light and fluffy to 
dark and brooding.

The Height field controls the height of the clouds in your 
scene. The range is 0 to 999, and the default value is 3.

The Sky Dome Color control in the Sky & Fog palette lets 
you choose a color from either the color picker or the color 
dialog.

Use Frequency and Amplitude to control the types of cloud 
formations in your scene.

Sky Dome Color
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To set Cloud Frequency and Amplitude:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 In the Cloud Frequency and Amplitude 
control, drag horizontally to control the 
frequency of your cloud formations. 

Drag left, and the “spikes” will get closer 
together, resulting in smaller formations. 
Drag right for larger, more luxurious 
formations.

The Text Display area shows you the numerical 
value of the amplitude as you drag.

3 Drag vertically to control the amplitude of 
your cloud formations. 

Drag away from the horizontal center, and 
the spikes increase in height, resulting in 
formations with harder edges. Drag toward 
the horizontal center for softer-edged 
formations. 

Note: It is possible to invert the spikes. This 
means that you can exchange positive and nega-
tive spaces in your sky. If you invert the ampli-
tude, everything that was previously clear sky 
will be clouds, while everything that was cloud 
will be clear sky.

To set Frequency and Amplitude numerically:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Cloud Cover tab.

4 Drag the slider or enter a value in the 
Frequency field. 

5 Drag the slider or enter a value in the 
Amplitude field. 

This graph shows the effects of different Frequency and 
Amplitude settings on a sky. Frequency values range from 
2 at the top to 150 at the bottom. The Amplitude values 
range from 50 at the left to 500 on the right.
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Amplitude

The Frequency field controls the frequency (scale) of cloud 
formations in your scene. The range is -200 to +200, and 
the default value is 25.

The Amplitude field controls the amplitude (edge softness) 
of clouds in your scene. The range is -500 to +500, and the 
default value is 100.
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Linking Clouds to the Camera View

If you move the camera view during an 
animation, the clouds in your environment will 
appear to zoom by, creating a kind of time-
lapsed effect. If you want the clouds to appear 
fixed as you move the camera, link the cloud in 
the sky to the camera view. This way, wherever 
the camera moves the clouds will follow, so that 
they seem to remain stationary.

To link clouds to view:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Cloud Cover tab.

4 Click the Link Clouds to View button.

Refer to “Animating Skies” on page 393 for 
more on animating skies.

Using a Fixed Cloud Plane

As you move higher up in a Bryce environment, 
the cloud pattern shifts, so that it appears as if 
you’re getting closer to the clouds. If you want 
to counter this effect, you can use the Fix Cloud 
Plane option to freeze the cloud pattern so that 
it doesn’t change as you move higher up in the 
environment. 

To use a fixed cloud pattern in your sky:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Cloud Cover tab.

4 Click the Fixed Cloud Plane button.

Setting the Cloud Motion

You can set the speed and turbulence of clouds 
as well as specify the direction of motion.

To set cloud speed:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Cloud Cover tab.

4 Drag the slider, or enter a number in the 
Speed field.

To set cloud turbulence:

1 If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Cloud Cover tab.

4 Drag the slider or enter a value in the 
Turbulence field.

To set the direction of motion:

1  If it’s not already visible, display the 
Sky & Fog palette by clicking the text item 
on the menu bar.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Cloud Cover tab.

4 Drag the control to specify the angle of 
motion.
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Working with the Sun
The sun is the source of all natural light in your 
scene. Its attributes have a profound effect on 
the look of your scene. 

The color of the sun affects all the colors of all 
the objects in the scene; Sunlight color tints all 
the other visible colors. 

The position of the sun controls the time of day 
in your scene. If the sun is above the horizon, it 
is day; if it is below, it is night, and if it is at the 
horizon, it is sunrise or sunset. 

The sun can be animated just like all the other 
elements of your Bryce scene. You can create 
time-elapsed effects by changing the position of 
the sun over the course of an animation. Refer 
to “Animating Sun or Moon Position” on 
page 395 for more on animating the Sun.

Positioning the Sun

The sun position control sets the direction your 
natural light is coming from whether it is 
sunlight or moonlight. The position can be set 
using the Sun control in the Sky & Fog palette. 
The control works like a trackball, with the sun 
at one end and the moon at the other.

You can think of the control as a compass: if the 
highlight on the Sun Control sphere is 

positioned at 12 o’clock, the light comes from 
the north, and so on.

The colors in your sky will change depending 
on the position of the Sun Control, or the “time 
of day...” just like in the real world.

The angle of the shadows changes as the sun 
changes. If your object is shiny, and there are 

The control works like a trackball. As you drag over the 
control both elements move in the direction you drag.

Moon

Sun

As you change the position of the sun, the “time of day” 
changes. When the sun position is closer to the edges of the 
control, the sun appears closer to the horizon, making the 
scene darker. 

When the sun is in the center of the control, the sun shines 
from directly above the sun, like it would at high noon.
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no other light sources, the position of the sun 
controls where the highlight appears. 

Day and Night

Your sky always contains two heavenly bodies: 
the sun and the moon. There is always one 
body visible in your sky. At night it is the moon 
and in the day its the sun. 

The two bodies are connected and always 
remain at opposite ends of the sky. As you move 
the sun you’re also moving the moon. This 
means that when the sun dips below the 
horizon in front of you, the moon is rising 
behind you. 

To switch between night and day:

1 Display the Sky & Fog palette.

2 Click the Day/Night toggle button in the 
top-left corner of the sun position controls.

Sunrise/Sunset

You can create a sunset or sunrise by 
positioning the sun or moon so that it is visible 
on your horizon. 

In this example, you can see the effects of the sun’s position 
on several reflective and shiny objects.

The link between the sun and the moon can be seen by 
positioning the sun at the horizon in front of the camera...

.if you turn the camera 180° you’ll see the moon just rising 
over the horizon as well.

Sunsets or sunrises can be created by moving the sun closer 
to the horizon.
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The colors in the sky automatically change to 
create the illusion of the sunrise or sunset 
colors. You can also use the Sky Dome color to 
give your sunset/sunrise added color.

For a more realistic sunset you may want to link 
the fog and haze to the sun so that they react to 
the sun color as it approaches the horizon. 
Refer to “Blending the Fog Color” on page 132 
and “Blending the Haze color with the Sun” on 
page 135 for more on this feature.

You may also want to enable the Horizon 
illusion for the sun. This feature makes the sun 
appear larger as it approaches the horizon. 
Refer to “Sun/Moon Horizon Illusion” on 
page 152 for more on this effect.

To position the sun manually:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Drag the larger highlight area in the Sun 
Position controls to the position where you 
want the light to originate.

You can position the sun, or the moon, on the 
horizon as you like by nudging the Sun Control 
until the light is visible in your scene.

To position the sun numerically:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
palette appears

3 Click the Sun & Moon tab.

4 In the Numeric Sun Values fields, type a 
value into the Azimuth field. The Azimuth 
field controls the east-to-west position of 

the sun. The range is 0 to +360, and the 
default value is in the range of 0 to 90. 

5 Enter a value in to the Altitude field. The Y 
field controls the height of the sun relative 
to your scene. The range is -99 to +99, and 
the default value is 20. 

 Positive values are above the horizon, negative 
values below. 

Linking the Sun to the Camera

Normally, you’d have to reposition the sun 
every time you changed the camera to maintain 
a certain effect or sunlight angle. However, if 
you apply the Link Sun to Camera, you’re sun 
will track the camera. The position of the sun 
relative to the camera remains the same no 
matter where the camera is positioned. This 
way you can set up the sun position once and 
then not worry about losing the effect as you 
move the camera. 

This feature can also be very useful when 
you’re animating your scene. Refer to 
“Animating” on page 353 for more.

When the sun is linked to the camera, the sun moves 
relative to the Camera. Wherever the camera moves the 
sun follows. As it moves, the sun maintains a constant 
distance from the camera.
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To link the sun to the camera:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog text button.

2 Click the Sky Lab button. The Sky Lab 
palette appears.

3 Click the Sun & Moon tab.

4 Click the Link Sun to View button.

When this option is enabled, your sun will 
always remain in the same position relative 
to the camera. Wherever you move the 
camera the sun will follow. This is an easy 
way of seeing how a sunset will look against 
different skylines.

Sun Color

Light in nature is not usually visible until it 
strikes an object. When you’re using normal 
light, a purple sunlight color will not paint your 
entire sky purple, but objects in your scene will 
reflect purple.

When you’re using Visible World, choosing pur-
ple will paint your entire scene purple.

The grayscale bar at the bottom of the color 
palette lets you set the intensity of the sun. 
Black turns the sun off and white sets the sun 
to its brightest intensity. 

To set the Sun Color:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog text button.

2 Click the Sun Color swatch and choose a 
color from the color picker.

Disabling the Sun

You can also remove the sun from the sky 
altogether, by disabling it. When the sun is 
disabled, the only light visible in your scene 
comes from individual light sources. (The scene 
will still be illuminated.)

To disable the Sun:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog text button.

2 Click the Sky Lab button. The Sky Lab 
palette appears

3 Click the Sun & Moon tab.

4 Click the Disable Sun Light button.

Working with the Moon
The moon is the most prominent object in the 
night sky. In a night scene it provides all the 
natural light in the environment. Like the sun, 
the moon’s attributes can greatly affect the final 
look of your scene. 

Its position in the sky effects all the angles and 
intensities of all the shadows in the scene. 

The brightness is affected by the illumination 
reflected off the earth. The brighter the 
earthshine, the brighter the moon appears.

Unlike the sun, the moon has phases which 
simulate the effects of the earth’s shadow 

You can also use the color palette to set the intensity of the 
sun. Black represents the lowest intensity and white the 
highest.
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passing over the face of the moon during a 
month. 

The moon’s position and phases can be 
animated using the Animation controls and the 
timeline. Refer to “Animating Sun or Moon 
Position” on page 395 for more on animating 
the moon.

Positioning the Moon

The moon is positioned at the same time as the 
Sun. The two are always at opposite ends of the 
sky, so wherever the sun is positioned, the 
moon is directly opposite. 

In the Sun/Moon control on the Sky & Fog 
palette, the moon’s position is represented by 
the smaller highlight portion of the Sun 
Position trackball.

To position the moon manually:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Drag the blue highlight area in the Sun/
Moon Position controls to the position 
where you want the light to originate.

You can position the sun, or the moon, on the 
horizon as you like by nudging the Sun/Moon 
control until the light is visible in your scene.

To position the moon numerically:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
palette appears

3 Click the Sun & Moon tab.

4 In the Numerical Sun Values fields, type a 
value into the Azimuth field. The Azimuth 
field controls the east-to-west position of 
the sun/moon. The range is 0 to +360, and 
the default value is 60. 

• The moon will be positioned exactly 
opposite these values, so you can invert 
them to position the moon numerically, 
or place the Sun behind the camera so 
that the moon appears in front of it.

5 Enter a value into the Altitude field. The 
Altitude field controls the height of the 
sun/moon relative to your scene. The range 
is -99 to +99, and the default value is 20.

Positive values are above the horizon, negative 
values below. 

The position of the moon is represented by the smaller 
highlight portion of the position control trackball. You can 
position the moon by either moving the smaller highlight 
or by dragging the sun. The moon is always opposite the 
sun.
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Moon Phases 

The moon phases control simulates different 
aspects of the moon as it orbits the earth. 

The moon phase is a visual clue to the time of 
the month. In an animation, you can use the 
moon phase to simulate the passage of a time. 
Refer to “Animating Sky & Fog settings” on 
page 393 for more. 

The phase is controlled using the Moon Phase 
controls in the Sky Lab palette. 

To set the moon’s phase:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Sun & Moon tab.

4 Drag over the Moon Phase control. The 
phase changes as you drag.

5 Click the OK icon to exit the dialog.

Moon Brightness and Sharpness

The moon is directly affected by the light 
reflected from the earth. The brighter the 
reflection, the brighter the moon’s shadow. In 
Bryce this effect is controlled by the Earthshine 
setting which makes the moon brighter or 
darker. 

A realistic moon does not have sharp edges and 
may appear blurry on hazy nights. The Softness 
control lets you set the moon’s edge softness to 
give a more realistic feel.

To set the brightness of the moon’s shadow:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Sun & Moon tab.

4 Drag the Earthshine slider. Drag left to 
increase the brightness and right to 
decrease it.

The change in the phases of the moon can indicate the 
passage of time.

The Moon Phase control lets you set the phases of the 
moon.

The Earthshine control lets you adjust the brightness of the 
moon.
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• Enter a value in the Earthshine field to 
set Earthshine numerically.

5 Click the OK icon to exit the dialog.

To set the moon’s edge softness:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Sun & Moon tab.

4 Drag over the Softness control. Drag left to 
soften edges, or right to sharpen them. 

• Enter a value in the Softness field to set 
Softness numerically.

5 Click the OK icon to exit the palette.

Adding Environmental 
Effects
The elements in a sky aren’t constant; it is 
always changing, reflecting weather patterns or 
the time of day. If it rains there’s a rainbow. If 
its night, there’s stars. If it’s sunset, the sun 
looks bigger. If you look right at the sun on a 
hazy day you’ll see rings around it. Sometimes, 
if its hazy enough you can even see the sunlight 
streaking out of the clouds. All these illusions 
are called environmental effects and Bryce’s 
Sky Lab palette contains all the controls you’ll 
need to the add them to your scene.

Sun/Moon Rings

If you look directly at the sun on a hazy day 
you’ll be able so see rings surrounding it. These 
rings are created by the reflection off ice 
particles in the air. In Bryce, you can use the 
Sun/Moon Rings to create this effect.

This effect creates concentric circles around 
the image of the sun or moon. Using the Sky 
Lab palette, you can set the radius of the rings 
and add a secondary ring to increase the effect. 
The color of the rings is controlled by the color 
of the sun/moon. 

To add Sun/Moon rings:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Sun & Moon tab.

4 Click the Halo Rings button.

The Softness control lets you set the edge softness of the 
moon.

In this example, rings have been added to the sun to make 
the scene look like a sweltering desert. 
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5 In the Rings area, enter a value in the 
Intensity field, or drag the slider, to set the 
brightness of the ring. 

6 Enter a value in the Radius field, or drag 
the slider, to set the radius of the ring. 

To add a secondary Sun/Moon ring:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
palette appears.

3 Click the Sun & Moon tab.

4 Click the Secondary Ring button in the 
Halo Rings area.

Sun/Moon Horizon Illusion

If you’ve ever watched a sunset, you probably 
noticed that the sun appeared to get larger as it 
approached the horizon. The same is true for 
the moon. At certain times of the month it 
appears huge. This illusion can be simulated 
using Sun/Moon size.

When the illusion is active, the sun or moon 
will appear to grow larger as it approaches the 
horizon. 

To change the size of the Sun or Moon as it 
approaches the horizon:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
palette appears.

3 Click the Sun & Moon tab.

4 Click the Sun/Moon size button at the top 
of the dialog.

5 In the Sun/Moon size area, enter a value in 
the Disk Size field, or drag the slider, to set 
the overall size of the sun/moon anywhere 
in the sky. 

The Intensity field next to the rings preview sets the 
brightness of the rings.

The Radius field next to the Rings preview sets the radius 
of the ring.

The spooky look of this night scene was created by 
applying a Horizon Illusion. 
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6 Enter a value in the Horizon Illusion field, 
or drag the slider, to set multiplier used to 
determine how much larger the sun or 
moon gets as it approaches the horizon.

Rainbows

In the real world rainbows appear after 
rainstorms as arcs of light displaying all the 
color in the spectrum. In Bryce a rainbow is an 
atmospheric effect that can be added to any sky. 

A rainbow is only visible if the sun is visible, 
meaning you can’t have a rainbow at night. As 
well, you can add a secondary rainbow to create 
the illusion of reflection. 

Rainbows are linked to the sun so that as the 
color or intensity of the sun changes, so does 
the rainbow. 

Rainbows are infinitely distant. You can’t 
approach them by moving the camera, so the 
pot of gold is always just out of reach.

To add a rainbow to your sky:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
dialog appears.

3 Click the Atmosphere tab.

4 Click the Rainbows button to activate the 
rainbow controls.

5 Drag the slider or enter a value in Radius 
field in the Rainbow area. This value sets 
the width of the rainbow.

6 Drag the slider or enter a value in the 
Opacity field. This controls the rainbow’s 
transparency.

To add a secondary rainbow to your sky:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
palette appears.

3 Click the Atmosphere tab.

4 Click the Secondary Rainbow button.

5 Enter a value in Intensity field in the 
Rainbow area. This value sets the width of 
the secondary rainbow.

The Intensity field next to the Rings preview sets the width 
of the illusion.

The Atmosphere tab of the Sky Lab dialog contains all the 
controls you’ll need to create rainbows.
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Star Fields

Stars in Bryce are randomly generated star 
maps. They are infinitely distant so they do not 
get closer as you move the camera. Star Fields 
are affected by the moon’s brightness and color.

You can also add comets to your Star Fields. 
Comets appear at random positions. You’ll 
usually only get one or two comets per starfield.

To add a Star Field:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
palette appears.

3 Click the Sun & Moon tab.

4 Click the Starfield button at the bottom of 
the palette.

To add comets to a Star Field:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
palette appears.

3 Click the Sun & Moon tab.

4 Click the Comets button at the bottom of 
the palette.

Volumetric World

The Volumetric World effect simulates the 
effects of particles in the air being illuminated 
by light sources. In Bryce this effect turns all 
the light sources in your scene into visible light 
sources. Sunlight also becomes visible, so that 
any color you applied to the sun appears 
everywhere in the scene.

Visible sunlight is volumetric, meaning that it is 
affected by all the objects within it. 

Although Volumetric World is a very beautiful 
effect, its also a time consuming one. It will add 
considerably to your scene’s rendering time. 

In this example you can see how the moon affects the color 
and intensity of the stars around it.

In this example you can see how the Volumetric World 
effect transforms a scene.

Normal Environment

Volumetric World
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To add visible sunlight to your scene:

1 Display the Sky & Fog palette by clicking 
the Sky & Fog button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab 
palette appears.

3 Click the Atmosphere tab.

4 Click the Volumetric World button.

5 Drag the slider or enter a value in the 
Quality field. This corresponds to the 
Rough or Fine button in the Visible Light 
area in earlier versions of Bryce. This 
option controls the quality of the light.

Using the Preset Skies 
Library
The Preset Skies Library contains all the preset 
skies available in Bryce. You can place them in 
your scene and edit them just as you would 
another object.

To add a sky from the Preset Skies library to 
your scene:

1 Click the triangle icon next to the 
Sky & Fog text button at the top of the 
Bryce window, or click the arrow next to 

the preview area in the Sky Lab dialog. The 
Preset Skies Library appears.

2 Click on the preset thumbnails to view 
preset names and descriptions.

3 Click the OK icon to add the selected sky 
to your scene.

The Sky & Fog palette does not need to be active 
for you to access the Preset Skies Library. 

You can select presets in one motion by dragging 
directly to the desired preset, and releasing the 
mouse button. You can also drag over the cate-
gory names to change categories, into the cate-
gory’s presets, and then release the mouse 
button.

Adding and Deleting Preset 
Skies

You can add the sky from any open scene to the 
Preset Skies Library. This is a good way of 
saving your favorite skies.

Use the Preset Skies Library to add pre-made skies to your 
scene.
155 Bryce 4



To add a sky to the preset library:

1 Click the triangle icon next to the 
Sky & Fog text button at the top of the 
Bryce environment. The sky from your 
scene appears in the preview area of The 
Preset Skies Library dialog.

2 Click the Add button at the bottom of the 
dialog. The Add Object dialog appears.

3 Enter a name for the new preset in the 
Preset Name field.

4 Enter a description of the preset in the 
Description field and click the OK icon.

This name and description will appear 
beneath the object preview whenever the 
preset is accessed. 

You can edit the name and description of any 
preset at any time simply by pressing the Tab key, 
or clicking on the name or description.

5 Click the OK icon. Your preset will be 
added to the first available space within the 
current category.

To delete an object preset:

1 Click the triangle icon next to the 
Sky & Fog text button at the top of the 
Bryce environment. The Preset Skies 
Library appears.

2 Click on the preset you want to delete, or 
hold down Shift and select a continuous 
series of presets, or hold down Command/

Ctrl and select a discontinuous set of 
presets.

3 Click the Delete button at the bottom of 
the Preset Skies Library dialog. 

Importing and Exporting Preset 
Skies

Importing and exporting presets is a handy way 
to exchange custom presets with other users. 

To import a preset sky file:

1 Click the triangle icon next to the 
Sky & Fog text button at the top of the 
Bryce environment. The Preset Skies 
Library appears.

2 Click the Import button at the bottom of 
the Preset Skies Library dialog. The file 
open dialog appears.

3 Locate the file which you would like to 
import and click Import.

The contents of the file are placed into the 
first available space in the current category.

To export a preset sky file:

1 Click the triangle icon next to the 
Sky & Fog text button at the top of the 
Bryce environment. The Preset Skies 
Library appears.

2 Select the preset or presets you wish to 
export.

3 Click the Export button at the bottom of 
the Preset Skies Library dialog. The save 
file dialog appears.

4 Enter a name and location for the file and 
click Save. 

The preview area displays the sky from your scene.
156 Creating Skies 



8  

Terrains

What is a Terrain?
Terrain objects define the landscape of your 
scene. They represent the land forms of any 
scene: mountains, deserts, islands or even 
floating cities. In Bryce, a terrain object is a 
height map, which determines the shape of 
your landscape. You can make subtle adjust-
ments to the map that can result in new moun-
tain ranges or river beds. 

Bryce creates a terrain’s shape by converting 
brightness values in grayscale images into a 
height map. White areas in the image result in 
the highest altitudes and black areas result in 
the lowest. The Terrain Editor lets you gener-
ate the grayscale images that are used to create 
terrain objects.

Creating terrains in the Terrain Editor is a 
two-step process. First, generate the source of 
your terrain image by using the preset effects, 
painting an image using the paintbrush or 
importing a picture. Then, filter the image. The 
editor’s Filtering tools let you fine-tune the 
grayscale values in your terrain.

You can also animate the creation of a terrain. 
Using the Animation controls available at the 



bottom of the editor, you can change the shape 
of your terrain object over time. You can ani-
mate the formation of mountains and valleys, or 
the gradual destruction of the landscape.

The Terrain Editor
The Terrain Editor can be used to generate the 
grayscale image that is converted into a terrain 
object. It can also be used to edit an existing 
terrain. 

You cannot access the Terrain Editor unless you 
have a terrain object in your scene. When the 
editor opens, it temporarily replaces the screen 
and displays the current terrain as a three 
dimensional preview. The height map that was 
used to create the terrain is displayed in the 
Terrain Canvas.

To add a terrain object to your scene:

1 Click the Create text button at the top of 
the Bryce environment. The Create palette 
appears.

2 Click the terrain object tool. A randomly 
generated terrain appears in your scene.

Once you have a terrain object you can custom-
ize it in the editor. 

To open the Terrain Editor:

1 Select the terrain object.

2 Click the E icon that appears next to the 
terrain object, 

or choose Objects menu>Edit Object, 

or click the Edit text button and then click 
the Edit Terrain tool,

or press Command-E/Ctrl+E.

Features of the Terrain Editor

The Terrain Editor is divided into four sections: 

• The Editing tools, which let you generate 
and edit the terrain’s height map 

• The Terrain Canvas, which displays the 
grayscale image used as a height map 

• The 3D Terrain Preview, which displays a 
three-dimensional preview of the terrain 
you’re working on

• The Animation controls, which let you set 
up key frames for animating the terrain

When you access the Terrain Editor, it temporarily takes 
over your screen.

Editing Tool panels

3D Terrain Preview

Terrain Canvas
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Editing Tools

Terrain tools are divided into three tabs that 
contain tools for generating terrain elevations, 
filtering terrains, and importing pictures to use 
as terrains:

• Elevation contains tools for generating 
terrains, and applying effects.

• Filtering contains tools for fine-tuning the 
gray levels in your terrain Canvas. 

• Pictures contains tools for importing a 
picture to use as a Terrain Canvas.

To access a tab:

• Click the tab label. The tab tools move to 
the front. By default, the Elevation tools 
are in front.

Setting Terrain Options

The 3D Terrain area has several options that 
control how the preview updates and displays.

To set 3D Terrain options:

• Click the triangle icon in the bottom left 
corner of the Terrain Canvas frame and 
choose an option from the menu:

Auto Rotate sets the 3D Preview to rotate 
perpetually. All changes update the 3D 
preview as it turns.

Realtime Linking connects all terrain 
editing to the 3D Terrain Preview. Every 
analog change you make is applied 
simultaneously to the Terrain Canvas and 
the 3D preview.

RIP To Screen displays a full-screen 
preview of your terrain. Clicking anywhere 
will return you to the main Terrain Editor. 
Use Command-W/Ctrl+W to toggle in and 
out of this mode.

Visible Brush lets you turn the circle of the 
brush on and off.

Turn Terrain Solid applies volumetric 
materials to the terrain. Even if you are not 
using volume materials, this selection 
causes the material to render as a solid.

Smooth allows a smooth rendering of the 
terrain. If this is not selected, the terrain is 
faceted. 

Keep Gradient makes the gradient the 
terrain’s diffuse color. 

Terrain Canvas

The Terrain Canvas displays the grayscale image 
that is used to create the terrain object. You can 
think of the Terrain Canvas as a top view of the 
terrain object you’re creating. 

The Terrain Canvas is where you paint the 
height map for your terrain. The image in the 
center of this area is the canvas. Around the 
canvas are the painting tools and zoom area 
controls.

The Terrain Editor tools are divided into three tabs.
159 Bryce 4



The main tools in this area are the grayscale 
paintbrush and the height picker. The paint-
brush lets you paint images using different 
shades of gray. The Height Picker lets you pick 
up gray levels from other parts of your image to 
set the gray level of the paintbrush.

The left side of the frame includes all the paint-
brush controls (Size, Hardness, Flow, and 
Level) as well as the Grid selector, which con-
trols the resolution of the grayscale data.

The right side contains a gradient strip and 
bracket for clipping operations and controls for 
color mapping.

The bottom part of the frame includes a Brush 
Mode selector and Zoom Area controls.

3D Terrain Preview

The 3D Terrain Preview in the lower left corner 
of your screen displays the resulting terrain 
object based on the image in the Terrain Can-

vas. As you edit the terrain image, the preview 
updates to show the result of your changes.

The preview of your terrain can be rotated so 
you can see your terrain object from different 
angles.

To rotate the terrain preview:

• Click and drag the preview object in the 
direction you want to rotate the terrain.

Animation Controls

The Animation controls at the bottom of the 
editor let you create key frames for your terrain. 
Any change you make to the geometry of the 
terrain can be stored in a key frame and ani-
mated.

The Terrain Canvas displays the grayscale image that is 
used to create your terrain.

Brush Mode Selector

Paintbrush Controls

Color Gra-
dient Strip

Clipping 
Bracket

Zoom Area Controls

The 3D Terrain Preview shows the terrain object that 
will be produced from the image in the Terrain Canvas.

The Animation controls let you create key frames for the 
terrain so you can animate the terrain editing process.

Current Time Indicator
Preview Controls

Key Frame Controls
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The Timeline that runs along the bottom of the 
editor displays the length of the animation. The 
Current Time Indicator within the timeline lets 
you set the current time of the animation. 

The buttons in the Animation controls let you 
preview the animation. The buttons beside the 
preview controls let you add and delete key 
frames from the Timeline.

Working in the Terrain Editor

Using Terrain Editor Tools

Most of the tools in the Terrain Editor are dis-
played as control dots. These dots let you apply 
an effect or operation to the terrain gradually or 
at 100%. 

To apply a tool to the Terrain Canvas:

1 Move the cursor over the tool you want to 
use.

2 Do one of the following:

• To apply an effect or operation entirely, 
click the control dot just once. 

• To apply an effect gradually, click and 
drag over the control dot. 

• Apply an effect by clicking a tool more 
than once. The effect is applied in 100% 
increments.

Starting a New Terrain

By default when you open the Terrain Editor, 
the terrain you selected in the Working window 
appears in the Terrain Canvas. If you want to 
begin with a new, flat Terrain Canvas, use the 
New button.

To create a new Terrain Canvas:

1 Make sure the Elevation tab is displayed. If 
it’s not, click the Elevation title. 

2 Click the New button.

or press Command-N/Ctrl+N.

A flat black image appears in the Terrain 
Canvas.

To gradually flatten your terrain:

• Click and drag to the right over the New 
button.

The existing Terrain Canvas gradually fades 
to black.

Many of the effects in the Elevation tab require 
grayscale values. If you apply these effects to a 
black map they may have no effect. Try to use 
this only when you’re setting up for brushing 
operations.

To reset your terrain:

• Hold down Control and click the New 
button. 

The Terrain Canvas is reset to the terrain 
that appeared when you first opened the 
editor.

Inverting Terrains

Since the Terrain Editor uses brightness to 
determine altitude, you can change mountains 
into canyons by inverting the black and white 
values in your image. 

To invert your terrain image:

1 Make sure the Elevation tab is displayed. If 
it’s not, click the Elevation title. 
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2 Click the Invert button, or press 
Command-I/Ctrl+I.

All the black areas of your image become 
white and white areas become black.

To gradually invert your terrain image:

• Click and drag to the right over the Invert 
button.

The black areas in the existing Terrain 
Canvas progressively turn white.

Undoing Operations

You can reverse any effect you apply to your 
image using the Undo button. You can toggle 
between Undo and Redo by clicking the Undo 
button repeatedly.

To undo operations in the Terrain Editor:

1 Make sure the Elevation tab is displayed. If 
it’s not click the Elevation title. 

2 Click the Undo button, or press 
Command-Z/Ctrl+Z

The last operation you applied is undone.

Eroding Terrains

Erosion simulates the effects of water erosion 
on your terrain objects. The calculations in this 
effect simulate droplets of water falling on your 
terrain, and then calculate where the droplets 
would trickle based on the shades of gray pro-
gressing towards black. This effect works best 
on maps that have large sloping areas.

The Erode button simulates the effects of ero-
sion over a short period of time, like decades. 

To simulate the effects of centuries of erosion, 
use the Eroded tool.

To erode terrains:

1 Make sure the Elevation tab is displayed. If 
it’s not, click the Elevation title. 

2 Click the Erode button. To gradually apply 
erosion, hold down the mouse button and 
drag while the pointer is over the Erode 
button.

Using the Zoom Area

When the Zoom Area is active, only a small 
portion of your terrain is displayed in the 3D 
Terrain Preview. The 3D Terrain Preview dis-

This is what a terrain looks like before you apply the 
Erode effect. Notice that this image map has sloping 
areas that will make the erode effect more visible.

This is the same terrain after the Erode effect is applied. 
You can see how the surface now contains tracks created 
by running water.
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plays the zoomed-in portion of your Terrain 
Canvas. You can use this feature to see small 
variations in the surface of your terrain. The 
Zoom Area can be moved to any point on your 
Terrain Canvas.

You can always paint while the Zoom Area is 
active; in fact this is a nice way to paint in the 
Terrain Canvas while previewing a small sec-
tion in 3D to observe details.

To turn the Zoom Area on:

• Click the On text button below the Zoom 
Area title at the bottom of the Terrain 
Canvas frame.

A marquee appears on your Terrain 
Canvas. 

To turn the Zoom Area off:

• Click the Off text button below the Zoom 
Area title at the bottom of the Terrain 
Canvas frame.

To move the Zoom area:

1 Move your pointer over an edge of the 
Zoom Area marquee. The pointer changes 
to a hand tool.

2 Drag the marquee to an area in the Terrain 
Canvas.

To resize the Zoom area:

1 Move the pointer over a corner of the 
Zoom Area marquee.

2 Drag away from the center of the marquee 
to enlarge the Zoom Area, or towards the 
center to shrink the area.

To scale the zoom area to fill the Terrain 
Canvas:

• Click the Crop text button below the Zoom 
Area title at the bottom of the Terrain 
Canvas frame.

The contents of your Zoom Area are scaled 
to fill the entire Terrain Canvas area. The 
Zoom Area contents replace the existing 
contents of the Terrain Canvas. 

This feature can be useful for creating new ter-
rains from larger high-resolution terrains.

To fit the contents of the Terrain Canvas into 
the Zoom Area:

• Click the Fit text button below the Zoom 
Area title at the bottom of the Terrain 
Canvas frame.

The entire contents of your Terrain Canvas are 
scaled down to fit into the Zoom Area marquee. 
The rest of the Terrain Canvas will be filled 
with black.

Setting Terrain Resolution

The terrain’s resolution determines the amount 
of detail in your terrain. The higher the resolu-
tion, the more detail appears in your terrain’s 
surface. However, higher resolution values also 
increase the rendering time for your scene and 
require more memory.

Use the Zoom Area to see a close up of an area in your 
Terrain Canvas in 3D.
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The default resolution is 128. The highest reso-
lutions should be reserved for terrains that are 
very close to your camera and for any other case 
where detail is important. For items that are far 
away, or where detail is not so important, lower 
resolutions are more appropriate. 

Brush sizes may appear to vary depending on 
your resolution, but in fact they remain propor-
tional to the size of the Terrain Canvas. The Ter-
rain Canvas is always displayed at 256x256. So, 
if you change the resolution to 1024x1024, the 
Terrain Canvas will still appear in that 256x256 
window and, in order to remain proportional, 
brushes will appear smaller. 

To set the Terrain resolution:

• Click the Grid icon on the left side of the 
Terrain Canvas frame and choose a 
resolution from the menu.

The resolutions available are:

• 16 very coarse

• 32 coarse

• 64 simple

• 128 normal

• 256 fine

• 512 ultra fine

• 1024 massive resolution

Creating Terrains
You can create terrains in several ways. You can 
let the editor do all the work of generating a 
terrain based on a series of algorithms, you can 
use the editor’s painting tools to create a cus-
tom image, or you can import an image into the 
editor. 

When you generate a terrain, you use the Ter-
rain Editor’s Elevation tools, which include 

erosion effects as well as dozens of other effects 
optimized for the purpose of heightening real-
ism in Bryce terrains. 

When you paint a terrain you use the editor’s 
grayscale paintbrush to paint a topographical 
image. The image is then converted to a terrain 
object.

You can also create a terrain by importing a pic-
ture into the editor. The picture is converted to 
grayscale which is then used to generate alti-
tude values.

Creating Landscapes

When you’re planning the shape of your terrain 
you should keep in mind the kind of landscape 
you want to create. You don’t have to create all 
the land in your scene as a single terrain. More 
complex landscapes can be created by combin-
ing several terrain objects. 

Before creating terrain objects, plan out the 
entire map of your landscape. Then you’ll be 
able to see where different terrain objects 
might be combined to create a single land mass. 

Before you start creating terrains you should map out 
all the land masses in your environment...
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If you have more terrains in your scene, you’ll 
have a bigger scale for the environment. This 
gives you more resolution and better atmo-
sphere effects.

Pay attention to where the camera is positioned 
in the scene. Terrains that are closer to the cam-
era need to be more detailed than those off in 
the distance.

Animation and Terrain Editing

You can record the process of creating a terrain 
into an animation using the Animation con-
trols. Refer to “Animating” on page 353 for 
more on animating. Some of the Elevation tools 
can produce some unpredictable results when 
they’re animated, so you may want to experi-
ment with animating elevations before you cre-
ate your final terrain.

Elevation Tools

The Elevation tools are preset effects that apply 
different calculations to your Terrain Canvas. 
The tools are divided into three categories on 
the tab: Source Generator, Basic Tools and Spe-
cial Effects.

Source Generators create basic terrain sur-
faces. The Basic Tools edit the overall shape of 
your terrain, and Special Effects add realism to 
your terrain’s surface.

You can create a terrain by combining effects. 
For example, you can start off creating a basic 
terrain using the Fractal tool, then create realis-
tic ridges by applying the Erode tool. From 
there you can fine-tune your terrain by apply-
ing Spikes, creating Mounds or adding Cross 
Ridges. Finally, you can define the basic shape 
of your terrain by blurring the edges. 

Using Elevation Tools

Along the bottom left corner of the Elevation 
tab are an orange and green curve of dots. The 
orange curve contains tools for changing a ter-
rain’s geometry, like adding mounds or spikes. 
The orange curve contains tools that apply fil-
tering effects to an existing terrain, like poster-
izing or equalizing. 

To switch between sets of elevation tools:

1 Click the curves in the bottom left corner 
of the panel. The button works like a 
toggle. 

2 Click again to return to the first set. 

Including both sets of buttons, there are a total 
of 30 elevation tools.

...then you’ll be able to see where you will need to 
combine more than one terrain to create a specific type 
of landscape.

These two curves represent different sets of elevation 
tools. Click the curves to toggle between the two sets.
165 Bryce 4



To use an elevation tool:

1 Make sure the Elevation tab is displayed. If 
it’s not, click the Elevation title. 

2 Click an effect tool. 100% of the effect is 
applied to the Terrain Canvas.

3 Click the tool again to increase the 
intensity of the effect.

Most elevation effects can also be applied grad-
ually. 

To apply an elevation effect gradually:

1 Move the pointer over an Elevation tool. 
The pointer changes to a two-headed 
arrow.

2 Click and drag to the left to increase the 
effect or click and drag to the right to 
decrease it.

Source Generators

The Source Generator tools can be used in two 
ways: to generate a terrain from scratch, or to 
alter the geometry of an existing terrain. 

Fractal

The Fractal tool creates terrains based on frac-
tal patterns. It can be applied to an existing 
image and it can be applied gradually.

To create an even more detailed and realistic 
terrain, set your resolution to greater than 512, 
then hold Control/Ctrl as you click the Fractal 
button. 

Eroded

This tool applies natural erosion to your ter-
rain. It can also be applied to a blank image to 
create an eroded terrain, or to an existing 
image. You can also gradually apply erosion to 
an image. Eroded produces extremely realistic 
terrains.

This tool produces terrains based on fractal patterns. 
The terrains it creates have lots of spikes and valleys. 
This tool produces good basic terrains.
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Notice that when animating this type of terrain, 
material is actually added to the terrain, not 
removed from it as you might expect.

The Eroded tool is a more intense version of 
the Erode tool. 

Picture

This tool creates terrains from imported 
images. When you click this tool, the Open dia-
log appears. You can use this dialog to locate 
and load a picture to use as a Terrain Canvas. 
Refer to “Working with Pictures” on page 108 
for more information.

Using this tool you can import an image map 
created in another application like Painter or 
Photoshop. 

Basic Tools

The Basic Tools are used to alter an existing 
Terrain Canvas only. They have no effect on a 
blank canvas.

Raise/Lower

This tool adjusts the brightness of your Terrain 
Canvas. Click and drag to the right to lower 
your height map or click and drag to the left to 
raise it. Single clicks gradually lower the map.

Sharpening

This tool sharpens the gray values in your Ter-
rain Canvas. Click and drag left to increase 
sharpening and right to decrease it. 

This tool produces terrains based on eroded land. The 
terrains produced by this tool have deep grooves and 
canyons.

This tool produces terrains based on a picture. This tool 
is how you import image maps created in other graphics 
applications.

This tool adjusts the brightness of your Terrain Canvas, 
which raises or lowers the height of the entire terrain.

This tool sharpens the Terrain Canvas gray values. You 
can use smoothing to create spikes or ridges.
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Smoothing

This tool blurs the Terrain Canvas. Click and 
drag right to decrease the blurring effect or left 
to increase it. 

Smoothing is especially effective prior to using 
the Erode button, since the Erode algorithm 
works best when there are shades of gray in an 
image. If your canvas has too many sharp black 
to white transitions, the Erode may not be as 
effective.

Gaussian Edges

This tool does not blur your map. It creates a 
“Gaussian curve” from dark to light, starting 
from the edges of your Terrain Canvas. This cre-
ates edges that gradually transition from dark to 
light, or start at the lowest possible altitude, 
and gradually progress into higher altitudes. 

Gaussian Edges eliminates the seams between 
ground and terrain objects, when the ground 
plane and the terrain have the same surface 
material. You should apply this tool to any ter-
rain that is going to be sitting on a ground 
plane in your scene. 

Square Edges

This tool creates an abrupt drop at the edges of 
your terrain. Use this tool when you have a ter-
rain whose edges are not level, and you do not 
wish to use the Gaussian Edges tool for soft 
transitions.

This tool blurs your Terrain Canvas creating smoother 
black to white transitions.

This tool creates gradually ascending edges on your 
terrain which can create a smooth transition from the 
ground plane of your scene to the terrain.
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You can add a slope to the square edges of your 
terrain by applying this tool gradually. Click 
and drag left to increase the slope and right to 
decrease it. 

Round Edges

This tool creates an abrupt circular drop at the 
edges of your terrain.

You can add a slope to the round edges of your 
terrain by applying this tool gradually. Click 
and drag left to increase the slope and right to 
decrease it.

Basic Noise

This tool adds roughness to your terrain’s sur-
face by adding noise to the Terrain Canvas. 
Click and drag left to increase the noise and 
right to decrease it.

Slope Noise

This tool adds roughness to any sloping sur-
faces in your terrain. Slope Noise adds noise to 
all the sloping areas of your terrain. Click and 
drag left to increase the noise and right to 
decrease it.

Slope Noise has no effect on flat surfaces. More 
noise is added to steep slopes.

This tool creates an abrupt drop at the edges of your 
terrain. Use Square Edges to level the edges of a terrain.

This tool creates an abrupt circular drop at the edges of 
your terrain. Use Round Edges to create a circular base 
for your terrains.

This tool adds roughness to your terrain’s surface. Use 
Basic Noise to create rocky mountains.

This tool adds roughness to the sloping surfaces of your 
terrain.
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Height Noise

This tool adds small amounts of noise at lower 
altitudes and more noise at higher altitudes. 
Click and drag left to increase the noise and 
right to decrease it.

Image Filtering Effects

These tools, located on the orange curve, apply 
filters to your terrain that act like image filters. 
They can change the look of the terrain without 
altering its basic shape.

Spikes

This tool adds spiky structures to your map. 
When you apply the right material to these 
structures they can look remarkably like trees if 
they’re viewed from a distance

.

Mounds

This tool adds midsized splotches to your can-
vas. You can use this tool to create the appear-
ance of stones or boulders under transparent 
water planes.

Dampen

This tool works like a contrast control. It will 
push gray values towards either black or white 
depending on where the gray value falls in the 

This tool adds a little roughness to your terrain’s surface 
at lower altitudes and more at higher altitudes.

This tool adds spikes to your terrain’s surface. Use Spikes 
when you want to add trees to your terrain.

This tool adds splotches to your Terrain Canvas that 
look like boulders on flat surfaces or towers on sloped 
surfaces.
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black/white range. Less than 50% goes to black, 
greater than 50% goes to white. 

Equalize

This tool acts like the Equalize function you 
may have seen in 2D image editing applica-
tions. It redistributes gray values in your Ter-
rain Canvas such that a full range from black to 
white is present in your canvas. 

Posterize

This tool stratifies the gray levels in your Ter-
rain Canvas, resulting in stair-stepped terrain 
structures. This is a good tool for creating 
desert plateaus.

Mosaic

This tool is not a button on the Elevation tab. 
To use this tool, hold down Opt/Alt as you drag 
over the Posterize button. 

Mosaic creates highly pixelated square struc-
tures based on the gray content of your canvas. 

This tool is excellent for instant cityscapes. Try 
adding one of the sci-fi city materials from the 
Preset Materials Library to a Mosaic terrain.

This tool controls the contrast of your Terrain Canvas. 
Use Dampen to create abrupt drops and valleys.

This tool equalizes black and white values in your 
Terrain Canvas. Use Equalize to eliminate sharp ridges 
or deep valleys.

Use Posterize to create stair-stepped desert plateaus or 
paddy fields on the side of a mountain.

This tool pixelizes your Terrain Canvas. Use Mosaic to 
create cityscapes.
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Sawtooth

This tool modifies your Terrain Canvas based 
on a sawtooth waveform structure. The results 
look like schizoid desert canyons and icebergs.

Subcontours

This tool works like a contrast control with the 
threshold set almost at white. Most values are 
pushed to black while only the very lightest are 
pushed to white.

Subcontours produces spiky peaks with very 
low, gently sloping contours.

Geometry Effects

This green set of Elevation tools add to the 
geometry of your terrain, which can alter its 
basic shape. You can also use most of these 
tools to create terrains from scratch.

Blob Maker

This tool creates a smooth, circular structure 
within your existing Terrain Canvas. Click and 
drag left or right to change the size of the struc-
ture. Click and drag up and down to set the ver-
tical location of the structure. 

Relief Noise

This tool acts like an emboss effect. It will 
emboss the grayscale data in your canvas and 
convert it to height information.

This tool creates schizoid desert canyons or icebergs.

This tool produces spiky peaks with sloping contours.

This tool creates circular structures within your Terrain 
Canvas.

This tool embosses the grayscale data in your Terrain 
Canvas.
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Raise Edges

This tool acts like an inverted version of the 
Square Edges tool. It creates abrupt increases 
in altitude at the edges of your terrain.

Subplateaus

This tool smears your grayscale data in one 
direction while averaging the gray values. The 
result is natural structures not unlike those cre-
ated by the Mounds effect, except that these 
structures are more directly related to your 
original gray data. 

Because it creates boulder-like structures, this 
tool is good for making tidepools.

Cross Ridges

This tool creates sharp ridges in a cross pattern. 
It creates very interesting canal-like structures.

Cross Ridges 2

This tool is the inverse of the Cross Ridges tool. 
Instead of creating canals, it creates peaks.

This tool creates abrupt increases in altitude at the edges 
of your terrain.

This tool creates boulder-like structures within your 
Terrain Canvas.

This tool creates canal-like structures within your 
Terrain Canvas.

This tool creates peak-like structures within your 
Terrain Canvas.
173 Bryce 4



Bubble Ridges

Similar to the Blob Maker, the spherical struc-
ture this tool creates is of a consistent size. 
Dragging this button allows you to place the 
structure anywhere you like in your canvas.

Painting Terrains
Although you can create some very spectacular 
terrains using just the elevation tools, there are 
times when you want to create a precise Terrain 
Canvas. The Terrain Editor’s paintbrush lets 
you paint any type of terrain you wish. Using 
the Paintbrush, you can re-create real-world 
topographical maps or design landscapes with 
specific contours.

Setting Up the Paintbrush

Before painting with the Paintbrush, you 
should set up some of its parameters. Using the 
brush settings you can control the size, hard-
ness, strength and color of your brush.

To set brush attributes:

1 In the Terrain Canvas frame, drag over the 
Size control. 

Drag away from the center to increase the 
size of the brush and towards the center to 
decrease it.

2 Drag over the Hard control.

Drag towards the center of the control to 
make brush edges harder or away from the 
center to make brush edges softer.

3 Drag the pointer over the Flow control.

Drag to the right to increase the flow or to 
the left to decrease it.

Brush Flow determines the strength of the 
paintbrush. The higher the flow setting, the 
more color is applied.

4 Drag over the Level control.

Drag down to apply a darker gray, or up to 
apply a lighter gray.

Since you’re painting altitudes, lighter 
grays result in higher points and ridges 
while darker grays create lower points and 
valleys.

This tool creates a spherical structure within your 
terrain that can be placed at any point in your canvas.

Use the Paintbrush settings to control the attributes of 
your brush.

Brush Size

Brush Hardness

Brush Flow

Gray Level Control

Brush Behavior Options
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The default level is 100% gray. However, it 
effectively paints at 50% because of the 
other default settings.

While you’re painting, you may want to re-cre-
ate a specific altitude in different parts of the 
terrain. If you’ve changed the brush settings, 
re-creating a specific altitude can be quite diffi-
cult. However, using the Height Picker tool you 
can quite easily re-create altitudes by picking 
up gray levels from different parts of your 
image and applying them to the brush. 

To pick up gray levels from the terrain 
image:

1 While holding down the spacebar, move 
the cursor over the Terrain Canvas and 
click the desired altitude color. The color is 
applied to the brush.

2 Drag the brush over a different area of the 
canvas. The altitude color you picked up is 
applied to the new area. 

Brush Behaviors

The paintbrush in the Terrain Editor paints ele-
vations by default, but this is not the only way 
of painting using the brush. You can also set the 
brush to paint effects. This lets you apply eleva-
tion effects locally, or to increase/decrease 
existing gray levels in your Terrain Canvas.

To paint elevations:

1 Make sure the Elevation tab is visible. If it’s 
not, click the Elevation title.

2 Click the triangle icon to the right of the 
Brush Behaviors heading and choose Paint 
Elevation from the menu.

The brush paints in shades of gray that are 
then used to generate altitudes. This is the 
default brush behavior.

To apply an effect locally:

1 Make sure the Elevation tab is visible. If it’s 
not, click the Elevation title.

2 Click the triangle icon next to the Brush 
Behavior heading and choose Paint Effect 
from the menu.

3 Hold down the Spacebar and click the 
Elevation effect you want to paint.

4 Drag the paintbrush over an area of your 
canvas. 

To remove an effect locally:

1 Click the triangle icon next to the Brush 
Behavior heading and choose Unpaint 
Effect from the menu.

2 Drag the paintbrush over an area of your 
canvas where you applied an effect locally. 

The Unpaint Effect brush only affects 
areas where you applied an effect with the 
paintbrush. 

An effective way of using this brush is to 
paint an effect in broad, easy strokes, and 
then selectively unpaint areas of effect 
away.

To erode areas of your terrain:

1 Click the triangle icon next to the Brush 
Behaviors heading and choose Erode from 
the menu.

2 Drag the paintbrush over the area you 
want to erode. 

The paintbrush applies the erosion effect 
to the area painted over.
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To lighten gray levels:

1 Click the triangle icon next to the Brush 
Behavior heading and choose Maximum 
from the menu.

2 Drag the paintbrush over an area you want 
to lighten. 

In this mode, gray levels in your canvas 
that are below the current gray level are 
lightened to match the current level. Values 
above the current Level setting are 
untouched.

To darken gray levels:

1 Click the triangle icon next to the Brush 
Behavior heading and choose Minimum 
from the menu.

2 Drag the paintbrush over an area you want 
to darken. 

In this mode, gray levels in your canvas 
that are above the current gray level are 
darkened to match the current level. Values 
below the current Level setting are 
untouched.

Modifying Brush Behavior

The Option/Alt key can modify the behavior of 
the paintbrush on-the-fly.

• In Elevation mode, Option/Alt inverts the 
gray level. For example, if you’re painting 
white, holding down Option/Alt will paint 
black.

• In Paint Effect mode, the Option/Alt key 
will toggle to Unpaint Effect mode. 

Hold down Shift to constrain the pen movements 
in 45 degree steps.

Filtering Terrains
Filtering is the process of adjusting the gray-
scale curve of your Terrain Canvas. By adjusting 
the grayscale curve, you create a custom eleva-
tion effect. 

How Filtering Works

The Filter area is essentially a graph that repre-
sents gray level input from black to white hori-
zontally, and gray level output from black to 
white vertically. 

The default diagonal filter creates a graph 
where all values input as black are also output 
as black, and all values input as white are also 
output as white. That is why your Terrain Can-
vas appears unchanged—none of its gray level 
values have been altered.

By dragging in this Filter area, you can remap 
the gray values in your Terrain Canvas.

The Filtering graph expresses all the input and output 
gray values in your Terrain Canvas.

Darkest Gray Value 
Input

Lightest Gray 
Value Input

Darkest 
Gray 
Value 
Output

Lightest 
Gray 
Value 
Output
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To see how filtering works:

1 Place your cursor (which changes to a Pen 
within the Filtering area) in the top left 
corner of the Filter Area.

2 Drag diagonally to the bottom right corner. 

As you can see in the Preview area, your Terrain 
Canvas is inverted. 

The original graph stated that all values input 
as black were output as black and all the values 
input as white were output as white.

The new graph you created now states that all 
values input as black are output as white and all 
the values input as white are now output as 
black. In other words all the dark values are 
light and all the light values are dark.

This is a drastic example. In most cases you 
would adjust more specifically, like lightening 
the midtone grays or darkening specific gray 
values. Remember that this graph represents 
your Terrain Canvas, so you’re changing the 
shape of your terrain object as you adjust gray 
values.

The Filtering Tab

The Filtering tab is divided into three areas: the 
Filtering graph, the graph preview and the fil-
tering presets.

In the original Filtering graph all values input as black 
are output as black and all values input as white are 
output as white.

In this area, the darkest 
(black) gray levels are 
output as black.

In the new Filtering graph all values input at 0 are 
output at 255 and all values input at 255 are output at 
0.

At this point, the dark-
est (black) gray levels 
are output as white.
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The Filtering graph displays your Terrain Can-
vas’s gray levels as value inputs and outputs. 
You can edit this graph to adjust the gray level 
values in your canvas.

Next to the graph is the Preview area. This area 
shows you what your Terrain Canvas would 
look like if applied to the current Filtering 
graph.This area automatically updates as you 
make changes to the graph.

Along the top of the tab are the nine Filtering 
presets you can apply to the graph. Each preset 
represents a different predefined graph. They 
are designed to create specific changes in gray 
levels, like smooth gradients and abrupt transi-
tions.

Working in the Filtering Tab

Altering the Filtering Graph

The best way to start adjusting the Filtering 
graph is to determine the type of effect you 
want to create. For example, if your canvas is 
too dark, raise the value of the darker gray value 

inputs by drawing a ridge in the left side of the 
graph.

To alter the Filtering graph:

1 Make sure the Filtering tab is visible. If it’s 
not, click the Filtering title or press the Tab 
key until it is displayed.

2 Drag your pointer over the area of the 
Filtering graph you want to adjust.

When you drag over a black area, the 
pencil draws in gray; dragging over a gray 
area draws in black.

Use the Filtering tab to edit the Filtering graph and 
apply filtering presets.

Preview AreaFiltering Graph

Filtering Presets

Drawing a ridge on the left side of the graph....

....raises the value of the darkest grays in your Terrain 
Canvas.

Before

After
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Tracing over any lines you’ve drawn erases 
them.

To undo all changes to the Filtering graph:

1 Make sure the Filtering tab is visible. If it’s 
not, click the Filtering title or press the Tab 
key until it is displayed.

2 Click the Reset text button below the 
Filtering graph.

The graph returns to the default Filtering 
graph.

To soften harsh transitions in the graph:

1 Make sure the Filtering tab is visible. If it’s 
not, click the Filtering title or press the Tab 
key until it is displayed.

2 Click the Soften text button below the 
Filtering graph.

3 Click the Soften button again to soften the 
transitions more.

Applying Presets

Filtering presets are provided to help you get 
started adjusting the Filtering graph. These 
presets are designed to provide different 
effects. The best way of using these presets is to 
apply them to your graph and see what hap-
pens.

To apply presets:

1 Make sure the Filtering tab is visible. If it’s 
not, click the Filtering title or press the Tab 
key until it is displayed.

2 Click one of the preset buttons along the 
top of the tab. The current graph is 
replaced with the preset graph.

Applying Filtering Changes to Your 
Terrain Canvas

Although any changes you make to the graph 
are applied to the Preview area, they do not 
automatically affect your Terrain Canvas. You 
have to Apply the changes before they affect the 
canvas. 

You can temporarily apply your changes to the 
3D Preview in real-time by holding down Con-
trol/Ctrl as you click and drag over the Filtering 
graph.

To apply the Filtering graph to the 3D 
Preview:

• Hold down the mouse button over the 
filter graph preview. The 3D preview 
updates. 

When you release the mouse the 3D 
Preview switches back to the unfiltered 
terrain.

To apply filtering changes to the Terrain 
Canvas:

• Click the Apply text button beneath the 
Preview area.

Blending the Filtering Graph With 
the Terrain Canvas

The Filtering Tab offers several ways of apply-
ing your Filtering graph to the Terrain Canvas. 
You can apply the graph directly or you can 
blend the graph with the canvas.

When you use a blending option you’re essen-
tially drawing a grayscale gradient and then 
blending it with your original canvas. 
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To blend the Filtering graph with the Terrain 
Canvas:

1 Adjust the Filtering graph to achieve the 
desired effect.

2 Click the triangle icon below the Filtering 
graph and choose an option from the 
menu: 

Horizontal horizontally blends your 
Filtering graph, expressed as a grayscale 
gradient, with your Terrain Canvas.

Vertical vertically blends your Filtering 
graph, expressed as a grayscale gradient, 
with your Terrain Canvas.

Horizontal Add horizontally blends your 
Filtering graph, expressed as a grayscale 
gradient, with your Terrain Canvas. 

This option uses a slightly different 
algorithm than the previous Horizontal 
option: it’s not a traditional Additive, but 
an average of the existing terrain grayscale 
values with the maximum of the Terrain 
and Filter values.

Vertical Add vertically blends your 
Filtering graph, expressed as a grayscale 
gradient, with your Terrain Canvas.

This option uses a slightly different 
algorithm than the previous Vertical option: 
it’s not a traditional Additive, but an 
average of the existing terrain grayscale 
values with the maximum of the Terrain 
and Filter values.

3 Click Apply.

Using Creation Models
Bryce provides a selection of terrain models 
from which you can choose. When you select a 
terrain from the list of models, you get a ran-
domized version of the model you select.

To access a terrain model:

1 From the Terrain Editor, select the Pictures 
tab.

2 Click and hold on Load Image.

3 Select a model from the menu that 
appears.

The last model you selected will always be 
the default model.

This terrain was altered by directly applying a filtering 
effect.

This terrain was altered by blending a filtering effect 
with the original canvas.
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Creating Terrains Using 
Pictures
The Terrain Editor converts grayscale values in 
the Terrain Canvas into altitudes to create ter-
rain objects. You can take advantage of this pro-
cess to create unique terrains based on the 
grayscale values in a picture.

The Terrain Editor’s Picture tab lets you import 
a picture into the Terrain Canvas. You can then 
apply elevation effects or filter it just as you 
would any other Terrain Canvas.

The Pictures Tab

The Picture Tab is made of three picture 
squares and a blend control. The first two pic-
ture squares let you load a picture to use a ter-
rain and the third square shows you the result 
of combining the two pictures. The blend con-
trol lets you specify how the pictures are com-
bined. 

Working in the Pictures Tab

Loading Pictures

You can load any two pictures from anywhere 
on your system. You can also copy and paste 
images from the Clipboard.

To load pictures:

• Click the Load text button above the 
picture box into which you want to load 
the picture.

From the Picture button in the Elevation tab, 
hold down Option/Alt key to load the picture’s 
color data directly into the 3D Terrain preview. 
This allows you to see the interaction between the 
picture and the grayscale to height interpreta-
tion of its luminance values. The color data is 
only for viewing purposes and will not render 
with the terrain.

To copy and paste a picture into the Picture 
tab:

1 In another application, copy the picture 
you want to use to the Clipboard.

2 In the Picture tab, click the Paste text 
button below the picture box where you 
want the picture to appear.

When you use Command+V/Ctrl+V to paste 
from the Clipboard, the picture always appears 
in the first square. 

Blending Pictures

Once you have a picture in each of the first two 
squares, you blend them to create a third image 
that is used to create the new Terrain Canvas.

Use the Picture tab to load and blend pictures to create 
unique terrains.
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To blend pictures:

1 Load pictures into the first two squares.

If you load only one picture a white square 
is used as the second blend image.

2 Click the triangle icon under the third 
picture box and choose a Blend mode from 
the menu:

Blend compares each corresponding pixel 
from the first two squares, and displays an 
average of the two in the corresponding 
location of the third square.

Minimum compares each corresponding 
pixel from the first two squares, and 
displays the darker of the two in the 
corresponding location of the third square.

Subtract compares each corresponding 
pixel from the first two squares, subtracts 
the brightness value of one from the 
brightness value of the other, and displays 
the result in the corresponding location of 
the third square.

Add compares each corresponding pixel 
from the first two squares, adds the 
brightness value of one to the brightness 
value of the other, and displays the result in 
the corresponding location of the third 
square.

3 Drag the pointer over the Blend control.

Click and drag to the left to use more of 
the first image in the blend. Click and drag 
to the right to use more of the second 
image.

Applying Changes to the Terrain 
Canvas

Although the results of blending pictures 
appears in the third picture box, it is not auto-
matically applied to your Terrain Canvas. 

To apply a picture to the Terrain Canvas:

• Click the Apply text button beneath the 
third picture square.

Adding Color to Terrains
Color in the Terrain Editor is used as a visual 
aid to help you see the relationship between 
color values and altitude. This color only exists 
in the Terrain Editor and is not applied to the 
terrain object.

When you apply color in the editor, it maps a 
gradient to the altitudes in your Terrain Canvas. 
For example, if you apply a gradient from blue 
to yellow, blue might represent the lowest alti-
tude while yellow may represent the highest. 
Which colors are mapped to which altitudes is 
left completely up to you.

You can apply a color gradient to your Terrain Canvas 
to help you visualize the relationship between color 
values and altitude.
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Gradients can be extremely useful when you’re 
filtering terrains, as they make the differences 
between gray levels more visible. 

Mapping Color to Your Terrain 
Canvas

The Terrain Editor’s color picker contains all 
the gradient you can apply to your terrain. The 
gradient you select is applied to both the Ter-
rain Canvas and the 3D Terrain Preview.

To map colors to your Terrain Canvas:

1 Click the Color Picker button in the 
bottom right corner of the Terrain Canvas 
Frame and drag over a gradient in the 
palette.

The gradient you selected appears in the 
Gradient bar and is mapped to the Terrain 
Canvas and the 3D Terrain Preview.

2 Drag the gradient up or down to map the 
colors to altitudes. 

The colors at the bottom of the gradient 
represent the lowest altitude and those at 
the top represent the highest.

The Gradient Bar has two modifiers: 

• Opt/Alt resets the Gradient Bar.

• Command-F/Ctrl+F flips the colors in 
the gradient.

To return to grayscale:

• Click the /Grayscale to switch back to the 
default gray gradient.

Although gradients are meant to be used only 
in the Terrain Editor, you can apply the gradi-
ent to the Terrain’s Diffuse channel. The gradi-
ent then becomes the terrain’s Diffuse color. 
This allows you to render the gradient with the 
terrain.

To remove a gradient from a terrain’s Diffuse 
channel:

1 Open the terrain in the Terrain Editor.

2 Click the Color/Grayscale toggle.

You can apply a color gradient to your Terrain Canvas it 
also appears in the Filtering tab. This makes it easier to 
see the differences in gray levels.

Use the Color Picker button to choose a color gradient 
and the gradient bar to set color mapping.

Gradient Bar

Color Picker

Color/Grayscale 
Toggle
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Clipping Terrains
Using the Terrain Editor’s clipping controls, 
you determine which values in your terrain are 
rendered as the final terrain object. The Clip-
ping controls next to the Gradient bar repre-
sent the render range for the terrain. Anything 
outside the range included in the brackets will 
not be rendered. 

You can use these controls to eliminate any 
unwanted information from the terrain without 
altering its basic shape. For example, you can 
keep the main terrain while eliminating the 
black square on which it sits.

The clipping feature is particularly useful when 
editing a Symmetrical Lattice. The maximum 
lower range of the Clipping Bracket determines 
where the two halves of the Symmetrical Lat-
tices are joined.

To set the clipping range:

1 Drag the top of the Clipping Bracket to set 
the maximum upper range. 

Any areas in the Terrain Canvas whose gray 
levels fall outside the bracket’s maximum 

upper range will appear colored to indicate 
they will be omitted from rendering.

2 Drag the bottom of the Clipping Bracket to 
set the maximum lower range. 

Any areas in the Terrain Canvas whose gray 
levels fall outside the bracket’s maximum 
lower range will also appear colored to 
indicate they will be omitted from 
rendering.

The out-of-range colors for upper and lower 
limits are different, to better enable you to dis-
tinguish upper and lower clipped areas at a 
glance. Upper out-of-range color is usually 
blue, and lower out-of-range is usually red, 
though the colors change for many of the color 
maps.

To reset the Clipping Bracket:

• Hold down Option/Alt and click the 
bracket.

To move the entire Clipping Bracket at once:

• Click the center of the Clipping Bracket 
and drag up or down.

Terrain objects are actually hollow, so if you 
clip the upper range off your terrain, you’ll be 
able to see through the top of the terrain to 
whatever is underneath. To make the top solid, 
you should select Make Solid from the drop-
down menu.

Using the Clipping Bracket you can eliminate unwanted 
areas from the terrain’s edges. This feature can be useful 
when you’re creating islands. 
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Saving Terrains
Since the terrains you create in the Terrain Edi-
tor are objects in the scene, you can save any 
terrain in the Preset Objects Library just as you 
would any object. Refer to “Adding and Delet-
ing Preset Categories and Objects” on page 120 
for instruction on saving objects to the preset 
library. 

Exporting Terrains
The Export Terrain Lab allows you to convert 
Bryce terrains into polygonal meshes. The Lab 
provides you with full control over the level of 
detail of the polygonal mesh. 

You can adjust the number of polygons with 
realtime feedback so you can instantly see the 
resulting change to your mesh. 

In addition, the Lab allows you to manage the 
all-important texture maps so that your 
exported meshes retain the cool look as gener-
ated within Bryce. 

To access the Export Terrain Lab:

Do one of the following:

• Select a terrain and go to File menu 
>Export Object, 

or 

• Edit and save a terrain in the Terrain 
Editor and click Export, which is located at 
the bottom of the map view.

Features of the Export Terrain 
Lab

The Export Terrain lab is divided into two 
areas:

• The polygonal mesh previewer with 
polygon count slider.

• The image map controls.

The mesh previewer allows you to instantly 
examine the quality of the current tessellation. 

To manipulate the mesh:

• To rotate the mesh, click and drag in the 
previewer. 

• To zoom the mesh in and out, Command/
Control-click and drag in the previewer. 

• To change the previewer display mode, 
select one of the buttons to the right of the 
previewer. 

Available preview modes are: Wireframe, 
Shaded, Textured, and Textured With 
Wireframe Overlay. 

• To adjust the colors of the wireframe and 
the shaded preview select the color 
swatches underneath the preview mode 
buttons. 

The Export Terrain Lab. 
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• To adjust the polygon count, use the slider 
below the previewer to adjust the polygon 
count. This changes the quality of your 
mesh. The number of polygons in the 
mesh is displayed in the right bottom 
corner of the previewer.

Preview Options

Selections on the right hand side of the Pre-
view window allow you to preview your terrain 
in the following ways:

• Wireframe

• Shaded

• Textured

• Textured with Wireframe Overlay

Types of Tessellations

You can create two different types of tessella-
tions in the Export Terrain Lab: Grid and 
Adaptive.

The default method is Adaptive. The initial tes-
sellation is set to 6,000 polygons. If this is not 
sufficient you can add polygons by selecting 
Add Polygons in the Options Menu. This can 
be found at the right bottom corner of the pre-
viewer. 

To switch between tessellation types:

To switch between Grid and Adaptive tessella-
tions, click on the triangle to the left of the pre-
viewer and select the tessellation type.

Grid Tessellations

Grid tessellates the original height field with a 
grid. 

In order to achieve a good mesh representation 
of the source terrain, selecting Grid requires a 
large number of polygons. However, this 
method is suitable for geometric shapes. 

Adaptive Tessellations

Adaptive achieves much lower polygon counts 
with good representation of the terrain.

 This is an excellent choice when the terrain 
models natural landscapes. 

Exporting to MetaStream

When exporting to MetaStream, MetaCre-
ations’ multi-resolution streaming file format, 
you can select additional options: Clamp Min 
and Clamp Max. 

These options define the lowest and highest 
polygon counts within the multi-resolution 
mesh. 

To reset the Clamp Min and Clamp Max:

• Select Reset Clamps within the Options 
menu.

To apply the Clamps:

1 Use the slider to set the desired lower 
polygon count.

2 Select Options menu>Clamp Min.

3 Use the slider to set the desired higher 
polygon count.

4 Select Options menu>Clamp Max. 
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If Clamp Min and Clamp Max are set to the 
same amount, the MetaStream file will contain a 
single resolution.

Handling Image Maps

The second area of the Export Terrain Lab 
deals exclusively with handling image maps. 

A large part of the appeal of Bryce terrains are 
Bryce materials, which consist of different sig-
nificant properties. Each of these properties 
can be exported, along with their geometry, 
through the Export Terrain Lab. 

The image map controls lets you refine which 
of the material properties you wish to export by 
selecting out of the list of ten. By default any 
material properties of the terrain that use image 
maps will be exported. 

Depending on the selected export file format, 
the image maps will be imbedded within the 
export file. If, however, the export file format 
does not support imbedding of image maps, 
they will be saved out as separate image files in 
the same folder as the export file. The filename 
of each separate image will be the name of the 
export file appended with the name of the 
appropriate material property.

To adjust the resolution of the exported 
image maps:

• Select one of the presets in the Size Menu. 

To save the tessellated terrain and all its 
image maps: 

• Click on the OK icon. 

If you do not wish to save, click on Cancel.

To export a terrain:

1 Create a terrain and apply materials.

2 Either select the terrain and go to 
File>Export Object or enter the Terrain 
Editor and click Export.

3 Choose the desired file format and target 
folder.

4 Adjust the complexity of the mesh.

5 Select material properties to be exported 
as image maps.

6 Select image map size.

7 Click the OK icon to cause the tessellated 
mesh to be written to the exported file.

Tips for Speeding Up the Terrain 
Editor on Slower Machines

To speed up performance on slower machines, 
disable both the Realtime Linking and AutoRo-
tate options. 

To speed up the Elevation effects, use the sin-
gle-click method rather than the click- drag 
“dial in” method, as the latter can be quite slow 
on these machines. 

When you create a terrain in your Bryce scene, 
a natural impulse is to immediately dress it up 
with a cool material and render it right away to 
see what it looks like. For serious composition, 
consider keeping your terrains free of textural 
attributes until the final stages, as procedural 
textures take longer to render than smooth 
shaded surfaces. This will keep you working 
rapidly on your composition. Then, before your 
final output, you can take some time to design 
surfaces for your terrain.
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9  

Materials

Materials are what bring your Bryce 
environment to life. A material defines the 
surface properties of an object in your scene. 
It has the power to turn a bunch of polygons 
into an island or the peaks of the Himalayas. 
You can also alter the basic function of an 
object. A simple cylinder can become a pillar, 
a tree trunk or a metal pipe, just by adjusting 
the properties of the material applied to it.

In Bryce, a material isn’t just a picture that’s 
wrapped around an object; it’s a truly 3D 
surface. The material properties you assign to 
an object are applied to the whole object—
inside and out. 

Bryce’s new volume materials let you apply a 
material to the interior of the object as well as 
to its surface. The Volume Material controls let 
you set how the entire object’s volume reacts 
to its environment. 



Material Structure
A material is made up of fourteen channels. 
Each of these channels defines a different 
property of an object’s surface. When you 
combine all the channels together you get a 
material.

New materials are created by adjusting the 
values for each channel. 

There are two types of materials you can create 
in Bryce: surface materials, which define the 
properties of an object’s surface, and volume 
materials, which define the properties of an 
object’s volume.

Understanding Surface Material 
Channels

The fourteen channels of a surface material 
each represent a different surface property. 
These properties simulate different physical 
properties of a surface, and the combination 
defines how the object’s surface interacts with 
light in the Bryce environment. 

To understand how the channels work you 
need to understand a little about how you 
perceive light and color. 

The color and size of an object is determined 
by how the light that hits the object is reflected 
back to your eye. Objects appear green because 
they reflect green light. Objects are reflective 
because they reflect light. An object appears 
shiny because it reflects light back at you. 

An object appears transparent because light 
passes through its surface, hits the objects 
behind it and is reflected back through the 
surface. Bryce’s material channels simulate all 
these behaviors. When you set a channel value, 
you’re setting how your object’s surface 
interacts with light that hits it, whether that 
light is from a direct source like the sun, or an 
indirect source like light reflected off other 
surfaces.

When you’re creating volume materials, your 
settings not only control how light interacts 
with the surface of the object, but also how it 
interacts with the object’s volume.

The effects of the channels are additive, 
meaning that each value you set directly affects 
all the other values. So, if you set the Diffuse 

A material has fourteen channels that define its surface 
properties. The combination of the values of all the 
channels produces a material.

Material Channels

Material

Material channels simulate physical properties of an 
object. When you set channel values, you’re defining how 
the object’s surface, or volume, interacts with light.

Light Source
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Color to yellow and the Ambient Color to Blue, 
the object will have a greenish tint. 

Channels are interdependent. For example, you 
won’t see the effects of the Transparent Color if 
the object is not transparent.

When you’re using these channels it’s 
important to understand the physical property 
they’re simulating. Only in this way can you 
make meaningful adjustments to the 
component values. 

For example, if you set both Transparency and 
Reflection to 100, you’ll get an unusually bright 
object that doesn’t look very realistic. The 
reason for this is that the object is emitting 
more light than it is receiving, something it 
couldn’t do in reality. 

Since material channels simulate real-world 
surface properties, you should try to keep 
channel values within a realistic range.

A good rule of thumb to keep in mind while 
you’re setting these channels is that the 
Transparency and Reflection channels should 
always add up to 100, and Diffusion and 
Ambience values should also always add up to 
100. 

Each surface material is made up of fourteen 
channels, divided into three groups:

Color channels

• Diffuse Color

• Ambient Color

• Specular Color

• Transparent Color

• Specular Halo

• Volume Color

Value channels

• Diffusion

• Ambience

• Specularity

• Metallicity

• Bump Height

For example, here Transparency and Reflection are both 
set to 100. With these settings you’re saying that 100% of 
the light that hits the object, passes through its surface, 
and 100% of the light that hits the object is also reflected 
off its surface. 

The result is an object that emits more light than it receives 
because it’s reflecting the light that hits it as well as the 
light from behind it. 

In reality, an object can only reflect a portion of the light 
that’s passing through it. So, Transparency and Reflection 
values should always add up to 100.
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Optics channels

• Transparency

• Reflection

• Refraction

Color Channels

The Color group contains all the channels that 
control the color reflected off an object’s 
surface. The channels in the Color group are 
Diffuse Color, Ambient Color, Specular Color, 
Transparent Color and Volume Color.

Diffuse Color, Ambient Color, and Specular 
Color define the colors the surface reflects 
when direct light hits it. For example, Diffuse 
Color defines the color that is reflected in all 
directions when direct light hits it and 
Specular Color is the color that appears in the 
object’s highlight. 

These color channels are directly related to the 
Diffusion, Ambience, and Specularity 
channels. Diffusion, Ambience, and 
Specularity control how light reflects off the 
object, while Diffuse Color, Ambient Color and 
Specular Color control the color of that light.

So, for example, if you selected yellow as the 
Diffuse Color, the object appears yellow. The 
intensity of the yellow color is controlled by the 
Diffusion channel. Refer to “Diffuse Color” on 
page 197, “Ambient Color” on page 199, and 
“Specular Color” on page 200 for more 
information. 

Transparent Color sets the color of any light 
that passes through the surface of the object 
and Specular Halo controls the size of the 
highlight that appears when an object has a 
shiny surface. Refer to “Transparent Color” on 
page 203 and “Specular Halo” on page 200.

The remaining color channel, Volume Color, 
controls the color of the interior of the object. 
Refer to “Volume Color” on page 206 for more 
information. 

Value Channels

The second group of channels, the Value group, 
controls how much light affects an object. The 
channels in the Value group are Diffusion, 
Ambience, Specularity, Metallicity and Bump 
Height.

Diffusion, Ambience, and Specularity define 
how the surface interacts with direct light. They 
let you control how much direct light affects 
the surface of an object. In a physical 
environment, these channels control how 
shiny, dark or bright the object appears. Refer 
to “Diffusion” on page 196, “Ambience” on 
page 197 and “Specularity” on page 199 for 
more information.

Metallicity is related to Reflection. It 
determines how much reflected light is filtered 
through the Diffuse Color. Refer to “Volume 
Material Channels” on page 206 for more 
information.

Bump Height controls the height of any bumps 
or dents on the object’s surface. Refer to 
“Bump Height” on page 202 for more 
information.

Optics Channels

The Optics group of channels controls the 
intensity of optical effects produced by the 
object’s surface. The channels in the Optics 
group are Transparency, Reflection and 
Refraction.

Transparency and Reflection channels control 
how indirect light interacts with the object’s 
surface. In a physical environment, these 
channels control how transparent or reflective 
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the object appears. Refer to “Transparency” on 
page 202 and “Reflection” on page 205 for more 
information.

Refraction is directly related to Transparency. 
The Refraction channel sets how much the 
light that passes though the object is bent. 
Refer to “Refraction” on page 204 for more 
information. 

Understanding Volume Material 
Channels

Surface materials define the properties of the 
surface of an object. The interior of the object 
is empty. If you were to fly through the object 
you would see one layer of material, emptiness 
and then another layer of material. A volume 
material is applied to the entire object, both 
inside and out. If you were to fly through a 
volume material you would be surrounded by a 
material. 

When you’re setting channel values for a 
volume material, you’re setting up how light 
will interact with the object’s volume. Channels 
control whether the interior of an object is 
bright, dark, shiny, or transparent. 

In most cases the interior of an object will be 
filled with a texture. If so, the channels control 
the surface properties of the elements within 
the texture. 

For example, if you apply blue spots as a 
volume material, you get a volume filled with 
blue spheres. The channels then control 
whether those spheres are bright, dark, shiny, 
or dull.

When you create a volume material, the channels define 
not just the surface of an object, but its volume as well.

Blue spots become blue spheres when 
the texture is applied as a Volume 
Material.

When the interior of an object is filled with a texture, the 
material channels control the surface properties of the 
elements within the texture. 

In this example, the Specularity channel is used to make 
the blue spheres within an object shiny.
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Volume materials are made up of thirteen 
channels, divided into three groups:

Color channels

• Diffuse Color

• Ambient Color

• Specular Color

• Transparent Color

• Specular Halo

• Volume Color

Value channels

• Diffusion

• Ambience

• Specularity

Volume channels

• Base Density

• Edge Softness

• Fuzzy Factor

• Quality/Speed

The channels in the Color and Value groups 
work exactly as they do for surface materials, 
except that the channel settings are applied to 
the object’s volume instead of its surface.

Volume Channels

The Volume channels control special volume 
properties of the object’s interior.

Base Density controls the density of the object. 
This channel defines how much material there 
is in the interior of an object. As a result, Base 
Density controls how much light passes into 
the object. A solid object doesn’t allow any light 
to pass through it, while less dense objects 

allow more light in. Refer to “Base Density” on 
page 206 for more.

Edge Softness, Fuzzy Factor and Quality/Speed 
control the appearance of texture elements 
within the material. Edge Softness and Fuzzy 
Factor control the quality of the edges and 
sharpness of the texture while Quality controls 
the render quality of the material. Refer to 
“Edge Softness” on page 207, “Fuzzy Factor” 
on page 207 and “Quality/Speed” on page 207 
for more.

Understanding Material 
Components

Each Bryce material channel can contain up to 
three components that determine the channel’s 
setting. A component can be a color, a texture 
or a numerical value. A texture can be either a 
2D texture (picture) or a 3D texture. 

Each Bryce material channel contains components that 
determine its setting. 

You can have up to three texture components in a channel, 
and some channels let you use four textures and a value as 
components.

Component
Color

2D/3DTexture
Value

Channels
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Colors can only be used in the Diffuse, 
Ambient, Specular Transparent, Specular Halo 
and Volume channels. Values are used in the 
Diffusion, Ambience, Specularity, Metallicity, 
Bump Height, Transparency, Reflection, 
Refraction, Base Density, Edge Softness, Fuzzy 
Factor, and Quality/Speed channels.

When you’re using a texture as a component, 
the information in the texture’s channels is 
used as the value of the material channel. For 
example, if you’re using a texture to set Diffuse 
Color, the texture’s color channel is used. If 
you’re using a texture to set the Diffusion value, 
the texture’s alpha channel determines the 
Diffusion intensity.

Components are combined using one of three 
modes: Mode A, Mode AB and Mode ABC. In 
Mode A, only one component is used to set the 
channel’s value. In Mode AB, two components 
are combined to set the channel’s value, based 
on altitudes. The values from texture A are 
applied at low altitude and values from texture 
B are applied at higher altitude. 

In Mode ABC, the values of two textures, A and 
B, are blended based on the alpha channel of 
texture C.

When you’re using textures as a component 
you can choose from a number of preset 
textures, or you can open the Texture Editor 
and create your own textures. Refer to 
“Combining Components” on page 219 for 
more information.

In some channels, you can use both a texture 
and a value. In this case, the value determines 
how much of the texture’s value is used to drive 
the channel. For example if you apply a Blue 

Checkers texture to the Bump Height channel, 
the texture sets the shape of the bumps and the 
value sets how prominent those bump appear.

A Word About Alpha Channels

One of the outputs a texture component can 
produce is an alpha channel. The alpha channel 
is a grayscale representation of the texture 
pattern or grain. When you use a texture as a 
component in a material channel, these 
grayscale values are used to map surface 
properties. White areas in the alpha channel 
represent 100% of the effect and black 
represents 0%.

Images, or 2D textures, also contain an alpha 
channel. In images, the alpha channel acts as a 
mask for the image. The image’s alpha channel 
is used in the same way as a texture’s alpha 
channel.

In this example the shape of the bumps on the object is set 
by the texture component in the Bump Height channel, but 
the height of those bumps is set by a value.
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Surface Material 
Channels
This section provides details on each of the 
surface material channels.

Diffusion

Diffusion determines how much direct light is 
reflected diffusely, or scattered, in all 
directions. 

When light hits an object with diffusion set to 
100%, all the light that hits it is reflected back 
scattered in all directions. This gives the object 
a flatly lit appearance. If the object’s diffusion is 
set to 0%, no light is reflected off its surface, so 
the object appears black.

Setting Diffusion Using a Texture

When you assign a texture to the Diffusion 
channel, the texture’s alpha channel 
determines which areas of the surface have 
high diffusion and which have low diffusion. 
Bright areas in the alpha channel have a high 
diffusion value and darker areas have low 
diffusion values.

The small arrows projecting off the surface of the object 
illustrate how Diffusion works.

Direct Light

Viewer

Surface 
reflects light 
diffusely

Diffusion controls how much light is diffusely reflected off 
the object’s surface.

When you use a texture to set the Diffusion channel, the 
grayscale values in the texture’s alpha channel determine 
the diffusion of the objects.

Diffusion set to Diffusion set to 

Higher Diffusion 
values

Lower Diffusion 
values

Alpha Channel
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Diffuse Color

Diffuse Color acts like a filter through which all 
diffuse light passes. When light hits the object, 
the amount of light that’s reflected diffusely is 
determined by the Diffusion channel setting, 
and the color of that light is set by the Diffuse 
Color channel. 

When Diffusion is set to a value greater than 
zero, the Diffuse Color appears wherever the 
object is hit by direct light.

Be careful when using pure constant colors as 
the Diffuse Color because you may not get the 
results you’re expecting. If you use a pure color, 
only that color is reflected off the object. So if 
you’re using 100% green, only green light is 

reflected off the surface. This doesn’t cause a 
problem when the object is hit by white light 
because there is green in white. However, if you 
use 100% red light on the object, it will appear 
black, since there is no green in 100% red, so 
no light is reflected off the object. 

Try to avoid using pure colors for the Diffuse 
Color, so that your object always reflects some 
color. 

Ambience

Ambience simulates the effects of light hitting 
the object from all directions. The Ambience 
value controls the amount of light that is 
reflected off the surface uniformly. 

When Ambience is set to a value higher than 
zero, the object will reflect light from all over its 
surface, not only from the area hit by light. This 
makes the object look brighter.

The higher the Ambience value, the brighter an 
object appears. At 100%, the object appears 
unnaturally bright, regardless of the light 
source. If you want to create a realistic effect, 

This graphic shows how diffuse light passes through the 
Diffuse Color.

Diffuse Color is the color of diffusely reflected light.

Direct Light

Viewer

Surface 
reflects light 
diffusely

Diffuse Color

Diffuse Color 
applied to areas 

The large arrows represent ambient light hitting the 
object’s surface. The smaller arrows represent the light 
reflected off the object’s surface.

Light from 
all direc-
tions is scat-
tered back
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the sum of the Ambience and Diffusion values 
should add up to 100.

An object’s ambience is directly related to the 
general ambience of the environment. So, the 
ambient value you set for the object is directly 
affected by the Ambient Color you set in the 
Sky & Fog palette. 

The Ambient Color in the Sky & Fog palette 
controls how much ambient light is available in 
the environment. The Ambience channel 
controls how much of the available ambient 
light is reflected off the object’s surface.

So, if you set the Ambient Color in the Sky & 
Fog palette to black, or 0% ambience, then the 
Ambience channel value has no effect. If you 
set the Ambient Color to white, or 100% 
ambience, the Ambience channel value will 
control how much of the available light is 
reflected off the object’s surface.

Setting Ambience Using a Texture

When you assign a texture to the Ambience 
channel, the grayscale values from the texture’s 
alpha channel determine which areas of the 
surface have high ambience and which have 
low ambience. Bright areas in the alpha 

channel have high ambience values and darker 
areas have low ambience values.

Generally, it’s best to set Ambience using a 
value. However, you can get some interesting 
effects using textures instead. For example, if 
you use a splotchy texture, you’ll get areas of 
your surface that appear to glow regardless of 
external light, mixed in with normal surface 
areas.

Ambience controls the general brightness of an object.

Ambience set to 
0%

Ambience set to 
100%

When you use a texture to set the Ambience channel’s 
value, the values are determined by the grayscale values in 
the texture’s alpha channel.

Higher Ambience
values

Lower Ambience val-
ues

Alpha Channel
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Ambient Color

Ambient Color is the color that is reflected off 
the surface of an object regardless of where the 
light source hits it. The Ambient Color is 
directly linked to the Ambience channel 
setting. If the Ambience is set to zero, the 
Ambient Color is invisible.

The Ambient Color tints the entire surface of 
the image.

The Ambient Color channel is also related to 
the ambient color you set in the Sky & Fog 
palette. The ambient color of the environment 
is added to the ambient color of the object, so if 
your environment is blue and your object’s 

ambient color is yellow, your object appears 
green.

Setting Ambient Color Using a Tex-
ture

When you assign a texture to the Ambient 
Color channel, the color channel in the texture 
is used as the Ambient Color. In other words 
the texture’s color is applied to any area of the 
object that’s in shadow.

Specularity

Specularity controls how much light is 
reflected back from the surface of the object at 
the viewer. 

Since the direct reflection creates a highlight 
on the object, you can think of Specularity as 
the channel that determines the intensity of the 
highlight that appears on the object, or the 
“shininess” of the object.

Ambient Color is the color that reflects off the entire 
surface of the object and is directly related to Ambience.

Ambient Color is the color that appears no matter where 
light strikes the object.

Ambient Color

Ambient Color 
tints the entire 
surface Specularity is the highlight reflected back at the viewer.

Surface is 
reflective

Incoming Light

Reflected Light

Viewer sees high-
light
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The higher you set the Specularity, the shinier 
the object appears. When the Specularity is set 
to zero, the object appears dull.

Setting Specularity Using a Texture

When you assign a texture to the Specularity 
channel, the grayscale values in a texture’s 
alpha channel are applied to the object’s 
highlight. Bright areas of the alpha channel 
increase the intensity of the highlight, and 
darker areas decrease the intensity. The alpha 
channel may also create patterns in the 
highlight.

Specular Color

Normally, the color of an object’s highlight 
would reflect the color of the light source. 

However, using Specular Color you can set a 
specific color for your highlight.

Specular Color is directly linked to the 
Specularity channel. If the Specularity is set to 
zero, the Specular Color is invisible.

By adding Specular Color you can make it 
appear as though a colored light is shining on 
the object. 

Setting Specular Color Using a Tex-
ture

When you assign a texture to the Specular 
Color channel, the texture’s color channel is 
used as the Specular Color. In other words the 
texture’s color is applied to the object’s 
highlight.

Specular Halo

The Specular Halo channel lets you control the 
size of the Specular highlight.

The size is controlled by the luminance value of 
the component you select. Brighter colors 

Specularity controls the intensity of the highlight of an 
object.

When you use a texture to set the Specularity channel’s 
value, the highlight’s intensity is determined by the 
texture’s alpha channel values.

Specularity set to 
0%

Specularity set to 
100%

High Specularity 
values

Lower Specularity 
values

Alpha Channel

Specular Color is the color of the object’s highlight.

Specular Color 
applied to 
object’s highlight
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create larger highlights and darker colors create 
smaller highlights.

Colors are expressed as RGB (Red, Green and 
Blue) values. Specular Halo channels use the 
values from each of these channels to set the 
size of the highlight. If the values are all in 
balance (that is, all the same), the highlight 
appears uniform. However, if one value is 
higher that the rest (for example, R=200, 
G=100, B=100), you’ll get a highlight with a 
slightly colored ring (for example, a red ring). 

Depending on the component you use in this 
channel, you may be able to set each color value 
differently to create different highlight effects. 
The easiest way to use this channel is with a 
color.

When using a color, try picking more 
desaturated colors. These colors produce more 

predictable results because the difference 
between RGB values is less.

Check out the Specularity Lesson series in the 
Fast & Simple category in the Preset Materials 
Library to see Specular Halo in action.

Setting Specular Halo Using a Tex-
ture

When you assign a texture to the Specular Halo 
channel, the RGB value of the texture’s color 
channel is used for the Specular Halo. 

Metallicity

The Metallicity channel value acts as a filter for 
reflected light. This value controls how much of 
the reflected light is filtered through the 
Diffuse Color.

At 50%, half the reflected light is tinted with the 
Diffuse Color; at 100%, all the light that’s 
reflected is tinted.

Metallicity is linked to Reflection. If Reflection 
is set to zero, the Metallicity channel has no 
effect.

Metallicity makes objects look metallic because 
it tints the color of reflections. If you want to 
create specific types of metals you need to 
adjust the Diffuse Color. For example, to create 
gold use a yellow Diffuse color.

Specular Halo controls the size of the highlight on your 
object.

When you use a balanced color as the Specular Halo, you 
get a uniform highlight. If you use a color with varied 
RGB values, slight rings appear on the highlight.

Specular Halo set 
using bright colors

Specular Halo set 
using dark colors

Specular Halo with 
balanced color

Specular Halo with 
varied RGB values

Metallicity controls how much of the reflected light is 
tinted with the Diffuse Color.

Metallicity set to 
50%

Metallicity set to 
100%
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Setting Metallicity Using a Texture

When you apply a texture to the Metallicity 
channel, the texture’s alpha channel is used to 
determine the intensity of the Diffuse Color. 
Lighter areas of the alpha channel increase the 
intensity of the color, and darker areas decrease 
the intensity.

Bump Height

The Bump Height controls the height of bumps 
in an object’s surface. The bumps on an object’s 
surface are determined by the texture’s Bump 
channel. The Bump Height channel is linked to 
the Bump channel in the texture. If you use a 
texture without a Bump channel, this channel 
has no effect. You can enter negative values in 
this channel, which turns bumps into dents.

Transparency

The Transparency channel controls how much 
light can pass through the object’s surface. 

The higher the Transparency value, the more of 
the surrounding environment is visible through 
the object’s surface. If there is no other light 
being reflected, an object set at 100% 
Transparency appears invisible.

To create a realistic transparent object, you 
need to pay attention to details. You’ll need to 
combine the effects of the other channels to 
simulate a realistic object. For example, 
transparent bubbles all have highlights, so 
you’ll need to add Specularity. Balloons have a 
flatter surface so you’ll need to add more 

Bump Height controls the height of bumps on the surface 
of your object.

Bump Height set to Bump Height set to 

The amount of light that can pass through an object’s 
surface is set with the Transparency channel.

Transparency controls how much of the surrounding 
environment is visible through the object’s surface.

Direct Light

Transparency set 
to 0%

Transparency set to 
100%
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Diffusion to the surface. Glass has a refraction 
effect associated to it, so you’ll need to add 
Refraction to the surface.

Setting Transparency Using a 
Texture

When you apply a texture to the Transparency 
channel, the texture’s alpha channel is used to 
determine which areas of the object are 
transparent. Lighter areas of the alpha channel 
are not transparent while darker areas are.

You can create some interesting effects using 
textures. For instance, a checkerboard texture 
will result in an object that’s alternately 
transparent and solid. The final look of the 
Transparency channel is determined by the 
Shading mode. When the material is applied 
using normal shading, Transparency creates an 
optical effect. 

When the material is applied using Blend 
Transparency mode, Transparency creates a 
punch-out effect. The areas of the surface that 
are 100% transparent are completely ignored 
during shading so that they appear as gaps or 
holes it the surface. Any areas that are less than 
a 100% result in a normal transparency effect.

Refer to “Shading Modes” on page 221 for 
more on Shading modes. 

Transparent Color

The Transparent Color channel determines the 
color of the transparent areas of your object. 
Light is filtered through this color as it passes 
through the object’s surface. As a result, 
anything you can see through your object is 
tinted with the Transparent Color you select.

Keep in mind that the Transparent Color 
interacts with the other colors in the material. 
If the Diffuse Color is white, then the 
Transparent Color takes precedence. If the 
Diffuse color is yellow, and the Transparent 
color is red, the object appears orange. 
However, when you’re using Refraction, the 

You can create some interesting effects using textures in 
the Transparency channel, like this checkerboard object. 
This example was created using regular shading.

Cage texture applie
to Transparency 
channel

This is what the same material looks like when you use 
Blend Transparency.

Transparent Color tints any light that passes through the 
object.

Transparent 
Color
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Transparent Color blends with the Diffuse 
Color.

Transparent Color is linked to the Transparency 
channel. If the Transparency is set to zero, the 
Transparent Color is invisible. 

Setting Transparent Color Using a 
Texture

When you assign a texture to the Transparent 
Color channel, the texture’s color channel is 
applied to the transparent areas of your object.

Refraction

The Refraction channel determines whether 
light bends when it passes through the surface 
of an object. 

Higher Refraction settings produce slight 
reflections as some of the light is bent directly 
back at its source. Higher Refraction settings 
also change the color of the object’s surface as 
the colors reflected from the environment 
affect the object’s color. 

The Refraction value is what makes transparent 
surfaces look like glass. 

As you increase the Refraction value, the edges 
of the object will become reflective. This 
simulates the effect of light being refracted so 

The Transparent color tints everything you see through the 
surface of your object.

Transparent 
Color applied to 
the object

Light may bend as it passes through an object, depending 
on the Refraction value.

Refraction controls how much light bends as it passes 
through a transparent surface.

Light is fil-
tered through 
Transparent 
Color

Light is bent 
if Refrac-
tion is 
greater than 

Refraction set to 
0

Refraction set to 
116
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sharply that it does not penetrate the object’s 
surface. 

The higher you increase the Refraction value, 
the more the Diffuse Color is blended with the 
Transparent Color. The higher the value, the 
more Diffuse Color is visible in the object’s 
surface. Any light that’s visible through the 
surface of the object is then tinted through 
both the Diffuse Color and the Transparent 
Color.

Refraction values are expressed as 100 x Refrac-
tion Index value. The Refraction Index contains 
refraction values for specific types of surfaces. 
For example, the Refraction Index of water is 
1.3; this value is expressed as 130 in the Materi-
als Lab.

Refraction is linked to Transparency. If 
Transparency is set to zero, this channel has no 
effect.

Setting Refraction Using a Texture

You cannot use a texture to set the value of the 
Refraction channel. You can only use a value to 
set this channel.

Reflection

The Reflection channel controls how much 
light, direct or indirect, is reflected off the 
object’s surface. Unlike Diffusion, which 

scatters light, Reflection directs light back at its 
source, giving the object a mirrorlike 
appearance. 

The higher the Reflection setting, the more 
reflective the surface. At 50%, half the light that 
hits the object’s surface is reflected, at 100% all 
light is reflected.

As you increase the Reflection value, the color 
of the object changes, since you can see more of 
the environment in the object’s surface. 

Setting Reflection Using a Texture

When you apply a texture to the Reflection 
channel, the texture’s alpha channel is used to 

In these examples you can see how the edges become more 
reflective as you increase the Refraction value.

Refraction set to 
140

Refraction set to 
300

Reflection determines how much light is reflected off the 
surface of the object.

Reflection controls how much light is reflected off the 
surface of an object.

Surface is 
Reflective

Incoming Light

Viewer sees object on the
surface of object

Reflected Light

Reflection set to 
50%

Reflection set to 
100%
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determine which areas of the object are 
reflective. Lighter areas of the alpha channel 
are reflective, while darker areas are not.

Volume Material 
Channels
Volume materials use most of the same 
channels as surface materials. These channels 
all work the same as they do for surface 
materials. The only difference is that the 
channels control the properties of the object’s 
volume, not its surface. 

In addition to the channels already discussed, 
Volume materials have several specialized 
channels.

Volume Color

The Volume Color channel controls the color 
applied to the interior of an object. Everything 
inside the object will appear tinted with this 
color as all light is filtered through the Volume 
Color.

The Volume Color interacts with the 
Transparent Color. If your surface is 
transparent, light is tinted by the Transparent 
Color and the Volume Color.

Volume color is an excellent way of creating 
underwater light effects.

Base Density

Base Density controls how dense the object is. 
In areas where the object is very dense, no light 
passes through the object. Where the object is 
less dense, more light passes through its 
volume. Base Density works like Transparency 
in 3D space. Areas that are less dense appear to 
be more transparent. 

High values create very solid objects like rocks, 
while lower settings create less dense objects 
like clouds.

The interior of an object can have color, which you set with 
Volume Color.

This portion 
of the light is 
tinted by the 
Volume 
Color

The Volume color tints everything inside the object.

Base Density controls the density of the area within an 
object. Objects with a low density will appear more 
transparent.

Volume Color 
applied to the 
interior of the 
object

Base Density set 
to 100

Base Density set 
to 0
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You should use this channel cautiously. The 
more transparent objects are, the more time 
they take to render. 

Setting Base Density Using a 
Texture

When you use a texture to set this channel, the 
alpha channel is used to determine which areas 
of the object are solid and which are empty.

Edge Softness

Edge Softness controls the softness of the 
edges of the silhouette of objects with a volume 
material. For example, a sphere with a low Edge 
Softness value will have a “hard” silhouette, 
meaning that you’ll be able to clearly see the 
edges of the sphere. A high Edge Softness 
value will almost totally obscure the edges of 
the sphere.

This channel is useful for obscuring the general 
shape of an object. Use this effect if you want to 
blur the overall shape of the object to which 
you’re applying the material.

Fuzzy Factor

Fuzzy Factor controls the dullness or sharpness 
of a material. Values greater than 100 adjust the 
dullness of the material, and values less than 

100 adjust the sharpness of a material. At 100 
there is no dullness or sharpness applied

As you increase the dullness of your object, it 
becomes less dense, so you may have to 
increase the Base Density to compensate. 
Likewise, as you increase the sharpness of the 
object it becomes more dense.

You can use this channel to smooth sharp-
looking clouds, or sharpen dull stone textures.

Quality/Speed

Quality/Speed controls the render quality of 
the texture. This channel represents the inverse 
relationship between render quality and 
rendering speed. As you increase the render 
quality of the material, you decrease the speed 
at which its rendered. As you increase the 
speed at which a material is rendered, you 
decrease its quality.

Edge Softness controls the softness of an object’s 
silhouette.

Edge Softness set 
to 0

Edge Softness set 
to 100

Fuzzy Factor controls dullness/sharpness of the texture 
within your object.

The Quality/Speed value controls the quality of the 
texture’s render in relation to how fast it renders.

Fuzzy Factor set 
to 0

Fuzzy Factor set 
to 200

Quality/Speed set 
to set to 0

Quality/Speed set 
to set to 100
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The material loses detail as the quality 
decreases. Detail is introduced as it increases. 

For still images you probably want to increase 
the quality of the material and sacrifice speed, 
since the scene only has to be rendered once. 
For animations, you probably want to sacrifice 
quality since the scene will have to be rendered 
once for each frame in the movie.

Material Components
This section describes the various components 
you can use to set a material channel value. It 
also describes how to set the parameters for 
each component.

Color Components

A color component is an RGB color that is 
directly applied to a channel. Colors can only 
be used in the Color channels: Diffuse, 
Ambient, Specular, Specular Halo, and Volume.

When you’re using a color in these channels 
you cannot combine it with a texture. If you 
choose a texture component for any of the 
Color channels, the color oval appears blank. 
The Volume channel can only be set with a 
color.

To use a color as a component:

1 In the Materials Lab, click the color oval in 
one of the channel rows on the Material 
Grid and choose a color from the palette.

• To choose a color using the Color 
Picker, hold down Option/Alt when you 
click the color oval.

The selected color appears in the color 
oval. If you click on one of the columns, the 
color oval appears blank.

Value Components

Value components are numerical values you use 
to set the intensity of a channel. Values can only 
be used in the Value, Optics or Volume 
channels.

A value is indicated by either the numerical 
field in the left side of the channel in the 
Material Grid, or the slider that extends out 
from the channel. The sliders let you quickly 
set the value of a channel and the numeric field 
shows the current setting.

Values can be used with textures. In this case 
the value sets how much of the texture is 
applied to the channel. For example, if you use 
an orange-colored texture to set the Diffuse 
Color channel, the value would indicate how 
much of the texture color is used as the Diffuse 
Color. 

A value of 100 means that all the texture 
information is used in the channel; a value of 0 
means that none of the texture is used.

Not all channels use values. The Color channels 
only use colors or textures. The Refraction 
channel can only be set with a value.

The Color oval in the channel column displays the color 
palette.

The value slider in a channel lets you set a numerical value 
for the intensity of the channel and displays the channel’s 
current setting.
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To use a value as a component:

• In the Materials Lab, drag the slider next to 
the channel whose value you want to set. 
As you drag, the numerical value appears 
in the number field.

Some channels let you set negative values.

Texture Components

When you use a texture as a component, Bryce 
extracts values from the texture to use as a value 
for the material channel. There are two types of 
texture components you can use: pictures and 
3D textures. Pictures are images you import 
from either the Picture Library or from another 
application. 3D textures are procedural textures 
generated by Bryce and stored in a texture 
library.

You can assign up to four textures as 
components for a material. These textures can 
be any combination of pictures and 3D 
textures. Each texture component is assigned a 
letter: A, B, C, or D. 

The texture you assign to a component is used 
throughout the material, so the texture you 
assign as component A in the Diffusion 
channel is the same component A used in the 
Ambience channel and so on. 

When you’re setting channel values, you can 
mix and match components. For example, you 
can assign component A to Diffusion and 
component D to Ambience. You can also 
combine textures within the same channel 
using the blend modes AB and ABC. In this 
case the texture you assigned to A is blended 
with the textures assigned to B and C to set a 
material channel value. Refer to “Combining 
Components” on page 219 for more on blend 
modes.

The Texture Component Window

The Texture Component window displays the 
attributes of a selected texture component. You 
can have up to four windows visible in the 
Materials Lab.

The six buttons on the Texture Component 
window let you set the type of component, the 
texture mapping mode, access the texture 
transformation controls and the Deep Texture 
Editor.

To use a Texture as a component:

• Click a column in the material grid. A 
Texture Component window appears.

The component window corresponds to 
the columns in the grid, so if you click 
column A in the grid, texture component A 
becomes active. 

3D Textures

3D textures have three different types of 
outputs: Color, Alpha channel and Bump. 
These outputs are used differently by the 
material channels. 

The Component window displays the selected component 
and its current attributes.

Display Texture 
Transformation 
Palette

Texture Name

Display Deep Tex-
ture Editor

Texture Library 

Use 3D Texture Current Mapping Mode

Mapping ModesUse Picture
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Color channels use the texture’s color to set the 
value of the channel. For example, if you use a 
texture in the Diffuse channel, the colors in the 
texture appear wherever the object reflects light 
diffusely.

Value, Optics and Volume channels use the 
alpha channel information from a texture to set 
the value of the material channel. For example, 
when you use a texture to set Specularity, the 
texture’s alpha channel information determines 
which areas of the object are shiny. As a result, 
you’ll see the pattern of the texture on the 
object. 

The Bump information in a 3D texture is used 
only by the Bump Height channel. The Bump 
channel in the texture determines the pattern 
of bumps or dents in the object. In fact, you 
won’t be able to see the effects of the Bump 

Height value unless you assign a texture to the 
channel.

To use a 3D texture as a component:

1 In the Materials Lab, click a channel 
column. 

A randomly selected texture appears in the 
Component window.

2 If you want to change this texture, click the 
triangle button next to the texture name at 
the top of the window and choose a preset 
texture from the menu.

When you use a texture to set the value of a Color channel, 
the color information is used to set the material channel 
value. In this example, the Diffuse color was set using a 
texture.

When you use a texture to set the value of an Intensity 
channel, the alpha channel information is used to set the 
material channel value. In this example, Specularity was 
set using a texture.

Diffuse color set 
using a color

Diffuse color set 
using a texture

Specularity set 
using a value

Specularity set 
using a texture

Bump channel information from a texture is used to 
determine the pattern of bumps or dents in an object. You 
must assign a texture to the Bump Height channel to see 
the bumps or dents. 

When you select 3D texture as a component, the 
Component window displays a randomly selected texture 
in the preview area and shows the texture’s current 
attributes.

The triangle button next to the 3D texture’s name in the 
component window provides access to all the preset 3D 
textures available in Bryce.

Bump Height set 
using a value

Bump Height set 
using a texture
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The texture you selected appears in the 
Component window.

2D Textures

2D textures are pictures you’ve created in 
another application or ones you select from the 
Pictures Library. The data in the channels of 
these pictures are used as values in the material 
channels.

To use a 2D texture as a component:

1 In the Materials Lab, click a channel 
column. A texture appears in the texture 
component window.

2 In the Component window, click the P 
button at the bottom of the Component 
window.

A default picture appears in the 
Component window.

3 To change the picture, click the pink 
button at the top of the component 
window. 

The Pictures Library appears. 

4 Click an image square to load an image.

5 If the image you want is not in the library:

• Click the Load text button. The Load 
Image dialog appears.

• Use the dialog controls to locate the 
picture you want to use and click Open.

or

• In another application, copy the picture 
you want to use to the Clipboard.

• Access the Picture dialog and click the 
Paste text button. 

The picture is loaded into the first image 
box and its alpha channels are loaded into 
the second box.

The P button changes the component to a 2D picture.

When you select 2D texture as a component, the 
Component window displays a default picture in the 
preview area and shows the picture’s current attributes.

The pink button displays the Pictures Library.

The Pictures dialog lets you select a 2D image to use as a 
Pict object.

When you load a new picture into the Picture dialog, the 
main image is loaded into the first box and its alpha 
channel is loaded into the second box.
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You can invert the alpha channel by 
clicking the invert button.

6 Click the OK icon to exit the dialog.

The picture appears in the Component 
window.

Using the Pictures Editor 
The Pictures Editor in Bryce has three squared 
previews, at the top of the window. These three 
previews represent one image, three different 
ways. The left image is the RGB information of 
the image, the middle one is the alpha channel, 
right is the combined image. You can apply 
filters to each of the three parts independently.

How to select a plug-in folder:

• Click on the triangle to the right of the 
desired preview type. 

If a plug-ins folder has been previously 
selected, a pull-down menu appears that 
displays the available Photoshop filters.

• If, for some reason, the Photoshop filters 
cannot be found, or you wish to select a 
new plug-ins folder, select Select Plug-ins 
Folder at the bottom of the menu.

Select a folder for the plug-in.

How to add blank images into the library:

1 Click on the New button at the upper right 
of the Pictures Editor.

The New dialog appears.

2 Enter a name for the image as well as the 
resolution and default color.

3 Click the checkmark to return to the 
Pictures Editor.

The Pictures Editor will contain the new 
image in one of the tiles.

Once the picture is available in your library, you 
can load different alpha channels or different 
RGB information. You can also run any 
Photoshop filter on either of the two 
components of this image or the entire image. 

How to apply filters to pictures:

1 Select a picture from the picture tiles.

The picture appears in the top preview 
frames of the picture editor.

Select a plug-in from the currently 
selected plug-in folder.

2 Select a plug-in from the folder.

3 The filter is applied to your image.

Texture Mapping Modes

Once you’ve decided on a texture to use as a 
component, you need to decide how the texture 
is mapped onto your object. The appearance of 
the texture can change dramatically depending 
on how it’s applied to the object.

Each texture you apply can have a different 
mapping mode. When you’re mixing textures 
(Mode AB or Mode ABC), you can choose which 
portions of your textures you want to combine.

To select a mapping mode for a texture:

1 In the Materials Composer, click a channel.

2 Select a mode for the channel.

3 Click the title of the Component window 
and choose either 2D Texture or 
3D Texture.
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4 Click the current Mapping Mode title and 
choose a mapping mode from the menu.

Object Space

In this mode, textures are scaled proportionally 
to the size of your object. If you change the size 
of your object, the texture scale changes with it. 
The texture also rotates along with the object. 
This means that the texture does not appear to 
move as you reposition or rotate the object.

World Space

In this mode, the texture is infinitely large 3D 
space, and only a small portion is applied to 
your object. This means that the texture 
appears to change as you move your object, 

since it is moving through the texture in 3D 
space.

Parametric

In this mode, the texture is applied onto the 
object as if it were a decal. For example, if you 
use this mapping mode on a cube, one iteration 
of the texture is placed on each face.

The texture is mapped onto the object so it 
rotates and scales as the object is scaled or 
rotated.

This mode works best with 2D Pict textures.

In Object Space mode, textures are applied to the object so 
the texture will not move as you move the object.

In World Space mode, the texture is applied to the entire 
world, so the texture appears to move as you move the 
object.

Parametric mode applies the texture as a 2D decal.
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Parametric Scaled

This mode works like the World Space mode, 
only in 2D. Textures mapped using this mode 
are not scaled with the object.

Use this mode when you want to map a 2D 
picture onto constructed objects like buildings.

World Top

In this mode a 2D projection of the texture is 
applied to the object from directly above it. If 
you move your object or rotate it, the texture 
does not move with the object; it remains 
constant while the object moves through it.

Spherical 

In this mode, a 2D projection of your texture is 
mapped onto a virtual sphere that surrounds 
your object. It is then projected from the 
sphere onto your object.

Cylindrical 

In this mode, your texture is mapped onto the 
front of your object, wrapping around the right 
and left sides all the way to the back. Edge 
pixels going to the center appear on the top and 
bottom of your object.

Parametric Scaled mode applies the texture as a decal, but 
does not scale the texture as you scale the object.

World Top mode applies the texture to the top of the world. 
The texture appears as a projection on top of the object 
and streaks down its sides.

Spherical mode applies the texture to a virtual sphere and 
then projects it onto your object.

Cylindrical mode wraps a texture around the object 
starting from the front.
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Reflection Map

In this mode, a 2D projection of your texture is 
applied to a virtual sphere that surrounds your 
scene. The texture is then reflected off of the 
sphere and onto your object.

This mode works best on objects with irregular 
surfaces. It also works well with terrains.

Random

This mode randomly applies a 2D projection of 
the texture all over the surface of your object.

Object Top 

This mode applies a 2D projection of the 
texture to the top of your object. The texture 
rotates and scales along with the object.

Object Front 

This mode applies a 2D projection of the 
texture to the front of your object. The texture 
rotates and scales along with the object.

Reflection Map mode applies a reverse image of your 
texture to your object.

Random mode applies the texture all over the object in a 
random pattern.

Parametric 
Scaled

Reflection 
Map Object Top mode applies the texture to the top of the 

object.

Object Front mode applies the texture to the front of the 
object.
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Mapping Mode Modifiers

You can modify the mapping modes in the 
following different ways.

Symmetrical Tiling

When you tile a texture onto an object in 
symmetrical tiling mode, each repeated 
instance of your texture is tiled horizontally and 
vertically. as needed to seamlessly produce a 
symmetrical pattern over the surface of the 
object.

Repeat Tiling

Unlike symmetrical tiling, in which a seamless 
tiled pattern is achieved by flipping the texture 
horizontally and vertically, Repeat Tiling 
repeats your texture across the surface of your 
object without any alteration in orientation. 
The number of instances of the texture 
depends on the scale applied to the texture. 

Scale Pict Size

This mode modifier only affects picture 
textures. When selected, the image behaves like 
a sticker placed on the surface of the textured 
object. Unless Scale Pict Size is selected, the 

picture will repeat itself across the surface in a 
similar way to Repeat Tiling.

Centered Transforms

Centered transforms works with parametric 
mapping modes to force the transformation of 
the textures to be applied around the center of 
the object surface.

Decal Colors

Decal colors blends the color of a texture with 
the affected component’s base color. It uses the 
texture’s alpha channel to control the amount 
of blending. This can make decalcomania 
effects easier to achieve.

Alpha Scaling

Normally, if you drive a component’s value with 
a texture, the texture’s alpha channel will set 
the value without regard to the amount that was 
set using the component’s slider. With alpha 
scaling turned on, the amount set with the 
slider will “scale’ the amount provided by the 
texture’s alpha channel. This gives you more 
subtle control over the influence of the texture 
on the material component’s value.

Transforming Textures

Since a 3D texture exists in three-dimensional 
space, it can be transformed along the X, Y, or Z 
axis—just like a 3D object. Using the texture 
transformation tools, you can scale, position or 
rotate your texture. 

The final look of the transformation depends 
on the mapping mode you use to apply the 
texture to the object. In some modes, texture 
transformations may not be very noticeable, 
while in others, like Parametric, transforms can 
have a large impact on the look of the material. 

in Symmetrical Tiling mode, textures are seamlessly tiled 
across the object.
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You may find it necessary to experiment with 
different settings to get the results you want. If 
you find that the texture isn’t reacting the way 
you want it to, try changing the mapping mode. 
Refer to “Texture Mapping Modes” on page 212 
for more on mapping modes. 

The transformation tools give you very fine 
control over the final appearance of the texture. 

Scale

Using the Scale tool, you can control the 
frequency of the texture. Increasing the scale of 
a texture decreases the frequency of the 
pattern, since it doesn’t have to be repeated as 
many times to cover the surface of the object. 

Rotation

Using the Rotation controls you can control the 
angle of the texture on the object’s surface. You 
can create very different texture effects 
depending on its orientation.

Since a 3D texture exists in 3D space, you can change its 
size in all three axes. Adjusting the scale in X changes the 
size of the texture along the X axis.

Adjusting the scale in Y changes the size of the texture 
along the Y axis.

Scale X=0% Scale X= 50% Scale X=100%

Scale Y=0% Scale Y= 50% Scale Y=100%

Adjusting the scale in Z changes the size of the texture 
along the Z axis.

Since a 3D texture exists in 3D space you can change its 
orientation in all three axes. Adjusting the rotation in X 
changes the angle of the texture along the X axis.

Adjusting the orientation in Y changes the angle of the 
texture along the Y axis.

Scale Z=0% Scale Z= 50% Scale Z=100%

Rotation
X=0°

Rotation 
X=90°

Rotation 
X=180°

Rotation Rotation 
Y=90°

Rotation 
Y=180°
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You can transform a texture numerically by 
adjusting the X, Y and Z coordinates or 
interactively using the transformation tools.

Position

Using the Position controls, you can control 
where the texture appears on the object’s 
surface. When you’re using a picture as a 
component, placement can be vital to the look 
of the material. For example, if you’re placing a 
decal on an object, use the Position controls to 
precisely place the image in the center of the 
object or on the correct face. 

To transform a texture numerically:

1 In the Texture Component window, click 
the click the first button on the left at the 
top of the window. 

The Transformation palette appears. 

2 Move your cursor over the transformation 
you want to apply.

3 Drag the cursor over the value you want to 
adjust. 

Drag left to increase the value or right to 
decrease it.

Adjusting the orientation in Z changes the angle of the 
texture along the Z axis.

Since a 3D texture exists in 3D space you can change its 
position in all three axes. Adjusting the position in X 
changes the placement of the texture along the X axis.

Adjusting the position in Y changes the placement of the 
texture along the Y axis.

Rotation 
Z=0°

Rotation 
Z=90°

Rotation 
Z=180°

Position Position Position 
X=100 BU

Position Position 
Y=50 BU

Position 
Y=100 BU

Adjusting the position in Z changes the placement of the 
texture along the Z axis.

Use the texture transformation palette to adjust the scale, 
position and orientation of the texture component.

Position Position Position 
Z=100 BU
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As you adjust the value, the material 
preview updates to show the results of your 
changes.

4 Click the OK icon to apply your changes.

To transform a texture interactively:

1 In the Texture Component window, click 
the click the first button on the left at the 
top of the window. 

The Transformation tools appear.

2 Move the cursor over the tool you want to 
use until the mode you want is active. 

3 As you pass the cursor over the tool, the 
tool changes to display the different modes 
available.

4 Drag the mouse in the direction you want 
to move, scale, or rotate the texture.

5 Click the OK icon to apply your changes.

Editing Textures

You can edit the makeup of an existing texture 
or create a completely new texture using the 
Deep Texture Editor. This editor uses some 
rather complex texture-generation concepts to 
create textures for Bryce. You can either choose 
to learn all these concepts to create your 
textures precisely, or use the editor as a type of 

lab where you combine random settings and 
see the results. 

Refer to “Textures” on page 237 for more 
information about learning texture-generation 
concepts.

Combining Components 

You can combine material components using 
one of three blending modes:

• Mode A

• Mode AB

• Mode ABC

Mode A

In Mode A, only one component is used to set 
the value of a channel. The component can be a 
value, a picture or 3D texture.

Mode AB

In Mode AB, two textures are blended together 
based on altitudes. At the lowest altitudes the 
values from texture A are used, at higher 
altitudes texture B is used to set the value of the 
channel. 

Altitude is based on the distance between the 
ground level and the highest object in your 
scene.

When you use this mode, an object’s surface 
material is a blend between two texture 
components. Texture B appears at the bottom of 
the object and Texture A appears at the top. In 
between is a blend between texture B and 
texture A. Bryce creates the blend by 
interpolating between the two textures. 

For example, if you use Mode AB in the Diffuse 
Color channel, the color in texture A appears at 

The material preview area updates as you transform the 
texture to show your changes.
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the bottom of an object’s surface, and the color 
from texture B appears at the top. A color 
gradient between color A and color B appears 
in the middle of the object 

Mode AB can be used to create snow covered 
peaks on terrains or murky depths in infinite 
water slabs.

To use mode AB to blend textures:

• In the Materials Lab, Control/Ctrl- click 
the B column of a channel.

Component indicators appear in both the 
A and B columns of the channel.

Mode ABC

In Mode ABC, two textures, texture A and 
texture B, are blended based on the alpha 
channel of texture C. In this mode the alpha 
channel from texture C acts like a map that tells 
Bryce where to apply the values from texture A 
and texture B. All the white areas of the alpha 

channel use values from texture A; black areas 
in the alpha channel use values from texture B. 
Gray areas in the alpha channel use a 
combination of both textures.

In the example that follows three textures were 
combined using Mode ABC in the Diffuse 
Color channel. 

To use Mode ABC to blend textures:

1 In the Materials Lab, Control/Ctrl- click 
the C column of a channel.

In this example, Mode AB was used to set the Diffuse 
Color channel. Values from texture A set the Diffuse Color 
channel at lower altitudes while values from texture B set 
the channel at higher altitudes.

Component indicators in both the A and B columns of a 
channel indicates that you’re using mode AB to blend 
texture components.

Texture A

Texture B

Alpha Channel Texture Used

Texture A

Combination of 
A and B

Texture B

Using Mode ABC to combine the three textures, the spot 
texture (A) appears in the white areas of the checker 
texture’s alpha channel (C) and the lines texture (B) 
appears in the black areas of the alpha channel.

Texture A

Texture B

Texture C
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Component indicators appear in the A, B 
and C columns of the channel.

Shading Modes
Shading refers to the process of applying 
material channel values to an object. When an 
object is shaded, the different values in the 
material are applied to the object. The shading 
modes available in Bryce determine how 
material channels are applied to create 
different effects.

To choose a shading mode:

• Click the triangle icon next to the material 
type buttons at the top of the Materials 
Lab.

Component indicators in the A, B and C columns of a 
channel indicate that you’re using Mode ABC to blend 
texture components.

Using a material, you can define whether a surface is 
shiny, smooth, or opaque.

Using a shading mode, you determine how those 
properties are applied to the object.

The shading mode cannot only determine how the 
material is applied to the surface of the object, but how it’s 
applied to its volume as well.

Click the triangle icon at the top of the Materials Lab to 
display a listing of the available shading modes.
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Surface Material Shading Modes

This section explains the surface material 
shading modes.

Normal

Normal mode applies the values of the material 
without modifying them in any way. Objects are 
shaded according to the values you set in the 
material channels. This mode has no special 
effects; it simulates a real-world appearance 
using the material channel values. 

This is the default mode and is appropriate for 
most objects.

Blend Transparency

In Blend Transparency mode, visibility is 
controlled by Transparency. When this mode is 
active, areas of the object that are 100% 
transparent are ignored. Transparent areas are 
not shaded and do not cast shadows. These 
areas appear as gaps or holes in the object’s 
surface.

This mode lets you create punch-outs when 
using a texture.

Anything less than 100% Transparency results 
in normal transparent areas.

Fuzzy

Fuzzy mode changes the effective Transparency 
based on the thickness of the object. As a 

This cage was created by using blend transparency to 
“punch-out” areas of the object’s surface.

Using Normal Shading

Using Blend Transparency Shading
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result, objects appear fuzzy on the edges and 
solid at the center. 

Since Bryce uses depth information to 
synthesize this blurry effect, it is not available 
for 2D objects such as Squares or Disks. 

Use the Transparency setting to adjust the 
degree of fuzziness.

Light

Light is a very specialized shading mode best 
used to create visible lighting effects. Objects 

shaded with this mode appear transparent and 
self-illuminating. 

Only the Diffuse, Ambient and Transparent 
Color channels are used to determine the color 
of the light. All other channels are ignored.

This mode is useful for creating point lights 
without the rendering overhead that comes 
with true volume light objects (that is, light-
sensitive volume materials).

Volume Material Shading Modes

This sections explains the volume material 
shading modes.

Flat Shading

Flat shading mode is designed for clouds, gases 
and other self-luminous gaseous materials. Flat 
shading mode does not shade an object, 

When you apply a material using Fuzzy shading mode, 
the edges of the object appear blurred, while the center 
remains solid.

The Light shading mode is designed to create simple light 
effects. If you apply it to a cone object, it looks like a cone 
of light.
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meaning that light sources have no effect on 
the color or brightness of the object. 

When this mode is active, Diffusion, Ambience, 
Specularity, Ambient Color, Specular Color 
and Transparency Color have no effect.

The color of the material is determined entirely 
by the Diffuse Color channel.

Full Shading

Full shading mode is designed for hard edged, 
sharp objects like rocks. When Full shading 
mode is active, the visible portions of the 
material are shaded and can be affected by light 
sources. 

Since light sources can affect portions of your 
material, shadows will appear within the object. 
This can greatly increase rendering time. If you 
don’t need to see shadows in the object, make 
sure the Receive Shadows filter is disabled. 
Usually you should disable this filter unless 
you’re creating very specialized effects.

Light Sensitive

Light Sensitive mode is designed for creating 
visible light effects such as light beams. Light 
Sensitive mode does not shade objects, but the 
particles in your material are sensitive to light. 

In this mode, Density doesn’t control density as 
much as it sets the light sensitivity of material 
particles. Higher values create brighter 
particles and lower values create darker 
particles.

To get the best results for light objects, use the 
Additive blend mode.

The color of the particles is determined entirely 
by the Diffuse Color channel.

The result is like shining a light through a 
volume. If you were shining a light through a 

The Flat shading mode applies your material as a volume 
material, but does not apply any shading.

The Full shading mode applies your material as a 
volumetric material, and applies shading to the visible 
portions of the material.
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cloud material, you would be able to see the 
clouds within the light cone. 

When this mode is active, Diffusion, Ambience, 
Specularity, Ambient Color, Specular Color 
and Transparency Color have no effect.

Shading Mode Modifiers

Shading mode modifiers are not shading 
modes, but they modify an existing shading 
mode. When you select a modifier it remains 
enabled until you disable it. You can also apply 
more than one modifier at the same time.

Additive

When this modifier is active, material channels 
are applied to the environment behind the 
object instead of to the object’s surface. 

If you put an object on a bright background, it 
appears almost white. For best results, set your 
Ambient Color control to zero and render 
against a dark, plain background. Objects with 

this shading mode modifier selected will not 
cast shadows. 

This mode is very useful for creating planets 
and quarter moons, light beams, and ghost 
images. 

Distance Blur

This modifier is designed to minimize the 
problem created by highly bumpy textures 
fading into infinity (i.e., the horizon). Often, 
moiré-like patterns appear in these cases as the 
pixels try to resolve the infinitely receding high 
frequencies of bumpy water or grooved sand, 
and so on. The Distance Blur modifier fades the 
bumpiness well before it hits the horizon.

Use Light Sensitive shading mode to create visible light 
effects like light beams.

When you modify a shading mode using Additive, objects 
appear as ghost images.
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Receive Shadows

This modifier prevents an object’s surface from 
accepting shadows cast by objects around it. 
The object itself will cast a shadow, but it won’t 
accept them from other objects.

Cast Shadows

This modifier prevents an object from casting 
shadows. The object’s surface still reacts 
normally with light but it does not cast any 
shadows. 

Self Shadows

This modifier prevents an object from casting a 
shadow onto itself, yet still shadow all the other 
elements of the scene.

Volume Blend-Altitude

This modifier gradually blends in the Volume 
color based on altitude. Areas at lower altitudes 
are tinted with the 100% Volume Color; as you 

move higher up, less of the Volume Color is 
added.

This modifier can be used to create a sense of 
depth in an infinite water slab. If you blend 
between a light Diffuse Color and a darker 
Volume Color, you can create the illusion of 
depth as you sink deeper into the water.

Volume Blend-Distance

This modifier blends the Diffuse and Volume 
Colors of your material based on the distance 
from the camera. Areas that are closer to the 
camera will be tinted less with the Volume 

When the Receive Shadow filter is disabled, no shadows 
will appear on the object’s surface. Using the Volume Blend-Altitude you can simulate the 

effects of sinking deeper into a volume of water. The lower 
you sink, the darker it becomes.
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color. As you move further away, more of the 
Volume Color is visible.

This modifier is excellent for creating 
underwater depth effects. If you blend a darker 
Diffuse Color with a lighter Volume Color in an 
infinite slab, you can simulate the effects of 
murky water on distant objects.

The Materials Lab
The Materials Lab is where you create and edit 
your materials in Bryce. This unique editor lets 
you combine a wide variety of components and 
channels to create an infinite number of 
different surfaces and volumes.

To display the Materials Lab:

1 Create an object.

2 Select the object in the Working window. A 
number of object attribute icons appear to 
the right of the object.

3 Click the M icon. Alternatively, you can 
choose Objects menu> Edit Material or 
display the Edit palette and click the Edit 
Material tool.

The contents of the composer depend on the 
material currently applied to the object. If there 
is no material, the default material’s settings 
appear. 

A Quick Tour of the Materials 
Lab

The Materials Lab is set up like a visual chart 
that lets you see all the different channels that 
make up your material. At a glance, you can see 
all the settings for each material channel and 
the texture components used to drive channel 
values. 

In the top left corner is the mode toggle button. 
This button lets you switch between surface 
material and volume material. The buttons also 
indicate what type of material you’re creating. 
Surface is enabled by default. When you toggle 

Using the Volume Blend-Distance you can simulate the 
effects of looking through murky water. Distant objects 
appear darker than closer ones.

Use the quick access buttons next to a selected object to 
access editors and get information about the object.
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to Volume, the channels in the lab change to 
display the volume channels.

Material Preview Window

On the left side of the Materials Lab is the 
Material Preview. This little window shows you 
what your material will look like when its 
applied to an object. The preview updates as 
you adjust the channels.

The Materials Grid

The center of the Materials Lab is call the 
Material Grid. This is where you combine 
values, colors and textures to set channel 
values. The Materials Grid is divided into three 

sections each containing logical groups of 
channels. 

The Color channels group contains all the 
material channels that define the colors that 
appear on the object surface when it’s struck by 
light.

Each channel in the Color group has a color 
oval next to its title. This oval lets you quickly 
set a color for the channel.

Use the toggle button to switch between material types.

The Material Preview shows you what your material will 
look like when it’s applied to an object. You can drag the 
preview to get a different view of the object.

The Material Grid gives you a one-glance view of all the 
channels that make up your material.

The Color group in the Material Grid contains all the 
channels that define the color of an object’s surface or 
volume.

Use the Color oval to quickly set a color for the channel 
using the Color Picker.
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The Value group contains all the channels that 
define how the object’s surface or volume 
reacts to light. In other words, they control 
whether the object is shiny, metallic, bright or 
dark.

The Optics group contains all the channels that 
define any optical effects associated with the 
object.

When you’re creating volume materials, the 
Optics group is replaced by the Volume group. 
This group contains all the channels that define 
the appearance of an object’s volume.

All of the channels in these three groups have 
sliders on the left side of its row. The sliders lets 
you quickly set the value of the channel. Values 
can be used in conjunction with textures or on 
their own. In the case of the Refraction 
channel, you must use a value.

Each channel is divided into four columns: A, 
B, C, and D. These columns represent texture 
components you can use to set the value of the 
channel. At the top of each column is a 
Frequency slider. This slider lets you quickly set 
the frequency of a texture component. Setting 
the frequency is the same as scaling the texture.

When a texture component indicator appears 
in a column, it means that a component is 

being used to drive the value of the channel. 
The column in which the indicator appears 
indicates which texture component is being 
used. For example, if a texture component 
indicator appears in column A of the Ambience 
channel, component A is being used to drive 
the Ambience value.

Texture Component Windows

Along the right side of the lab are the Texture 
Component windows. These four windows are 
also labeled A, B, C, and D. When a texture 
component is active, these windows display a 
preview of the texture and provide access to 
texture editing tools.

Along the bottom of the Materials Lab are the 
Animation controls. These controls let you 

The Value group contains all the channels that define how 
an object’s surface or volume reacts to light.

Use the value sliders to set a value for the channel.

Component indicators let you know which channels are 
being driven by a texture and which texture component 
(A, B, C or D) is being used.

The four Texture Component windows correspond to the 
four columns in each channel in the Materials Grid

Component A

Component B

Component C

Component D
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animate between textures or animate the 
properties of a single texture over time. 

Working in the Materials 
Lab
This section describes how to use the Materials 
Lab to create and store materials.

Building Materials

A material is a combination of values, colors 
and textures applied through fourteen different 
channels. You build materials by selecting 
components (colors, values or textures) and 
combining them on the Materials Grid. 

To create a new surface material:

1 Select an object.

2 Display the Materials Lab.

3 Set the material channels to define the 
properties of your material.

Remember, channels can be set using values, col-
ors or texture components. You may want to 
experiment with different setting to see the 
results of your changes.

4 If you’re using texture components, you 
can:

• Edit the scale, position or rotation of 
the texture using the texture 
transformation controls.

• Edit the makeup of the texture using the 
Deep Texture Editor.

• Set a mapping mode for the texture.

5 Choose a shading mode for the material by 
clicking the triangle icon at the top of the 
Materials Lab and choosing a mode from 
the menu. 

6 Click the OK icon. The new material is 
applied to the selected object.

To create a new volume material:

1 Select an object.

2 Display the Material Lab.

3 Click the toggle button to switch to 
Volume.

4 Set the material channels to define the 
properties of your material.

Remember, channel values are applied to the 
object’s volume not its surface, so adjust the 
material’s channels accordingly.

5 If you’re using texture components, you 
can:

• Edit the scale, position or rotation of 
the texture using the texture 
transformation controls.

• Edit the makeup of the texture using the 
Deep Texture Editor.

• Set a mapping mode for the texture.

You should always use a texture component in 
the Base Density channel.

6 Choose a shading mode for the material by 
clicking the triangle icon at the top of the 

Use the Animation controls to animate a material over 
time.
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Materials Lab and choosing a mode from 
the menu. 

The shading modes for volume materials 
are different from those for surface 
materials.

7 Click the OK icon. The new material is 
applied to the selected object.

To activate a component in the Materials 
Grid:

• Click an empty channel column. A 
component window appears.

To use a component in a channel:

• In a material channel, click the column 
that corresponds to the component you 
want to use.

To switch between components:

• Click in a new column.

To combine a component with a value:

1 In a material channel, click an empty 
column.

2 Drag over the value control for the 
channel.

Copying and Pasting Materials

The Materials Lab has its own dedicated 
clipboard that lets you store materials. You can 
have an object in your clipboard, then enter the 
Materials Lab and copy a material without 
disturbing the contents of your clipboard.

To copy a material to the Materials 
clipboard:

• Click the Copy button below the Material 
Preview window.

To paste a material to the Materials 
clipboard:

• Click the Paste button below the Material 
Preview window.

Using the Material Preview Area

There are several different ways you can see the 
effects of your material on an object. 

To switch preview modes:

• Click the triangle at the bottom of the 
material preview and choose an option 
from the menu:

Normal displays your object as it looks in 
your scene. This is the default view of your 
selected object.

Up Close displays a zoomed in view of your 
object.

Render With Neutral Sky displays your 
object against a plain sky. When disabled, 
your preview contains the current sky 
settings. This option makes it easier to see 
the material without being distracted by 
patterns in the sky.

Render With Neutral Ground displays 
your object with a plain ground. When 
disabled, the ground in your preview has 
the same texture as the object. 

Current Selection displays the selected 
object exactly as it appears in the your 
scene.
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Box displays the material applied to a 
cube.

Sphere displays the material applied to a 
sphere.

Cone displays the material applied to a 
cone.

Cylinder displays the material applied to a 
cylinder.

Terrain displays the material applied to a 
randomly generated terrain object.

Ground displays the material applied to an 
infinite plane.

Torus displays the material applied to a 
torus object. Torus objects are good for 
displaying material properties like altitude 
changes, slope and height changes, and 
metallicity.

To change the view angle of the preview 
area:

• Drag the Preview area in the direction you 
want to view it from. 

The preview switches to wireframe as you 
move it. The angle of the preview does not 
affect the angle of the object in your scene.

Material Presets
Material presets are predefined materials. 
Presets contain channels values that simulate a 
wide variety of commonly used surfaces. 
Presets are stored in the Material Presets 
Library.

Presets are a great way of understanding how 
materials are made. You can open one of the 
presets and see what channel and components 
were used to create the final material. 

The Material Presets Library can also be used 
as a cookbook. Some of the shaders are 
organized as lessons that can lead you through 
the process of creating interesting effects. For 
example, try opening the Specularity lessons in 
the Simple & Fast category.

Using the Preset Materials 
Library

The Preset Materials Library contains all the 
material presets available in Bryce. You can 
place them on your objects directly and edit 
them just as you would any other material.

To add a material from the Preset Materials 
Library to an object:

1 Select an object.

2 In the Working window, click the triangle 
icon next to the Edit text button at the top 
of the Bryce environment. The Preset 
Materials Library appears.

or

Use the Preset Materials Library to add pre-made 
materials to your object.
232 Materials 



In the Materials Composer, click the 
triangle icon next to the Material Preview 
window

3 Click one of the Category names along the 
left side of the dialog.

4 Click the thumbnail of the preset you want 
to add.

5 Click the OK icon to add the selected 
material to your object.

You can also select presets in one motion by 
dragging directly to the desired material preset 
and releasing the mouse button. You can also 
drag over the category names to change catego-
ries into the category’s presets, and then release 
mouse button.

Adding and Deleting Preset 
Materials

You can add the material from any object to the 
Preset Materials Library. This is a good way of 
saving your favorite materials.

To add a material to the library:

1 Select the object whose material you want 
to add to the library.

2 Click the triangle icon next to the Edit text 
button at the top of the Bryce 
environment. Your selected object will 
appear in the preview area of the Preset 
Material Library dialog.

3 Click a category name. The library switches 
to the category you selected. 

The new preset will be added to the 
category you select.

4 Click the triangle icon at the bottom right 
corner of the preview and choose a view 
option from the menu. 

Normal is the default view of your selected 
object.

Up Close displays a close-up of your 
object.

Render With Neutral Sky displays your 
object with a flat sky instead of the sky 
applied to your scene.

Render With Neutral Ground displays 
your object on a flat ground plane instead 
of the ground used in your scene.

Current Selection displays your object 
exactly as it appears in your scene.

Box displays your material applied to a 
cube.

Sphere displays your material applied to a 
sphere.

Cone displays your material applied to a 
cone.

Cylinder displays your material applied to 
a cylinder.

Terrain displays your material applied to a 
terrain. You might want to disable Render 
With Neutral Ground as terrain materials 
look better when placed on a ground plane 
with the same material.

Ground displays your material applied to 
an infinite plane.

Torus displays your material applied to a 
torus object.

5 Drag the preview area to rotate the view of 
your object.The preview area displays the object you selected.
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6 Hold down the Spacebar and drag up, 
down, right, or left to pan the your object 
preview.

7 Hold down Command/Ctrl and drag in the 
preview area to zoom in and out of the 
preview.

8 Click the Add button at the bottom of the 
dialog. The Add Material dialog appears.

9 Enter a name for the new preset in the 
Preset Name field.

10 Enter a description of the preset in the 
Description field and click the OK icon.

The name and description will appear next 
to the material preview whenever the 
preset is accessed. 

You can edit the name and description of any 
preset at any time simply by pressing the Tab key 
or by clicking the name or description.

11 Click the OK icon. Your preset will be 
added to the first available space within the 
current category.

To delete a material preset:

1 Click the triangle icon next to the Edit text 
button at the top of the Bryce 
environment. The Preset Materials Library 
appears.

2 Click the preset you want to delete.

or 

Hold down Shift and select a continuous 
series of presets.

or 

Hold down Command/Ctrl and select a 
discontinuous set of presets.

3 Click the Delete button at the bottom of 
the Preset Materials Library dialog. 

Importing and Exporting Preset 
Materials

Importing and exporting presets is a handy way 
to exchange custom presets with other users. 

To import a preset material file:

1 Click the triangle icon next to the Edit text 
button at the top of the Bryce 
environment. The Preset Materials Library 
appears.

or 

In the Materials Lab, click the triangle icon 
next to the Material Preview window.

2 Click the Import button at the bottom of 
the Preset Materials Library dialog. The 
File Open dialog appears.

3 Locate the file you want to import and click 
Import.

The contents of the file are placed into the 
first available space in the current category.

To export a preset material file:

1 Click the triangle icon next to the Edit text 
button at the top of the Bryce 
environment. The Preset Materials Library 
appears.

2 Select the preset or presets you want to 
export.

3 Click the Export button at the bottom of 
the Preset Materials Library dialog. The 
Save File dialog appears.

4 Enter a name and location for the file and 
click Save. 
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Animating Materials

Animating materials can add an exciting new 
dimension to your materials—time. Using the 
Animation controls, you can interpolate 
between textures over time or change the 
properties of a single texture over the course of 
an animation. 

The animation tools are a great way of adding 
life to your scene. Instead of creating an 
animation with simple motion, you can create 
subtle effects like changing a cube from water 
to ice or changing the seasons on a mountain. 

Refer to “Animating Materials” on page 388 for 
complete instructions on animating materials.

Speeding Up Materials

While there is almost an infinite number of 
materials with the added complexity of creating 
materials using multiple components and 
adding volumes, you need not use all the 
features of the lab all at once. 

The more complex your material, the longer it 
takes to render so you should use complexity 
only where its necessary.

Rendering Transparency, Reflection and 
Refraction always require longer rendering 
time, but when you add the complexity of 
creating transparent, reflective or refractive 
volumes, your rendering time can increase 
exponentially. If you find that your scene is 
taking too long to render, you may want to try 
setting the Transparency, Reflection and 
Refraction values to zero. 

Additionally, use Full Shading Volume textures 
sparingly. This type of material creates specific 
types of effects, so you should limit these 
materials to specific areas of your scene. If you 

spread Full Shading Volume textures 
everywhere throughout your scene, be 
prepared for a long wait while the scene 
renders.
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Textures

Textures and Materials
The thing that makes Bryce so unique is its 
materials. A material can truly bring any object 
to life, and textures are the power behind the 
material. A material can make your object 
shiny, dull, or transparent, but the textures 
within that material are what make it look like 
wood, rock. water or clouds. 

Textures define the color, pattern or bumps 
within a material. A material can contain up to 
four textures. These textures can be used to 
drive the channels that make up the material. 
So, by altering the make-up or pattern of a 
texture you can dramatically alter the 
appearance of a material. 



Texture Structure
A Bryce texture can be made up of three 
components. These components contribute the 
raw patterns or textures within a texture. Each 
component can then contribute one of three 
types of output to the final texture. These 
outputs are then combined to create the final 
texture.  

Within each component is a combination of 
colors and noise that create a pattern. Noise is 
what creates the pattern within the texture. The 
shape of the noise inside a component is 
determined by the phase of the noise and the 
filter applied to it. The filter can create 
coherent patterns, random spots or anything in 
between. Refer to “Noise” on page 248, “Phase” 
on page 255 and “Filtering” on page 261 for 
more on Noise, Phase and Filtering. 

 

A component can contribute one of three types 
of output to the final texture: Color output, 
which determine the colors in a texture, Alpha 
output, which determines the bright and dark 
areas in a texture, and Bump output, which 
determines the size and pattern of bumps in 
the texture. 

The component can contribute any 
combination of outputs. So you can have a final 
texture that contains Color output, Alpha 
output, and Bump output, or it can have all 
Color output or all Bump, or any combination 
of the three. 

The outputs in a texture are used by the 
material, so the type of output you have in a 
texture depends entirely on how you want to 
use the texture in the material. For example, if 
you’re using the texture as a bump map for the 
Bump Height channel in a material, you’d 
probably want all the components to contribute 
only Bump output. 

A texture can contain up to three components. 
It can be made up of all three components or 
just one, depending on the type of texture you 
want to create. The more components you use, 
the more complex your texture. 

This diagram shows the structure of a texture.

C C CA AAB B B

COMBINED

FINAL TEXTURE

Result

Component 1 Component 2 Component 3

This diagram shows the structure of a texture including 
the structure of a component.

C C CA AAB B B

COMBINED

FINAL TEXTURE

Result

Component 1 Component 2 Component 3

NOISE

FILTER

NOISE

FILTER

NOISE

FILTER
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Components are combined using Blend Modes. 
These modes can create a wide range of effects.  

Components are combined differently 
depending on how many you use. If you use 
one or two they are combined according to the 
blend method you select. If you use three, the 
first two components are combined, and the 
resulting texture is then combined with the 
third component to create the final texture. 

The texture components are combined together 
to form the final Combination texture. The final 
texture can have its own color scheme, noise, 
phase or filter. Any changes you make to the 

combination texture changes the final texture. 
These types of operations are called Global 
changes. Refer to “Global Changes” on 
page 270 for more on global changes. 

The end result of the Global changes is the 
final texture which can then be used in the 
Materials lab to create a material.

Components vs. Texture 
Components

Before you get any deeper into the discussion 
of texture structure you should understand a 
little terminology. 

A texture is a part of a material. It can be used 
to drive any of the material’s channels. When 
you use a texture in a materials it’s called a 
material component.

The texture itself also has components. It can 
be made up of up to three components that 
determine the look and color of the texture. 

The way components are combined to create the final 
texture is determined by the Blend Mode you select.

When you use three components, the first two components 
(C1 and C2) combine to create a hybrid texture which is 
then combined with the third component (C3) to create the 
final texture. So they’re combined using the formula 
(C1+C2)+C3=FINAL.

C CA AB B

COMBINED

Component 1 Component 2

BLEND MODE

C C CA AAB B B

COMBINED

Component 1 Component 2 Component 3

RESULT

FINAL TEXTURE

When the components are combined they produce the 
combination texture. This texture can have its own color 
scheme, noise, phase or filter. These operations are called 
Global changes.

Changes 
to this 
texture 
are global
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The components that make up a texture are 
called components. 

Understanding Component 
Structure

A texture can have up to three components. 
When combined, the components create the 
final texture. A component consists of noise 
and color. 

A component can have up to three colors. The 
combined texture can also have a different set 
of three colors which is added to the colors 
from the components. In total your texture can 
contain up to twelve colors. 

The noise in a component is made of base 
Noise which is modified by the Phase, which 
controls the complexity of the noise, and the 

Filter, which determines the shape or pattern of 
the noise.

Components and Output

A component’s output type determines what 
type of information it’s going to contribute to 
the final texture. The Output type also 
determines the component’s structure. A 
component that does not have a Color output 
won’t contain any color information. The same 
is true for the two other types of output. If 
there’s no Alpha or Bump output there’s no 
Alpha or Bump information in the component.

Component Output
The main purpose of creating a component is 
to use it as part of a material which will then be 
applied to an object. How and what a texture 
contributes to a material is determined by the 
type of output it produces.

A texture can produce three different types of 
output: Color, Alpha and Bump.

When you apply a texture to a material, you can 
see the output types in the Texture Component 
Window in the Materials Lab.

The difference between components and texture 
components may be a bit confusing. Just remember that 
when you’re talking about a texture, you’re dealing with 
components. When you’re working with materials, you’re 
using texture components.

COMPONENT

COMBINED

TEXTURE TEXTURE

MATERIAL

TEXTURETEXTURE

C1 C2 C3

TEXTURE COMPONENTS

A component consists of noise and color. The Noise is 
modified by the Phase and the Filter. Each component can 
then produce Color, Alpha or Bump output.
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Refer to “Texture Components” on page 209 for 
more on using textures in materials.

In the Deep Texture Editor, the output type for 
a component is indicated by the three output 
buttons along the left side of the Component 
Window.

Assigning Output Types

A texture can produce all three output types or 
only one. The number of output types for the 
final texture depends on the output you assign 
to the components. A component can produce 
one or all three types of outputs. 

You can assign more than one component to 
the same output type. If you do have more than 
one component with the same output type, the 
output information will be blended to produce 
a final output.

For example, if you have two components that 
produce Color output, when you combine them 
the colors from both components are blended 
together and the result is applied to the final 
texture.

In order to produce an output type, a final 
texture must contain at least one component 
that produces the type of output you want. For 
example, if you want your final texture to 
contain color output, at least one of its 
components must produce color output.

Each output type contributes something 
different to the final material. 

Color Output

Color output is used by the color channels of a 
material. The color values you assign to a 
textures’s components are combined to form a 
final texture. The combined values are then 
used to drive the Diffuse, Ambient, Specularity, 
Specular Halo, or Transparency color channels. 
Refer to “Understanding Surface Material 
Channels” on page 190 for more on these 
channels.

The colors in a texture usually appear in the 
form of a pattern or grain. When you assign the 

The three boxes in the Texture Component Window in the 
Materials Lab represent the three output types available 
for a texture. 

If a texture does not produce a particular output the box 
appears gray.

The three buttons along the right side of the Component 
window indicate the output type for a component. If a 
button appears depressed, it means that the component 
produces the selected output type.

Color output Alpha output Bump output

Color output

Alpha output

Bump output
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texture to a material, this pattern appears in the 
final material.

To assign Color output to a texture:

1 Display the Deep Texture Editor.

2 In the desired component window, click 
the C button on the right side of the 
component window.

Alpha Output

Alpha output is used by the various Intensity 
and Optic channels of the material. When a 
texture’s Alpha output is assigned to a material, 
it’s used to either to determine an effect’s 
intensity or as a guide map for combining 
multiple textures.

When there is only one texture component in a 
material channel, the texture’s Alpha output is 
usually used to determine the intensity of a 
channel effect. For example, if you assign a 
texture to the Diffuse channel, the texture’s 
Alpha output is used to determine which areas 

are the most diffuse and which are the least 
diffuse.

To assign Alpha output to a texture:

1 Display the Deep Texture Editor.

2 In the desired component window, click 
the A button on the right side of the 
component window.

Bump Output

The Bump output is used only by the Bump 
Height material channel to determine the 
pattern and height of the bumps in a material.

The texture in this example was applied to the Diffuse 
color and Ambient Color channels of the object’s material. 
You can see how the color pattern in the texture appears in 
the material.

Original Texture

Material containing texture

The texture in this example was applied to the Diffuse 
channel of the object’s material. You can see how the alpha 
pattern in the texture controls the diffuse intensity on the 
object’s surface.

The texture in this example was applied to the Bump 
Height channel of the object’s material. You can see how 
the bump output in the texture controls the pattern of 
bumps on the object’s surface.

Original Texture

Material containing texture

Original Texture

Material containing texture
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To assign Bump output to a texture:

1 Display the Deep Texture Editor.

2 In the desired component window, click 
the B button on the right side of the 
component window.

Component Elements
A texture is made up of components. Each of 
those components can contain several elements 
that determine the color, pattern, grain or 
bumps in the component.

The Component window

You can have up to three components in your 
texture. As you activate components, a 
component window becomes active. Each 
window displays a preview of the component 
elements. 

The three buttons on the Component window 
let you access the Noise palette, the Filtering 
palette and the Phase palette. The buttons 
along the right side of the window indicate the 
type of output produced by the component.

To activate a component:

1 Display the Deep Texture Editor.

2 Click the component selector in the top-
left corner of the editor.

The selector lets you choose from 1, 2, or 3 
components.

Color

The colors in a component determine its color 
scheme. Each component can have up to three 
colors. Colors can be chosen using the color 
picker or the Color dialog. 

The color in a component is affected by the 
noise, phase and filter. You can create some very 
interesting patterns of color by modifying the 
noise. The color pattern created by the changes 
in the noise is applied directly to the final 
texture. So even if Color is the only output type 
for the component you’ll still see a pattern in 
your final texture.

When the Color Output is selected for a 
component, only the color information is 
combined with the other components. Also, 
when you apply the texture to a material, the 
colors in the component contribute to the 
colors used in the Color channels of the 
material.

The Component window displays the selected component 
and its current attributes.

Open Noise palette

Open Filtering 
palette

Alpha output
Color output

Component 
Colors

Open Phase 
palette

Bump 
Output

Color Modes

Randomize 

Reset Component

The component selector lets you pick how many 
components you want to use to build your texture.
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There are two color models you can use to 
create colors in the components: RGB and 
HLS. RGB combines red, green and blue to 
create color. HLS combines Hue, Lightness 
and Saturation values to create color. The 
method you choose depends on the final output 
of your Bryce scene. RGB usually works best for 
most types of output.

If the Color output is not active for a component, 
changing the colors or Color Blending Modes 
has no effect.

To activate Color output for a component:

1 Display the Deep Texture Editor.

2 In the desired component window, click 
the C button. 

An output type is active when the button 
appears light gray.

To choose colors for a component:

1 Display the Deep Texture Editor.

2 In the desired component window, make 
sure the C button is selected.

3 Click one of the color indicators along the 
left side of the component window and 
choose a color from the palette. 

To mix colors for a component:

1 Display the Deep Texture Editor.

2 In the desired component window, make 
sure the C button is selected.

3 Option/Alt-click the one of the color 
indicators along the left side of the 
component window. The Color dialog 
appears. 

4 Choose a color model by clicking one of 
the buttons along the bottom of the dialog.

5 Enter color values or adjust the sliders to 
mix a new color.

6 Click the OK icon.

The three buttons along the right side of the component 
window display the component’s output type.

The three color indicators along the left side of the window 
display the colors used in the component.

The Color dialog lets you mix a color to use in the 
component by entering values or adjusting the color 
sliders.
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Color Blending Modes

There are several blending modes you can use 
to create a color scheme.

To choose a Color Blending mode:

1 Display the Deep Texture Editor.

2 In the desired component window, make 
sure the C button is active.

3 Click the triangle icon in the lower left 
corner of the window and choose a mode 
from the menu. 

None

No blending is applied. 

Red or Hue

When the RGB model is used, this mode 
outputs only red color values. When the HLS 
model is used, only Hue values are output. 

This mode and the Green or Light, and Blue or 
Saturation mode are available so that you can 
separate color values among the components. 
For example, you could set each component to 
output one of the different color values.

Green or Light

When the RGB model is used, this mode 
outputs only green color values. When the HLS 
model is used, only Lightness values are 
output. 

Blue or Saturation

When the RGB model is used, this mode 
outputs only blue color values. When the HLS 
model is used, only Saturation values are 
output. 

Spline Interpol

This mode creates a blend between all the 
colors in the component.

The pop-up lists all the Color Blending Modes available in 
the Deep Texture Editor.

This is what a color blend looks like using Spline Interpol.
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Linear Interpol 2

This mode creates a linear blend between the 
first two colors selected for the component.

Linear Interpol 3

This mode creates a linear blend between all 
the colors in the component.

Randomized

In this mode the three colors are blended and 
then applied randomly throughout the 
component. 

Earth Map

In this mode extra colors are generated 
according to the contours of the component’s 
bump map. The three colors you selected for 
the component are applied to the middle range 
of the bump map. Blue is applied to the lowest 
bump values and white is applied to the highest 
values to simulate polar caps. Earth Map is 
excellent for creating planets. 

Banded

In this mode colors are applied in bands. The 
bands are determined by color values. Colors 
with the lowest value (i.e. dark colors) are 
applied to the bands furthest from the center, 
colors with middle range values are applied 
next and colors with the highest values (i.e. 
bright colors) are applied closest to the center. 

This is what a color blend looks like using Linear Interpol 
2.

This is what a color blend looks like using Linear Interpol 
3.

This is what a color blend looks like using Randomized.

This is what a color blend looks like using Earth Map.

This is what a color blend looks like using Banded.
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Perturbed

In this mode colors are applied in irregular 
patterns. 

Interferences

In this mode the red, green and blue values of 
the first color in the component are used to 
create a repeating pattern around the contours 
of the component’s noise. 

Interpol + Interferences

This mode is a combination of Linear 
Interpolation and Interferences. 

Altitude

In this mode a white layer is added above the 
colors at high altitudes. Any portion of the 
object below ground is automatically colored 
blue. Altitudes are based on the object’s height. 

Spline with Snow

This mode performs a spline interpolation of 
the colors in the component, but adds a white 
layer above the colors at high altitudes. 
Altitudes are based on the object’s height. 

This is what a color blend looks like using Perturbed.

This is what a color blend looks like using Interferences.

This is what a color blend looks like using Interpol + 
Interferences.

This is what a color blend looks like using Altitude.

This is what a color blend looks like using Spline with 
Snow.
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Slope

In this mode the three colors are applied to the 
object depending on its slope. 

Orient

In this mode the three colors are applied to the 
object according to its east-west orientation. 

Noise

Noise is the basis of all the textures. It is the 
background turbulence that creates the basis 
for texture patterns. 

In audio terms you can think of noise as the 
background static that you hear on old 
recordings. Sound is layered on top of this 
noise to create music. Like in audio, you layer 
other functions on top of the noise in your 
texture to create the final pattern or look of 
your texture. 

There are two ways of creating noise: the Noise 
palette or the Noise Editor.

The Noise palette can increase or decrease the 
amount of noise in any of the texture 
components. However, using the palette, you 
can only edit the existing noise. 

To display the Noise palette:

1 Display the Deep Texture Editor.

2 Click the Noise button at the bottom of the 
editor. The Noise palette appears.

or

• Click the Noise button in the top-left 
corner of on any of the component 
windows.

This is what a color blend looks like using Slope.

This is what a color blend looks like using Orient.

The Noise palette lets you increase or decrease the amount 
of noise in a component.

The three buttons at the bottom of the Deep Texture Editor 
let you display the Noise, Phase and Filter palettes.

The three buttons along the outside of a component 
window let you display the Noise, Phase and Filter 
palettes.

Component Indica torOpen Noise 

Noise slider

Editor
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The Noise Editor is much more powerful than 
the Noise palette. It contains controls for 
creating noise from scratch. 

To display the Noise Editor:

1 Display the Deep Texture Editor.

2 Click the Noise button at the bottom of the 
editor. The Noise palette appears.

3 Click the top-left corner of the palette. The 
corner turns green as you pass your cursor 
over it. 

Creating Noise

The Noise editor is the tool you’ll use to create 
noise with a component or combined texture. 
The noise creation process involves several 
steps:

• Choose the number of dimensions in the 
noise.

• Choose a Noise Type. This will give the 
basis for creating a noise pattern or grain.

• Adjust the frequency of the noise.

• Adjust the orientation of the noise.

• Apply a modifier to your noise, by 
choosing a Noise Mode.

The following sections describe the various 
parts of the editor and how to use them in the 
noise creation process.

Noise Dimensions

Texture in Bryce can exist in 3D so your noise 
can have up to three dimensions. Noise 
dimensions determine which axes you can use 
to adjust the orientation and frequency of the 
noise.

It’s easier to see the number of dimensions for 
your noise if you use a cube in the Noise Preview.

The Noise Editor lets you create noise and adjust its 
properties.

The top-left corner of the Noise palette lets you display the 
Noise Editor.

No. of Dimensions

Direction Controls

Frequency Cont rol s

Octaves Noise Mode

Noise Type Noise Preview

These three examples show the difference between 1D, 2D 
and 3D noise.

1D Noise 2D Noise 3D Nois
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To choose the number of dimensions for 
your noise:

1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Click one of the dimension buttons at the 
bottom of the editor.

Noise Type

There are 27 different types of noise available 
in the Noise Editor. Random noise is the 
default (RND). 

Each noise type provides you with a different 
basic pattern to start your texture. Some are 
more linear or geometrical while others are 
more random.

More complex noise types require more 
rendering time. The time it takes to render the 
preview is a good indication of how long the 
final texture will take to render. 

You should use the more complex noise types 
cautiously. 

The best way of choosing a noise type is to 
apply a few to your component and see how 
they look. Remember that this noise is only the 
basis of the texture. You can still edit this noise 
using the other controls in the editor, so don’t 
discard a noise type because it’s not perfect. 
The other controls can help you fine-tune the 
noise.

To choose a noise type:

1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Click the type field at the top of the editor 
and choose a noise type from the menu.

The three buttons at the bottom of the editor let you choose 
between 1D, 2D and 3D noise.

These are examples of the some of the types of noise 
available.

The Type area at the top of the editor displays the name of 
the currently selected noise type.
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Noise Frequency

Noise Frequency determines how often the 
pattern within a texture repeats. Frequency is 
like scaling the noise. Higher frequencies 
decrease the scale of the noise so you can see 
the pattern more often. Lower frequencies 
increase the scale of the noise so the pattern 
repeats less often. 

You can change noise frequency using the 
Frequency fields. The fields let you enter 
numerical values to adjust the noise frequency 
along the X, Y or Z axis. You can also adjust the 
values using the scroll arrows. 

The number of dimensions in the noise 
determines how many axes you can use to 
adjust the frequency. For 1D noise you can only 
use the X axis. With 2D noise you can use both 
the X and Y axes. For 3D noise you can use all 
the axes.

If you try to adjust the Z axis frequency for a 2D 
noise, your changes will have no effect.

Adjusting the frequency can radically change 
the look of your noise. If you adjust the 

frequency in separate axes, you can achieve 
even more interesting effects.

 

To change the frequency of noise:

1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Drag over the X field in the Frequency area 
to set the noise frequency in the X axis. 

Drag left to decrease the value or right to 
increase it.

4 Drag over the Y field in the Frequency area 
to set the noise frequency in the Y axis.

5 Drag over the Z field in the Frequency area 
to set the noise frequency in the Z axis.

The Frequency fields let you enter values to precisely 
control the noise frequency along the X, Y or Z axes.

Noise frequency settings control the repetition of patterns 
in a component.

In this example, the noise frequency was changed in only 
the Y axis.

Frequency Frequency Frequency 
=100

Frequency X=10 Y=80 Z= 10
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You can also drag over the scroll arrows to speed 
up the increments.

Noise Orientation

Noise Orientation controls the direction of the 
noise. Noise has a grain or a fixed up and down, 
when you adjust the orientation you change 
how the noise is laid out within the texture.

When you apply a texture, the direction of the 
noise within the texture remains constant 
regardless of the orientation of the object. 

Since noise can exist in three dimensions, you 
adjust the direction of the noise in the X, Y, or 
Z axis.

The number of dimensions in the noise 
determines how many axes you can use to 
adjust the orientation. For 1D noise you can 
only use the X axis. With 2D noise you can use 
both the X and Y axes. For 3D noise you can 
use all the axes.

You can edit the noise orientation using the 
Direction numerical fields.The fields let you 
enter precise angles for noise orientation. You 
can also use the scroll arrows to set the angle in 
increments. 

Changing noise orientation can dramatically 
change the look of your noise. You’ll see just 

how different your noise can look when you 
rotate it along a single axis. 

To change the orientation of noise:

1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Drag over the XY field in the Direction 
area to set the noise angle in the X and Y 
axes. 

Drag left to decrease the value or right to 
increase it.

4 Drag over the YZ field in the Direction area 
to set the noise angle in the Y and Z axes.

You can also drag over the scroll arrows to speed 
up the increments.

Noise Octaves

Noise octaves are like musical octaves. In a 
musical scale, if you play F and then F an 
octave down, you’re playing the same note, only 
it sounds lower. If you play both notes at the 
same time, the sound is more complex than if 
you played only one note. The same is true of 
noise. When you add an octave to noise it 

The Direction fields let you enter rotation angles to 
precisely control the noise direction along the X, Y or Z 
axes.

Noise orientation controls the direction of the noise.

Rotation in Rotation in Rotation in XYZ
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becomes more complex but the type of noise 
remains the same. 

Increasing the octaves adds processing time to 
the component.

To change the number of octaves:

1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Drag over the octaves field at the top of the 
editor. 

Noise Modes

Noise modes modify the octaves of a noise. As 
you add complexity by increasing the octaves, 
the Noise Modes let you modify the additional 
noise so that it produces different effects. 

Many of the Noise modes use dark and light 
values to modify the existing noise. Also, you 
may not see the effects of the modes if the 
Octave is set to 0.

To choose a Noise Mode:

1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Click the Mode field at the top of the editor 
and choose a mode from the menu. 

There are thirteen noise modes available:

Standard

This mode adds a new octave to the noise at 
half the frequency and twice the amplitude. 
This is the default mode.

Irregular

This mode adds a new octave to the noise at 
half the frequency and twice the amplitude. 
However, in this mode higher frequency noise 
is modified more than the rest. The end result 
is that more detail is added to the noise.

These examples use RND Continuous noise and RND 
Linear noise to show the effects of increasing octaves.

The octaves field at the top of the editor displays the 
number of octaves currently applied to the noise.

1 Octave 2 Octaves 3 Octaves

In this example, Standard mode was applied to RND 
Continuous noise.

In this example, Irregular mode was applied to RND 
Continuous noise.
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More Irregular

This mode works exactly like Irregular except 
that this mode is more intense.

Maximum

This mode uses the only the highest values, or 
lightest areas, to produce the modified noise.

Mulitfractal

In this mode lighter areas create higher 
contrast noise.

With Rotation

In this mode each additional octave is rotated. 
With Rotation mode it’s easier to see linear 
noise types.

Minimum

This mode uses only the lowest values, or 
darkest areas, to produce the modified noise.

Multiply

In this mode all the values in the noise are 
multiplied together. The results is a darker 
noise.

In this example, More Irregular mode was applied to 
RND Continuous noise.

In this example, Maximum mode was applied to RND 
Continuous noise.

In this example, Mulitfractal mode was applied to RND 
Continuous noise.

In this example, With Rotation mode was applied to RND 
Linear noise.

In this example, Minimum mode was applied to RND 
Continuous noise.

In this example, Multiply mode was applied to RND 
Continuous noise.
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Difference

In this mode all the values in the noise are 
evaluated. All the values that are equal create 
black areas. When the values are different, the 
lower value becomes darker. The more octaves 
you have in the noise, the darker the modified 
noise. Difference works even at 0 octaves.

Minimum 90

This mode repeats the noise at a 90° angle from 
its original orientation and combines the 
original and copy using only the highest values. 
This mode is good for creating woven patterns.

Maximum 90

This mode repeats the noise at a 90° angle from 
its original orientation and combines the 
original and copy using only the lowest values.

Auto-phased

This mode automatically introduces phase 
shifts into the noise.

Displaced Max

This mode creates a copy of the noise and 
displaces noise by a small amount and then 
lightens any areas where the two overlap. This 
mode is good for creating stone textures.

Phase

Phase introduces turbulence into your noise. 
The phase displaces the grain or patterns 
within the your noise. When you design the 
phase, you’re creating a displacement map 
along which the noise will be modified.

You can control how the phase interacts with 
your noise using the Phase palette. You can 
design your phase using the Phase Editor. 

In this example, Difference mode was applied to RND 
Continuous noise.

In this example, Minimum 90 mode was applied to RND 
Continuous noise.

In this example, Maximum mode was applied to RND 
Continuous noise.

In this example, Auto-phased mode was applied to RND 
Continuous noise.

In this example, Displaced Max mode was applied to 
RND Continuous noise.
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The Phase palette controls the amplitude. The 
phase amplitude controls the intensity of the 
displacement. As the amplitude is increased, 
there is more interference with the original 
noise. 

You won’t have to increase the amplitude very 
much before you start seeing the phase pattern 
you designed interfere with the existing noise. 
In fact, it’s probably a good idea to keep the 
phase amplitude low so that the phase pattern 
doesn’t overwhelm the noise. 

To display the Phase palette:

1 Display the Deep Texture Editor.

2 Click the Phase button at the bottom of the 
editor. The Phase palette appears.

or

The Phase palette lets you increase or decrease the 
amplitude of the phase in a component.

Am plitude Slider

Open Phase Editor
Component Indicator

This graph shows how the phase interacts with the noise at 
different amplitude settings.

The three buttons at the bottom of the Deep Texture Editor 
let you display the Noise, Phase and Filter palettes.

Phase Nois e

Phase=10 Phase=30

Phase=50 Phase=250

Original Noise
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• Click the Phase button in the bottom-
right corner of any of the component 
windows.

The Phase Editor looks a lot like the Noise 
Editor. It has the same type of tools and they 
work exactly like they do in the Noise Editor. 
The difference is that you’re using noise 
patterns, orientations, frequencies and modes 
to design how the basic Noise will be displaced.

Using the Phase Editor you can perform several 
functions:

• Create 1D, 2D, or 3D phase.

• Change the type of noise.

• Change the frequency of the phase.

• Change the orientation of the phase.

• Change the noise octaves.

• Change the noise modulations.

While the Phase Editor lets you create the 
noise pattern or grain within the phase, the 
Phase palette controls how that phase is 
applied to the component or the combined 
texture. 

To display the Phase Editor:

1 Display the Deep Texture Editor.

2 Click the Phase button at the bottom of the 
editor. The Phase palette appears.

3 Click the top left corner of the palette. The 
corner turns green as you pass your cursor 
over it. 

The three buttons along the outside of a component 
window let you display the Noise, Phase and Filter 
palettes.

The Phase Editor lets you create noise to use as phase.

The top left corner of the Phase palette lets you display the 
Phase Editor.

Number of Dimensions
Frequency

Direction Controls

Phase Preview 
Noise Type

Noise Mode

Octaves

Controls
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Creating Phase

Phase is designed using the Phase Editor. The 
phase creation process involves several steps:

• Choose the number of dimensions in the 
phase.

• Choose a noise type. This gives the basis 
for creating a phase pattern or grain.

• Adjust the frequency of the noise.

• Adjust the orientation of the noise.

• Apply a modifier to the noise by choosing a 
Noise Mode.

You’ll notice that many of the steps for creating 
the phase are the same as those for creating 
noise. That’s because you are creating noise. 
The difference is that instead of applying the 
noise to the texture, the noise you create for the 
phase is used to displace the existing noise.

The following sections describe the various 
parts of the editor and how to use them in the 
noise creation process.

Phase Dimensions

Just like noise, you can set the dimensions of 
the phase. The number of dimensions 
determines which noise axes will be displaced 
when you apply the phase. For example, if you 
apply a one-dimensional phase to a three- 
dimensional noise, only the X axis of the noise 
will be displaced.

Its easier to see the number of dimensions for 
your phase if you use a cube in the Phase Pre-
view.

To choose the number of dimensions for 
your phase:

1 Display the Deep Texture Editor.

2 Display the Phase Editor.

3 Click one of the dimension buttons at the 
bottom of the editor.

Phase Noise Type

There are 27 types of noise available in the 
Phase Editor. Random Noise is the default 
(RND). 

In this example, a 1D phase was applied to a 3D noise.

The three buttons at the bottom of the editor let you choose 
between 1D, 2D and 3D phase.

3D Noise 1D Phase

Combined Texture
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Each noise type provides you with a different 
basic pattern for the phase. The noise types 
available in the Phase Editor are the same as 
those in the Noise Editor, so you can refer to 
“Noise Type” on page 250 for more on noise 
types. 

Phase Frequency

Phase frequency determines how often the 
pattern within the noise repeats. Frequency is 
like scaling the noise. Higher frequencies 
decrease the scale of the noise so you can see 
the pattern more often. Lower frequencies 
increase the scale of the noise so the pattern 
repeats less often. 

You can change phase noise frequency using 
the Frequency numerical fields. The fields let 
you enter numerical values to adjust the noise 
frequency along the X, Y or Z axis. You can also 
adjust the values using the scroll arrows. 

The number of dimensions in the phase 
determines how many axes you can use to 
adjust the noise frequency. For 1D phase you 
can only use the X axis. With 2D phase you can 
use both the X and Y axes. For 3D phase you 
can use all the axes.

Adjusting the frequency of the Phase noise 
disproportionately can have some very 
interesting effects on your noise. 

To change the frequency of phase noise:

1 Display the Deep Texture Editor.

2 Display the Phase Editor.

3 Drag over the X field in the Frequency area 
to set the phase noise frequency in the X 
axis. 

Drag left to decrease the value or right to 
increase it.

4 Drag over the Y field in the Frequency area 
to set the Phase noise frequency in the Y 
axis.

In this example, the phase noise frequency was changed in 
only the Y axis and then applied to 3D noise.

The Frequency fields let you enter values to precisely 
control the noise frequency along the X, Y or Z axes.

Frequency X=10 Y=80 Z= 10
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5 Drag over the Z field in the Frequency area 
to set the Phase noise frequency in the Z 
axis.

You can also drag over the scroll arrows to speed 
up the increments.

Phase Noise Orientation

Phase noise orientation controls the direction 
of the noise within the phase.

The number of dimensions in the phase 
determines how many axes you can use to 
adjust the orientation.

You can edit the noise orientation using the 
Direction numerical fields.The fields let you 
enter precise angles for noise orientation. You 
can also use the scroll arrows to set the angle in 
increments. 

Like frequency, changing the orientation of the 
phase noise in only one or two axes can create 
some very interesting results. 

To change the orientation of phase noise:

1 Display the Deep Texture Editor.

2 Display the Phase Editor.

3 Drag over the XY field in the Direction 
area to set the noise angle in the X and Y 
axes. 

Drag left to decrease the value or right to 
increase it.

4 Drag over the YZ field in the Direction area 
to set the noise angle in the Y and Z axes.

You can also drag over the scroll arrows to speed 
up the increments.

Phase Noise Octaves

Phase noise octaves work exactly like the noise 
octaves. They introduce an extra level of 
complexity to the noise. Refer to “Noise 
Octaves” on page 252 for more on octaves.

The Direction fields let you enter rotation angles to 
precisely control the noise direction along the X, Y or Z 
axes.

In this example, the phase noise orientation was changed 
in only the Y axis and then applied to 3D noise.
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Phase Noise Modes

Phase noise modes work exactly like the noise 
modes. They modify the octaves of a noise. 
Refer to “Noise Modes” on page 253 for more 
on octaves.

Filtering

The filter you apply to the noise in a 
component can change the entire look of the 
noise. The filter refines the noise so that it has 
more or less detail, increases its contrast, 
applies it only at high altitude or changes its 
spatial orientation. Whatever the change, the 
filter has a profound effect on the final look of 
your texture.

Filters are expressed as equations with 
variables. When the equation is applied to the 
noise, it changes some aspect of the noise. You 
can control how the equation affects the noise 
by changing the values of the variables. 

The filter only affects the noise. The phase 
cannot be altered using a filter. The phase is 
blended with the noise. 

Filters are edited using the Filtering palette. 
The palette displays the current filter and 
provides tools for editing the filter graph.

To display the Filtering palette:

1 Display the Deep Texture Editor.

2 Click the Filtering button at the bottom of 
the editor.

or

• Click the Filtering button in the top-
right corner of any of the component 
windows.

The Filtering palette displays the current filter and 
provides tools for editing it.

The three buttons at the bottom of the Deep Texture Editor 
let you display the Noise, Phase and Filter palettes.

The three buttons along the outside of a component 
window let you display the Noise, Phase and Filter 
palettes.

Rest button Filt er Variable s

Filtering Equation Filt ering graph

Component Indicator
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Editing the Filter

Filters are equations which have variables. 
Each equation can have up to three variables 
labeled a, b and c. The values for each variable 
are displayed at the bottom of the palette. 
Generally, a controls the intensity of the filter 
effect while b controls the overall height. In 
some filters a and b may stand for other things.

There are two ways you can adjust a filter: by 
changing the variable values or by changing the 
shape of the graph (which automatically 
changes the variable values). The method you 
use depends on how much you know about a 
particular filter. If you’re not sure what the filter 
does, change the graph—it’s a much more 
intuitive way of working.

To edit the Filtering graph:

1 Display the Filtering palette.

2 Drag over the Filtering graph area. The 
shape of the graph changes as you drag. 

Notice that the variables also changes as 
you move the graph.

• Dragging horizontally changes the 
value of a.

• Dragging vertically changes the value of 
b.

To change variable values:

1 Display the Filtering palette.

2 Drag over the variable field you want to 
change. Drag left to reduce the value or 
right to increase it.

The shape of the graph changes as you adjust 
the values.

Choosing a Filter

Each filter available in the Filtering palette 
offers something unique. The best way of 
choosing which filter you want to use is to 
apply it to a component and see what happens.

To choose a filter:

1 Display the Deep Texture Editor.

2 Display the Filtering palette.

3 Click the Filtering Equation area and 
choose a filter from the menu.

There are fourteen filters available. The 
following sections describe the filters and gives 
you some idea of how to edit them.

None

This option deactivates the filter. No filtering is 
applied to the component.

Quantize

This filter works like a Posterize effect. When 
its applied, gray values jump from one value to 
the next, creating a blocky stair-step type of 
effect. 

The graph area of the Filtering palette lets you 
interactively adjust the filtering effect.
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In this filter a and b control the contrast and 
height, while c controls the number of levels 
between white and black.

Saw Wave

When the graph for this filter has only a small 
curve, it acts like a contrast filter. As it 
approaches the height limits (set by b), it 
bounces back on itself. This creates high-
contrast breaks in the noise. 

For color output use this filter to get areas of 
high-contrast alternating color. 

When you set the value of a to a high number 
you’ll get areas with a larger amount of noise.

Sine Wave—Sin (aX) + b

This filter creates noise that appears as large 
number of lines that are oriented in the same 

direction. Use this filter to generate wood 
grains. 

The a variable controls the number of lines. 
Higher values create a better effect.

Absolute—Abs(aX + b)

This filter works like a Difference effect. When 
it’s applied, you’ll get more light areas in your 
noise and a higher level of detail in a bump 
map. 

To get additional bump information using this 
filter, set a to 2 and b to -1.

In this example, Quantize was applied to RND 
Continuous noise.

In this example, Saw Wave was applied to RND 
Continuous noise.

RND Continuous
Noise

RND Continuous
Noise + Quanti z

In this example, Sine Wave was applied to RND 
Continuous noise.

In this example, Absolute was applied to RND Continuous 
noise.
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XPower—(X PWR a) + b

This filter smooths out the darkest areas of your 
noise. However it has less effect on lighter areas 
and no effect on white.

Gaussian—(a(X + b))

This filter smooths out darker areas of your 
noise and makes lighter areas noisier. White 
areas become the noisiest.

Clip aX + b

Clip is probably the filter you’ll use most. It’s a 
contrast filter. 

The a variable controls the contrast and b 
controls the overall brightness. 

For a low contrast effect make the wave in the 
graph smaller. Decrease the value of a to reduce 
the size of the wave and increase b to move the 
wave up. Using this wave, all the values will be 
expressed as mid-gray.

For a high contrast effect, adjust the wave so 
that it hits both the top and bottom edges of the 
preview. Increase the value of a and make b 
negative to move the curve down. 

To invert the colors in your noise, make a 
negative and increase b.

Altitude Minus Slope—Xb + a 
(Altitude-Slope)

This filter applies noise only at certain 
combinations of slope and altitude. When a is 
positive and b is negative, noise is applied at 
high altitudes and on flat surfaces.

When a is negative and b is positive, noise is 
applied at low altitudes and on steep slopes.

In this example, XPower was applied to RND Continuous 
noise.

In this example, Gaussian was applied to RND 
Continuous noise. In this example, different levels of Clip were applied to 

RND Continuous noise.
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The Altitude Minus Slope filter works on the 
slope and altitude of an object in World Space. 

Slope—X(a * Slope + b)

This filter applies noise based on an object’s 
slope. Slope can range anywhere from flat and 
horizontal to steep and vertical. This is an 
excellent filter to use if you want to isolate a 
texture to vertical cliffs or flat surfaces. 

In this filter a determines the steepness of the 
noise (-4 is flat, 4 is vertical). The b variable 
controls the starting point of the transition.

• To place noise on vertical surfaces make 
a=4 and b=2.

• To place noise on flat surfaces make a=-4 
and b=1.5.

The Slope filter works on the slope of an object 
in World Space. 

Altitude—X(a* Altitude + b)

This filter modulates the scale of the noise 
according to an object’s altitude. 

In this filter a determines how fast the noise is 
scaled by altitude. A lower value creates a 
gradual transition, while higher values create 
sharper transitions. 

To apply noise at higher altitudes make sure a is 
positive. At high altitudes b controls the 
transition. The higher the transition, the lower 
the number. So, at high altitudes b should be a 
negative number.

To apply noise at lower altitude, reverse the 
variables so that a is negative and b is positive.

The Altitude filter works on the altitude of an 
object in World Space. 

In this example, Altitude Minus Slope was applied to RND 
Continuous noise and then to objects in a scene.

In this example, Slope was applied to RND Continuous 
noise and then to objects in a scene.
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Orientation—X(a * Orientation + b)

This filter applies noise based on an object’s 
east-west orientation. 

Smooth Clip

This filter works exactly like the Clip filter. It’s 
also a contrast filter, except that this filter 
smooths out the transitions between darks and 
grays. 

The a variable controls the contrast and b 
controls the overall brightness.

Snow Puddles

This filter turns noise into snow patches. Snow 
is applied according to an object’s slope and 
altitude. 

The a variable controls how much the noise 
interferes with the smoothness of the snow. 
When a=0 the noise doesn’t interfere at all so 
the snow is perfectly smooth. When the a value 
is higher, the snow starts looking like the noise.

The b variable shifts the altitude or snow level. 
It sets where the snow begins.

The c variable controls how steep an object has 
to be before the snow appears on its surface. 

In this example, Altitude was applied to RND Continuous 
noise and then to objects in a scene.

In this example, Orientation was applied to RND 
Continuous noise and then to objects in a scene.

In this example, Smooth Clip was applied to RND 
Continuous noise.
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The higher the number, the flatter an object 
has to be before snow appears on its surface. 

Combining Components
The Deep Texture Editor gives you unparalleled 
control over the look and feel of each one of the 
components that make up a texture, but the 
control doesn’t stop there. The Deep Texture 
Editor also lets you control how those 
components are combined to create the final 
texture. 

Blend Modes

Components are combined using Blend modes. 
These modes are filters applied to the 
components to determine how the properties 
in each component are combined with the 
other components’ properties to form the final 
texture.

The number of blend modes you can use varies 
depending on how many components you’re 
using to build the texture. 

If you’re using only one component, the 
properties in the component are applied 
directly to the final texture. When you’re using 
two components, they’re blended using a single 

blend mode, and the result is then applied as 
the final texture. 

When you’re using three components, the first 
two components are blended together using a 
blend mode, then the result of that blend is 
combined with the third component using a 
second blend mode. The result of all the 
blending is then applied as the final texture.

Depending on the Blend mode, the different 
types of output can affect each other during the 
combination process. So its possible that the 
Bump output of one component may affect the 
Color output of another.

To apply a blend mode:

1 Display the Deep Texture Editor.

2 Click the Arrow between components and 
choose a mode from the menu.

In this example, Snow Puddles was applied to RND 
Continuous noise and then to objects in a scene.

This diagram explains when the blend modes are applied 
as you combine components to form a texture.

The arrows between components in the Deep Texture 
Editor provide access to the Blend Modes menu.

C C CA AAB B B

FINAL TEXTURE

Component 1 Component 2 Component 3

RESULT

BLEND

BLEND
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• Click the arrow on the left to choose a 
Blend Mode to combine components 1 
and 2. 

• Click the arrow on the right to choose a 
Blend Mode to combine the results of 
Component 1 and 2 with 3.

There are nineteen blend modes you can use to 
combine your components:

Parallel

This mode does not blend components. Use it 
when each component has a different output 
type. If two components share an output type, 
only the first output will be applied to the final 
texture. 

For example, if Component 1 has output= 
Color and Bump, and component 2 has 
output=Color and Alpha, only the color from 
Component 1 will be applied to the texture.

Combine

Combine is a blend mode for colors only. When 
you use this blend mode, the first color in 
Component 2 is used as an alpha channel. 
Wherever that color appears in Component 2, 
it is replaced with the colors from Component 
1. 

For example, lets say Component 2 has Yellow, 
Green and Blue and Component 1 has Orange, 
Purple and Black as its color scheme. 

When you combine them using the Combine 
blend mode, Yellow disappears from 
Component 2. Everywhere that Yellow 
appeared, you’ll see Orange, Purple and Black.

Average

Average is normal blend mode where all the 
component values are mixed with equal weight. 

So if one component is white and the other is 
black, the result is gray.

This is a good all-purpose blend mode to use 
for creating textures.

Multiply

When you use this blend mode to combine 
components, you’ll get a darker result. In this 
mode, when a black component is combined 
with a gray component, the result is black. 
When a gray component is combined with a 
white component, the result is gray. When two 
shades of gray are combined, the result is 
proportionally darker.

In the case of Bump output, this mode will 
flatten most areas since black is flat and darker 
values create flatter bumps.

Maximum

When two components are combined using 
Maximum, the two components are compared 
and the one that’s lighter becomes the result.

Blend Maximum

Blend Maximum works the same as Maximum, 
except that it creates blurring at points of sharp 
transition.

When Blend Maximum is applied to Bump 
output, the resulting bump map will have many 
high points and few deep pits. 

This mode works best on Bump output.

Minimum

This mode is the opposite of Maximum. When 
two components are combined, they’re 
evaluated and the darker areas of both are 
combined to produce the result.
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Blend Minimum

Blend Minimum works the same as Minimum 
except that it creates blurring at points of sharp 
transition.

When Blend Maximum is applied to Bump 
output, the resulting bump map will have 
mostly low areas with very few high points. 

Add

Add combines colors so that they appear 
dramatically lighter. However, it doesn’t have 
the same effect on Bump output.

Subtract

When you combine grayscale components 
using Subtract, they tend to turn out black or 
very dark. When you use it with colored 
components, the result is brilliant colors that 
tend to compliment the original colors.

Blend v1 and v2

These two blend modes let you use one of the 
components as an alpha channel for blending. 

When you choose Blend v1, the noise in the 
first component is used as an alpha channel to 
blend the two components. 

When you choose Blend v2, the noise in the 
second component is used as an alpha channel 
to blend the components. 

Blend Slope

Using Blend Slope, components are combined 
according to an object’s slope. The first 
component is applied to areas that are flat and 
the other is applied to areas that are steep.

Fast Slope

Fast Slope works exactly like Blend Slope 
except that the transition from one component 
to the other is more abrupt.

Blend Altitude

This mode blends components according to an 
object’s altitude. The first component appears 
at low altitudes and the second appears at high 
altitudes.

Blend Orientation

In this mode, one component is applied in all 
directions, while the other is applied in only 
one direction. You can use this mode to 
simulate things like moss that only grow on one 
side of a tree.

Blend Random

This mode introduces an extra layer of noise 
and uses it as an alpha channel for combining 
the two components. Component 1 appears in 
some areas of the new noise, and Component 2 
appears in other. 

Since this mode adds another layer of noise, 
you’re also adding more processing time.

Procedural Blend

Procedural Blend combines two components so 
that the color and values of Component 1 are 
applied to Component 2 based on the gray 
values in Component 2. In essence, the Alpha 
output from Component 2 is used as a guide for 
blending.
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Where Component 2 is light, Component 1 is 
not applied. Where Component 2 is dark, 
Component 1 is made darker. Where 
Component 2 is gray, Component 1 is applied 
without change.

This mode usually results in more saturated 
colors.

Difference

Difference finds the difference between the 
noise in the two components and displays the 
result. 

This mode only works on output of like types. 
So if Component 1 has Alpha and Color output 
while Component 2 has only Alpha, the two 
Alpha outputs are combined and the Color 
output is left unchanged.

Global Changes

The component window in the center of the 
editor, called the Combination component, 
represents the final combined texture. Any 
changes you make to this final component are 
considered global changes since they affect the 
entire texture.

The Combination component can have its own 
color scheme, filter, noise pattern or phase. 
These attributes are applied to all the 
component elements. For example, the 
Combination noise values affect the noise 
within each component. 

Global changes give you a way of applying a last 
layer of complexity to your texture.

Global Colors

The colors in the Combination component 
interact with the combined colors in the three 
components. They act as a final color filter for 

the texture. After the colors in each component 
are combined, they are blended with the 
combination component colors to produce the 
colors in the final texture.

You can also apply a final Color Blending 
method to the combination component. The 
Blending method you apply to the combination 
component is applied on top of the other 
modes used in the components. 

For example, if you choose Altitude in the 
Combination component, the texture color is 
applied using the blend modes in the 
components and then also applied by altitude.

To add colors directly to a texture:

1 Click the top color circle in the 
combination component window and 
choose a color from the palette.

x

This example shows a texture containing a texture with 
different Color Blending modes in it.

The color circles in the Combination component window 
let you apply colors directly to the final texture.
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2 Repeat for each of the other two color 
circles. 

Global Noise

When you change the noise in the 
Combination component, (i.e., globally) it 
applies to all the components equally. So if you 
increase the noise in the final component, the 
noise in each of the components increases. 
Likewise, when you decrease the noise globally, 
the noise in each individual component 
decreases.

Global noise can be different than component 
phase, so you can introduce a completely 
different type of noise into the texture. 

Use this option cautiously. The more noise you 
introduce into your texture, the longer it takes to 
render and draw. If you introduce too much 
complex noise patterns into a texture, you may 
find your render time increased significantly.

You can adjust global noise in the same way you 
would for a single component, using the Noise 
palette or the Noise editor.

To adjust noise globally:

1 Click the top left button in the 
combination component window.

The Noise palette appears.

2 Drag the slider to adjust the noise value.

or

Click the top left corner of the Noise 
palette to display the Noise Editor.

• Use the editor’s controls to design the 
global noise pattern or grain.

Global Phase

As you adjust the Global Phase value, new 
phase is introduced into each of the 
components.

Global phase can be different than component 
phase, so you can introduce a completely 
different type of phase into the texture. 

You can adjust global phase in the same way 
you would for a single component using the 
Phase palette or the Phase Editor.

To adjust phase globally:

1 Click the bottom-right button in the 
combination component window.

The Phase palette appears.

2 Drag the slider to adjust the phase 
amplitude.

or

Click the top left corner of the Phase 
palette to display the Phase Editor.

• Use the editor’s controls to design the 
global phase.

The three buttons along the outside of the Combination 
component window let you access the editing palettes.

The bottom-right button on the outside of the Combination 
component window accesses the Phase palette.
271 Bryce 4



Global Filtering

The Filter affects the final look of the noise 
within a component. The Global Filter affects 
the look of the combined noise. The Global 
Filter is applied to the noise in the 
Combination component.

The global filter only affects the noise, not the 
phase in the component. Any of the filters you 
used in the components can be used as the 
global filter.

Use this option cautiously. The more complex the 
noise in your texture, the longer it takes to render 
and produce. If you introduce too much com-
plexity, you may find your render time increased 
significantly.

To filter noise globally:

1 Click the top-right button in the 
combination component window.

The Filtering palette appears.

2 Choose a filter and adjust its variables to 
create the desired effect.

The Deep Texture Editor
The Deep Texture Editor can be a source of 
incredible power or incredible frustration. It all 
depends on how you jump into it. 

The editor can be used in two ways. If you’re 
comfortable with equations and algorithms, it 

gives you the freedom to create any textural 
pattern or surface you can imagine. If you’re 
not so mathematically inclined, playing around 
with these deep functions can get you lost 
rather quickly. 

For those who don’t want to learn to calculate 
and postulate, the Deep Texture Editor can be 
used as a large palette. Take a little of this and 
little of that, blend them all together and see if 
you like the result. If it’s a magnificent work of 
art, keep it; if not, discard it. 

The only real penalty you may encounter when 
using the Deep Texture Editor unawares, is that 
you may inadvertently create a very complex 
texture that could add considerably to your 
rendering time. This is an easy pitfall to avoid 
however. The last section of this chapter gives 
you some tips on reducing the complexity of 
your textures. Refer to “Tips for Speeding Up 
Textures” on page 276 for more.

Before you start creating textures, you may want 
to familiarize yourself with this incredible tool.

Tip: When you’re just exploring the editor, set all 
the component outputs to Alpha. This lets you see 
the effects of your changes more clearly.

To display the Deep Texture Editor:

1 Display the Materials Lab.

2 Click the A, B or C column of the material 
channel to which you want to assign a 
texture.

A component window becomes active.

3 Click the pink button at the top of the 
Component window.

The Deep Texture Editor appears.

The top-right button on the outside of the Combination 
component window accesses the Filtering palette.
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A Quick Tour: The Deep Texture 
Editor

The layout of the Deep Texture Editor is a 
visual representation of the texture creation 
process. The three components along the top 
combine to form the final texture, shown in the 
middle. The layout makes the editor very easy 
to use. 

Along the top of the editor you’ll see the 
preview options. These three icons let you 
choose how you want to display the 
component.

Below the preview control on the left, you’ll see 
the component selector. This tool lets you 
choose the number of components you want to 
use to build your texture. 

The rest of the editor displays the component 
window. The three windows along the top 
represent the three components you can use in 

a texture and the center window represents the 
combined texture. 

The arrows between windows represents the 
blend modes. 

The three buttons along the bottom of the 
editor let you display the three editing palettes. 
The palettes let you control the noise, phase 
and filtering applied to the texture.

You can access the Noise and Phase Editors 
from within the Noise and Phase palettes.

The three icons at the top of the editor let you choose a 
preview mode.

The component selector lets you choose how many 
components you want to use to build a texture.

The three windows along the top of the editor represent 
the components, and the window in the center displays the 
final combined texture.

The arrows between components in the Deep Texture 
Editor provide access to the Blend Modes menu.

The three buttons along the bottom of the editor let you 
display the editing palettes.
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Working in the Deep 
Texture Editor
This section describes how to use the Deep 
Texture Editor to create and store textures.

Building Textures

A texture is a combination of components. You 
build textures by designing or editing 
components (i.e., colors, noise, phase or filters) 
and combining them using Blend modes. 

 To build a texture:

1 Display the Deep Texture Editor.

2 Click the Component Selector to choose 
the number of components you want to 
use to build the texture.

The component windows become active.

3 In the first component window, click one 
of the Output buttons to choose an output 
type.

4 If your component contains color, click 
one of the color circles and choose a color 
to apply to the texture.

You can choose up to three colors for each 
component.

5 Click the triangle icon below the color 
circles and choose a Color Blending mode 
for your colors.

6 Click the Noise button at the bottom of the 
editor. The Noise palette appears. 

7 Adjust the noise in the component by:

• Dragging the Noise slider on the Noise 
palette to increase or decrease the 
amount of noise in the component.

• Click the top left corner of the palette 
to display the Noise editor, then use the 
editor controls to design or edit the 
noise in the component.

8 Click the bottom-right button on the 
Component window. The Phase palette 
appears.

9 Adjust the phase in the component by:

• Dragging the Phase slider on the Phase 
palette to increase or decrease the 
amplitude of the phase in the 
component.

• Click the top left corner of the palette 
to display the Phase editor, then use the 
editor controls to design or edit the 
phase in the component.

10 Click the Filtering button at the bottom of 
the editor. The Filtering palette appears.

11 Choose a filter to apply the component 
noise and adjust that filter’s variables.

12 Repeat steps 3–11 for each component in 
the texture. 

As you edit the noise, phase, or filter of the 
remaining components, make sure you 
move the component indicator at the top of 
each palette to be sure you’re editing the 
right component’s attributes.

13 Click the arrow between Component 1 and 
Component 2 and choose a Blend mode 
from the menu.

14 If you have more than two components, 
click the arrow between Components 2 and 
3 and choose a second blend mode.

The component indicator at the top of each palette lets you 
know which component you’re editing.
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The result of blending all the components 
appears in the Combination window.

15 Click the color circles in the Combination 
component window, and choose colors for 
the final texture.

• You can also choose a Blending mode.

16 If you want to change the noise of 
combined component, display the Noise 
palette. 

If it’s already displayed, make sure the 
component indicator is on the fourth 
component.

17 If you want to change the phase of 
combined component, display the Phase 
palette. 

If it’s already displayed, make sure the 
component indicator is on the fourth 
component.

18 If you want to change the filter of 
combined component, display the 
Filtering palette. 

If it’s already displayed, make sure the 
component indicator is on the fourth 
component.

19 Click the OK icon at the bottom of the 
editor. The texture appears in one of the 
component windows in the Materials Lab.

Using Drag and Drop in the 
Editor

The Deep Texture Editor lets you drag and 
drop component elements between component 
windows. This a quick way of copying elements 
between components. 

For example, if you were setting up a red, green 
and blue separation of the colors in your 
texture, you could drag the same elements to all 

three component windows and change the 
Color Blending mode.

To drag and drop between windows:

• Drag from the window you want to copy to 
the window where you want the elements 
to appear. Release the mouse button to 
drop the component elements. 

The elements you drop into a window 
replace the existing elements.

Changing Component Preview

Each component window has a preview of the 
component’s elements. You can choose to 
display the elements mapped onto a flat 
surface, a cube or a sphere. 

Displaying the component on a cube makes it 
easier to see 3D noise and phase changes.

To choose a preview mode:

• Click the flat surface, cube or sphere in the 
top-right corner of the editor.

Randomizing Textures

A quick way of designing a texture without 
going into designing noise or filters is to create 
random components. 

The three icons at the top of the editor let you choose a 
preview mode for the component windows.
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The randomize buttons in the component 
windows let you randomize the elements in the 
component window. The type of output you 
choose for the component determines what 
part of the component is randomized. 

This is an excellent way of exploring the editor. 
Just randomize the components elements and 
combine them to see what happens.

To randomize component elements:

• Click the knob in the bottom-right corner 
of the component window.

Undoing Changes

The Reset control lets you undo all the changes 
you’ve applied to a component and returns to 
the component displayed when you first 
entered the editor.

To reset a component:

• Click the knob in the top-left corner of the 
component window.

Saving Textures

You can save your texture as part of texture list 
so you can access it quickly from the Materials 
Lab.

To save a texture:

1 In the Combination component window, 
click the knob in the top-right corner of 
the component window.

The Save Texture dialog appears. 

2 Enter a name for the new texture and click 
the OK icon.

The new texture appears at the bottom of 
the texture list. The list can be accessed 
from the Materials Lab.

Tips for Speeding Up 
Textures
Textures can be the most powerful effects you 
create in Bryce. They can also be the most 
costly. The more complex the texture, the 
longer it takes to calculate and the longer it 
takes to apply to an object, which finally 
increases the rendering time.

When you’re creating the texture, you always 
have to keep in mind that it’s part of a material, 
which is part of an object. All these parts can 
contribute to the rendering time:

The knob in the bottom-right corner of the component 
window randomizes the elements in the component.

The knob in the top-left corner of the component window 
resets the component to the way it looked when you first 
opened the editor.

The knob in the top-right corner of the Combination 
component window lets you save your texture.
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• The material that contains the texture may 
have several complex attributes of its own, 
like Transparency and Reflection. 

• The size of the object may also contribute 
to the rendering time. 

Consider the effect of applying a complex 
texture to a complex material onto an infinite 
plane. The time to calculate this object would 
be staggering.

A good rule of thumb when working with 
complex objects and textures is to make the 
texture element as simple as possible.

These tips are meant only as a precaution to pre-
vent you from inadvertently creating a huge tex-
ture. That doesn’t mean that you shouldn’t use 
the more complex features as well, after all they 
were created for a reason. You should just use 
them cautiously.

Noise

• Use a simpler noise type. Some noise types 
(like Vortex) require more time to process 
than others. 

• Restrict the amount of noise you add to 
each component. in fact, not all the 
components need to have noise.

• Watch the frequency of the noise. Higher 
frequency noise requires more time to 
calculate then lower frequency noise.

• Watch the number of octaves in the noise. 
Each octave adds another level of 
complexity.

Phase

• When you’re designing the phase, you may 
want to use simpler noise.

• Cut down on the number of phase types 
you combine. If each component has a 

different type of phase, combining them 
can increase calculation times.

• Watch the amplitude of the noise. Higher 
amplitude phase takes much longer to 
calculate.

• Apply Global Phase cautiously. This is the 
quickest way of increasing the complexity 
of your texture because global phase 
introduces more complexity into each 
component simultaneously.

Filtering

• Filtering introduces complexity or detail 
into the noise of a component. Make sure 
that you aren’t using a filter unnecessarily. 
Not all noise needs filters.

• Be careful when you apply a Global Filter 
as this adds even more complexity to the 
noise.
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11  

Arranging 
Objects

Arranging Objects in a 
Scene
In a scene, the arrangement of objects is as 
important as their form. You can design 
beautiful landscapes, or build complex 
models, but if they’re the wrong size or in the 
wrong position, they won’t look right in the 
scene. To get the right look, you’ll need to 
position or rotate the objects to make sure 
they are in the right places within the scene, or 
you may need to resize an object so that it is in 
proportion with the rest of the objects. These 
kinds of operations are called transformations.

Bryce supports three basic types of 
transformations: size, position, and rotation. 
The tools in the Edit palette let you 
interactively perform these operations on any 
object in your scene. As well, the Object 
Attributes dialog lets you transform objects 
numerically for more precision.

As you arrange objects, you’ll probably need 
to create some kind of object hierarchy. An 
object hierarchy lets you create a structure in 



your scene that organizes objects according to 
their spatial or logical relationships. The 
structure can make arranging objects much 
easier and faster.

You can create an object hierarchy by grouping 
and linking objects.

This chapter describes how to use the 
transformation tools and the Object Attributes 
dialog to resize, reposition, rotate, align and 
randomize objects. It also describes how to 
create object hierarchies.

Bryce and 3D Space
Since all the objects in your scene exist in 3D 
space (defined by XYZ), any transformation you 
perform is a 3D transformation. This means 
that you’re changing the attributes of the object 
in each axis.

Bryce has three ways of defining 3D space: 
World space, which is constant, Object space, 
which changes as the object changes and 
Camera space, which changes as the camera 
changes.

When you’re using the interactive transform 
tools on the Edit palette you can use any one of 
the 3D space definitions. Refer to 
“Transformation Tools” on page 285 for more 
on using these tools.

World Space

World Space is the coordinate system that 
defines all the space in the Bryce universe. It is 
constant and cannot be modified. It is also the 
default space used for transformations.

World Space is defined by three axes, X, Y and 
Z, that all meet at world center. This center is 
defined numerically as 0, 0, and 0 for the X, Y 
and Z axes. By default, all new objects appear at 
world center.

The Y axis that extends from world center 
defines all vertical space. Positive values 
represent distances above ground level and 
negative values represent distances below 
ground. The X axis represents distances left 
and right and the Z axis represents distances 
backwards and forwards.

When you use World Space for 
transformations, objects move in relation to 
this absolute coordinate system.

World space is defined by three axes that extend out 
infinitely from a center point called world center.

When you transform objects in relation to world space, 
they move along the three absolute axes.

ZX

Y

Z
X

Y
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Object Space

When Bryce creates an object, it defines the up, 
down, right, left, back and front of the object. 
These definitions remain with the object no 
matter what transformations you apply to it. So 
in a sense, each object carries with it its own 
coordinate system.

When you transform an object using Object 
space, the object moves in relation to its 
internal coordinate system. For example, you 
can increase the height of an object based on 
its own Y axis.

Because Object space ignores the absolute 
coordinates, the object becomes taller without 
being skewed. If you used World space, the 
object would become deformed since it 
increases along the absolute Y axis.

Object space is defined by three axes that extend out from 
the center of the object.

When you transform an object using Object space, it moves 
along an axis that extends from its center, not an absolute 
axis.

Z
X

Y

ZX

Y This is an example of an object transformed using World 
Space and then using Object Space.
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Camera Space

Camera Space is defined by three axes, X, Y 
and Z, that extend out from the camera center. 
Wherever you move the camera, these axes 
move along with it.

When you use Camera Space for 
transformations, you’re moving objects in 
relation to the camera. When you drag along 
the X axis in camera space, you’re moving left 
or right from the camera. When you move 
along the Y axis in camera space, you’re moving 
up or down from the camera. When you move 
along the Z axis, you’re moving away or towards 
the camera.

Since the camera can be rotated and 
repositioned, it can sometimes be hard to tell 
which way is up, left or right, because your view 
from the camera is no longer aligned to the 
absolute XYZ axes.

Suppose you’ve rotated the camera and then 
you move an object along the Y axis in World 
Space. Instead of moving up, it may appear to 
move off to the left, since your view of the 
scene is not aligned to the World Space Y axis. 

However, in Camera Space, the object will 
move up, because the object moves along the 
camera’s Y axis.

To choose a 3D spatial option for 
transformations:

1 Click the Edit button at the top of the 
Bryce window to display the Edit palette.

2 Click the triangle icon below one of the 
transformation tools and choose a 3D 
spatial option from the menu.

Bryce Units

Bryce maintains an invisible, absolute, infinite 
3D grid internally. This grid is comprised of 3D 
cube increments, each 2048x2048x2048 “Bryce 
units” in size. All primitive objects (spheres, 
cubes, etc.) are created at the same size as a 3D 
cube increment (2048x2048x2048) called unity.

Camera space is defined by three axes that extend out 
from the center of the camera.

ZX

Y

When you transform objects using Camera space, they 
move along an axis that extends from the center of the 
camera.

Each of the transformation tools has a triangle icon below 
it, which lets you access addition tool options.

ZX

Y
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All interactive 3D transformations are relative 
to an absolute (unity) size, position, and 
orientation for all objects.

To reset object to unity:

•  Hold down Command-Option/Ctrl+Alt 
and click one of the object’s control points. 
The object is reset to 2048x2048x2048.

Coordinate Systems
When you’re transforming objects numerically, 
in the Object Attributes dialog, you can use one 
of two coordinate systems: Absolute 
Coordinates or Object Coordinates.

Absolute Coordinates

Absolute Coordinates use the World Space axes 
as the reference for object transformations. 
When you enter transformation values using 

Absolute coordinates, you’re defining how the 
object is transformed along the World Space, or 
absolute, X, Y and Z axes.

Object Space Coordinates

Object space coordinates define how an object 
is actually created. In object space, the origin of 
the object is located at X=0, Y=0, Z=0. All the 
other points in the object are defined by 
coordinates along the object’s internal X, Y and 
Z axes.

Unity is the base size of all primitive objects created in 
Bryce. Unity is always 2048x2048x2048.

Absolute Coordinates use the World Space axes as 
reference, so you’re repositioning the object along the 
absolute X, Y, and Z axes.

Object Space coordinates define how an object is created. 
The origin is at 0, 0, 0, while all the other points that 
define the object’s shape and size are coordinates along the 
X, Y and Z-axes within the object.

(2,2,3)

Y

X

Z

(0,0,0)
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This coordinate system uses the object’s 
internal axes as a reference for transformations. 
When you enter transformation values using 
this system, you change how the object is 
defined, so that includes where its origin is 
positioned, it’s size, and orientation.

In Object Space transformations, the origin 
point of the object always remains at Object 
Space 0, 0, 0. As you move or scale the object, it 
changes, moves or grows along its internal axes, 
but the origin remains at 0, 0, 0. This can cause 
some unpredictable results. For example, if you 
scale an object using Object Space coordinates, 
the origin point will no longer be in the exact 
center of the object, so if you rotate the object, 
it won’t rotate around its center.

Transforming using Object Space coordinates 
is not the same as using Object Space with one 
of the Transformation tools. When you choose 
Object Space for one of the transformation 
tools, transformations are performed using 
Object Space axes as a reference, but the final 
position, or size, is calculated using Absolute 
Coordinates. So in this case the object origin 
and all its points move along with the object. 

When you use Object Space Coordinates to 
transform an object, you’re redefining how the 
object is created, so its origin does not change 
as the size and position change.

Relative Coordinates

Relative Coordinates use the World Space axes 
as reference for object transformations, but the 
values represent changes relative to the object’s 
current position, or size. For example, if you 

Object Space Coordinates use the object’s internal axes as 
reference, so you’re redefining the object’s position along 
its internal X, Y, and Z axes.

(0,0,0)

(0,0,0)

Z

X

Y

In this example, an object was scaled using Object Space 
coordinates and then rotated. You can see that it no longer 
rotates around its center.
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enter a position change of 2 units, the object 
moves two units from its current position along 
one of the World Space axes.

Relative Coordinates are the only coordinate 
systems available in the 3D Transformation 
dialog.

Transforming Objects
Transformation Tools

The transformation tools let you perform all the 
object transformation operations available in 
Bryce. The tools act as interactive controls. As 
you drag over the tool, the operation is 
performed on the selected object.

The transformation tools are located on the 
Edit Palette.

To select a tool:

1 Click the Edit button at the top of the 
Bryce window to display the Edit palette.

2 Select an object.

3 Drag over the tool to perform a 
transformation operation.

Resize Tool

Use the Resize Tool to resize objects along one 
of the three axes.

Rotate Tool

Use the Rotate tool to rotate objects in 3D 
space.

Reposition Tool

Use the Reposition tool to reposition objects 
along any of three axes.

Align Tool

Use the Align tool to align objects along their 
tops, bottoms, left sides, right sides, fronts, 
backs or centers.

Relative Coordinates use the World Space axes as 
reference, but transformations are relative to the current 
position or size of the selected object.

Z

X

Y 2

2
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Randomize Tool

Use the Randomize tool to scatter or disperse 
objects in 2D or 3D space.

Object Origin Points

Every object in Bryce has an origin point. This 
point defines the object’s center of rotation.

In the Working window, the Origin point 
appears as a small dot. By default the origin 
point appears at the center of the object’s 
bounding box. You can adjust the position of 
the origin point to any point along the object’s 
surface or outside of the object.

Where you place the origin point depends on 
the effect you want to create. For example, if 
you rotate an object when its origin point is at 
its center, it spins in place. When the point is 
placed outside the object, it rotates around the 
origin point like a planet around the sun.

To display the origin point:

• Enable Show Origin Handle in the 
General tab of the Object Attributes dialog 
box.

To reset the origin point to the default 
position:

• Hold the shift key while clicking on the 
origin point of an object. 

To set the origin point to the center of all 
the objects in the scene

• Hold Cmd/Ctrl+Shift while clicking on the 
origin point of an object

To cause the origin point to stay in position 
while the object moves

• Click, then hold, the spacebar while 
positioning an object with its origin point 
showing. 

The object’s origin point defines the object’s center of 
rotation.

Origin 
Point

When the origin point is at the center of the object it 
rotates in place. When you move the origin point outside 
the object, it orbits around its point.
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Nano-Edit Mode 

Nano-Edit Mode activates the Nano-Editor 
which lets you perform transformations on a 
small preview of your scene, instead of the full 
scene.

When this mode is active, the Nano-Editor 
appears any time you perform a camera or 
object transformation. The Nano-Editor 
window displays a small preview of your scene. 
The transformation is applied to the preview. 
When you close the editor, the transformation 
is applied to the full scene.

This mode is useful when you’re working on a 
large scene, as it saves on redraw time.

To activate Nano-Edit Mode:

• Click the Nano-Edit button on the Display 
palette.

When the smaller square inside the icon 
(which represents an active Nano-Editor) is 
red, the Nano-edit mode is on; when it is 
white, it is off.

To temporarily activate Nano-Edit mode:

• Hold down Option-Spacebar/Alt + 
Spacebar before you perform 
transformations. The Nano-Editor appears 
only during the operation.

Resizing Objects
When you create an object, it appears at a 
default size. Once you place it in your scene 
you’ll need to resize it make it proportional to 
the other objects in your scene. If the tree is 
larger than the terrain, one of them is at the 
wrong scale.

There are three ways of resizing objects in 
Bryce: 

• Using the Resize tool, in the Edit palette, 
to resize an object along different axes.

• Using the 3D Transformation dialog which 
lets you enter precise values to resize 
objects.

• Using the control points on the object’s 
bounding box to interactively resize the 
object.

Objects are measured in Bryce units. When you 
resize an object you’re increasing or decreasing 
its size based on unity size. When you resize an 
object to 150%, you’re sizing it to 150% of unity. 
Refer to “Bryce Units” on page 282 for more.

Using the Resize tool

The Resize tool lets you resize a selected object 
along any axis. Objects are resized from their 
origin point.

Use the Nano-Edit mode to quickly see the effects of 
transformation on a preview of your image.
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The Resize tool has seven different states. As 
you move the pointer over the tool each state 
becomes active. 

The different states let you resize the object 
along different axes. Resizing along the Y axis 
increases/decreases the object’s height. 
Resizing along the X axis increases/decreases 
the object’s width. Using the Z axis for resizing 
increases/decreases the object’s depth.

To resize an object along a specific axis:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit text button at the top of 
the Working window.

2 Move the Cursor over the Resize tool.

3 When the state you want to use becomes 
active, drag to resize the object.

For example, if you’re using Resize Y Up, 
drag to the left increase the object’s height 
in the Y axis. The more you drag, the taller 
the object becomes.

Hold down Shift to constrain the resize 
increments to 50% intervals.

To resize an object in all directions:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit text button at the top of 
the Working window.

2 Click the center of the Resize tool and drag 
left to increase the size of the object, or 
right to decrease it.

To resize an object from two directions along 
a single axis:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit text button at the top of 
the Working window.

2 Move the cursor over the Resize tool.

3 When the state you want to use becomes 
active, hold down Option/Alt drag in the 
direction you want to resize the object.

For example, if you’re using Resize Y Up, 
when you hold down Option/Alt as you 
drag, the object becomes longer both up 
and down along the Y axis.

Objects can be resized using any of the three 
spatial definitions (World, Object or Camera). 
The definition you choose depends on the 
effect you wish to create. 

To choose a spatial option for resizing:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

The resize tool has seven states. As you move your cursor 
over the tool each state becomes active.

Resize Y up
Resize Z backResize X left

Resize Z front Resize X right

Resize Y down

Resize XYZ 
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2 Click the triangle icon next to the Resize 
tool and choose an option from the menu:

Object Space resizes your selection relative 
to itself (see “Object Space” on page 281).

World Space resizes your selection in 
absolute world coordinates (see “World 
Space” on page 280).

Camera Space resizes your selection 
relative to the camera (see “Camera Space” 
on page 282).

When you set Object, World, or Camera space 
for the Resize tool, it is also the option set for 
the other two transformation tools. However, 
spatial options are global for the transformation 
tools only. The option you select in the Edit 
palette does not affect the 3D Transformations 
dialog.

Flipping Objects

Flipping is not the same as rotating an object 
180°. Flipping mirrors an object along an axis 
instead of rotating it.

To flip an object:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Click the triangle icon next to the Resize 
tool and choose a flip option from the 
menu:

Flip X inverts your object’s dimensions 
along the X axis.

Flip Y inverts your object’s dimensions 
along the Y axis.

Flip Z inverts your object’s dimensions 
along the Z axis.

To undo resize operations:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Select an object.

This example shows an object that has been rotated 180° 
and the same object flipped in X.

Original object

Rotated 180° in X

Flipped in X
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3 Click the triangle icon next to the Resize 
tool and choose Unscale from the menu.

Numerical Resizing

Sometimes you will need more precise control 
over the size of your object. The 3D 
Transformations dialog lets you enter specific 
resize values for a selected object.

All transformations you enter in this dialog are 
performed in World Space regardless of the 
spatial option you chose for the Resize tool.

Resize values are expressed as a percentage of 
the current size of the selected object. You can 
not enter negative numbers in this dialog.

To resize an object numerically:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Select an object.

3 Click the triangle icon below the Resize 
tool and choose 3D Transformations from 
the menu. The 3D Transformations dialog 
appears.

4 Enter a percentage in one or all of the axis 
fields.

The percentage determines the new size of 
the object based on its original size. For 
example, to double the object’s size in all 
directions, enter 200 in the X, Y, and Z 
fields. To resize along a single axis, enter 
values in only one axis field.

Since you are dealing with World Space 
transformations in this dialog, if you resize an 
object along only one or two axes you may 
unintentionally skew the object’s shape. 

To resize the object without skewing it, use the 
numeric entry fields in the Object Attributes 
dialog. Using this dialog can resize the object 
based on its original position, with no 
unintentional skewing. Refer to “Object Space 
Coordinates” on page 283 for more.

Interactive Resizing

While you can resize objects using the Resize 
tool or the 3D Transformation dialog, there are 
resize controls on the object’s bounding box 
that let you resize objects directly in the 
Working window. You may find this a much 
more intuitive way of transforming your 
objects.

When you select an object, a bounding box 
appears surrounding your selection. At each 
corner of the box, and at the center of each 
face, is a control point. 

Use the 3D Transformation dialog to resize an object using 
numerical values.

An object’s bounding box has control points at the corners 
and at the center of each face that can be used to resize the 
object. 

Control 
Points
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As your cursor passes over the corner control 
points, it changes to a generic Resize cursor. As 
it passes over the control points on the faces, it 
changes to an X, Y or Z. This indicates the axis 
along which you can resize the object by 
pressing and dragging at that point.

To resize an object along a single axis 
interactively:

1 Select an object.

2 Drag one of the control points at the center 
of a bounding box face. 

As you pass your cursor over the face, the 
cursor changes to an X, Y or Z to indicate 
the axis you’re resizing along.

To enlarge or shrink an object interactively:

1 Select an object.

2 Drag one of the control points on the 
corners of the bounding box.

Drag right to enlarge it, or left to shrink 
the object.

• Hold down Command/Ctrl while 
dragging to resize in the opposite 
direction from the selected corner 
point. 

• Hold down Option/Alt while dragging 
to resize from the center of the object. 

• Hold down Shift to constrain resizing 
to 50% increments.

To resize an object from the bottom center:

1 Select an object.

2 Click the Y facial control point and hold 
down the mouse button, then press 
Command-Option/Ctrl+ Alt and drag the 
point.

The object resizes in all directions from 
the bottom center of the object. This 
transformation may be useful if the object 
is on the ground and you want it to remain 
there. 

Using the Keyboard

You can also you use the keyboard keys to 
resize objects:

*doubles a selected object’s size.

/halves a selected object’s size.

=returns the object to unity size and snaps 
it to the Grid.

Rotating Objects
Most object have a specific up, down, left, right, 
back and front associated with them when you 
create them. When you place the object in a 
scene, its orientation may need to be altered to 
achieve a desired effect. For example, an 
airplane that’s taking off should be tilted 
upwards, or tilted downwards when it’s 
landing.

There are three ways of rotating objects in 
Bryce: 

• Using the Rotate tool to resize an object 
along different axes. 

The corner control points resize the object along all three 
axes. The control points on the faces of the bounding box 
resize the object along a single axis.
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• Using the 3D Transformation dialog, which 
lets you enter precise rotation angles.

• Using the object’s control points to 
interactively rotate the object. 

Using the Rotate tool

The Rotate tool lets you rotate a selected object 
along any axis. Objects can be rotated in World 
Space, Object Space or Camera space.

The Rotate tool has three different states. As 
you move the pointer over the tool, each state 
becomes active.

To rotate an object around a specific axis:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Move the cursor over the Rotate tool. 

3 When the state you want to use becomes 
active, drag in the direction you want to 
rotate the object. 

Hold down the Shift key while dragging to 
constrain rotation operations to 45 degree 
increments.

You can rotate an object using any of the three 
spatial options (World Space, Object Space, 
Camera Space.)

To choose a spatial option for rotation 

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Click the triangle icon next to the Rotate 
tool and choose an option from the menu:

Object Space rotates your selection relative 
to itself (see “Object Space” on page 281).

World Space rotates your selection in 
absolute world coordinates (see “World 
Space” on page 280).

Camera Space rotates your selection 
relative to the camera (see “Camera Space” 
on page 282).

The three spatial options are also available for 
the Resize and Reposition tools. When you 
select Object, World, or Camera space for the 
Rotation tool, it is also set for the other two 
tools. Spatial options are global for all 
transformation. The option you choose in the 
Edit palette does not affect the 3D 
Transformations dialog.

To undo rotation operations:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Click the triangle icon next to the Rotate 
tool and choose Unrotate from the menu.

As you move your cursor over the tool each rotation state 
becomes active.

Rotate 
around X

Rotate 
around Y

Rotate 
around Z
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Numerical Rotation

In a complex scene, orienting objects may 
require more precision than the Rotation tool 
offers. The 3D Transformations dialog lets you 
enter specific rotation angles for a selected 
object.

All transformations performed using this dialog 
use World Space coordinates regardless of the 
spatial option you chose for the Rotate tool.

Rotation values are expressed as degrees, with 
360° being a single full rotation. Since rotations 
are relative, you may enter negative values and 
cumulative values (greater than 360° or less 
than -360°).

In this dialog, Bryce units have been 
transposed for the sake of simplicity. For 
instance, an object at Unity size of 
2048x2048x2048 is seen in the 3D 
Transformations dialog box as 
20.48x20.48x20.48. 

Moving the decimal two points to the left lets 
you have a full range of resolutions without 
having to enter either excessive integer values 
or values with excessive places to the right of 
the decimal point.

To rotate an object numerically:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Select an object.

3 Click the triangle icon next to the Rotate 
tool and choose 3D Transformations from 
the menu. The 3D Transformations dialog 
appears.

4 Enter a degree value in one or all of the 
Rotate fields.

The degrees determine the angle of 
rotation. For example, to rotate an object 
45° around Y, enter 45 in the Rotate Y field. 
To rotate around other axes, just enter 
values in the appropriate fields.

Since you’re dealing with World Space 
transformations, objects are rotated with 
respect to the World Space X, Y, and Z axes. 

You can also rotate an object numerically using 
the Object Attributes dialog. The values in the 
Attributes dialog rotate the object using either 
Absolute coordinates or Object space 
coordinates. Refer to “Absolute Coordinates” 
on page 283 and “Object Space Coordinates” 
on page 283 for more on the these coordinate 
systems.

Interactive Rotation

Using the control points on an object’s 
bounding box, you can freely rotate an object 
directly in the Working window.

Rotation control points appear when you hold 
down Command /Ctrl and pass your cursor 
over the object’s bounding box. The corner 

Enter a degree value in the Rotate fields to rotate objects 
by a specific angle.
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control points let you free-rotate your object. 
The control points at the center of each face 
rotate the object along a single axis. 

To rotate around a single axis:

1 Select an object.

2 Hold down Command /Ctrl and drag on 
any face control point. 

You can tell which axis you’re rotating 
around by releasing the Command /Ctrl 
key for a moment. The cursor changes to an 
X, Y or Z.

To free rotate an object:

1 Select an object.

2 Hold down Command /Ctrl and drag on 
any corner control point. 

• Hold down Option/Alt to rotate in very 
fine increments

• Hold down Shift to constrain rotations 
to 45° increments.

Positioning Objects
The composition of your scene depends on the 
position of the objects relative to other objects. 
In most cases, you’ll need to use the Reposition 
tool in conjunction with the Resize and 
Rotation tools to create the desired 
relationships.

Positioning applies to objects, groups and 
families as well as lights and the camera. In this 
section the term “object” also refers to the 
camera and lights.

Bryce lets you position objects in four ways: 
using the Position tool to move objects along a 
specific axis, using the 3D Transformation 
dialog to enter specific offset positions, by 
dragging the object to a different location, or by 
using the arrow keys to nudge objects.

Using the Reposition Tool

The Reposition tool has six different states. As 
you move the pointer over the tool each state 
becomes active.

An object’s bounding box has control points at the corners 
and at the center of each face that can be used to rotate the 
object.

Control 
Points

The rotate tool has six states. As you move your cursor over 
the tool each state becomes active.

Reposition Y up

Reposition Z backReposition X left

Reposition Z front

Reposition Y 

Reposition X right
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To position an object along a specific axis:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Move the cursor over the Reposition tool. 

3 When the state you want to use is active, 
drag in the direction you want to move the 
object. 

To choose a spatial option for repositioning:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Click the triangle icon next to the 
Reposition tool and choose an option from 
the menu:

Object Space moves your selection relative 
to itself (see “Object Space” on page 281).

World Space moves your selection in 
absolute world coordinates (see “World 
Space” on page 280).

Camera Space moves your selection 
relative to the camera (see “Camera Space” 
on page 282).

The three spatial options are also available for 
the Resize, and Rotate tools. When you select 
Object, World, or Camera space for the 
Rotation tool, it is also set for the other two 
tools. Spatial options are global for all 

transformation. The option you choose in the 
Edit palette does not affect the 3D 
Transformations dialog.

To undo position operations:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Click the triangle icon next to the 
Reposition tool and choose Unreposition 
from the menu.

Numerical Repositioning

The most precise method of positioning objects 
is by using the 3D Transformations dialog. This 
dialog lets you enter specific offset values for a 
selected object.

All transformations performed using this dialog 
use World Space coordinates regardless of the 
spatial option you chose for the Reposition 
tool.

Offset values are expressed in Bryce units of 
measure (refer to “Bryce Units” on page 282). 
You may enter negative numbers in the 
Reposition fields.

In this dialog, Bryce units have been 
transposed for the sake of simplicity. For 
instance, an object at Unity size of 
2048x2048x2048 is seen in the 3D 
Transformations dialog box as 
20.48x20.48x20.48.

Moving the decimal two points to the left lets 
you have a full range of resolutions without 
having to enter either excessive integer values 
or values with excessive places to the right of 
the decimal point.
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To reposition an object numerically:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Select an object.

3 Click the triangle icon next to the 
Reposition tool and choose 3D 
Transformations from the menu. The 3D 
Transformations dialog appears.

4 Enter a value in one or all of the Offset 
fields.

The value determines the number of Bryce 
units the object is offset from its current 
position.

Remember that since this dialog only performs 
transformations in world space, you are moving 
the object relative to world X, Y, and Z 
coordinates.

You can also position an object numerically 
using the Object Attributes dialog. The values 
in the Attributes dialog position the object 
using either Absolute coordinates or Object 
space coordinates. Refer to “Absolute 
Coordinates” on page 283 and “Object Space 
Coordinates” on page 283 for more on the these 
coordinate systems.

Interactive Repositioning

The simplest way of positioning objects is by 
dragging them to different locations in your 
scene.

When you drag an object, you’re repositioning 
it with respect to the camera. 

To reposition objects by dragging:

• Pass you cursor over an object. When it 
changes to a crossed arrow, drag the object 
to a new location.

• Hold down Command-Option /
Ctrl+Alt while dragging to constrain 
movement to the X axis. 

• Hold down Option/Alt while dragging 
to constrain movement to the Y axis. 

• Hold down Command /Ctrl while 
dragging to constrain movement to the 
Z axis. 

You can change modifiers mid-drag as you like. 

Nudging Objects

Nudging lets you move objects by pressing the 
arrow keys and the PageUp and PageDown 
keys.

Nudging uses World Space coordinates to 
reposition objects. Each time you press a key, 
the object is moved in 1/4 unity size increments 
(512 Bryce units). Refer to “Bryce Units” on 
page 282 for more on Unity.

Enter a value in the Offset fields to move objects by a 
specific number of units.

Use the Arrow, PageUp and PageDown keys to nudge 
objects in World Space.

PageUp

PageDown

Right

Down

Up

Left
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To nudge an object along the X axis:

1 Select one or more objects.

2 Press either the Right or Left arrow keys.

• Hold down Shift to nudge objects in 1/
2 unity size increments (1024 Bryce 
units)

• Hold down Option/Alt to nudge objects 
in 1/256 unity size increments (8 Bryce 
units).

To nudge an object along the Y axis:

1 Select one or more objects.

2 Press either the PageUp or PageDown 
arrow keys.

• Hold down Shift to nudge objects in 1/
2 unity size increments (1024 Bryce 
units)

• Hold down Option/Alt to nudge objects 
in 1/256 unity size increments (8 Bryce 
units).

To nudge an object along the Z axis:

1 Select one or more objects.

2 Press either the Up or Down keys.

• Hold down Shift to nudge objects in 1/
2 unity size increments (1024 Bryce 
units)

• Hold down Option/Alt to nudge objects 
in 1/256 unity size increments (8 Bryce 
units).

Aligning Objects
Bryce’s alignment features let you position 
several object with respect to each other. 

Alignment transformations are performed with 
respect to the Grid. Bryce maintains an internal 
grid that is comprised of 3D cube increments, 
2048x2048x2048 Bryce units in size. 

The Grid is used for Snap To operations and 
acts as common reference for alignment 
operations. One grid unit is equal to unity size, 
and unity position is always snapped to a 
position on the grid. 

Using the Grid

The Grid can be used as a guide to help you 
precisely position objects in your scene. 

The following example illustrates how the grid 
can be used to position a pyramid beside a 
cube:

To precisely position objects using the grid:

1 Make sure all the objects are unity size.

• When you create primitives like cubes 
or spheres, they are unity size 
(2048x2048x2048 Bryce units). 

The Grid gives you a common reference for all alignment 
operations. If all your objects are at unity size you can use 
grid units to precisely align objects.
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• You can return existing objects to unity 
by holding down Command-Option/
Ctrl+Alt and clicking one of its control 
points.

This returns the objects to a perfect 
multiple of Bryce’s grid units.

2 Determine the objects’ positions relative to 
the grid.

• When you create an object, it usually 
appears at World center or 0, 0, 0. 

• For existing objects, use the Snap to 
Grid option in the Edit palette to move 
the object to a point on the grid.

3 Use the nudge controls to move the object. 
Nudging moves objects in grid increments. 

To place the sphere precisely on top of the 
cube, press the up arrow four times. The 
cube moves up exactly 1 grid unit.

Using the Align Tool

The Align tool has ten different states. As you 
move the pointer over the tool each state 
becomes active.

To align objects along a specific axis:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Select two or more objects. 

3 Move the cursor over the Align tool. 

4 When the state you want to use is active, 
click the mouse button. 

First, return all the objects you’re aligning to unity, they 
fill exactly one grid unit...

...then move the objects to grid using the Snap To Grid 
option...

Finally, use the Nudge controls to move in precise 
increments along the grid.

 As you move your cursor over the Align tool each of its 
states becomes active.

Align X left
Align X center

Align X right

Align XYZ center

Align Z back
Align Z centerAlign Z front

Align X left

Align Y bottom

Align Y center

Align Y top
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Anchor Objects

An anchor object is the object in an alignment 
operation that does not move. All the other 
objects move in relation to the anchor object. 
The anchor object is the first object you 
selected.

Snap To Options

Bryce’s snap to options let you automatically 
align objects to the grid, world center, ground 
or a land object.

To snap objects to the Grid:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Select an object. 

3 Click the triangle icon next to the align tool 
and choose Snap to Grid.

Refer to “Using the Grid” on page 297 for 
more on the grid.

To snap objects to the center of the anchor 
object:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Select an object. 

3 Click the triangle icon next to the align tool 
and choose Snap Together. 

The X, Y, and Z centers of all selected 
objects are aligned the X, Y, and Z center of 
the anchor object in the selection. 

To snap object to the World Center:

1  Make sure the Edit palette is visible. If it’s 
not, click the Edit text button at the top of 
the Working window.

2 Select an object. 

3 Click the triangle icon next to the Align 
tool and choose Snap to World Center.

The selected objects move to coordinate 
X=0, Y=0, Z=0, or World Center.

To drop or lift objects to ground level:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Select an object. 

3 Click the triangle icon next to the Align 
tool and choose Snap to Ground.

Landing Objects

The Land Selection align option lets you snap 
an object to any object directly below it, much 
like creating a gravity effect.
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When you activate the Land Section option, 
Bryce looks snaps the selected object to the top 
of any object directly below its center “Y” 
control handle. 

The second object must be directly below the Y 
control handle, otherwise the object lands on 
the ground plane

.

If the selected object is below the ground 
plane, it snaps up to the bottom of any object 
directly above its top center Y handle.

Landing operations work best with objects that 
have not been rotated, and that have no sloped 
characteristics. 

This option can create many interesting effects. 
For example, you can quickly create falling rock 
animations by placing rock objects throughout 
your scene with a terrain below them in one 
frame. Then, in a different frame, select all the 
rocks and choose the Land Selection option. 
When you run the animation, all the rocks will 
appear to fall onto the terrain. Refer to 
“Animating” on page 353 for more on 
animation.

Using Land Selection, a selected object snaps to the top of 
any object that’s directly below its Y control handle.

In this example, a corner of the selected object is over the 
“land” object, but since there are not objects directly under 
its Y control handle, the selected object lands on the 
ground.

When the selected object is below ground, it snaps up to 
the bottom of an object directly above its Y control handle.
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To snap object to the top surface of an 
object below it:

1  Make sure the Edit palette is visible. If it’s 
not, click the Edit text button at the top of 
the Working window.

2 Select an object. 

3 Click the triangle icon next to the Align 
tool and choose Land Selection from the 
menu.

or 

Click the Down arrow icon that appears 
next to the object’s bounding box.

Anchor and Non-Anchor Based 
Aligning

Bryce provides two ways to align multiple 
objects: anchor-based aligning and non-
anchor-based aligning.

Anchor-based aligning considers the first 
selected object to be the anchor of the aligning 
operation. All other objects are aligned to this 
object.

With non-anchor-based aligning, objects are 
aligned to the bounding box of all the selected 
objects.

Aligning Numerically

The most precise method of aligning objects is 
by using the 3D Transformations dialog. The 
dialog uses Bryce units for positioning, so you 
can use these increments to align objects based 
on grid increments (20.48=one grid unit).

In this dialog, Bryce units have been transposed 
for the sake of simplicity. For instance, an object 
at Unity size of 2048x2048x2048 is seen in the 
3D Transformations dialog box as 
20.48x20.48x20.48. 

Moving the decimal two points to the left lets you 
have a full range of resolutions without having 
to enter either excessive integer values or values 
with excessive places to the right of the decimal 
point.

These objects were aligned using the Land Selection 
option.
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Randomizing Objects
The Randomize tool is a great way of randomly 
dispersing objects throughout your scene 
without having to manually position each 
object. 

Using the Randomize Tool

The Randomize tool has eight different states. 
When you click on the tool, it cycles though its 
different modes.

To randomize objects:

1 Make sure the Edit palette is visible. If it’s 
not, click the Edit button at the top of the 
Bryce window.

2 Select a number of objects. 

3 Click the Randomize tool repeatedly until 
the mode you want to use is active.

There are eight modes available:

2D Disperse scatters your selection 
randomly along the horizontal (X and Z) 
plane.

2D Disperse/Rotate scatters and rotates 
your selection randomly along the 
horizontal (X and Z) plane.

2D Disperse/Size scatters and resizes your 
selection randomly along the horizontal (X 
and Z) plane.

2D Disperse/Size/Rotate scatters, resizes 
and rotates your selection randomly along 
the horizontal (X and Z) plane.

3D Disperse scatters your selection 
randomly in 3D space.

3D Disperse/Rotate scatters and rotates 
your selection randomly in 3D space.

3D Disperse/Size scatters and resizes your 
selection randomly in 3D space.

3D Disperse/Size/Rotate scatters, resizes 
and rotates your selection randomly in 3D 
space.

4 Click the Randomize Sphere. 

5 The selected objects are randomized.

To randomize objects interactively:

1 Select a number of objects. 

2 Drag over the Randomize sphere. Release 
the mouse button when you achieve the 
desired effect.

2D Disperse

2D Disperse/Rotate

2D Disperse/Size

2D Disperse/Size/Rotate

3D Disperse

3D Disperse/Rotate

3D Disperse/Size

3D Disperse/Size/Rotate

 As you click the Randomize tool each of its states becomes 
active.
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Object Hierarchies
An object hierarchy lets you create 
relationships between objects, by grouping a 
linking object together. 

A hierarchy adds structure to the objects in 
your scene. This can make arranging and 
animating objects much easier. When you’re 
arranging objects a hierarchy can make 
positioning and rotating easier since you can 
transform an entire hierarchy all at once 
instead of separately. The same is true for 
animating. You can quickly create motion 
animations by changing the position of a parent 
object, since all its children will move with it.

Hierarchies can be created by either grouping 
or linking objects. 

Grouping vs. Linking

Both grouping and linking let you create 
functional or spatial relationships between 
objects. The difference is how the objects 
within each hierarchy work. Within a group all 
the objects act as one. If one moves they all 
move. If one object is rotated, they all rotate. 
This type of hierarchy is good for creating 
complex objects with static parts, like a tree or a 
large terrain.

Within a linked hierarchy objects behave 
differently depending on which object within 
the hierarchy is being transformed. Any 
transformation you apply to the parent object is 
applied to all its children. However, 
transformations applied to a child object do not 
affect the parent. This type of hierarchy is good 
for creating objects that have moving parts or 
animating two objects with the same motion.

You can control exactly which transformations 
are applied to a child object using the options 
on the Linking tab in the Object Attributes 
dialog.

Hierarchical Structure

A hierarchical structure consists of a parent 
object or objects and its descendants. In the 
case of linking, the parent object is at the top of 
the hierarchy and its children are below it. 
Children in the hierarchy can also have 
children creating a branched hierarchy. 

In a hierarchy created using links, the parent 
object is obviously the parent object in the link. 
The children are any object linked to the 
parent. If you have multiple linked objects in a 

Group hierarchies are good for creating complex objects 
that have no moving parts like this terrain group. As you 
move the group all the objects in the group move.

Linked hierarchies are good for creating objects that have 
moving parts like this grandfather clock. As you move the 
parent all the objects in the hierarchy move, as the child 
moves the parent remains unchanged.
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hierarchy, the parent object at the top of the 
hierarchy is the parent object in the first link 
you created.

In a hierarchy created using groups, the parent 
object is the group. All the objects within the 
group are the children. If you have multiple 
groups within a group, the parent object is the 
final group you create.

A hierarchy can be made up of both linked and 
grouped objects. One way of creating this type 
of hierarchy is by grouping the parent objects 

from different link hierarchies together. In this 
case, the final group you create would become 
the parent object of the hierarchy. 

You cannot create a group using a child object. 
Only parent objects can be part of a group. 
When the parent is in a group all its children are 
also part of the group since they must follow the 
parent.

You could also create a hierarchy where a group 
is linked to a parent object. In this case, the 
parent object of the hierarchy would be the 
parent from the first link you created.

Viewing Object Hierarchies

The Hierarchy list area of the Advanced Motion 
Lab lets you see a list of all the objects in your 
scene. Object hierarchies are indicated by 
indents. A parent object is listed at the far left 
of the area; its children appear indented 
beneath it. 

The name of an object that appears in the 
Hierarchy listing can be set using the Object 
Attributes dialog. If no name is set, a default 
name is used (for example Sphere 1). 

In this link hierarchy the parent object has one child and 
that child has two children one of which also has a child. 
So if you were to transform this hierarchy, any operation 
you perform on the Parent at the top of the hierarchy is 
applied to all its children.

In this group hierarchy the parent group has four children 
one of which is a group that contains four children. If you 
were to transform this hierarchy, any operation you 
perform on the parent group would be applied to all the 
children.

Parent 
Object

Child Object

Parent Object

Child Object

In this hierarchy the parent object is a group that has four 
children one of which is the parent object of a link 
hierarchy that has two children.

Parent Object

Child Object
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These names are unique for each item in the 
scene, and are not reused regardless of the 
number of objects you create or whether the 
object has been deleted. 

To view a listing of the hierarchy:

1 In the Working window, make sure there 
are no objects selected. This will let you 
see all the hierarchies in your scene.

2 Click the Advanced Motion Lab button at 
the bottom of the window. The Advanced 
Motion Lab appears.

The Hierarchy List area, located along the 
bottom-left side of the lab, displays all the 
hierarchies in your scene.

Expanding and Collapsing a Hier-
archy

The arrow buttons next to an object’s listing 
indicate whether the hierarchy is expanded or 
collapsed. A collapsed hierarchy shows only the 
parent objects in the hierarchy. An expanded 
hierarchy shows a listing for all the children.

To expand/collapse a hierarchy listing:

• Click the arrow icon that appears next to a 
listing’s name to expand it. 

Click the arrow again to collapse the 
listing.

Linking Objects

When you link two objects, you connect them 
so that when one object moves, so does the 
other. This is called a Parent/Child link.

An indented listing indicates that there is a parent-child 
relationship between objects.

The Advanced motion Lab buttons displays the Advanced 
Motion Lab where you can see the hierarchy listing for 
your scene.

Parent Object

Child Object

Child Object

The arrows along the left side of the hierarchy list indicate 
whether the hierarchy is open or closed.

Expanded Hierarchy

Parent Object

Child Object

Collapsed Hierarchy
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In a parent-child link, the parent controls the 
actions of the child. This means that when the 
parent object moves, so does the child object. 
However, when the child object moves, the 
parent object does not. 

A child object will start its movement from it 
original position and always maintain a 
constant distance from the parent. The distance 
is determined by the original positions of the 
objects before they were linked.

The movement of the child object depends 
entirely on the type of transformations you 
apply to the parent object.  

To link objects in the Working window:

1 Select the object you want to set as the 
child object. A series of icons appear next 
to the object’s bounding box.

In a parent-child link, the movement of parent object 
dictates the movement of the child.

However, the parent object is unaffected by the child 
object.

If you rotate the parent, the child will orbit around it like a 
moon around a planet.

Parent moves

Child moves

Parent doesn’t move

Child moves

If the parent is moving along a path, the child will match 
the trajectory of the parent’s path, but maintain a constant 
distance from the parent object.

If both the parent and the child are moving along a path, 
the child object moves along its path while matching the 
trajectory of the parent object’s path.

The icons along the right side of the object’s bounding box 
let you interactively link objects.
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2 Click the Link icon and drag the linking 
line to the object you want to use as the 
parent object. 

You cannot create a link where the parent object 
is the child of its own child object (i.e.; a loop).

The parent object turns blue.

To link objects using the Object Attributes 
dialog:

1 Select the object you want to use as the 
child object. 

2 Click the A icon that appears next to the 
object’s bounding box. The Object 
Attributes dialog appears.

3 Click the Linking tab.

4 Click the Object Parent Name menu and 
choose the name of the object you want to 
use as the parent object.

5 Click the OK icon to link the two objects.

To break a link:

1 Select a child object.

2 Click the A icon that appears next to the 
object’s bounding box. The Object 
Attributes dialog appears.

3 Click the Linking tab.

4 Click the Object Parent Name menu and 
choose None.

5 Click the OK icon to unlink the two 
objects.

The object you select first becomes the child object. The 
object you drag the link line to becomes the parent object.

Use the options on the Linking tab of the Object Attributes 
dialog to setup the linking relationships between objects.
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Linking Options

Using the options available in the Linking tab 
on the Object Attributes dialog, you can control 
which parent object transformations are 
applied to child objects and how objects are 
constrained when they’re linked to a path.

Parent to Child Transformations 
Options

Once you’ve created a link you can determine 
exactly which transformations applied to the 
parent will affect the child. 

To set which parent object transformations 
are applied to a child:

1 Display the Object Attributes dialog.

2 Click the Linking tab.

3 Disable the buttons for the transformation 
you don’t want applied to the child.  

Geometric Path Linking Options

A Geometric path is an object that acts a kind 
of track for controlling the motion of objects. 
Normally when you link an object to a 
Geometric Path it is constrained to the path. 
However, using the linking options in the 
dialog you can disable or enable constraining. 

When an object is constrained to the path, it 
can only move along the path. When its not 
constrained it acts like a regular child of the 
path. Its movement is not constrained to the 
path.

The options in this dialog also let you set where 
on the path a object begins its motion. 

Refer to “Creating Geometric Paths” on 
page 117 for more on Geometric Paths.

To constrain/unconstrain an object to a 
geometric path:

1 Select an object linked to a geometric path.

2 Display the Object Attributes dialog.

3 Click the Linking tab.

4 Enable the Constrain to path button to 
constrain the object to the path.

• Disable the button to unconstrain it.

To set where the object sits on the path:

1 Select an object linked to a geometric path.

2 Display the Object Attributes dialog.

3 Click the Linking tab.

4 Enter a percentage in the Position field. 

100% places the object at the end of the 
path, and 0% places it at the beginning.

Grouping Objects

As your scene becomes more complex you’ll 
want to group objects. Grouping lets you 
control a set of objects as a single unit. When 
you perform a transformation on a group all the 
objects are equally affected. If you scale a 

The enabled buttons on the linking portion of the Linking 
tab represent the transformations that will be applied to 
child object.
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group, all the objects change size, or if you 
rotate a group, all the objects rotate around a 
single axis.

The objects you place in a group depend on 
how you want to organize your scene. You may 
want to group the objects that comprise more 
complex objects, like the walls and turrets of a 
castle. 

You can also create groups to maintain the 
spatial relationships between objects as you 
transform them. 

You can place as many objects as you like in 
your group. You can even nest groups within 
groups. Nesting can be an easy way of managing 
more complex scenes.

Groups are essential to creating Boolean 
objects. Boolean operations will not work 
unless the objects are part of a group. Refer to 
“Creating Boolean Objects” on page 114 for 
more on Booleans.

You cannot create a group using a child object. If 
a child object is part of your selection the “G” 
icon will not appear, meaning that you can’t cre-
ate a group from the objects.

To create a new group:

1 Select all the objects you want to group.

2 Choose Objects menu>Group, or press 
Command/Ctrl-G. You can also click the G 
button next to the selected objects’ 
bounding box. 

You can group objects to keep all the components of a 
complex object like this castle together.

You can also create a group to maintain the spatial 
relationships between objects as you transform them, like 
the boards in this fence.

Click the G button next to a selection’s bounding box to 
create a group.
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To select objects within a group:

• Hold down Control/Ctrl and click on the 
object inside the group bounding box.

Families

Families are a way of creating “logical groups.” 
Unlike regular groups, families are not treated 
as a single unit for transformations. Families 
help you keep track of elements in you scene, 
and can be used for selection purposes. For 
example, you can put all the elements that make 
up the background of your scene in to one 
family, all the items with a particular material in 
an another, all trees in another and so on.

Each family has a different object color. The 
color appears only when the object is not 
selected, since a selected object’s bounding box 
appears red.

To create a new family:

1 Select all the objects you want in the 
family.

2 Click the colored box next to the 
selection’s bounding box. The Family 
dialog appears. 

3 Click on a color. The color is applied to the 
bounding box of all the objects in the 
family.

4 You adjust these colors by dragging the 
rectangular color swatch at the bottom of 
the dialog. It’s best not to use black or 
white since they are difficult to see, or red 
since it’s the color of a selected object.

5 Enter a name for the family in the text 
field.

To select a family:

1 If the Animation controls are visible at the 
bottom of the Bryce window, click the Time 
Selection Palette toggle to display the 
Selection palette. 

• If there is nothing at the bottom of the 
window, move your cursor over the 
bottom area. The Selection palette 
appears.

2 Click the Family button and choose the 
name of the family you want to select from 
the menu.

You can easily see which objects belong to the same family 
when there no objects selected in the Working window.

Click the gray box next to a selection’s bounding box to 
create a family.

The Families button in the selection palette displays a list 
of all the families in your scene.
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12  

Editing Objects

Overview
Every object in Bryce has attributes that allow 
you to control everything from its position in 
the scene to how it animates along a path. 
Some objects have special editors that are spe-
cifically designed to adjust the attributes that 
are unique to the object type.

This chapter describes how you edit object 
properties and also covers how to use the 
Torus and Mesh editors.



Restoring Objects
Every object in Bryce has a default size and 
shape. When you create an object, the default 
size is used to define its size and placement. 

As you transform and edit objects these default 
properties are discarded and replaced. How-
ever, you can return an object to its original 
state at any time. 

The restore control returns the object to its 
default size and orientation, regardless of the 
number of transformations you’ve applied to it.

To restore an object:

• Hold down Control-Option/Alt+Shift (PC) 
or Control (Mac) and click one of the 
bounding box handles. 

Editing Object Attributes
Every object in Bryce has several attributes that 
let you control the object’s size, position, rota-
tion, Boolean state, preview and whether or not 
it’s locked.

There are two ways of editing an object’s 
attributes: the Object Attributes dialog and the 
Object Controls that appear next to the object’s 
bounding box. 

Object Attributes Dialog

The Object Attributes dialog contains three 
tabs which let you set various object properties:

• General contains options that let you set 
the object name, position, size, rotation 
and display quality.

• Linking contains options that let you set 
up a link between two objects. You can also 
use this tab’s options to set up a tracking 
link.

• Animation contains options for 
controlling the display of motion paths and 
setting motion path type.

To display the Object Attributes dialog:

1 Select an object.

2 Choose Objects menu> Edit Attributes, or 
press Command-Option-E/Ctrl+Alt+E, or 
click the A button next to the object’s 
bounding box.

When you use the restore control, the cursor changes to a 1 
when passed over the object’s bounding box.

Use the Object Attributes dialog to set transformation, 
linking and animation object properties.
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Object Attribute Icons

The Object Attribute icons appear as a list of 
buttons along the right side of an object’s 
bounding box. The icons that appear in this list 
vary depending on the type and number of 
objects selected.

These icons let you:

• Access the Object Attributes dialog, the 
Material Composer and any editors 
associated with the object

• Group objects in a selection

• Add objects to families

• Align objects

• Link objects

• Set up object tracking

If your selection falls outside of your Working 
window, the icons appear in the rightmost area 
available on the screen.

To display Object Attribute icons:

• Select an object or group of objects.

Object Attributes Icon

This control displays the Object Attributes dia-
log. When the dialog opens, it shows the cur-

rent name, position, orientation and scale of 
the object.

To display the Object Attribute dialog:

1 Select an object or group of objects.

2 Click the A icon that appears next to the 
object’s bounding box.

Families Icon 

This control indicates the family to which the 
object belongs. It also displays the Family dia-
log. Refer to “Families” on page 310 for more 
information. 

To add selected objects to a family:

1 Select all the objects you want to add to 
the family.

2 Click the Family icon that appears next to 
the object’s bounding box. The Family 
dialog appears.

3 Choose a color that represents an existing 
family, or enter a name to create a new 
family.

4 Click the OK icon. The color you select 
becomes the object’s wireframe color.

The Object Attribute icons that appear next to an object’s 
bounding box let you access different editors and set object 
attributes.

Use the Families dialog to add an object to an existing 
family or create a new one.
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Linking Icon

This control lets you set up a parent-child link 
between two objects. When the objects are 
linked, the transformations you apply to the 
parent object affect the child. Refer to “Linking 
Objects” on page 305 for more information.

To link one selected object to another:

1 Select the object you want to be the child 
object within the link.

2 Click the Link icon and drag it to the 
object you want to be the parent object. 
Release the mouse button when the parent 
object turns blue.

A link line extending from the child object 
to the parent appears as you drag.

Tracking Icon

This control lets you set up a Tracking link 
between two objects. When an object tracks 

another, the selected object pivots as the target 
object changes position so it’s always faces its 
target. Refer to “Tracking Objects” on page 382 
for more on tracking.

To set a selected object to track another:

1 Select the object you want to be the 
stationary object.

2 Click the Tracking icon and drag it to the 
object you want to be the target object. 
Release the mouse button when the target 
object turns blue.

A tracking line extending from the 
stationary object to the target appears as 
you drag.

Group Icon 

This control appears only if your selection con-
tains multiple objects. When you click this con-
trol all the objects in the selection are grouped. 
Refer to “Grouping Objects” on page 308 for 
more on grouping.

As you drag the Link icon, a link line extends from the 
child object.

As you drag the Tracking icon, a tracking line extends 
from the stationary object.
314 Editing Objects 



If this icon does not appear when you have a 
multiple selection, it means that you can’t 
group the selected objects because of some 
kind of object hierarchy conflict. Refer to 
“Object Hierarchies” on page 303 for more 
information.

To group selected objects:

1 Select all the objects you want grouped.

2 Click the G icon that appears next to the 
object’s bounding box. A group bounding 
box appears around all the objects.

Ungroup Icon 

This control only appears if you’ve selected a 
group or a number of objects contained in a 
group. When you click this control, any group 
in the selection is ungrouped. If the selection 
contains nested groups, you can continue click-
ing this control until all the groups are 
ungrouped, or until the control disappears.

To ungroup a selected group of objects:

1 Select all the objects you want ungrouped.

2 Click the U icon that appears next to the 
object’s bounding box. 

Material Icon

This control displays the Materials Lab. Refer 
to “Materials” on page 189 for more on Materi-
als. When you use this control, the Materials 
Lab displays the material currently applied to 
the selected object, and the object appears in 
the Material Preview area of the lab.

To display the Materials Lab:

1 Select an object or group of objects.

2 Click the M icon that appears next the 
bounding box.

Edit Object Icon

This control only appears if the object you 
selected is a terrain, a symmetrical lattice, a 
torus, a stone, an imported polyhedron object 
or a light. When you click this control, the edi-
tor for the object type you have selected opens. 

To display an object’s editor:

1 Select an object or group of objects.

2 Click the E icon that appears next to the 
bounding box.

Land Object Icon

This control appears as either an arrow point-
ing up or down, depending on the position of 
the object selected.

When you click this control, the object snaps to 
the top of the object below it. This control 
works like the Land Selection option available 

A large bounding box around a number of objects 
indicates a group.
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in the Edit palette. Refer to “Landing Objects” 
on page 299 for more.

To land a selected object:

1 Select the object you want to land.

2 Click the Arrow icon that appears next to 
the object’s bounding box. The object 
snaps to the top of the object directly 
below it.

If the selected object is below ground, it 
snaps to the bottom of the object directly 
above it.

Editing Object Names 

The Object Name field in the General tab of the 
Object Attributes dialog lets you name a 
selected object. An object’s name identifies it 
within the scene. 

When you have many objects of the same type, 
object names are used to select a specific 
object. The name is also used to identify an 
object in a hierarchy. Object hierarchies 
appears in the Hierarchy List area of the 
Advanced Motion Lab. Refer to “Object Hierar-
chies” on page 303 for more on hierarchies.

Editing Boolean Attributes 

Boolean attributes, listed in the General tab of 
the Object Attributes dialog, control how an 
object acts in a Boolean operation. For exam-

ple, if a boolean attribute is set to Negative, the 
object subtracts an area from a positive object. 

Refer to “Boolean Operations” on page 115 for 
a complete discussion of Boolean operations.

To set an object’s Boolean attributes:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable one of the checkboxes at the top of 
the dialog:

Neutral defines any selected object, 
objects, or group as non-Boolean. No 
Boolean operation can be performed on a 
neutral object. This is the default setting 
for all objects

Positive defines any selected object, 
objects, or group as solid when grouped. 

Negative defines any selected object, 
objects, or group as negative when 
grouped. Think of a negative object as a 
“cutting object.”

The Object Name Field lets you enter a name for the 
selected object.

These are examples of some of the objects you can create 
using Boolean operations.

The four options on the top right side of the General tab let 
you set an object’s Boolean attributes.
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Intersect defines any selected object, 
objects, or group as an intersecting object 
when grouped.

Editing Display Quality 
Attributes

The display options available in the General tab 
of the Object Attributes dialog let you control 
how the object appears in the Working window. 
Some of these options can speed up the redraw 
of your scene.

Hidden

When you apply this option to an object, it is 
not rendered when you render your scene. The 
object remains visible in the Working window, 
where you can still select and edit it, but it will 
not be visible in the final render.

To hide an object:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable the Hidden button.

Locked

This option locks any selected object, objects, 
or group, preventing unintentional changes to 
size, position, rotation, or material assignment. 
Locked objects appear grayed-out in your wire-
frame view. 

To lock an object:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable the Locked button.

To unlock an object:

1 Click the Time Selection Palette toggle at 
the bottom of the Working window to 
display the Selection palette.

2 Click an object type button or hold down 
the mouse while passing the pointer over 
an object type button and choose the 
desired object from the menu that appears.

Show as Box

This option displays any selected object, 
objects, or group as a box. This is useful when 
you just want to work with the object’s position, 
but don’t need more details. It can speed up 
work in a complex scene because it displays 
simpler objects. You can still manipulate your 
object using the bounding box control points.

To display an object as a box:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable the Show as Box button.

Show Origin Point

This option displays the selected object’s origin 
point. Once its displayed, you can edit the posi-

The four options on the top left side of the General tab let 
you set how the object is displayed in the Working window.

Use the Time Selection Palette toggle to switch between the 
Animation controls and the Selection palette.
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tion of the point to change the object’s center 
of rotation. Refer to “Object Origin Points” on 
page 286 for more on origin points.

To display an object’s origin point:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable the Show Origin Point button.

Editing Transformation 
Attributes

The numeric entry fields on the General tab of 
the Object Attributes dialog describe an 
object’s position, orientation, and size in 3D 
space. You can adjust these attributes by enter-
ing values in one or all of the numeric fields.

The values in this dialog use either Absolute or 
Definition coordinates for transformations. 
Absolute coordinates use the World Space X, Y, 
and Z axes as a reference for transformations. 
Definition coordinates redefine how the object 
is created in Object Space. Refer to “Coordi-
nate Systems” on page 283 for more on these 
coordinate systems. 

Using Definition coordinates can create some 
unpredictable results because you’re redefining 
the entire object when you change the Offset, 
Rotate and Size values.

To set an object’s origin point:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enter values in the Origin X, Y and Z 
fields.

To set an object’s position:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enter a value in the Position X field to set 
the object’s position on the X axis. This 
axis moves the object left or right.

4 Enter a value in the Position Y field to set 
the object’s position on the Y axis. This axis 
moves the object up or down.

5 Enter a value in the Position Z field to set 
the object’s position on the Z axis. This axis 
moves the object backwards or forwards.

When you select multiple objects and 
access this dialog, there are no values 
displayed in the Position fields. If you then 
enter a value in any offset field, the selected 
objects are moved to the new coordinate, 
essentially aligning them in the same place 
relative to the designated axis or axes.

To rotate an object:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enter a value in the Rotate X field to set 
the object’s rotation around the X axis. 

You can enter negative values, values 
greater than 360 or values less than -360. 
Bryce reduces the value to an absolute 
value within a range of 0-360.

The Offset, Rotate and Size fields let you numerically 
transform the selected object.
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4 Enter a value in the Rotate Y field to set the 
object’s position on the Y axis.

5 Enter a value in the Rotate Z field to set 
the object’s position on the Z axis.

To set an object’s size:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enter a value in the Size X field to set the 
object’s size in the X axis.

You can enter negative values here if you 
need to.

4 Enter a value in the Size Y field to set the 
object’s size in the Y axis.

5 Enter a value in the Size Z field to set the 
object’s size in the Z axis.

When you select multiple objects and 
access this dialog, there are no values 
displayed in the Size fields. If you then 
enter a value in any Size field, the selected 
objects are scaled to the new coordinate.

Editing Link Attributes

Link attributes control how an object is linked 
to another. The controls on the Linking tab of 
the Object Attributes dialog let you set parent-
child link attributes and tracking attributes.

Linking 

When you link an object to another, you create 
a parent-child relationship. Transformations 
applied to the parent object affect the child, but 
transformations applied to the child object do 
not affect the parent. Refer to “Linking 
Objects” on page 305 for more on linking.

The Link options let you set the parent object 
for the selected object and choose which parent 
object transformations will affect the child.

To link objects:

1 Display the Object Attributes dialog.

2 Click the Linking tab.

3 Click the Object Parent Name field and 
choose a name from the menu that 
appears.

Choose None to break a link.

4 Enable a Propagate option. These options 
control which Parent object 
transformations affect the child.

Tracking

When you set up a tracking link, the stationary 
object tracks the target object as it moves or 
rotates. Whenever the target object moves, the 
stationary object pivots so that its always facing 
the target.

The Link options let you set up the attributes of a parent-
child link.
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The Tracking options let you set the target 
object for the selected object and define which 
axis of the stationary object will face the target.

To set an object to track another:

1 Display the Object Attributes dialog.

2 Click the Linking tab.

3 Click the Track Object Name field and 
choose a name from the menu that 
appears.

Choose None to break a tracking link.

4 Enable one of the Orientation options. 
These options set which object axis will 
track the target.

Editing Animation Attributes

Animation attributes control the display of an 
object’s motion path. A motion path is a graph-
ical representation of an object’s trajectory over 
the course of the animation. Refer to “Motion 
Paths” on page 376 for more on motion paths.

The options on the Animation tab of the Object 
Attributes dialog let you control how an 
object’s motion path is displayed in the Work-
ing window and how that path is drawn.

Motion Path Display Options

Normally, a motion path is displayed as it is 
being drawn and when the object is selected. 
The motion path display options on the Anima-

tion tab of the Object Attributes dialog let you 
control when the motion path is displayed. 

To set motion path display options:

1 Display the Object Attributes dialog.

2 Click the Animation tab.

3 Enable one or all of the display options:

Show Trajectory enables or disables the 
display of the motion path. When it is 
disabled, no motion path is drawn.

Show When Selected displays the motion 
path only when the object is selected.

Show Always displays the motion path at 
all times, even when the object is not 
selected.

Motion Path Attributes

When a motion path is created, it looks like a 
curve that extends out from an object. The 
motion path attributes let you display addi-
tional information on a motion path. 

To set motion path attributes:

1 Display the Object Attributes dialog.

The Tracking options let you set the attributes for a link 
between a stationary object and its target.

The Motion Path Display options let you control when an 
object’s motion path appears.

The Motion Path Attributes let you control the appearance 
of an object’s motion path.
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2 Click the Animation tab.

3 Enable one or all of the attributes:

Show Handles displays or hides the path’s 
control handles. The handles represent key 
frames.

Show Tangents hides or displays lines 
extending from each control handle. 
Tangents help you see the slope of the 
curve.

Show as Ribbon displays the motion path 
as a flat ribbon in the working window. 
This makes the path easier to see when you 
move the camera.

Align Options

Normally, unless you apply a rotation, an 
object’s orientation remains constant as it 
moves along a motion path. The align options 
let you force the object’s orientation to match 
the slope of the motion path so that as the path 
curves up, the object tilts up.

To set align options:

1 Display the Object Attributes dialog.

2 Click the Animation tab.

3 Enable one of the following options:

Do Not Align disables aligning. The shape 
of the curve has no effect on the object’s 
orientation. This is the default setting.

Align adjusts the object so that its 
orientation matches the shape of the path.

Motion Path Geometry Options

The shape of a motion path is determined by 
the position of the object as it moves through 
the animation. The motion path geometry 
options let you change the shape of the path to 
create different effects.

To set motion path geometry options:

1 Display the Object Attributes dialog.

2 Click the Animation tab.

3 Enable one or all of the options:

Make One Shot restores the path to its 
original shape, meaning the shape created 
by changes in the object’s position.

Make Repeat creates a loop in the action. 
The motion on the path will continuously 
repeat.

Make Pendulum creates a repeating cycle 
in the action along a path. The object will 
move forward on the path and then back.

Make Circular closes the path to create a 
circular path. The object will move along 
the path until it reaches the end. It then 
swings around to the front of the path and 
starts over. You must have at least four 
position key frame points for this feature to 
work.

The Align options let you control how an object is aligned 
to its motion path.

The Motion Path Geometry options let you control the 
shape of an object’s motion path.
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Editing Toruses
A torus object is any pre-made donut-shaped 
object in Bryce. The Torus editor lets you adjust 
the inner radius of any torus object.

To display the Torus editor:

1 Click a Torus object.

2 Click the E button that appears next to the 
object’s bounding box.

To adjust the inner radius:

• Press and drag on the spinning Torus. 
Release the mouse when the radius is the 
size you want.

To accept your changes and exit the Torus 
Editor:

• Click anywhere outside the Torus Editor, or 
press the Return/Enter key.

To exit the Editor without accepting any 
changes:

• Press the Escape key.

Editing Imported Meshes 
and Stones
Imported objects (such as DXF or 3DMF 
objects) and Bryce’s Stone objects are both 
treated as meshes inside Bryce. 

The Mesh Editor lets you adjust the smooth-
ness of an object’s surface. You can smooth 
objects that are very rough or remove the 
smoothing previously applied to DXF objects. 

It is not a good idea to smooth or unsmooth 
Stones. These objects are highly dependent 
upon the clumpiness of the polyhedral shape as 
well as the bumpiness in the assigned proce-
dural texture to retain their realism. Smooth 
stones look very unnatural.

To smooth imported objects or stones:

1 Click the imported object or stone.

2 Click the E button that appears next to the 
object’s bounding box.

3 Adjust the value of the smoothing range by 
dragging the gauge along the left side of 
the dialog.

The gauge sets the maximum angle you 
wish to be smoothed.

For instance, you may wish to smooth all 
angles under 90° (to preserve the sharpness 
of cubes, perhaps). In that case, set the 
maximum angle to 85 before smoothing.

4 Click the Smooth button until you achieve 
the desired effect. The more you click, the 
smoother the object becomes.

Use the Torus editor to adjust the inner radius of a torus 
object.
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To unsmooth imported objects or stones:

1 Click the imported object or stone.

2 Click the E button that appears next to the 
object’s bounding box.

3 Adjust the value of the smoothing range by 
dragging the gauge along the left side of 
the dialog.

The gauge sets the maximum angle you 
wish to be unsmoothed.

For instance, you may wish to unsmooth all 
angles under 90°. In that case, set the 
maximum angle to 85 before unsmoothing.

4 Click the Unsmooth button until you 
achieve the desired effect. The more you 
click, the sharper the object becomes.

Converting Objects 
The Convert tool in the Edit palette lets you 
covert any type of object into another type of 
object with a single click. So you can change a 
square into a light, a terrain into a sphere, or an 
infinite plane into a cone. 

Any transformations you applied to the original 
object are preserved through the conversion.  

Conversions cannot be animated. You can’t have 
a box that turns into a cone over time.

To convert an object to another type of 
object:

1 Select the object you want to convert.

2 Click the Edit button at the top of the 
Bryce window to display the Edit palette.

3 Click the double-headed arrow in the top 
left corner of the palette and choose an 
object type from the pop-up palette that 
appears.

The Convert tool lets you quickly turn any object into any 
other. In this example, the object changed from an 
Egyptian pyramid...

...to a rocky desert by converting the pyramid primitive 
into a plane.

The pop-up palette that appears in the Edit palette 
displays all the object types you can convert your selected 
object to.
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13  

The Camera and 
Lights

The View of Your Scene 
and Lighting in Bryce
You can think of the view of your scene as the 
view seen through a window onto a whole new 
world. The view you see through this virtual 
window is determined by the orientation and 
position of a camera. As you move the camera, 
you get a different view of your world.

How much of the world is visible is 
determined by the lighting. The position of the 
light sources in your scene can determine 
everything from visibility to the time of day to 
the color of the atmosphere.



The View of Your Scene
The view of your scene refers to the portion of 
the scene visible in the Working window. There 
are eight views of your scene available in Bryce: 
the Camera View, which is the view produced by 
the Camera in the scene, the Director’s View, 
which shows your scene from the perspective 
of a director sitting outside of the scene, and 
the orthogonal projections (Top, Bottom, Left, 
Right, Back and Front) which are perspective-
free views of your scene.

Camera View

Camera View is produced by the Camera which 
exists in 3D space, meaning that you can view 
your scene from anywhere within your Bryce 
environment—even underneath it. The Camera 
View can be positioned using the positioning 
tools or by repositioning the Camera in the 
scene.

The Camera has a wireframe which can be 
dragged in the Working window and its 
motions can be recorded as an animation. 
However, the wireframe is only visible in the 
Director’s View or one of the orthogonal views.

Director’s View

The Director’s View gives you the freedom to 
look at your scene from any perspective, while 
still being able to manipulate the Camera as an 
object. 

The Director’s View motions are not recorded 
as part of an animation. This means that you 
can move to any position without inadvertently 
changing the view of your scene in the 
animation. The Director’s View can also be an 
invaluable tool for animating the view of your 

scene. While in this view, you can select the 
Camera and reposition it anywhere in the scene 
to create camera motions.

Director’s View is the default view of the scene. 

Orthogonal Views

These six views let you see the scene from all 
sides. They do not show you any perspective, 
but you can see all the objects in the scene 
including the camera. 

These views are only flat projections of the 
scene, so you can’t move around them using the 
camera controls. 

Lights
Lighting is what makes your scene visible. 
Different types of lighting can dramatically 
alter the appearance of your scene and the 
objects in the scene. 

In Bryce, most of the lighting in your scene is 
provided by either the sun or the moon. As in 
nature, the position of the Bryce sun controls 
the general brightness and ambient color of 
scenes. However, you can add additional light 

This is what your scene looks like when you view it in 
Director’s View.
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sources to create a variety of effects, like adding 
headlights to a car, or creating the glare of a 
distant city.

Refer to “Working with the Sun” on page 145 
for more on positioning and setting up the sun.

Viewing Lights

In Wireframe mode, lighting effects are not 
visible. Instead, all objects are displayed as 
wireframes to make it easier and faster for you 
to edit and position objects. Lighting appears 
in three places: the Shaded Preview mode, the 
final rendered scene, or in the Nano-Preview. 

In Nano-Preview, you can see a small preview of 
your lighting effects. This is the only preview 
available in Wireframe mode.

In Shaded Preview mode, all the objects in 
your scene appear as flat solids. Any lighting 
you apply creates simple highlights on the 
surface of the object. This mode does not show 
materials.

Shaded Preview mode is only available if you 
have a system that supports OpenGL. Refer to 
“Display Modes” on page 17 for more on this 
mode

If you want to see the effects of lighting on 
object materials, you’ll need to render the final 
image. 

You can use light sources to shine light from areas where 
sunlight couldn’t shine, like the light from inside a 
lighthouse.

Lighting effects also appear in the Nano-Preview.

In Shaded mode the objects in your scene are displayed as 
solids. You can also see the effects of different lighting.

When you render your scene you can see the effects of light 
position and color on your object’s materials.
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Visible Lights

One of the most spectacular uses of light 
sources is visible light. Visible light effects are 
like cones of light that appear in your scene, 
like a searchlight cutting through the fog.

There are two types of visible lights: surface 
visible lights and volume visible lights.

Surface visible lights make the light object 
visible in the scene, but the light does not 
interact with the environment, so you get a 
light cone or sphere. Volume visible lights 
interact with the environment, affect all the 
object s that they strike, and are directly 
affected by environment color and brightness. 
For instance, volume visible lights can show 
shadows thrown through the air that the light 
illuminates. Surface visible lights cannot.

Refer to “Creating Visible Lights” on page 348 
for more on setting up surface and volume visible 
lights. 

Setting Up the View of 
Your Scene
There are eight different views of your scene 
available in Bryce: Camera View, Director’s 
View, and the six orthogonal views. The Camera 
View and Director’s View let you see the scene 
from any perspective, while the orthogonal 
views let you see projections of the scene from 
the top, bottom, left, right, front and back.

Camera View

This view of your scene in the Working window 
is as seen through the lens of the Camera 
object in your scene.

Since your scene exists in 3D, you can view it 
from any vantage point: above, below, or even 
from inside an object. To see these different 
perspectives, you change the position of the 

The effect of a searchlight cutting through the fog can be 
created using a visible light.

The volume visible light source interact with the other light 
sources in the scene.
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Camera. The positioning tools available in the 
Control palette let you position the Camera 
along specific axes and change its orientation. 

As you create and position the objects in your 
scene, you can use the position and orientation 
of the camera (called Camera Space) as a 
reference for several transformation operations. 
You can rotate, position and resize objects 
using Camera Space. Refer to “Camera Space” 
on page 282 for more information.

When you’ve completed your scene, the 
Camera View can be used to create the final 
rendered image or animation. You can 
reposition the camera again and render the 
scene from several different viewpoints. 

The camera can also be animated just like any 
other object.You can record changes in its 
position at different points along the timeline. 
When you run the animation, the view from 
your camera appears to change like the view 
seen from an airplane as it flies through a 
landscape. Refer to “Animating the Camera” on 
page 383 for more on animating the camera.

When you’re in Camera View, a small camera 
icon appears in the View control. 

To switch to Camera View:

• Click the triangle icon next to the View 
Control icon and choose Camera View 
from the menu.

or 

• Click and drag over the View Control until 
the Camera icon appears.

Setting Camera Object Properties

Since the Camera acts as an object, there are 
several object properties you can use to set how 
it’s displayed, linked or animated.

Refer to “Editing Link Attributes” on page 319 
for more on linking properties and “Editing 
Animation Attributes” on page 320 for more on 
Animation properties.

To hide the camera wireframe:

1 Switch to Director’s View or an orthogonal 
view so you can see the camera’s 
wireframe.

2 Select the camera in the Working window.

3 Click the A icon that appears next to it. The 
Camera & 2D Projection dialog appears. 

4 Enable the Invisible option.

5 Use the Selection palette to re-select the 
camera once it is hidden. Refer to 
“Selection Palette” on page 12 for more 
information on reselecting the camera.

To display the camera’s field of view:

1 Switch to Director’s View or an orthogonal 
view so you can see the camera’s 
wireframe.

2 Select the camera in the Working window.

3 Click the A icon that appears next to the 
camera object. The Camera & 2D 
Projection dialog appears. 

4 Enable the Show FOV option.

The camera icon in the View Control indicates that you’re 
in Camera View.
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To lock the camera position:

1 Switch to Director’s View or an orthogonal 
view so you can see the camera’s 
wireframe.

2 Select the camera in the Working window.

3 Click the A icon that appears next to its 
bounding box. The Camera & 2D 
Projection dialog appears. 

4 Enable the Locked option.

Director’s View

Director’s View lets you view your Bryce 
environment through the eyes of a director 
sitting outside the scene directing the action of 
all the objects—including the camera. The 
camera that generates the Director’s View 
cannot be seen or positioned like an object. You 
have to use the positioning controls to move 
this view. As well, the motion of this view is not 
recorded as part of an animation.

When you’re working on a still image, you can 
use Director’s View to get a second perspective 
on your scene. You can also render your image 
from either camera.

The real power of the Director’s View becomes 
obvious when you’re working on camera 
animations. Animating camera motions while 
in Camera View can be tricky at best and very 
unpredictable at worst. However, in Director’s 
View you can see the camera as an object, 
which means that you can set up camera 
motion just like you would any other object.

To switch to Director’s View:

• Click the triangle icon next to the View 
Control icon and choose Director’s View 
from the menu.

In a still image, you can use both the Director’s View and 
the Camera View together to get different perspectives on 
your scene.

Camera View

Director’s View
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Swapping Director’s Views for 
Camera View

The Director’s View and the Camera View are 
interchangeable. So you can move the Camera 
View to the position of the Director’s View, or 
vice versa. 

Even though you can’t directly position the cam-
era that produces the Director’s View in the 
Working window, you can set up a Director’s 
camera position by dragging the Camera to a 
position in the scene and then swapping the 
Camera position with the Director’s View posi-
tion.

To swap the Director’s View position for the 
Camera View position:

• Click the triangle icon next to the Camera 
controls and choose either 
Camera->Director or Director->Camera 
from the menu.

Orthogonal Views

There are six other views available through the 
View controls, but these views are not 
generated by any camera. The other views (Top, 
Bottom, Left, Right, Back and Front) are 
perspective-free views of your scene called 

orthogonal projections. When you’re using one of 
these views you cannot use the Camera 
controls. 

Refer to “Orthogonality and Views” on page 25 
for more on orthogonal views. 

The orthogonal views are another way of seeing 
the camera as an object in the scene. This can 
be invaluable when you’re animating the 
camera, or setting up a complex scene.

If you hit the Render button while in an orthogo-
nal view, Bryce moves the camera to the position 
you need, and renders your image. Refer to 
“Rendering” on page 403 for more on rendering.

Using the orthogonal views, you can quickly move to 
different views of your scene. These views also let you see 
the camera as an object.
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Positioning the View of 
Your Scene
When you position a view, you’re affecting the 
position and orientation of a camera, not the 
scene. The scale and position of objects 
remains constant; only your view of the scene 
changes. 

The controls described in this section can be 
used to position either the Camera View or the 
Director’s View. However, some controls, like 
the Trackball, are limited when you’re in 
Camera View.

The controls behave differently depending on 
the Camera Mode you select.

Bryce has two sets of controls for positioning 
your view of the scene: the Trackball and the 
Camera controls.

The Trackball lets you adjust the position of the 
camera, as well as its orientation. 

The Camera controls change the position of the 
camera along the X, Y and Z axes.

Camera Modes

The cameras in Bryce have four modes that 
affect the behavior of the all the positioning 
controls. Three of the modes are only available 
when you’re in Director’s View. The only mode 
available in Camera View is Free.

The Trackball lets you adjust the position and orientation 
of the camera.

Banking Control Field of View

Camera Trackball

The Camera controls let you adjust the position of the 
camera in the X, Y and Z axis.

Y-Z Control X-Z Control X-Y Control
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Trackball Mode

In this mode the camera orbits around your 
scene. The center of the orbit, or origin, is the 
center point of a box which encompasses all the 
objects in your scene.

As the size of your scene changes, so does the 
size of the box, which changes the box’s center 
point. As a result, the center of rotation for the 
camera also changes as you change the size of 
your scene. In fact, in this mode the camera’s 
center of rotation is constantly updated so that 
it always remains in the center of the scene.

Center to Selection Mode

In this mode the camera also orbits around the 
scene. The center of the orbit, in this mode, is a 
selected object. The selected object becomes 
the pivot point for the camera. As the object 
moves so does the camera’s center of rotation. 
This mode is the best way of making sure that 
specific objects always remain in view.

Tripod Mode 

In this mode the center of rotation is fixed at 
the center of the camera, so it actually pivots in 
place. As its name suggests, the camera acts like 
it’s on a tripod. It can rotate around, or tilt up 
and down, but it always remains in place.

Use the Tripod mode in conjunction with the Eye 
Level Camera command to get a sense of height. 
Refer to “Camera Control Options” on page 336 
for more on this command. 

Free Mode

In this mode the camera is completely 
unconstrained. Its center of rotation can exist 
anywhere, from its center to a point somewhere 
in the scene. Since the placement of the 
camera’s center of rotation is not limited, this 
mode can simulate any of the other modes. For 
example, if you place the camera’s origin point 
in its center, it acts like its on a tripod. 

In Trackball mode the camera orbits around the center 
point of a box that surrounds all the objects in your scene.

When the size of your scene changes, so does the center of 
rotation of the camera.
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Refer to “Manually Positioning the Camera” on 
page 339 for more on positioning the camera’s 
origin point.

To choose a camera mode:

1 Double-click either the Trackball or one of 
the Camera controls. The Camera & 2D 
Projection dialog appears.

2 Make sure the General tab is visible.

3 Click one of the mode buttons at the top of 
the dialog.

You can also switch between modes by clicking 
the triangle icon next to the Trackball and choos-
ing a mode from the menu.

Using the Trackball

The Trackball lets you rotate the camera around 
its origin point. The position of the origin 
depends on the Camera mode you select. Refer 
to previous sections for more on these modes.

The Trackball doesn’t rotate the scene, it only 
changes the camera’s location (Offset) and 
orientation (Rotation) relative to your scene.

To move the camera using the Camera 
Trackball:

• Drag the mouse over the Camera Trackball 
control. The view of your scene moves in 
the direction you drag.

Using the Camera Controls

Camera controls let you move the view of your 
scene along specific axes. When you’re using 
these controls, the view does not tilt or rotate 
from its original position. It only moves up, 
down, back or forward.

Camera controls are not available if you are in 
any Orthogonal View. When unavailable, these 
controls turn white. If you are in an Orthogonal 
View, you must use the Zoom and Pan tools for 
navigation. Refer to “Orthogonality and Views” 
on page 25 for more on these views.

The Camera controls behave differently 
depending on Camera Mode selected:

• In Trackball and Center to Selection modes 
the Camera controls change the position of 
the camera, but the origin point remains 
the same. So in this mode the controls are 
actually adjusting the radius of the 
camera’s orbit.

• In Tripod mode the controls change both 
the position of the camera and the origin 
point. 

• In Free mode, the controls change position 
of the camera and its origin point at the 
same time. In this mode the relative 
positions of the camera and the origin 
point remain the same. So, if the camera’s 
origin point is offset, it will remain offset 
when you use the Camera controls.

In Free mode the camera can move to any point and can 
rotate around its center or any other point in the scene.
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If you hold down Option/Alt while in this mode, 
the origin point will remain fixed.

There are three Camera controls available:

X-Y Camera Control

The X-Y Camera control provides control for 
horizontal and vertical motion. The sphere at 
the center of the camera control lets you move 
the camera in both the X and Y axis. The arrows 
let you constrain movement either horizontally 
or vertically. 

This control affects your camera’s position 
(Offset) only, not its orientation (Rotation).

X-Z Camera Control

The X-Z Camera control provides control for 
horizontal and depth motion. The sphere at the 
center of the camera control lets you move the 
camera in both the X and Z axis. 

This control affects your camera’s position 
(Offset) only, not its orientation (Rotation).

Y-Z Camera Control

The Y-Z Camera control provides control for 
vertical and depth motion. The sphere at the 
center of the camera control lets you move the 
camera in both the Y and Z axis. 

This control affects your camera’s position 
(Offset) only, not its orientation (Rotation).

 

To move the camera in two axes at once:

• Drag the sphere at the center of one of the 
Camera controls. The cursor becomes a 
four-way arrow.

The motion of your mouse determines the 
direction of the camera movement:

X-Y Camera control: moving up, down, 
left and to the right, moves the camera up, 
down, left and to the right.

Use these controls to move the camera along the Y axis.

Use these controls to move the camera along the X axis

Use these controls to move the camera along the Z axis
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X-Z Camera control: moving up, down, 
left and right moves the camera forward, 
backward, left and to the right.

Y-Z Camera control: moving up, down, 
left and right, moves the camera up, down, 
forward, and backward.

To move the camera along a single axis:

• Drag along the tip of an arrow. 

When you move the cursor over an arrow 
point, it changes to a letter to identify the 
axis of constraint.

Camera Control Options

The Camera controls have options that lets you 
move the camera to create specific views.

To use a Camera control option:

• Click the triangle icon next to the Camera 
controls and choose an option from the 
menu:

Center Scene rotates the camera so that all 
items in your scene are centered in the 
Working window. This option only affects 
the camera’s rotation, not its offset. If you 
can’t see all the objects in your scene after 
using this option, try pulling your camera 
back a bit with one of the Z controls.

Center Selection rotates your camera such 
that any selected object or objects will be 
centered in your view. This option does not 
reposition the object itself, only the 
camera’s rotation relative to the selected 
object.

Eye Level Camera repositions the camera 
to just above ground level. Use this 
command (especially in conjunction with 
the Trackball’s Tripod mode) to create the 
feeling of large, looming mountains or 
other objects. This is also effective in 
concert with the Field of View control.

Choose Camera>>Director or 
Director>>Camera to select either the 
Director or Camera View.

Edit Current Camera brings up a dialog 
box that allows you to enter current camera 
information. “Positioning the Camera 
Numerically” on page 338

When you pass over a the tip of an arrow, the cursor 
changes to a letter to identify the axis of constraint.

Click the triangle icon next to the Camera controls to 
display the options menu.
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Banking Controls

The Banking control sphere tilts your Camera 
(really rotating the camera on the Z axis), 
creating the effect of a tilted horizon. This 
control is great for creating tilted airplane 
cockpit views. Banking simulates a Roll action.

To bank the camera: 

• Drag the Bank control. Drag right to bank 
to the right and left to bank to the left.

Press Option/Alt-click in this control to 
reset to normal. The normal, or default, 
setting is zero.

Field of View

The Field of View control sphere acts like a 
wide-angle lens control. The higher the setting, 
the wider the field of view for your lens.

Because you are admitting more information 
into your lens, it will create the illusion that 
objects are receding from view, or getting 
smaller. That is not the case. Since you’re 

admitting more information, existing objects 
necessarily occupy a smaller percentage of 
space within your field of view.

If you drag the Camera Z control to bring your 
“receding” objects back up to a larger area in 
your view, perspective distortion effects appear. 
This is particularly effective for creating broad, 
swooping cloud scenes.

When you view the camera in Director’s View 
or one of the orthogonal views, you’ll be able to 
see the camera’s Field of View displayed as a 3D 
pyramid that extends out from the camera 
wireframe. 

This scene was created by banking the camera.

This scene was created by increasing the camera’s field of 
view.

The large triangle that extends out from the camera’s 
wireframe represents its field of view. As the field of view 
changes so does the shape of the triangle.
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To increase/decrease the camera’s field of 
view: 

• Drag the Field of View control. Drag right 
to increase the field of view and left to 
decrease it.

Option/Alt-click on this control to reset to 
normal. The normal, or default, setting is 
60°.

Positioning the Camera 
Numerically

The most precise way of positioning the view of 
your scene is by using the Camera & 2D 
Projection dialog. This dialog lets you enter 
values to set the camera position, the position 
of the camera’s origin point, rotation and field 
of view. The dialog can be used to adjust either 
the Camera View or the Director’s View. 

When you display the dialog, you can see the 
numerical position of the camera and the 
position of its origin point. You can also see the 
currently active Camera Mode.

The dialog uses ether Absolute or Relative 
coordinates for positioning values. 

There are different options available in the 
dialog depending on whether you’re in Camera 
View or Director’s View. When you’re in 
Camera View, the only Camera Mode available 
is Free. As well, the Origin fields are only 
available if you’re using Free Mode.

Since the camera is an object, there are several 
more controls available when you’re in Camera 
View. These controls let you set linking and 
animation options. Refer to “Setting Camera 
Object Properties” on page 329 for more.

To position the camera’s origin point 
numerically:

1 Double-click either the Trackball or one of 
the Camera controls. The Camera & 2D 
Projection dialog appears.

2 With the Camera View active, make sure 
the General tab is visible.

The Camera & 2D Projection dialog lets you view and set 
position, camera mode and origin point position options 
for the current camera.
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3 Click the Free Mode button.

4 Enter values in the Origin X, Y and Z 
fields.

To set the position of the camera 
numerically:

1 Double-click either the Trackball or one of 
the Camera controls. The Camera & 2D 
Projection dialog appears.

2 With the Camera View active, make sure 
the General tab is visible.

3 Enter values in the Position X, Y and Z 
fields.

You can enter negative values here. 
Technically, since the Bryce environment is 
infinite, the range is infinite as well, but 
higher values can create unpredictable 
results. The default values are 102.40, 
30.72, and 102.40.

To rotate the camera numerically:

1 Double-click either the Trackball or one of 
the Camera controls. The Camera & 2D 
Projection dialog appears.

2 With the Camera View active, make sure 
the General tab is visible.

3 Enter values in the Rotate X, Y and Z 
fields. Values are expressed in degrees. 

X. Y and Z rotations are also known as Yaw, 
Pitch and Roll. The Z rotation, or Roll, 
field, describes the current value for the 
Banking control.

You can enter negative values in these fields. 
The effective range is +/- 999. Default values 
are 0, 135, and 0°.

To set the Field of View numerically:

1 Double-click either the Trackball or one of 
the Camera controls. The Camera & 2D 
Projection dialog appears.

2 With the Camera View active, make sure 
the General tab is visible.

3 Enter a value in the Field of View field.

The value in this field, expressed in 
degrees, describes current settings for the 
Field of View control. The effective range is 
1 to 180°, and the default value is 60°.

Manually Positioning the 
Camera

You can manually position the camera by 
adjusting the position of the camera wireframe 
in the Working window. The camera wireframe 
is only visible when you’re in Director’s View or 
one of the orthogonal views.

In the Director’s View, top, right, front, left, 
back and bottom views (also known as 
orthogonal), you will see a blue Camera 
wireframe, which represents the location of 
339 Bryce 4



your Camera. You can then drag the Camera 
wireframe to change Camera position. The 
Nano-Preview updates to reflect your changes. 

Camera Origin Point

In its default state, the Camera’s origin point is 
not visible and is located at its center. 

When the Camera’s origin point is visible, it 
appears as a green dot in the center of camera’s 
wireframe. 

You can simulate any of the camera modes by 
dragging the camera’s origin point to different 
locations in the scene:

• If you position the origin point in the 
center of the scene, the camera acts like it’s 
in Trackball mode. When you rotate the 
camera, it moves around the position of 
the origin point. 

• If you position the origin point over an 
object in the scene, it acts like it’s in Center 
to Selection. When you rotate the camera 
object, it will pivot around the object 
under the origin point.

• If you leave the origin point positioned at 
the center of the camera object, it acts like 
it’s in Tripod mode. 

Once you offset the origin point, all the 
camera’s movements will be altered, so when 
you switch to Camera View, the camera may not 
move as expected.

To display the camera’s origin point:

1 Switch to one of the orthogonal views or 
Director’s View.

2 Click the camera wireframe.

3 Click the A icon that appears next to the 
camera’s wireframe. The Camera & 2D 
Projection dialog appears.

4 Click the General tab and enable the Show 
Origin Handle option.

To position the camera manually:

1 Switch to Director’s View or an orthogonal 
view.

2 Drag the camera wireframe to a location in 
the scene.

or 

• Click the camera wireframe and use the 
tools in the Edit palette to move, or 
rotate it.

To position the camera’s origin manually:

1 In the Camera & 2D Projection dialog, 
display the camera’s origin point. 

The camera indicator only appears in either the 
orthogonal views or the Director’s View. Drag the 
indicator to adjust the camera’s position. 

The green dot in the center of the camera wireframe 
represents its origin point.

Origin Point
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2 Drag the green point to a location in the 
scene. 

• Hold down Shift and click the origin 
point to reset it to the center of the 
camera object.

Aiming the Camera

The only problem with positioning the Camera 
using the Orthogonal, or Director’s Views is 
that the view from the Camera remains fixed as 
you adjust its location, so you may inadvertently 
lose the objects you were looking at when the 
position of the Camera changes. 

To solve this problem, Bryce lets you adjust the 
aim of the camera as you adjust its position. 

When you look at the Camera as an object, 
you’ll see that there is a control handle 
extending out from the front of the object. This 

For example, at the beginning of this animation the 
Camera is pointing at the object in the center of the scene. 
The view from the Camera shows all the main objects in 
the scene.

When you move the Camera, it’s still pointing in the same 
direction but from its new position, only one of the objects 
in the scene is visible.
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handle represents the Camera’s current aim. By 
dragging this handle to a point in your scene, 
you can change the Camera’s aim.

When you change the aim of the Camera, it 
rotates to face the new target, but remains in 
the same position. 

To change the Camera’s aim in an orthogonal 
view:

1 In the Working window, click the triangle 
icon next to the View Control and choose 
top, left, right, bottom, front or back from 
the menu.

2 Drag the end of the control handle to the 
point in you scene where you want the 
camera to aim. 

As you drag, the end of the handle changes 
to a red dot so you can see the aiming point 
better.

Saving Camera Positions

You can save your favorite camera positions 
using the Memory dots. The dots let you store 
up to seven different views of your scene

The uppermost dot, slightly separated from the 
rest, is a quick way to return to the default 
Bryce camera position. There is no way to clear 
this dot. It will always contain the default 
Camera settings.

Dot settings are saved with your scene file, so if 
you open a previously saved scene, your dot 
settings from the previous session remain in 
place.

When you click on a full dot to activate it, the 
saved position becomes the current Camera 
View. If you switch to an active dot, and then 
want to return to your previous Camera View, 
undo the operation. 

To return to the default camera position: 

• Click the top memory dot.

The view returns to the default, regardless 
of how many changes you’ve made.

To save a camera position to a memory dot:

• Click an empty dot. Empty dots appear 
gray. Full dots appear turquoise.

The handle that extends out from the front of the Camera, 
lets you aim the camera.

As you drag the end of the camera’s control handle, it 
changes to a red dot. The dot represents the point where 
the camera will aim. 

Memory dots let you save views of your scene for later use.

Default position

Saved positions
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To switch between saved positions:

• Click a full (turquoise) dot.

Active dots appear turquoise with a white 
dot in the middle.

To clear a full dot:

• Option/Alt-click a full dot. The dot turns 
gray.

To switch between positions using the 
keyboard:

1 Press the numbers indicated to activate the 
saved memory dots. Press 1 through 4 for 
different camera views.
.

There are no keyboard shortcuts for the 
remaining two dots.

Setting Up Lights
There are two types of lights in Bryce—natural 
and direct. Natural lighting is provided by the 
Sun. By default every scene contains a sun. 
Direct light is provided by light sources. 

The light from direct light sources can be used 
to either add hyperrealism to natural scenes, or 
add light to objects that cast light in the scene, 
like lamps. The lighting setup you choose can 
greatly affect the look of your scene, so 
experiment with various lighting setups.

Creating Direct Light Sources

There are five types of direct lights you can 
create: Radial, Spot, Square Spot, Parallel and 
Cylindrical Parallel

You can create as many light sources as you 
need. The only limit is your system’s memory. 
Creating additional lights (or light sources) may 
add significantly to the render time of your 
scene.

The size, position, and orientation of a light 
source can be edited exactly like any other 
object. Refer to “Transforming Objects” on 
page 285 for more on transforming objects.

You can also link lights to specific objects so 
that a light source moves as the object moves, 
or you set a light to track an object. When it’s 
tracking an object, the light reorients itself so 

5 activates first position 

6 activates second position

7 activates third position

8 activates fourth position

9 activates position
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that it’s always facing the object no matter 
where it moves. Linking and tracking are quick 
ways of animating light positions.

Light attributes can be edited in the Edit Lights 
dialog.

Radial Light

Radial Lights throw light equally in all 
directions. Use this as a general light source, 
and remember that you can make these lights 
as tiny as you like, as many as you need.

Spotlight

Spotlights throw light along a cone-shaped 
path, creating the classic “stage spot” effect.

The motion of all the light sources in this example were 
animated using the track feature.

The lighting in this scene was created using a Radial 
Light.

The lighting in this scene was created using a Spotlight.
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Square Spotlight

Square Spotlights are the same as spotlights, 
except they cast light along a pyramid-shaped 
path, creating a square spot where the light 
falls.

Parallel Light

Parallel Lights cast parallel rays, resulting in no 
spatial distortion of shadows. This type of light 
is very useful for creating specific shadow 
patterns, or when used with gels, for creating a 
slide projector.

Cylindrical Parallel Light

Cylindrical Parallel Lights work exactly like 
parallel lights except that they produce 
cylindrical tubes of light and cast circular spots 
where the light falls. 

To create a light source:

1 Make sure the Create palette is visible. If 
it’s not, click the Create button at the top 
of the Bryce window.

The lighting in this scene was created using a Square 
Spotlight.

The lighting in this scene was created using a Parallel 
Light.

The lighting in this scene was created using a Cylindrical 
Parallel Light.
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2 Click one of the create light tools:

Note that Cylindrical Parallel lights are the only 
lights that require a modifier (Ctrl) key.

Editing Light Attributes

You can edit the attributes of any light using 
the Edit Lights dialog. This dialog lets you 
control the color, intensity and sharpness of a 
light source. 

To access the Edit Lights dialog:

1 Select a light. The Object Controls appear 
next to the light’s bounding box.

2 Click the E button. 

To adjust light intensity:

• In the Edit Lights dialog, drag the Light 
Intensity control.

Drag right to increase light intensity and 
left to decrease intensity.

To set a light’s color:

• In the Edit Lights dialog, click the Light 
Color control and choose a color from the 
picker.

To disable shadow casting for a light source:

• In the Edit Lights dialog, click the triangle 
icon at the bottom right corner of the 
preview area, and choose Disable Cast 
Shadows option.

The light from this source can illuminate 
the surface of an object, but does not create 
shadows.

Light Preview

The Light Preview area displays the effects of 
your changes to the intensity and edge softness 
of a light. 

You can have this preview display the light 
against a neutral background, or show the light 
in the scene.

Creates Radial lights

Creates Spotlights

Creates Square Spotlights

Creates Parallel lights

Creates Cylindrical 
Parallel lights

Use the Edit Lights dialog to adjust the brightness, color 
and hardness of a light.

+ Ctrl

Light Intensity Light Pr eview

Light Color 
Light 
Options

Edge 
Softness
346 The Camera and Lights 



To set the preview options:

• In the Edit Lights dialog, click the triangle 
icon at the bottom right corner of the 
preview area, and choose a preview option:

Render in Scene displays your scene in the 
Preview area. This lets you see how the 
changes you make to the selected light will 
impact your entire scene.

Render Against Neutral displays the light 
against a flat background. This lets you 
isolate the light so you can clearly see 
subtle changes.

Light Attributes

The light editor lets you adjust three attributes 
which let you create more realistic-looking light 
sources: 

• The light’s spread

• Edge Softness

• Falloff 

The spread of the spotlight (also called the Half 
Angle) controls the size of the light cone 
projected.The size of the light’s wireframe 
determines the spread of the light. The bigger 
the wireframe, the larger the spread.

To adjust the spread of a spotlight:

1 Select a spotlight.

2 Drag the one of its bounding box control 
points to set the wireframe’s size.

Increase the size to increase the spread and 
decrease its size to decrease the spread.

The Edge Softness attribute lets you set the 
sharpness/softness of the edges of the spot 
projected by the light. 

To adjust a light’s edge softness:

• In the Edit Lights dialog, change the 
position of the Edge Softness control.

Drag left to sharpen the edges and right to 
soften the edges.

Light Falloff

Light falloff lets you control the relationship 
between the intensity of a light and the 
distance from the light. In the real world, the 
farther you are from a light source, the less 
influence it has on the illumination of your 
surrounding. In other words, the greater the 
distance, the weaker the light.

In Bryce there are four types of falloff you can 
apply to a light:

• Linear Falloff causes the light’s intensity to 
fall off at a constant rate. When you use 
this type of falloff the light’s range is rather 
large. This type of falloff is good for 
outdoor lights like searchlights.

• Squared Falloff causes the light’s intensity 
to fall off rapidly. When you use this type 
of falloff, the light’s range is quite limited. 
This is useful for indoor lights, like lamps.

• Ranged Falloff causes the light to change 
abruptly from full intensity to zero (no 

The size of a light’s wireframe controls the light’s spread.
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illumination) after a defined distance 
range. 

• No Falloff causes the intensity of the light 
to stay the same regardless of the distance.

To adjust a light’s falloff:

1 In the Edit Lights dialog, click the triangle 
icon at the bottom of the dialog and choose 
either Linear Falloff, Ranged Falloff, 
Squared Falloff, or No Falloff from the 
menu.

2 A dialog box appears into which you enter 
a distance or range if appropriate for the 
type of falloff you selected.   

Creating Visible Lights

Visible lights make your light source visible in 
the scene, like the ball of light that appears 
around a lamppost on a foggy night.

There are two types of visible lights:

• Surface Visible Lights

• Volume Visible Lights

When you create a surface visible light, the 
light from the object appears as a semi-
transparent shape extending out from the light 
source.

Surface Visible lights have the same attributes 
as a non-visible light, so you can use the Edge 
Softness control to make the shape that extends 
from the light fuzzier at the edges, to give it a 
more realistic feel, or the Falloff options to 
adjust the range the light.

The properties within the light are controlled 
by the default Surface Material applied to the 
light object. The material can be edited in the 

Materials Lab. By changing the material, you 
can change the color of the light, the intensity 
of the light’s color and many other properties.

When you create a Volume Visible light source, 
a preset Light-sensitive Volume Material is 
applied to the light source. This makes the light 
coming from the light source appear visible in 
the scene, so in the case of a spotlight, the light 
would appear as cone. The light also becomes 
volumetric and reacts to other lights around it. 
Objects within the cone interact with the light. 
They can block it, reflect it, etc. Any textures 
applied to the light also have volume.

The material applied to the object is pre-
defined for you, but you can edit its properties 
in the Materials Lab. By editing the material 
you can change the light’s intensity, color and 
transparency.

When you create a surface visible light source, it appears 
as a semitransparent object in the scene.
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The real difference between the two types of 
lights becomes apparent when you apply a gel 
to the light. In Surface Visible lights, the gel 
texture is wrapped around the light cone like a 
skin. Making it semitransparent makes it look 
more real, but it doesn’t make it interact with 
objects inside the cone.

On the other hand, volume visible lights create 
a real illuminated volume. The texture gel exists 
everywhere inside the cone, and the objects 
within the cone are directly affected by the 
texture. The light also interacts with the 
surrounding light sources.

It’s a good idea to choose to apply the Infinite 
Light option to both types of visible lights, as this 
option extends the light’s range. This gives the 
light a more realistic look. 

To create a surface visible light:

1 Create a light source.

2 Select the light in the Working window.

3 Click the E button that appears next to the 
light’s bounding box. The Edit Lights 
dialog appears.

4 Click the triangle icon below the light 
preview and choose Surface Visible Light 
from the menu.

A number of preset Surface material 
properties are applied to the light.

• Click the triangle again and choose 
Infinite light from the menu if you want 
to extend the light’s range.

To create a volume visible light:

1 Create a light source.

2 Select the light in the Working window.

3 Click the E button that appear next to the 
light’s bounding box. The Edit Lights 
dialog appears.

When you create a volume visible light source, the light 
emanating from the light source is visible in the scene. This 
light has volume and interacts with the object inside it.

In this example, the same objects were illuminated by first 
a surface visible light...

...and then a volume visible light.
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4 Click the triangle icon below the light 
preview and choose Volume Visible Light 
from the menu.

A number of default Volume material 
settings are applied to the light source.

• Click the triangle again and choose 
Infinite light from the menu if you want 
to extend the light’s range.

Editing Visible Light Materials

The materials applied to a visible light control 
many of its properties. Although these 
materials can be edited, just like any other 
object’s material, you should keep in mind that 
when you’re editing a light’s material in the 
Materials Lab, you’re changing how the light 
source will appear in the scene. 

Any texture components you apply to the light’s 
material will appear as gels.

For Surface Visible lights, the light’s material is 
a Surface material. For a Volume Visible light 
the material is a Volume Material.

Refer to “Surface Material Channels” on 
page 196 for more on editing Surface materials, 
and “Volume Material Channels” on page 206 
for more on editing Volume materials.

Applying Gels

Gels are filters which are placed directly in 
front of lights to change the colors cast by the 
light, or to cast specific kinds of shadows. 

In Bryce, you can use any picture or procedural 
texture as a gel. Once you’ve assigned a gel to a 
light source, you’ll be able to see the pattern of 
the gel on any object it shines on. For example, 
if you apply a picture to a Square Spotlight, you 

can create a slide projector, or you can throw a 
wild texture across your entire scene by 
assigning a Texture gel to a Radial Light. 

When you apply a gel to a visible light, the 
texture’s pattern is visible throughout the 
visible light.

To use a picture as a gel:

1 In the Edit light dialog, click on the Pict 
Gels text button at the bottom of the 
dialog. The Pictures dialog appears. 

2 Choose a picture from the preset library, or 
click the Load button and load a picture.

Refer to “Working with Pictures” on 
page 108 for more on the Picture dialog.

3 Click the checkmark. The picture is 
applied as a gel.

To use a texture as a gel:

1 In the Edit Light dialog, click on the 
Texture Gels text button at the bottom of 
the dialog. The Preset Materials Library 
appears.

2 Select a material from one of the categories 
available. 

This lighting effect was created using a gel.
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Refer to “Using the Preset Materials 
Library” on page 232 for more on the 
Preset Materials Library.

3 Click the checkmark. The texture in the 
material is applied as a gel.

To use a texture as a Gel, you must select a 
preset that contains a texture. Preset 
materials that contain only color or optic 
information (such as many found in the 
Simple & Fast category) will have no effect.

If you selected a color other than white in the 
Edit Light dialog, that color overrides colors 
from Texture gels. However, the luminance pat-
terns are still used.

Positioning Lights

Light wireframes can be edited exactly like any 
other object, either directly in the scene using 
its bounding box, or indirectly using the tools 
in the Edit palette. 

Refer to “Positioning Objects” on page 294 for 
more on positioning objects.

Linking and Tracking with Lights

Since lights act just like other objects, you can 
link them to other objects, or have them track 
other objects in the scene. 

In an animation, lights that track an object can 
create some very complex lighting effects. 

Refer to “Linking Objects” on page 305 for 
more on linking, and “Tracking Objects” on 
page 382 for more on Tracking.
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14  

Animating

Key Event Animation 
and Bryce
Animation is process of simulating time. In 
the real world, we perceive time through the 
changes in our environment. The most 
obvious type of change is motion. When an 
object changes position at different points in 
time, it appears to be moving. But, an object 
doesn’t have to be moving to indicate the 
passage time. A change in color, texture or 
geometry also indicates that time is passing. 
These changes in the environment are called 
key events.

You create an animation, in Bryce, by moving 
to different points in time and changing the 
properties of a scene to define the action at 



that point in time. Bryce automatically fills in 
the gaps between these key events to create the 
illusion of time passing.         

You can use key event animation to animate 
most of the properties in your scene:

• The motion of object, lights and the 
camera.

• Object size, shape and orientation.

• Camera and light parameters.

• Object Material properties.

• Terrain object geometry.

• Environment properties.

Previewing Your Animation

Any time you make a change to your animation, 
you can see it immediately in the nano-preview 
window as a movie, or preview it in the working 
window. See “Previewing Animations” on 
page 363.

Time-Based Animation

In Bryce, key events are tied to real-world time 
increments (minutes and seconds) rather than 
individual animation frames. This means that 
you can create key events at specific points in 
time without worrying about the number of 
frames in your final animation.

Animation can simulate the passage of time by changing 
the position of an object at different points in time. Here 
an airplane is at the top of the scene at one point in time...

...and at the bottom of the scene at another point...

...by filling in the gaps between the two points, or key 
events, Bryce simulates motion.

The same principle applies to other scene properties. Here, 
the illusion of time is created by changing the geometry of 
a terrain object at two different points in the animation.

1

2

3

4
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Bryce automatically creates all the frames 
necessary to move from one key event to 
another. If you change the frame rate, Bryce 
adjusts the number of the frames between key 
events to match the new frame rate. 

For example, let’s say your frame rate is set to 
15 fps (frames per second) and then you set up 
two key events, one at 1 second and the other at 
2 seconds. Bryce automatically fills in the 15 
frames necessary to move from the key event at 
1 second to the key event at 2 seconds. If you 
change the frame rate to 30 fps, Bryce will add 
another 15 frames between the two key events 
to match the new frame rate.

Animation and Motion Paths

As you change the position, of an object, Bryce 
creates a motion path which shows you the 
path the object will take as it moves from one 
key event to another.  

You can edit an object’s motion path to adjust 
its trajectory throughout the course of the 
animation. 

Refer to “Editing Motion Paths” on page 378 for 
more on motion paths.

Animatable Properties

Each characteristic of an object or effect that 
can be animated is called a property. Most 
objects have many animatable properties. 
Properties like position, size and orientation 
are common to all objects. Other properties are 
specific to certain types of objects.

Lights have special properties like brightness, 
falloff and gels.

Skies have their own set of properties that 
control everything from cloud coverage to the 
time of day.

The properties of individual objects can change 
depending on the material you apply. The color, 
texture, and density of an object can also be 
animated.

Some properties can be animated directly in a 
specific editor. Object material properties can 
be animated from within the Materials Lab and 
terrain geometries can be edited from within 
the Terrain Editor.

Properties in the Sequencer

Every time you change an object’s property, it 
appears as a key event in the animation’s 
Sequencer. In the Sequencer, each property of 
an object can be viewed on a separate timeline. 
You can expand an object’s listing to see all the 
transformations or changes that have been 
applied to its properties. If you have not 
performed any transformations on the object, it 
cannot be expanded.

An object’s motion path shows you the trajectory of the 
object as it moves from one key event to another.
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Refer to “Editing Property Timelines in the 
Sequencer” on page 368 for a complete discus-
sion of the Sequencer.

To expand a listing in the Sequencer:

1 Make sure the Advanced Motion Lab is 
visible. If it’s not, choose Objects menu> 
Advanced Motion Lab.

2 Click the object’s listing.

Creating Animations
The Animation controls are the tools you’ll use 
most often when creating animations. The 
palette provides tools for most of the basic 
animation functions:

• viewing the timeline

• moving the current time

• setting the length of the animation

• specifying the Working Area

• previewing the animation

• recording key events

• adding/deleting key frames

The Animation controls appear at the bottom 
of the Working window as well as in the Terrain 
Editor and the Materials Lab.

The Animation controls are made up of three 
areas:

The Timeline, located at the top of the palette, 
displays a visual representation of the time in 
your animation. The indicator on the timeline 
(called the Current Time Indicator) represents the 
current time.

The Animation Preview Controls, located 
below the Timeline, let you preview your 
animation in the Working window.

The Key Frame Controls, located at the right 
edge of the palette, let you add and delete key 
frames.

You can expand an object’s listing to see the timelines for 
the transformation applied to it.

The Animation controls let you move through the timeline 
of your animation and create key frames.

Besides the Working window, the Animation controls also 
appear at the bottom of the Terrain Editor....

...and at the bottom of the Materials Lab.

Timeline

Current Time Indicator

Animation Preview Controls

Key Frame Controls
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To display the Animation controls in the 
Working window:

• By default the Animation controls are 
located at the bottom of the Working 
window. If the Selection palette appears 
the bottom of the window, click the Time/
Selection Palette toggle in the bottom-right 
corner of the Bryce window (or press S). 

The button switches between the Selection 
palette and the Animation controls.

Setting Up an Animation

Before you start setting up key frames or 
adjusting the timeline, you should set up some 
general parameters for your animation. 

The Animation Setup dialog lets you set up the 
duration, the frame rate and whether you want 
to display animation time as SMPTE (i.e.; 
hours:minutes:seconds:frames) or Frame 
numbers. 

To set the duration of your animation 
numerically:

1 Choose File menu> Animation Setup or 
double-click the Current Time Indicator. 
The Animation Setup dialog appears.

2 Click the Scale Timeline button. This 
switches the Duration fields to set the 
duration of your animation. 

3 In the Duration fields, enter the total 
length of your animation in hours, 
minutes, seconds and frames.

When you enter a duration, Bryce 
automatically calculates the number of 
frames in the animation, based on the 
current frame rate. The number of frames 
is displayed in the Frame # field.

Setting the Frame Rate

The Frame rate for your animation can have a 
large impact on the final quality of your 
rendered movie. A low frame rate, is faster to 
render but may produce more jumpy-type 
motion, while a higher frame rate produces 
much smoother motion.

Bryce displays frames as Frames per Second 
(fps). 15fps is usually good enough for motions 
displayed on a computer. 30fps is video quality.

To set the frame rate for your animation:

1 Choose File menu> Animation Setup or 
double-click the Current Time Indicator. 
The Animation Setup dialog appears.

2 Enter a frame rate in the FPS field.

Use the Time/Selection Palette toggle to switch between the 
Animation controls and the Selection palette.

The Animation Setup dialog can used to set the duration 
of your animation or to move to a specific point in the 
timeline.
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Working with the Timeline

The Timeline for your animation shows you:

• A graphical representation of time.

• The total length of the your animation 
within that time.

• The current time.

• The Working Area. 

The Timeline appears in three places in Bryce: 
the Working window, the Terrain Editor and the 
Materials Lab.

All three timelines represent the same time. 
The only difference is that when you’re in an 
editor, you can only add frames for properties 
associated with the editor. For example, in the 
Terrain Editor you can only add key frames 
associated with terrain properties. 

Refer to “Animating Terrains” on page 396 for 
more on working with the timelines in Terrain 
Editor and “Animating Materials” on page 388 
for more on working with the timeline in the 
Materials Lab.

When you preview a timeline in the Working 
window, you’ll be able to see all the changes in 
your scene, including any changes you may 
have made in other editors or the Advanced 
Motion Lab.

Working with Time 

The light gray area in the Timeline is called the 
Available Time Area and it represents all time. 
This area is unlimited, you can scroll the time 
area infinitely. 

The white tick marks within the time are visual 
cues that let you know when the time area is 
moving. If you move the Current Time 
Indicator off the screen you’ll see these white 
ticks move along the time area. 

To scroll the time area:

• Drag the Current Time Indicator off the 
screen to the right.

You’ll see the white tick marks move along 
the time area to the left.

Setting the Animation Range in 
the Timeline

The dark gray within the light gray area of the 
Timeline represents the total length of your 
animation. This area is usually hidden by the 
Working Area, so you may need to shorten the 
Working Area to adjust the Animation Range.

This area is automatically generated as you set 
up key events. The time of the final key event 
automatically creates the limit of the animation 

The timeline represents time in your animation. It can be 
used to set the length of the animation and to move the 
current time.

Time

Animation Range

Working Area

Current Time Indicator

The light gray area in the timeline represents time. The 
white tick marks in the time area are visual cues to let you 
know when the area is being scrolled.
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range. However, you can manually extend or 
shorten the area to set the range of your 
animation. 

You cannot shorten the Animation Range below 
the last frame in the scene since you can’t have 
frames outside the animation range.

To manually set the Animation Range:

• In the timeline, drag the light green handle 
that appears at the end of the Animation 
range to the point where you want the 
animation to end.

The handle may be obscured by the 
Current Time Indicator, so you might have 
to move the indicator to a different 
position.

Setting the Current Time for an 
Animation

The large green handle in the Timeline is called 
the Current Time Indicator (commonly called a 
scrubber). It sets the current time of the 
animation. 

The Current Time Indicator is the most 
important tool of the Animation controls. 
When you’re creating key events, the Current 
Time Indicator controls when the key event 
occurs in the animation. 

Refer to “Recording Key Events” on page 362 for 
complete instruction on creating key events.

As you move the Current Time Indicator the 
Text Display Area shows you the current time. 
If you’re using SMPTE time, the current time is 
displayed as:

The Frame # changes as you change the frame 
rate for the animation. For example, at 15fps 
Bryce will insert 15 frames within each second.

If you’re using Frame number, the number of 
the current frame is displayed.

You can also move to a specific point in time 
using the Animation Setup dialog. In this 
dialog, you can move to either a specific time or 
frame.

To move to a specific frame manually:

• Drag the Current Time Indicator along the 
Timeline. 

As you drag, watch the Text Display Area. 
You’ll notice that the final number cycles 
through each frame in the second of 
animation time. So at 15fps the final 
number will cycle through frame 0-14 
between seconds. 

Release the mouse button when the Frame 
# reaches the desired frame.

The Current Time Indicator also controls 
which portion of your animation is being 
displayed in the Working window. 

When the indicator is at the beginning of the 
animation, you’re seeing the first frame of the 
animation in the Working window. When you 
move the indicator, the Working window 
displays a different portion of the animation. 

The dark gray area of Timeline represents all the range of 
your animation.

Hours Minutes Seconds Frame #
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So, when you move the indicator to the center 
of your animation range, you’re seeing what the 
animation looks like at the middle of the movie. 

To move the current time manually:

1 Make sure the Animation controls are 
visible. If it’s not, click the Time/Selection 
Palette toggle.

2 Drag the Current Time Indicator along the 
Timeline. Release the mouse button when 
the Text Display Area shows the desired 
time. 

To move the current time numerically:

1 Choose File menu> Animation Setup. The 
Animation Setup dialog appears.

2 In the Current fields, enter the hour, 
minutes, seconds and frame you want to 
move to.

The Frame # field displays the number of 
the frame located at the specified time.

To save the position of the Current Time 
Indicator:

1 Make sure the Animation controls are 
visible. If it’s not, click the Time/Selection 
Palette toggle.

2 Move the Current Time Indicator to the 
position you want to save.

3 Click on an empty Memory Dot at the 
bottom of the Animation controls.

A dot is empty when it appears gray. 

To move the Current Time Indicator to a 
saved position:

1 Make sure the Animation controls are 
visible. If it’s not, click the Time/Selection 
Palette toggle.

2 Click the Memory dot for the position you 
want to use.

To delete a saved position:

1 Make sure the Animation controls are 
visible. If it’s not, click the Time/Selection 
Palette toggle.

2 Option/Alt+click on a full memory dot.

A full dot appears teal.

Setting Up the Working Area

The green portion of the Timeline represents 
the Working Area. This area highlights the 
portion of the timeline you’re currently 
working on. 

When you’re previewing your animation, only 
the portion of the timeline within the Working 
Area is previewed. 

The Working Area is most useful when you’re 
working on a long animations as it saves on 
preview time, or when you’re refining a specific 
portion of your animation. 

Use the Current Time Indicator to move the current time to 
different points along the timeline.

Use the Memory Dots to save the position of the Current 
Time Indicator.

Use the Working Area to isolate the portion of the timeline 
you’re currently working on.
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When you’re rendering the animation, you can 
choose to render the entire animation, or just 
the Working Area portion. 

You can also use the Working Area to render 
out sections of the timeline while your setting 
up the animation, and then render the entire 
Animation Range when you’re creating the 
final animation.

To set the range of the Working Area 
manually:

1 Make sure the Animation controls are 
visible. If it’s not, click the Time/Selection 
Palette toggle.

2 Drag either end of the existing Working 
Area. Release the mouse button when the 
Working Area is the desired length.

The Working Area cannot be extended past the 
end of the Animation Range.

To set the range of the Working Area 
numerically:

1 Choose File menu> Animation Setup or 
double-click the Current Time Indicator. 
The Animation Setup dialog appears.

2 Click the word “Current” at the top of the 
dialog and choose Working Range Low 
from the menu.

3 Enter the starting time for the Working 
Range. 

4 Click the word again and choose Working 
Range High. 

5 Enter the ending time for the Working 
Range. 

Setting Timeline Scale

The scale indicator at the right edge of the 
timeline let you adjust the scale the timeline.

If you have a very long timeline, you can use 
this controls to scale it down so you can see the 
whole timeline at once. If you have a very short 
timeline, you can use the control to scale it up 
so it extends across the length of the palette.

To set the scale of the timeline:

1 Make sure the Animation controls are 
visible. If it’s not, click the Time/Selection 
Palette toggle.

2 Drag the scale indicator. 

Drag right to increase the scale and left to 
decrease it.

The scale of the timeline does not affect its 
length, only how its displayed in the Animation 
controls.

Scaling Animation Duration

You can adjust the length of your animation, by 
scaling its duration to fit within a certain 
amount of time. For example, you created an 
animation that’s 5 seconds long, but only want 
it to take up 3 seconds, you can scale the entire 
animation to last only three seconds. 

When you scale the animation, all the events in 
the animation are compressed or starched to fit 
within the desired amount of time. If you 
increase the scale, the events are starched out, 

Use the scale indicator to scale the timeline.
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so they take longer to complete. If you decrease 
the scale, the events are compressed to the 
action speeds up.

To set the scale of the entire animation 
manually:

1 Make sure the Animation controls are 
visible. If not, click the Time/Selection 
Palette toggle.

2 Hold down Option/Alt and drag the 
animation range handle. Release the 
mouse button when the duration of the 
animation is the desired length. 

To scale the animation numerically:

1 Choose File menu> Animation Setup or 
double-click the Current Time Indicator. 
The Animation Setup dialog appears.

2 Click the Scale Animation button.

3 Enter the desired animation duration in 
the Duration fields. 

Recording Key Events

You can record key events by enabling Auto-
Record mode. The Timeline options menu, 
located at the right edge of the controls, lets 
you enable or disable Bryce’s automatic 
animation system.

When you enable Auto-Record mode every 
object transformation, or change of property 
you perform is recorded as a key event. 

A key event can store any change in size, 
position, orientation, material property, sky 
property, light property or geometry.

However, a key event can only store one change 
per property at specific point in time for each 
object in the scene. This means that at a single 
point in time, you can only have one change in 
position, size, material or geometry per object 
recorded as a key event. 

If you keep changing the same properties at the 
same point in time, the changes are recorded 
on top of existing changes. Only the last change 
you perform is recorded as the key event. 

To record more than one change in the same 
object’s property you have to move to a 
different point in time. Then each change can 
be recorded as a separate key event and applied 
to the animation.

Option/Alt-drag the animation range handle to scale the 
animation down or up.

Use the Timeline options menu lets you to enable or disable 
animation.

For example, if you move an object up and down at the 
same point in time, only the last transformation is recorded 
as the key event...
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When Auto-Record mode is disabled, the 
animation system is off. This means that your 
changes are not recorded as key events, and 
changes in the timeline do not effect your view 
in the Working window. 

You can continue changing object and scene 
properties, but they won’t be recorded as key 
events. If you want to record a setting or 
transformation you’ll have to manually add a 
key frame using the Add Frame button. Refer to 
“Adding and Deleting Key Frames” on page 365 
for more on adding frames.

To enable or disable Auto-Record mode:

1 In the Working window, make sure the 
Animation controls are visible. If it’s not, 
click the Time/Selection Palette toggle. 

2 Click the triangle icon to the right of the 
controls and choose Auto-Key. The 
animation system is on when the option 
has a checkmark next to it. 

Choose Auto-Key again to turn off the 
animation system.

Recording Key Events in the 
Editors

When you record a key event in either the 
Materials Lab or the Terrain Editor, you’re only 
recording a change to the properties associated 
with the editor. 

• In the Materials Lab only changes to an 
object’s material properties are recorded. 

• In the Terrain Editor only changes to a 
terrain object’s geometry are recorded. 

Previewing Animations

You can preview your animations using either 
the mini-preview in the movie nano-preview 
window or by using the Animation Preview 
controls. Both of these methods allow you to 
see either a rendered preview or a storyboard. 

Using the Movie Preview Window 

Using the movie preview window, you can see a 
rendered version of your animation quickly.

To preview your animation:

1 Create an animation.

2 Click the Animation Preview Button.

Using the Storyboard Preview

Using the storyboard preview feature, you can 
review or navigate your animation, frame-by-
frame.

To view your storyboard:

1 Create an animation.

2 Click and hold down on the Animation 
Preview button.

...but if you move the object up at one point in time and 
then move the object down at a different point in time, 
both transformations are recorded.
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3 Select Storyboard.

4 Click on the Animation Preview button.

All of the frames appear in a grid pattern as 
they are rendered. When the rendering is 
finished, the movie plays in the movie nano-
preview.

To stop the movie preview:

• You can stop the preview at any time by 
clicking the mouse. 

To exit movie preview mode:

• To exit movie preview mode completely, 
press the Esc key or redraw/render your 
scene.

Additional Features of the 
Storyboard

If you pause in the storyboard portion of the 
animation preview, you can perform various 
manipulations on your animation. You can:

• Click on a frame to select it.

• Set the current time to that frame. 

• Drag the scrubber and move forward or 
backwards through the animation.

• To render any of the frames, double-click 
the corresponding storyboard image.

As you perform these manipulations, the 
animation updates in realtime in the movie 
preview window.

Using the Animation Controls

When you play an animation, all the frames in 
the animation within the Working Area are 
displayed. The preview is shown in Wireframe 
display mode.

Setting Previewing Options

There are three options you can use to alter the 
preview of your animation. You can preview the 
animation only once. You can play the 
animation continuously, or you cycle forward 
through the animation, and then back.

Plays the animation. Click 
during play to pause the 
animation.

Stops the animation.

Moves to the beginning of the 
Recorded Area.

+ Shift moves to the beginning 
of the animation.

Moves to the end of the 
Recorded Area.

+ Shift moves to the end of the 
animation.

Moves one key frame forward in 
the animation.

+Shift moves one frame forward.

Moves one key frame backward 
in the animation.

+Shift moves one frame back.

Starts a quick animation preview.
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To set a preview option:

1 Choose File menu> Animation Setup. The 
Animation Setup dialog appears.

2 Enable a Play option:

Once plays the animation only once.

Repeat plays the animation continuously.

Pendulum plays the animation forwards 
then backwards, then forwards, 
continuously

Adding and Deleting Key Frames

Usually you use the Auto-Record mode to add 
key frames to your animation, but there are 
some cases when you would need to force the 
system create a key frame. For instance, if you 
accidentally make a number of changes while 
Auto-Record mode is disabled, you’ll have to 
create a key frame to store your changes, or 
they’ll be discarded when you move to a 
different point in time.

The Key Frame controls let you add or delete 
key frames from the timeline. The key Frame 
indicator, changes color when the Current Time 
Indicator is over a key frame.

Adding Frames

Bryce adds keys frames differently depending 
on what your selection in the Working window.

If you have an object selected, Bryce only 
records the changes in property for the selected 
object. If you have nothing selected, Bryce only 
records the changes in the sky (i.e. changes you 
make in the Sky & Fog palette).

You can also modify the add key frame 
operation so that, for a selected object, only a 
specific property is recorded as a key event. 

To add a key frame:

1 Move the Current Time Indicator to the 
point where you want to add a key frame

or 

If you need to force Bryce to overwrite an 
exiting key frame, leave the Current Time 
Indicator where it is.

2 Click the Add Key Frame button.

Any changes you made at this point are 
recorded in the key frame.

To a add a frame for a certain type of 
property:

1 Select an object. 

2 Hold down the mouse button over the Add 
Key Frame button and choose an object 
property from the menu that appears.

To add a key frame for sky properties:

• Make sure there is nothing selected, and 
click the Add Key Frame button.

The Key Frame controls let you add and delete key frames 
from your animation.

Add Key Frame Delete Key Frame

Key Frame Indicator
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or 

• Hold down the mouse button over the Add 
Key Frame button and choose Sky from the 
menu.

Deleting Frames

As with adding frames, Bryce deletes frames 
differently based on your current selection. 

If you have an object selected, Bryce only 
deletes the changes in property for the selected 
object. If you have nothing selected, Bryce 
deletes the changes recorded for your scene’s 
sky.

You can modify the Delete Fey Frame button’s 
function so that only a certain type of object 
property is deleted.

Adding or deleting frames will effect the shape 
of an object’s motion path.

To delete a key frame:

1 Use the Animation Preview controls to 
move through the key frames until you find 
the frame you want to delete.

2 Click the Delete Key Frame button.

All the properties recorded at that point in 
time are deleted.

To delete a frame for a specific object 
property:

1 Select an object. 

2 Hold down the mouse button over the 
Delete Key Frame button and choose the 
object property from the menu that 
appears.

Adding and Deleting Frames in the 
Editors

When you add a frame in the editors, only the 
properties associated with the editor are 
recorded as a key frame. 

When you delete a frame in the editors only the 
properties associated with the editor are 
deleted. For example, it you delete a frame that 
contains position, material and scale data in the 
Materials Lab, only the material data is removed 
from the key frame.

Advanced Motion Lab
The Advanced Motion Lab provides tools for 
refining your animations. In this window you 
can:

• view the hierarchical structure of your 
scene

• rearrange the sequence of key events for 
individual object properties

• remap the time it takes to move from one 
key event to another

• preview your animation.
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The Advanced Motion Lab is divided into four 
areas:

The Hierarchy List area, located in the bottom-
left corner of the window, displays a visual 
representation of the object hierarchies in your 
scene.

The Sequencer area, in the bottom-center of 
the window, displays timelines containing all 
the key events in your animation. A timeline is 
displayed for each object or scene property in 
the animation. 

The Time Mapping Curve Editor, located at the 
top-left of the window, displays a curve for each 
object or scene property that represents the 
time mapping filter applied to the property. You 
can adjust how long it takes to complete an 
action by changing the shape of the curve.

The Preview Area, located at the top right of 
the window, contains tools for previewing you 
animation.

All the changes you make in the Advanced 
Motion Lab are automatically applied to your 
animation.

Viewing Object Hierarchies

The Hierarchy List area displays the 
hierarchical structure of your scene. The term 
“hierarchy” refers to the structure of object 
links and groups in the scene. 

The Hierarchy List area is used to control the 
display of both the object hierarchies and 
object property timelines. If you want to view 
only your scene’s object hierarchies you’ll have 
to hide all the properties for all objects. You can 
hide each object individually or select from the 
menu to the right of the Preview Area to display 
or not display the hierarchy.

Refer to “Object Hierarchies” on page 303 for 
more on object hierarchies.

To hide an object’s property timelines:

• To hide an individual object’s property 
timelines, click the name of the object 
whose properties you want to hide.

• To hide all the property timelines in the 
Hierarchy List area, either hold down 
Option/Alt while you click, 

or

select Collapse all timelines from the menu 
to the right of the Preview Area. 

When all the object timelines are hidden, the 
only thing displayed in the Hierarchy Area is 
the hierarchical structure of your scene.

The Advanced Motion Lab lets you adjust the hierarchy of 
your scene, the speed of objects, and preview the results.

Time Mapping Editor Preview Area

Hierarchy List Area Sequencer Area
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The hierarchy list can be viewed in two ways: 
collapsed or expanded. You can use the arrow 
icons to expand or collapse the Hierarchy. 
When the Hierarchy list is collapsed you can 
only see the Parent objects in the object 
hierarchies.

When its expanded you can see all child objects 
in the hierarchy.

The indents indicate Parent-child links or 
groups. The parent is align to the far-left, and 
its children are indented from there.

To display or hide the hierarchical 
relationship:

• To display the hierarchical relationship in 
the hierarchy list area, select Display 
Hierarchy from the menu to the right of 
the Preview Area.

• To hide the hierarchical relationship in the 
hierarchy list area, deselect Display 
Hierarchy from the menu to the right of 
the Preview Area

To expand/ collapse the hierarchy list:

• To expand or collapse individual items in 
the hierarchy list, click the Arrow icon 
beside an object’s listing. 

• To expand the entire hierarchy, hold down 
Option/Alt and click an arrow, or select 
Expand all hierarchies from the menu to 
the right of the Preview Area.

• To collapse all hierarchies, select Collapse 
all hierarchies from the menu to the right 
of the Preview Area.

A right facing arrow indicates a closed 
hierarchy, and a down-facing arrow 
indicates an expanded listing.

Editing Property Timelines in 
the Sequencer

Each object in the Hierarchy list has a number 
of timelines associated with it. When you 
display an object’s properties you can see the 
timelines associated with each object.

To display object’s property timelines:

• To display an individual object’s property 
timelines, click the name of the object 
whose properties you want to display.

This is what the Hierarchy List area looks like when 
you’ve hidden all the property timelines.

When the Hierarchy listings are collapsed, you can only 
see the names of the Parent Objects in the scene.

When the Hierarchy listings are expanded, you can view 
the parent objects and their children.

Object Name
Collapsed 

Expanded 
Listing

Parent 
Object
Child 
Object

Animatable 
Object 
Properties
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• To display all the property timelines in the 
Hierarchy List area, either hold down 
Option/Alt while you click, or select 
Expand all timelines from the menu to the 
right of the Preview Area. 

These timelines represent the various 
animatable properties for an object type. 
Different types of objects have different 
animatable properties. 

The white tick on a property timeline indicates 
that a key event has been recorded for the 
property. 

The ruler at the top of the Sequencer lets you 
see the exact point in time when the key event 
was recorded. 

By moving these key events you can control 
precisely when events occur.

For example, this is the listing for a sphere object. When 
the object ‘s property timelines are displayed, you can see 
the key events recorded for each property.

This the listing for a terrain object. Here you can see that 
there are several different animatable properties. Some 
properties like position, size, and rotation are common to 
all objects.

Object 

Animatable 
properties

Recorded Key Event

Object 

Animatable 
Properties

Recorded Key Events

You can tell exactly when an event was recorded by lining 
the key event marker up with the ruler at the top of the 
Sequencer area.

In this example, a position key event was recorded at time 
00:00:01.25 (or 1 second and 25 frames)

This sequence represents an animation where a ball moves 
up and down four times, rotates as it makes its third jump 
and shrinks when its done bouncing.

Time Ruler
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You should take care when rearranging Position 
key events as they can greatly alter the 
trajectory of your object, resulting in 
unpredictable results.

It’s a good idea to activate the continuous pre-
view while your editing the timeline, so you can 
quickly see the effects of your changes. Refer to 
“Previewing Animations” on page 363 for more 
on previewing.

The amount of time available in the Sequencer 
area is not limited by the current Animation 
Range. If you position a key event past the 
current limit of your animation, the Animation 
Range is automatically extended.

To display an object’s property timelines:

• To see specific property timelines, click the 
name of the object whose properties you 
want to display, or,

• To display all property timelines, disable 
Show Selected from the menu at the right 
of the Preview Area.

• To see property timelines for all animated 
objects, enable the Show Animated 

If you move the position key events closer together the 
bounces occur faster, but the timeline remains the same.

If you move the fourth position key event in front of the 
third event, you’re changing the shape of the motion path, 
because the ball bounces up before it bounces down. 

Position is not the only key events you can arrange, here 
both the rotation and scale key events have been 
repositioned. Now, the ball grows large as it bounces and 
rotates only at the end of the animation.
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selection in the menu to the right of the 
Preview Area. 

To move a key event on a timeline:

1 Expand the listing you want to edit.

2 Click the white tick mark on the listing’s 
timeline.

3 Drag the key event to a new position.

To move a group of key events:

1 Drag a marquee around all the key events 
you want to select or hold down Shift and 
click each of the key events you want to 
move.

You can select key events on different 
timelines.

2 Drag one of the selected key events. All the 
other selected key events move also.

To delete a key event from a timeline:

1 Select the key event, or group of events 
you want to delete.

2 Press Delete. The key event is removed 
from the timeline.

To copy a key event on a timeline:

1 Hold down Option/Alt and drag a key 
event. The original remains in the same 
place, but the copy moves as you drag.

Time Mapping Curves

The Time Mapping editor displays a curve 
which represents the time mapping curve 
applied to the events in a property timeline. 
Each property in the Hierarchy List can have its 
own time mapping curve. By adjusting the 

shape of this curve you can change when events 
occur and how long it takes to complete an 
event.

The curve acts like a filter. Time from the actual 
animation is remapped according to shape of 
the curve to produce the final time. Depending 
on the shape of the curve, events can occur 
faster, or slower.

Time Mapping curves can only remap the time 
available in the animation. You cannot add more 
time, or reduce the amount of time in an anima-
tion. 

Editing Time Mapping Curves

The horizontal axis in the editor displays all the 
time in the animation. The vertical axis displays 
the time map for the properties’ timeline. The 
key events recorded for an object property are 
displayed as horizontal dotted lines. The curve 
in the middle represents the time mapping 
filter. The point where the curve intersects a key 
event line tells you exactly when an event 
occurs.

At point A in the this timeline, an event that occurred at 2 
seconds in the original animation, will occur at 3 seconds 
after it’s passed through the filter.

A

Animation Time

Time Map
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The default time mapping curve for any 
property is a diagonal line. In this curve, time is 
not being remapped since events occur at the 
same time along both the horizontal and 
vertical axes.

When you change the shape of the default 
curve, you’re remapping time. 

For example, if you make the curve convex, 
events occur later in the animation, but they’re 
closer together which means the action in your 
animation will speed up.

Different curve shapes represent different time 
mapping effects. A flat curve means that no 
motion is occurring since all the events on the 
curve are happening at exactly the same point 
in time.  

A steep jump in the curve indicates a sharp 
increase in speed, as many events occur in a 
very short time.

At point A in the default timeline, an event that occurred 
at 2 seconds in original animation, also occurs at 2 seconds 
in the time map.

In this example you can see that at point A an event that 
occurred at 1.5 seconds now occurs at 3.1 second. At point 
B an event that occurred at 2.5 seconds now occurs at 3.9 
seconds.

Although both events now occur later, there’s much less 
time between them, so the action in you animation occurs 
later but faster.

A

A

B

A concave curve would create the same type of effect, 
except that the events occur earlier. Here, event A and B 
occur much earlier, within the first second, and the amount 
of time between them is much shorter.

This curve indicates that a pause, or stop of motion occurs 
during the course of the animation.

This curve indicates a sharp increase in speed.

A

B
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An oscillation in the curve, indicates that 
events repeat, since they intersect the curve 
more than once.

You can combine any variation of curve slopes 
to create different velocity effects. 

While you’re editing a Time Mapping curve, 
you may want to continuously run the 
animation preview. As the preview runs, the 
cross-hairs in the Time Mapping editor moves 
from the beginning or the animation to the 
end. This way you can quickly see the effects of 
your edits. Refer to “Previewing Animations” 
on page 363 for more on continuous preview.

The counter at the bottom of the editor shows 
you the current time of the animation. As the 
animation runs, the counter updates to 
continuously show the current time.  

You can also move the current time by dragging 
the Current Time bar in the Hierarchy area.

To edit a Time Mapping curve:

1 Display the Advanced Motion Lab.

2 Click the name of the object whose 
properties you want to remap

3 Click the name of the property you want to 
remap.

4 In the Time Mapping Editor, click a point 
on the curve and drag it to a new location. 

• If you move over an existing point the 
cursor changes to a cross-hairs. 

• If there is not point on the curve, the 
cursor turns into a pen.

5 Continue dragging points until you achieve 
the desired shape.

To zoom into an area of the Time Mapping 
curve:

1 Move the cursor over the curve in the Time 
Mapping Editor. 

2 Click and drag over an area of the curve. 
When you release the mouse, the area is 
enlarged.

To zoom out of an area in the Time Mapping 
curve:

• Hold down the Shift key and click inside 
the Time Mapping editor.

To pan the Time Mapping curve:

• To pan, press the Spacebar and drag the 
curve in the editing window.

• To reset the view in the Curve Editor, press 
Cmd/Ctrl + Shift + Click.

Using Presets

Above the Time Mapping Curve Editor are 
eight time mapping curve presets. 

You can create a preset of the current curve 
then apply it to a different attribute of the same 
object or to another object. 

In this curve event A occurs once at 1.5 seconds and again 
at 3.5 seconds.

Watch the counter as you preview your animation to see 
the current time.

A A
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To add, apply, or remove a preset:

• To add a preset, click in one of the blank 
squares. 

• To apply a preset, click in the square that 
displays the present you want to apply. 

• To remove a present, press Option/Alt and 
click on the square that displays the preset 
you want to delete. 

When all the preset slots are filled, a new one is 
automatically generated when you click on the 
right arrow. 

• To scroll to the newest present or to the 
next preset in line, click on the nd of the 
present container. 

Previewing the Animation

The Preview Area in the Advanced Motion Lab 
lets you see a preview of your animation as you 
edit the Hierarchy or the Time Mapping curves. 

Any change you make in the lab is 
automatically applied to the preview. When you 
play the preview you see the effects of your 
changes.

Once a start playing the animation, it will run 
continuously until your press the Stop button. 
Running the preview also moves the Current 
Time Bar in the Sequencer area and the cross-
hairs in the Time Mapping editor. As well, the 
counter at the bottom of the Time Mapping 
editor displays the current time of the 
animation as it plays.

To preview an animation:

• Click the Play button in the Preview Area 
controls. 

The animation starts running. It will 
continue playing until you press the Stop 
button.

Click the stop button to stop the preview.

The controls along the left side of the Preview 
Area control several options for your animation 
preview.

To switch between Camera View and 
Director’s View in the preview:

• Click the Swap Views button next to the 
Preview Area.

When you first open the Advanced Motion 
Lab, the Preview Area displays the current 
camera view. 

The Preview Area in the Advanced Motion Lab displays 
the results of your changes to the Hierarchy or Time 
Mapping curves.
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In Director’s View you’ll be able to see the 
camera in the scene.

• Click the button again to switch back to 
Camera View.

Changing views in the Preview Area doesn’t 
affect the view in the Working window.

To render your preview:

• To render your preview, click the last VCR 
button under the Preview Area in the 
Advanced Motion Lab.   

To change the view in the Preview Area:

• To orbit around your scene, drag the 
preview in the direction you want to move 
the view of your scene.

• To change the position of camera, hold 
down Option/Alt and drag the preview.

To zoom in and out of the preview:

• Click the + button next to the Preview 
Area. The view of the scene enlarges.

• Hold down Shift and click the + button 
to zoom out.

To reset the view in the preview area:

• Click the Reset button next to the Preview 
Area.

The view switches back the view displayed 
when you first entered the Advanced 
Motion Lab.

To pan the Preview Area:

• Drag the cursor over the Pan button next 
to the Preview Area.

Hiding and Displaying Objects

The left side of the hierarchy area displays a list 
of all the objects in your scene. The icons on 
the left side of the listing indicates whether or 
not the object is displayed in the preview area. 

When you switch to Director’s View in the Preview Area 
you can see the camera in the scene.

When you click on the last VCR button, your wireframe in 
the Preview Area is rendered.

Director’s View

Camera View

The eye icon indicates whether or not an object is hidden.

Hidden Object

Visible Object
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When you hide an object it does not appear in 
the Preview Area at the top of the Advanced 
Motion Lab. This setting has no effect outside 
the lab. Objects that are hidden in the lab will 
be visible in the Working window and will still 
render normally.

You can use this feature to isolate objects that 
your editing in the Sequencer or Time Mapping 
areas.

To hide/display an object:

• Click the Eye icon to hide the object.

Click the icon again to display the object.

Saving Preview Positions

The Memory dots next to the Preview Area let 
you save specific camera positions in the 
preview for later use.

To save a position:

1 Play the animation and then stop it at the 
point you want to save.

or

Move the Current Time bar in the 
Hierarchy area to the position you want to 
save.

2 Click on an empty Memory dot on the right 
side of the Preview Area.

A dot is empty when it appears gray.

To move to saved position:

• Click on a full Memory dot. A dot is full 
when it appears purple.

To delete a saved position:

• Option/Alt+click on a full Memory dot.

Motion Paths
A motion path is a visual representation of an 
object’s trajectory as it moves through time. 

An object’s motion path is automatically 
generated as you create key events. Each new 
key event adds a new point to the path. 

The shape of the curve is determines by the 
interpolation performed by Bryce. In most 
cases Bryce tries to create smooth motion so 
the path is drawn as a curve. 

The Memory Dots on the right side of the Preview Area let 
you save positions in the Hierarchy area and the 
animation preview.

An object’s motion path is automatically generated as you 
create key events. As you move the object at a specific point 
in time, the motion path line extends out from the object’s 
wireframe.
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As you add key events, the curve is adjusted to 
include the new motion. 

Motion paths exist in 3D space so they can be 
view from any angle. If you move the camera, 
you can see how the object moves along the X, 
Y and Z axes. 

The default state of the motion path can be 
difficult to see in a complex scene. You can give 
your motion path some extra depth by 
displaying it as a ribbon. 

By default, the motion path for an object only 
appears when the object is selected. Otherwise 
the path is invisible. As well, it does not render 
in the final animation.

You can change the display mode of the motion 
path in the Animation tab of the Object 
Attributes dialog.

To show the motion path as a ribbon:

1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes 
dialog appears.

3 Click the Animation tab.

4 Enable the Show as Ribbon option and 
click the OK icon.

As you add more key events to your animation, the path 
changes shape to include the new motion. Bryce always 
keep the motion smooth, so each new point is added as a 
curve.

If you move the camera to different views, you’ll be able to 
see the object’s trajectory along all three axes.

The ribbon lets you see the motion path as a flat track 
running through the scene.
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To display the path only when the object is 
selected:

1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes 
dialog appears.

3 Click the Animation tab.

4 Enable the Show Only when Selected 
option and click the OK icon.

To display the path at all times:

1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes 
dialog appears.

3 Click the Animation tab.

4 Enable the Show Always option and click 
the OK icon.

Editing Motion Paths

Changing the shape of the motion path changes 
the trajectory of the object. The path acts like a 
Bezier curve. You can change its shape by 
dragging its control points. 

You don’t have to be in Auto-Record mode to 
edit the path. The changes you make to the 
path’s shape are applied directly to path the in 
real time.

Changing the shape of a path does not affect 
when key events occur. A key event that occurs 
at 00:00:01.00 will still occur at the same time 
regardless of where it 

Since Bryce treats the motion path as a Bezier 
curve, you can edit it just as you would any 
curve in any 2D illustration application. You 
can also display the curves tangents which 
indicate the angle of the curve. 

For example, the events on the path above occur at 
00:00:00.01, 00:00:01.00 and 00:00:02.00. When you 
change the shape of the path, the direction in which the 
object travels changes, but all the events still occur at the 
same they did in the original path.

When you display the path’s tangents you can see the 
angles of its curve points.
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Motion Path Modifiers

There are a number of modifiers you can apply 
to the path change the way motion occurs along 
the path. 

Normally an object moves from the first key 
event on the path to the last over the course of 
the animation. If you want the object to move 
backwards along the path, or repeat its action, 
you would have to reposition the object and set 
up new key events. The modifiers let you create 
these types of effects automatically. 

For example, if you wanted to animate the 
motion of a grandfather clock pendulum, you 
have to set up the forward motion, and then the 
backward motion. 

However, using the Pendulum modifier you just 
have to set up the forward motion path. Since 
the modifier changes the object’s behavior so 
that it moves forward than back along the same 
path during the course of the animation. All 
you have to do to see the new motion is extend 
the duration of the animation.  

There are four modifiers available:

• Make One Shot restores the motion of the 
path its original configuration, meaning 
the action along the path only occurs once. 

• Make Repeat creates a loop in the action. 
The motion on the path repeats 
continuously.

• Make Pendulum creates a repeating cycle 
in the action along a path. The object will 
move forward on the path, then back and 
then forward continuously.

• Make Circular closes the path to create a 
circular path. The object will move along 
the path and when it hits the end, it’ll 
swing around to the front of the path and 
start all over.

To apply a modifier to a motion path:

1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes 
dialog appears.

3 Click the Animation tab.

4 Enable a modifier.

5 Extend the duration of the animation so 
you can see the change in motion.

The motion of this clock’s pendulum was created using the 
Pendulum modifier.
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Moving the Path

You can also move the path, by dragging it to a 
new location. When you drag the path, all the 
events on the path shift position. Changes in 
motion path position are not recorded as key 
events.  

To move a motion path:

• Click on a section of the path that does not 
contain any control points and drag it to 
new location.

You have to click on a part of the path 
without control points, otherwise you’ll 
change its shape.

Aligning Objects to the Path

Normally, the center of object remains 
perpendicular to the motion path as it moves 
from point to point. Using the aligning option 
you can have the object’s center remain parallel 
to the path so that it reorients itself as moves 
from point to point

You can use this option to create more realistic 
motion for objects that have a distinct front and 
back.

There are two align options available:

• Do Not Align disables aligning. The shape 
of the curve has no effect on the object’s 
orientation.

• Align adjusts the object so that its 
orientation is matches the shape of the 
path.

To align an object to a motion path:

1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes 
dialog appears.

3 Click the Animation tab.

4 Enable an alignment option and click the 
OK icon.

When you drag the motion path, you’re not changing its 
shape, you’re adjusting the position of all the events on the 
path, so this animated ball occurs at a higher altitude.

For example, the motion of this airplane looks rather 
unrealistic since its rising and falling without tilting.

If you align the airplane to its path, the airplane’s nose 
tilts down as it moves down and up as it moves up.
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15  

Animating 
Techniques

Introduction
Bryce has several features you can use to add 
realism to your animations. The techniques 
covered in this chapter can be used together to 
help you develop more exciting, natural and 
dynamic animations. 

In this chapter you’ll learn how to animate 
objects using the Tracking feature. You’ll also 
learn how to animate several different proper-
ties of your scene like material channel prop-
erties, which can dramatically alter the look of 
your objects, and terrain object properties, 
which can alter the layout of your landscape.



Tracking Objects
Tracking lets you connect an object to another, 
called the target, so that the object remains 
pointed at the target throughout the animation.

As the target moves, the original object pivots 
around its origin so that it remains pointed at 
the target. Normally, the original object does 
not change position, only orientation. However, 
if you offset the object’s origin point, it might 
change location as it rotates around the 
offset point. 

You can use tracking to quickly set up the ani-
mation of a number of objects at once. When 
an object is tracking another, you only have to 
set up the motion path of the target object. The 
motion of the objects tracking the target are 
automatically created.

You can also use this feature to ensure that a 
light or the camera remains pointed at an 
object during the entire course of the anima-
tion. You can also use it to create motions like a 
radar dish following a satellite or a sunflower 
following the sun.

A parent object cannot track its child object. 

When an object tracks a target object, it remains pointed 
at the target object no matter where it moves in the scene.

The original object pivots around its origin point so that 
it’s always facing the target object. 

For example, in this scene the motion of all the lights is 
created when you move the target object.
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To set up object tracking interactively:

1 Select the object you want to remain 
stationary (that is, the one that tracks the 
target object).

2 Move the cursor over the target icon that 
appears next to the object’s bounding box.

3 Drag the Target line from the icon to the 
target object. The target object turns blue.

To set up object tracking using the Object 
Attributes dialog:

1 Select the object you want to remain 
stationary.

2 Click the A icon that appears next to the 
object’s bounding box. The Object 
Attributes dialog appears.

3 Click the Linking tab.

4 Click the Target Object Name menu and 
choose the name of the target object.

Animating the Camera
When you animate the camera, you’re changing 
the view of you scene over the course of the 
animation. Since you’re in 3D space you can 
move the camera to any position in the scene. 
You can have your camera circle around the 
scene, zoom into it or even fly under it.

There are two ways of animating the camera in 
Bryce: using the Camera Position controls, or 
by moving the camera as an object.

The easiest way of animating the camera is to 
use the Trackball, (or other Camera Position 
controls) in Camera View while Auto-Key mode 
is enabled. Any changes you make to the posi-
tion of the camera are automatically recorded 
as part of a key event. When you play the ani-
mation, your camera changes are added to all 
the other changes in scene properties to create 
the action in your animation.

While working in Camera View may be the eas-
iest way of animating the camera, it’s not the 
most precise. Because of the view’s first person 
perspective, it can be hard to see the exact path 
of the camera as it moves. This can make creat-
ing a precise motion difficult. 

However, if you switch views, to an orthogonal 
view or the Director’s View, you’ll be able to see 
the camera as an object in the scene. Then you 
can select the camera and set up key events for 
its position, just as you would for any other 
object. Also, you can display the camera’s 
motion path so you can make precise adjust-
ments to its movements.

After you’re done setting up the key events for 
the camera, you can see the changes in the 
Sequencer in the Advanced Motion Lab. There 
you can rearrange the order of events or change 
how long it takes to move between camera posi-
tions. Refer to “Object Hierarchies” on 
page 303 for more on working in the Hierarchy, 

As you drag the Tracking icon from the tracking object to 
the target, a tracking line appears.
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or “Time Mapping Curves” on page 371 for 
more on remapping time.

Camera Motion and Skies

The motion of sky elements can affect how fast 
the action in your animation appears. For exam-
ple, in time-elapsed movies, the clouds and sun 
fly by quickly as the objects stay in the same 
position. You could inadvertently create this 
type of action in your scene if you move only 
the camera in the scene without considering 
the static nature of the sky elements. Since the 
clouds stay in exactly the same position as you 
move the camera, they’ll appear to be moving 
much faster than the objects in the scene. 

To avoid this problem, Bryce lets you link the 
clouds to the camera. This way, whenever the 
camera moves, the cloud positions also move, 
so they look like they’re staying in the same 
position.

Although you can also link the sun to the cam-
era, it’s not a very good idea to link the two dur-
ing an animation since any change in the 
camera position will change the time of day.

To link clouds to the camera:

1 Display the Sky & Fog palette.

2 Click the triangle icon in the bottom right 
corner of the palette and choose Sky Lab 
from the menu. The Sky Lab dialog 
appears.

3 Click the Cloud Cover tab.

4 Click the Link Clouds to View button at 
the bottom of the palette.

5 Click the OK icon to exit the palette.

Using the Orthogonal Views

In Camera View you can’t see the physical posi-
tion of the camera in the scene since you’re 
looking through it, but using one of the 
Orthogonal views (Top, Bottom, Left, Right, 
Front and Back) you’ll be able to see the camera 
as an object.

In these view you can animate the camera by 
changing its position at different points in time. 
When you run the animation, Bryce fills in the 
gaps between positions to create smooth cam-
era motion.

After you’re done adjusting the position of the camera, you 
can see the events recorded for the changes in the 
Hierarchy Area.

In this example, the scene is displayed in Top view. Here 
you can see the exact position of the camera in the scene.
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To animate the camera in an orthogonal 
view:

1 In the Working window, click the triangle 
icon next to the View Control and choose 
an orthogonal view from the menu: Top, 
Left, Right, Bottom, Front or Back.

2 Move the Current Time Indicator in the 
Timeline to the point where you want to 
start changing the Camera View.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

4 Drag the Camera wireframe in the Working 
window to a new position.

5 If you want to see the results of your 
changes, choose Camera View from the 
View Control menu and click the Play 
button in the Animation controls.

Using Director’s View

Director’s View is similar to Camera View, 
except that in this view, you can see the camera 
as an object in the scene and the movements of 
the Director’s camera are not recorded as key 
events.

In Director’s View, you can move the view of the 
scene using the Trackball or the Camera Posi-
tion tools. The view of the scene changes in the 
Working window, but no new key events are 
created. 

You can also preview the animation while in 
Director’s View. In the Working window you 
can see all the object’s moving along their 
motion paths— including the camera.

To animate the camera using Director’s View:

1 In the Working window, click the triangle 
icon next to the View Control and choose 
Director’s View from the menu.

2 Move the Current Time Indicator in the 
Timeline to the point where you want to 
start changing the position of the camera.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

4 Drag the Camera wireframe in the Working 
window to a new position.

5 If you want to see the results of your 
changes, click the Play button in the 
Animation controls.

Displaying the Camera’s 
Trajectory

If you’re setting up a precise path for the cam-
era, you may want to display its motion path. 
Just like with other motion paths, you adjust 
the trajectory of the camera by adjusting the 
shape of the path. Refer to “Editing Motion 

In Director’s View you see the camera as an object in the 
Working window. You can change this view using any of 
the Camera Position controls in the Control Palette.
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Paths” on page 378 for more on working with 
motion paths.

To display the camera’s trajectory:

1 In the Working window, click the triangle 
icon next to the View Control and choose: 
Top, Left, Right, Bottom, Front or Back 
from the menu.

2 Select the Camera in the Working window.

3 Click the A icon that appears next to the 
camera’s bounding box. The Camera & 2D 
Projection dialog appears.

4 Click the Animation tab.

5 Click the Show Trajectory option and click 
the OK icon.

Linking and Tracking with the 
Camera

Since Bryce lets you treat the camera as an 
object, you can also link the camera to an 
object, or you can have it track an object. 

When you link the camera to an object, the 
view of the scene changes as the position of the 
parent object changes.

When the camera is linked to an object, both 
its aim and position change as the object 
changes.

When you set the camera to track an object, the 
camera remains pointed at the target object no 
matter where the object moves in the scene. 
This means the Trackball is disabled because 
the orientation of the camera is controlled by 
the position of the target object. Also, you can’t 
change the aim of the camera because it always 
aims at the target object. 

When you display the camera’s trajectory, you can see the 
exact path it will take during the course of the animation.

For example, if you link the camera to an airplane, the 
view of the scene will follow the airplane’s trajectory as it 
moves long its motion path.
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However, you can position the camera using the 
Camera controls as these controls change the 
position of the camera not its orientation.

Linking the camera can cause unpredictable 
movements when you’re in Camera View. If you 
change the position of the target object, the view 
of the scene will also shift.

To link the camera to an object using the 
Camera & 2D Projection dialog:

1 Switch to an orthogonal view or Director’s 
View.

2 Select the Camera.

3 Click the A icon that appears next to the 
camera’s bounding box. The Camera & 2D 
Projection dialog appears.

You can also access the dialog by double-
clicking the Trackball, or choosing Edit 
menu> Current Camera

4 Click the Linking tab.

5 Click the Object Parent Name menu and 
choose the name of the object you want to 
use as the parent object.

6 Click the OK icon to link the two objects.

To link the camera to an object interactively:

1 Switch to an Orthogonal view or Director’s 
View.

2 Select the Camera.

3 Move the cursor over the Link icon that 
appears next to the camera’s bounding box.

4 Drag the linking handle from the icon to 
object you want to use as the parent object.

To force the camera to track an object using 
the Camera & 2D Projection dialog:

1 Switch to an orthogonal view or Director’s 
View.

2 Select the Camera.

3 Click the A icon that appears next to the 
camera’s bounding box. The Camera & 2D 
Projection dialog appears.

4 Click the Linking tab.

5 Click the Track Object Name menu and 
choose the name of the target object.

6 Click the OK icon.

To force the camera to track an object 
interactively:

1 Switch to an orthogonal view or Director’s 
View.

2 Select the Camera.

For example, if you link the camera to an airplane, the 
view of the scene will follow the airplane’s trajectory as it 
moves long its motion path.
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3 Move the cursor over the Tracking icon that 
appears next to the camera’s bounding box.

4 Drag the tracking handle from the icon to 
the object you want to use as the target 
object.

Creating Camera Orbits

The camera’s origin point controls its center of 
rotation. When the origin point is at the cam-
era’s center, it rotates around in place. When 
the origin is positioned somewhere in the 
scene, it will orbit around the origin point. 
During an animation, the view of your scene 
will orbit around a specific point in the scene.

To create a camera orbit:

1 Switch to Director’s View or one of the 
orthogonal views.

2 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

3 Click the Camera wireframe in the 
Working window.

4 Click the A icon that appears next to the 
camera wireframe. The Camera & 2D 
Projection dialog appears.

5 Click the General tab.

6 Click the Show Origin Handle button and 
click the OK icon.

7 Drag the ring handle to a position in the 
scene.

8 Rotate the object using the Rotation tool in 
the Edit palette or the Trackball.

Animating Materials
The action in your scene can include much 
more that just motion. Many subtle or dramatic 
effects can be created by changing the proper-
ties of an object’s surface over the course of the 
animation. 

This section assumes that you’re familiar with 
the concepts and procedures involved in creating 
material and textures. Refer to “Building Mate-
rials” on page 230 for more on creating materi-
als and “Textures” on page 237 for more on 
editing textures.

By animating an object’s texture you can create 
subtle effects like changing the color of an 
object to simulate things like a tomato ripening. 
You can also create more dramatic effects like 
changing all the properties of a material at 

In this example, the camera’s origin point was positioned 
in the center of the scene. During the course of the 
animation, the camera appears to orbit around the entire 
scene.
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once. Using this technique you can change an 
object from marble to metal, or glass to wood.

In Bryce, animating materials is a rather 
straight-forward process. Using the animation 
tools in the Materials Lab you set the properties 
of a material at different points along the Time-
line. When you run the animation, Bryce inter-
polates between the properties to create a 
transition from one material to the other.

You can animate any property of a material:

• Colors

• Channel values

• Texture component usage (that is, 
switching between components A, B, C and 
D)

• Texture properties

• Volume Material properties

Take care when you’re choosing which proper-
ties to animate. Some properties, like transpar-
ency, and volumetric effects can greatly increase 
the rendering time or your animation.

Material animations are created using the Ani-
mation controls at the bottom of the Materials 
Lab. 

These controls let you move along your anima-
tion’s timeline. This timeline is the same as the 
one at the bottom of the Working window. It 
contains all the same key events as the Working 
window timeline. The Animation controls in 
the Materials Lab can perform all the same fea-
tures as the Animation controls in the Working 
window.

Animating Material Channel 
Values

By animating the channels in a material you can 
alter the properties of a material without 
changing its basic function. Using this tech-
nique, a rock material would still look like a 

In this animation, the illusion of a banana ripening was 
created by changing the color and texture of a material 
over time.

The Animation controls at the bottom of the Materials Lab 
lets you move along the Timeline and preview your 
animation.

Key frame controls

Previe w controls

Current Time 

Timeline

Indicator
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rock, but change color, or glass would still look 
like glass except become shinier. 

This is the simplest way of animating a material 
and it requires the least amount of processing 
time. 

To animate a material’s channel values:

1 Select an object.

2 Click the M icon that appears next to the 
object’s bounding box. The Materials Lab 
appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

4 Move the Current Time Indicator to the 
point where you want to start changing the 
material.

5 Change the values of the material channels 
using the Value controls.

or 

Change the color used for a channel by 
using the color picker.

6 Move the Current Time Indicator to a 
different point on the Timeline.

The current time appears in the counter 
next to the preview controls.

7 Change the channel values again.

8 Continue moving the Current Time 
Indicator and changing channel values 
until you achieve the effect you want.

9 Click the OK icon to exit the Materials Lab.

Animating Texture Components

Animating a texture component is an effective 
way of creating motion within a material. When 
you change the orientation, position or scale 
within a texture component, the texture ele-
ments, (like dots, checks or patterns) will 
appear to move.

You can use this technique to create realistic 
wave motion in a water texture. If you change 
the position of the texture pattern at different 
points in the Timeline, the waves will appear to 
move over the surface of the object.

In this example, the effect of a cat’s eyes growing brighter 
as the sunlight fades, was created by animating the 
Ambience channel value.
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If you wish to avoid unexpected texture move-
ment during a texture animation, use Object 
Space mapping mode for the texture. This way 
the texture moves as the object moves. How-
ever, you can create some very interesting 
effects using World Space.

You can also animate a texture component by 
altering the makeup of the texture using the 
Deep Texture Editor. Using the editor you can 
change the make-up of any or all of the four 
texture components in a material. 

To animate a material’s texture components:

1 Select an object.

2 Click the M icon that appears next to the 
object’s bounding box. The Materials Lab 
appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

4 Move the Current Time Indicator to the 
point where you want to start changing the 
material.

5 Click the button in the upper left corner of 
the texture component window. The Edit 
Texture palette appears.

6 Adjust the position, orientation or scale of 
the texture and click the OK icon to exit 
the controls.

7 Click the pink button in the upper-left 
corner of the texture component window. 
The Deep Texture Editor appears.

8 Adjust the values of the texture’s 
components and click the OK icon to close 
the editor.

9 Move the Current Time Indicator to a 
different point on the Timeline.

The current time appears in the counter 
next to the preview controls.

10 Change the texture properties again.

11 Continue moving the Current Time 
Indicator and changing texture properties 
until you achieve the effect you want.

12 Click the OK icon to exit the Materials Lab.

This tide effect was created by changing the makeup of the 
water texture in the material applied to the water slab.

Click the button in the upper left corner of the Texture 
Component window to display its transformation controls.

Click the pink button in the upper left corner of the Texture 
Component window to display the Deep Texture Editor.
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Animating Between Materials

Animating channel values or texture compo-
nents is a good way of creating subtle effects in 
a material, but to create more dramatic action, 
you’ll need to animate between two completely 
different materials.

This is how you create a transition from rock to 
glass, or wood to metal.

Animating between materials is exactly like cre-
ating two different materials for the same 
object. As long as the Auto-Key mode is 
enabled, all your settings are recorded as key 
events, so you can set up a material at one point 
in time and then move to a different point on 
the Timeline and create a completely different 
material. 

There are two quick ways of creating different 
materials:

• By switching the Texture Component used 
to set a material channel, you can 
completely change the color, pattern, or 
bumpiness of a texture.

• Using the Preset Materials Library, you can 
quickly apply a different material to the 
object.

To animate between materials:

1 Select an object.

2 Click the M icon that appears next to the 
object’s bounding box. The Materials Lab 
appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

4 Move the Current Time Indicator to the 
point where you want to start changing the 
material.

5 Set up a material by setting channel values 
and texture components.

6 Move the Current Time Indicator to a 
different point on the Timeline.

The current time appears in the counter 
next to the preview controls.

7 Set up a different material by choosing 
different components or applying a preset.

8 Click the OK icon to exit the Materials Lab.

Previewing Material Animations

Any change you make to a material’s properties 
are displayed in the Material Preview area. 
When you play a material animation, the same 
preview area shows you the transition of the 
material from one key event to the other.

The transition between rock and glass in these temple 
columns was created using two completely different 
materials.
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This is not the most effective way to see a material 
aniamtion.The best way of seeing a material 
transformation is by rendering the scene.

To preview a material animation:

• Click the Play button in the Animation 
controls at the bottom of the Materials Lab.

Click the Stop button to stop the preview.

Animating Skies
All the properties of a Bryce sky can be ani-
mated. This means that any attribute you can 
set in the Sky & Fog palette or the Skylab dia-
log can be animated using the Animation con-
trols on the Timeline. 

This section assumes that you’re familiar with 
the concepts and procedures involved in creating 
skies. Refer to “Creating Skies” on page 123 for 
more on creating skies.

By changing the attributes in the Sky & Fog 
palette at different points in the time, you can 

animate everything from the position of the sun 
to the color of the clouds. 

There are several techniques you can use to add 
motion to your skies. You can animate all or 
some of the properties of your sky. You can acti-
vate and deactivate sky effects at different 
points in the animation. You can also animate 
the position of the sun or moon. 

Sky animations are created using the Anima-
tion tools in the Working window and the Sky 
Lab dialog.

Animating Sky & Fog settings

Animating Sky & Fog settings changes the 
properties of a sky over time. For example a 
scene can become cloudier, or darker during an 
animation. The intensity of the change depends 

The Material Preview area displays the preview of your 
material animation.

For example, you can simulate changes in the time of day 
by changing the position of the sun over time.
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on how many properties you adjust and the 
amount of each adjustment.

Most Sky & Fog properties can be changed 
using the thumbnail controls. Other settings 
are available in the Skylab dialog. 

You won’t be able to see the effects of a sky ani-
mation until you render the entire animation.

To animate Sky & Fog settings:

1 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

2 Move the Current Time Indicator to the 
point in the Timeline where you want the 
sky to change.

3 Adjust the sky’s properties using the Sky & 
Fog palette controls.

4 Move the Current Time Indicator to a 
different point on the Timeline. 

5 Change the properties of the sky again.

6 Continue moving the Current Time 
Indicator and changing the sky’s properties 
until you achieve the desired effect.

Animating Clouds

You can create the effects of wind in your envi-
ronment by setting up cloud motion parame-
ters. Based on your settings, Bryce 
automatically moves the clouds in your envi-
ronment to create motion.

Cloud motion parameters are set in the Sky 
Lab dialog.

To animate clouds:

1 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

2 In Sky & Fog palette, click the Sky Lab 
button. The Sky Lab dialog appears.

3 Click the Cloud Cover tab.

4 Move the direction indicator in the Cloud 
Motion controls to set a direction for the 
clouds as they move in the animation.

In this example, the animation of approaching storm 
clouds was created by changing the Cloud Frequency and 
Amplitude value and the Cloud Color at different points in 
the Timeline.

The Cloud Direction control lets you set the direction for 
cloud motion, while the other controls set the speed and 
distortion of the clouds. 

Cloud Direction 
controls

Speed control

Turbulence control
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5 Adjust the speed control to set how fast the 
clouds move. You can also enter a speed 
value.

6 Adjust the Turbulence control to set how 
much the clouds will distort as they move. 
You can also enter a turbulence value.

Animating Environmental 
Effects

Many environmental effects like rainbows and 
fog are not permanent features of sky. They 
appear for a brief time and then fade way. You 
can simulate this action by changing the prop-
erties of the environmental effects at different 
points along the Timeline. 

Environmental effects controls are located on 
the Atmosphere tab of the Sky Lab dialog. You 
can also animate the various settings for an 

effect. For example, the radius of moon rings 
can increase or decrease during the course of 
your animation.

To animate environmental effects:

1 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

2 Move the Current Time Indicator to the 
point in the Timeline where you want the 
sky to change.

3 Display the Sky Lab dialog: Atmosphere 
tab and change the properties of an effect.

4 Move the Current Time Indicator to a 
different point on the Timeline. 

5 Change the properties of the effect again.

6 Continue moving the Current Time 
Indicator and changing the effect’s 
properties until you have the desired 
effect.

Animating Sun or Moon Position

One of the most spectacular effects you can 
create using the scene’s sky is elapsed time. In 
the great outdoors we perceive time in relation 
to the position of the sun and the brightness of 
the sky. By changing the position of the sun or 

The natural appearance and disappearance of this 
rainbow was created by changing the rainbow density 
over time.
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moon you can simulate time passing in terms of 
days or months.

Since all the elements in the sky are linked, the 
other properties of the sky like Ambient Light 
change as the position of the sun changes, add-
ing to the realism of the effect.

For the moon, you can also change its phases, 
so you simulate the passage of an entire month 
just by adjusting the moon attributes.

To animate Sun or Moon position:

1 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

2 Move the Current Time Indicator to the 
point in the Timeline where you want the 
sky to change.

3 Adjust the position of the sun or moon 
using the Sun Position control in the Sky 
& Fog palette.

4 Move the Current Time Indicator to a 
different point on the timeline. 

5 Change the position of the sun or moon 
again.

6 Continue moving the Current Time 
Indicator and changing the sun or moon 
position until you achieve the desired 
effect.

Animating Terrains
Terrain objects are animated by changing their 
properties in the Terrain Editor. 

This section assumes that you’re familiar with 
the concepts and procedures involved in creating 
terrains. Refer to “Creating Terrains” on 
page 164 for more on creating and editing ter-
rains.

By changing the shape of your landscape at dif-
ferent point on the Timeline you can simulate 
geological events like earthquakes or erosion.

In this example, the passage of time is simulated by the 
change in the sun’s position.
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There are several techniques you can use to 
control how the shape of your terrain changes. 
You can use the grayscale paintbrush to totally 
change the geometry of the terrain by adding 
new peaks and valley, or you can use the Filter-
ing tools to add small changes in elevation to 
the terrain.

Terrain animations are created using the Ani-
mation controls that appear at the bottom of 
the Terrain Editor.

The Timeline in the Terrain Editor is the same 
as the one in the Working window. All the key 
events recorded for object transformations and 
material changes are displayed in the Timeline. 
The Animation controls in the Terrain Editor 
can perform all the same functions as the those 
in the Working window. Refer to “Creating Ani-
mations” on page 356 for more on using the 
animation controls.

Animating Terrain Geometry

There are two ways of changing the geometry of 
a terrain object: by painting directly on the Ter-
rain Canvas or by applying an elevation effect. 
When you paint on the canvas you create large 
changes in the terrain like the creation of new 
mountains or valleys.

The appearance of cracks in the earth during an 
earthquake, can be created by animating the geometry of 
the terrain.

The Animation controls at the bottom of the Terrain Editor 
lets you move along the Timeline and preview you 
animation.

Key frame controls

Previe w controls
Current Time 

Timeline

Indicator
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When you apply an effect you create smaller 
more subtle changes like a mountain eroding 
over time.

The violent motion of great rock columns shooting up from 
the ground was created by painting a new peak onto an 
existing terrain at different points along the timeline.

The appearance of foot prints in the sand was created by 
painting dark footprint shapes in the Terrain Canvas at 
different points in the Timeline.

The rolling motion in this terrain was created by applying 
the erode effect at one point in the Timeline and then 
undoing it in another.
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You can also use this technique to record how a 
terrain object was formed. By adjusting the 
Current Time as you add elements to the ter-
rain, you’ll have a complete record of all your 
steps.

To animate terrain geometry:

1 Click a terrain object. 

2 Click the E icon that appears next to the 
terrain object’s bounding box. The Terrain 
Editor appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

4 Move the Current Time Indicator to the 
point in the Timeline where you want the 
terrain to change.

5 Paint new areas in the terrain using the 
Grayscale paintbrush.

or 

Apply one of the effects in the Elevation 
tab.

6 Move the Current Time Indicator to a 
different point on the Timeline. 

7 Change the shape of the terrain again 
using an effect or the paintbrush.

8 Continue moving the Current Time 
Indicator and changing the terrain’s shape 
until you achieve the desired effect.

9 Click the OK icon to exit the editor.

Animating Terrain Filtering

By animating the shape of a terrain object’s fil-
tering graph you can create some very specific 
geometry effects. 

For example, you can make specific areas of 
your terrain sink to simulate the damage caused 
by an earthquake. To create this effect you 
would darken only areas you want to sink in the 
Filtering graph. Likewise, you create the effect 
of ridges forming by lightening specific areas of 
the graph. 

You can also use the Filtering graph to gradu-
ally raise or lower the entire terrain over the 
course of your animation.

To animate terrain filtering:

1 Click a terrain object. 

2 Click the E icon that appears next to the 
terrain’s bounding box. The Terrain Editor 
appears.

3 Click the Filtering tab.

The gradual appearance of stairs in this terrain was 
created by adjusting the filtering graph at different points 
in the timeline.
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4 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

5 Move the Current Time Indicator to the 
point in the timeline where you want the 
terrain to change.

6 Adjust the shape of the Filtering graph.

7 Move the Current Time Indicator to a 
different point on the timeline. 

8 Change the shape of the graph again.

9 Continue moving the Current Time 
Indicator and changing the terrain’s graph 
until you have the desired effect.

10 Click the OK icon to exit the editor.

Animating Terrain Clipping

The setting of the Terrain Clipping bracket can 
also be animated. As areas of the terrain are 
clipped, they’re removed from the terrain 
object in the scene. Your terrain will look like 
it’s breaking up, or like portions it are falling 
into the sea.

To animate terrain clipping:

1 Click a terrain object. 

2 Click the E icon that appears next to the 
terrain’s bounding box. The Terrain Editor 
appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is 
enabled. 

4 Move the Current Time Indicator to the 
point in the Timeline where you want the 
terrain to change.

5 Adjust the width of the clipping bracket.

The gradual destruction of this island was created by 
changing the length of the clipping bracket at different 
points in the Timeline.
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6 Move the Current Time Indicator to a 
different point on the timeline. 

7 Change the width of the bracket again.

8 Continue moving the Current Time 
Indicator and changing the width of the 
bracket until you achieve the desired 
effect.

9 Click the OK icon to exit the editor.

Previewing Terrain Animations

Any change you make to a terrain’s properties 
appear in the 3D Terrain Preview. When you 
play a terrain animation, the same preview area 
shows you the transition of the terrain from one 
key event to the other.

To preview a material animation:

• Click the Play button in the Animation 
controls at the bottom of the Terrain 
Editor.

Click the Stop button to stop the preview.

The 3D Terrain Preview displays the preview of your 
terrain animation.
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16  

Rendering

What is Rendering?
Rendering is the process of capturing a view of 
your 3D scene and saving it as a 2D image. 
Once you’ve rendered the image, it can be 
used in other image editing or page-layout 
applications.

Bryce’s rendering process uses multiple passes 
to generate the final rendered image. On the 
first pass, the image is rendered in large pixel 
blocks, and then, in successive passes is 
refined to produce finer detail. The final pass 
of the rendering is an AntiAliasing pass. 



Using this method you can quickly see how the 
final image will look.Things like colors and 
light/object placement are very easy to see even 
during the first pass or two.

Rendering an image requires a great deal of 
computation. Scenes with multiple terrains (at 
512x512 each or more) can generate hundreds 
of thousands of height points, plus the bump 
elevations in the textures. This can yield 
millions of polygons to hit with the rays. 

Raytracing

Bryce renders images using a technique known 
as Raytracing. With raytracing, every pixel in an 
image has a certain color. In the case of a 
photograph, any given pixel’s color is the result 

of light coming from a scene, through a lens, 
and onto the film. Raytracing does the inverse. 
Virtual rays of light are shot from the virtual 
“film” through a mathematical “camera” and 
out into a 3D scene. As they pass through the 
scene, these rays collide with objects. The 
object they collides with is assigned a color. For 
example, if it hits a gray object, then that gray 
color ends up on that portion of the “film” or 
your final image.

Raytracing becomes much more complex when 
the beam strikes an object that has reflective, 
transparent, refractive, or other complex optical 
properties. These properties can cause the ray 
to be traced further into your scene, where it 
could end up bouncing from mirrors, 
dissipating through fog, or bending through a 
chunk of dense glass. Eventually, a final color is 
determined for each and every pixel, one by 
one. 

This technique can involve staggering amounts 
of computation which might make it 
impractical or impossible to use, but Bryce 
contains raytracing algorithms optimized for 
the task of creating natural and supernatural 
landscapes of all kinds.

The Rendering Procedure

Before you render your final image, you’ll need 
to complete the following steps:

• Create and transform the objects in the 
Working window to create a scene. Refer to 
“Creating Objects” on page 95 for more on 
creating objects. Refer to “Transforming 
Objects” on page 285 for more on 
transforming objects.

• Add a sky and lights to illuminate your 
scene. Refer to “Creating Skies” on 
page 123 for more on creating skies. Refer 
to “Setting Up Lights” on page 343 for 
more on creating lights.

Bryce renders images using multiple passes. On the first 
pass object placement and color are easily visible...

...on successive passes, the image becomes more refined.
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• Adjust the position of the camera to get the 
best view of your scene. Refer to 
“Positioning the View of Your Scene” on 
page 332 for more on positioning the 
camera.

• Set rendering options using the options 
menu and the Document Setup dialog. 
Refer to “Setting Render Options” on 
page 405 for more on setting render 
options.

• Choose a Render Mode. Refer to “Render 
Modes” on page 407 for more on choosing 
rendering options.

• Use the Render Controls to produce a 
rendered image. Refer to “Using the 
Render Controls” on page 410 for more on 
using the Render Controls.

Setting Up a Render
Bryce offers a number of options and controls 
that let you control rendering. 

As you’re working on creating the scene, you 
should use settings that produce fast renders, 
but when you’re ready to produce your final 
image, you’ll want to choose settings that 
produce the highest quality image.

Setting Render Options

These options let you control the quality and 
size of the rendered image.

Anti-Aliasing

Anti-Aliasing removes the jaggies on the edges 
of objects within the image. In Bryce, 
AntiAliasing is performed using a super-
sampling method. This means that for every 
pixel that’s raytraced, more than one ray is used 

to determine the pixel’s color. The increase in 
rays increases the quality of the raytraced 
object.

AntiAliasing can greatly improve the quality of 
your image, but it is time consuming. It can also 
eliminate some desired roughness from high 
frequency textures. AntiAliasing is performed 
on the last pass of the rendering process.

There are three Anti-Aliasing modes available 
in Bryce: AntiAliasing Off, Anti-Aliasing 
Normal Quality and Anti-Aliasing Fine Art.

Anti-Aliasing Off

In this mode there is no Anti-Aliasing 
performed on the image.

An image rendered without antialiasing....

...and the same image rendered using Anti-Aliasing.
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Anti-Aliasing [Normal Quality]

In this mode after the image is rendered, Bryce 
scans the entire bitmap to determine which 
areas require Anti-Aliasing. Only the areas of 
high concentration are antialiased. In this 
mode Anti-Aliasing is performed in only the 
last pass of the rendering process.

Anti-Aliasing Fine Art [Slow]

In this mode, Bryce uses 16 rays to trace every 
pixel in the image. This produces a higher 
quality image, but it slows down the entire 
rendering process from start to finish. 

You should probably only use this mode to 
render showcase type artwork—not normal 
working images.

To enable Anti-Aliasing:

• Click the triangle icon next to the Render 
Controls and choose either Normal or Fine 
Art from the menu.

An option is enabled when a checkmark 
appears next to its name. Normal 
antialiasing is enabled by default. 

To disable Anti-Aliasing:

• Click the triangle icon next to the Render 
Controls and choose Anti-Aliasing from 
the menu again.

The option is disabled when there is no 
checkmark next to its name. When Anti-
Aliasing is disabled, the final rendering 
pass is not performed.

Render Resolution

The render resolution options control the 
resolution of your final image. These options do 
no effect the resolution of your working 
document: only the final rendered image.

Resolutions are expressed in terms of aspect 
ratio and pixels.

To choose a render resolution:

1 Double-click the Render all control, or 
choose File menu> Document Setup.

2 Click one of the render resolutions at 
bottom of the dialog. The selected 
resolution appears highlighted.

3 Click the checkmark button.

Spatial Optimization

This option changes the number of rays used to 
raytrace your image depending on the contents 
of your scene. This option has three modes:

Spatial Optimization Off

This mode is best used for very simple scenes 
with less than 5 objects. When in this mode, 
Bryce predetermines the areas where your 
objects reside and shoots rays only through that 
area. 

Spatial Optimization Low

This is best mode to use for most scenes. In this 
mode Bryce determines where your objects 
reside and then go out from there to a larger 
area to examine the concentration of objects 
within a larger area, This eliminates the 
expenditure of unnecessary rays.
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Spatial Optimization High

This mode is more extreme version of Spatial 
Optimization Low. It is best used for complex 
scenes with localized concentrations of objects. 
If you have imported DXF objects in your 
scene, this mode will help speed up rendering 
considerably.

To use Spatial Optimization:

• Click the triangle icon next to the Render 
Controls and choose either Spatial 
Optimization Off, Spatial Optimization 
Low or Spatial Optimization High from the 
menu.

48 Bit Dithering

48 bit dithering helps you work around 
limitations of computer displays. It is a process 
that allows you to avoid color bands by 
smoothing. Evening skies or moon rings are 
good candidates for this option.

Gamma Correction

Gamma correction allows Bryce to compensate 
for some of the shortcomings of the computer 
displays. Your images will be brighter and 
contain more true to nature colors.

Render Reporting

This option, when selected, produces a 
summary report when your image is finished 
rendering. 

The report tells you how long the render took, 
including the antialiasing pass. It also provides 
statistics on how many rays were shot to create 
the image and breakdowns for the different 
types of rays, including a per-pixel breakdown. 

To produce a render report:

• Click the triangle icon next to the Render 
Controls and choose Render Reporting 
from the menu.

Document Resolutions

The menu commands at the end of the Render 
Options menu are quick ways to resize your 
document. Values shown are expressed in 
pixels. For customizing the size and aspect of 
your document and resulting render.

Render Modes

Bryce offers several rendering modes that let 
you produce images that can be used to create 
different effects. For example, the Mask Render 
mode lets you produce an image that can be 
used as an alpha channel in other graphics 
applications.

To choose a Render mode:

• Click the triangle icon next to the Render 
controls and choose a mode from the 
menu.

Perspective Render

This mode renders a fully raytraced color 
image, based on your current camera’s position 
and view.
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Mask Render

This mode renders any selected object or 
objects in as antialiased white shapes against a 
black background. You can use this image as a 
mask or alpha channel in other 2D image 
editing programs. 

360° Panorama

This mode produces an image that looks as if 
your camera had a 360° lens. The left and right 
edges of the resulting image join seamlessly. 

This feature is intended for use with the Bryce 
360° scrolling screensaver, or Apple’s 
QuickTime VR™ technology. Refer to 
“QuickTime VR” on page 429 for a description 
of Apple QuickTime VR.

Rendered 360° images will have little resem-
blance to the wireframe working window behind 
it; this makes flipping back and forth between 
wireframe and bitmap modes during composi-
tion fairly difficult. For this reason, we recom-
mend working in standard Perspective Render 
mode as you compose your image.

For a good 360° panoramic image, you need a 
natural distribution of objects on all sides of 
the camera. 

Before beginning a 360° panoramic render 
you should follow these steps:

1 Switch to the Top view using the View 
controls and position objects around the 
camera while in Perspective Render mode. 

2 Display the Document Setup dialog using 
File menu> Document Setup, and either 
select the Panorama preset aspect ratio, or 
type in the dimensions that you wish. 

3 Do a quick test render in Perspective 
Render mode to check composition.

The horizon should be level at the vertical 
midpoint of your window. If it is not, 
double-click the Trackball, enter “0” in the 
Rotate X field and exit the dialog.

4 Alter your camera position and Y/Z 
rotation

5 Switch to 360° Panorama render mode and 
render your image. 

Distance Render

This mode results in a grayscale image, with 
objects represented in shades of gray based 
upon their distance from the camera. Nearby 

An example of an image rendered as a mask using Mask 
Render mode.

An example of an image rendered using 360° Panorama 
Render mode.
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objects are black, distant objects are white, and 
objects in-between are progressive shades of 
gray. 

The purpose of this mode is to produce a 
distance mask that you can use to create several 
depth of field effects. Refer to “Adding Depth” 
on page 421 for more on using Distance Render 
images.

Altitude Render

This mode results in a grayscale image, with 
objects represented in shades of gray based 
upon their height.

You can use Altitude Render images in the 
same way you can Distance Render images to 
create special effects in other applications.

Preview Render Modes

Preview Render modes are accessed using the 
Render Controls and provide lower quality 
renders that you can use to preview you image. 

Fast Preview

When this mode is enabled, the rendering 
ignores areas of low frequency and raytraces 
areas to high frequency only. This results in 
accelerated renders that are great for 
previewing during a session. However, it also 

An example of an image rendered using Distance Render 
mode.

You can use the Distance render image to produce depth-
of-field effects using a 2D graphics application.

An example of an image rendered using Altitude Render 
mode.
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results in some patchiness in certain mid-
frequency areas, so it should not be used for 
final output.

To enable Fast Preview Mode:

1 Click the Fast Preview button in the 
Render Controls.

When the button appears depressed, the 
mode is enabled. When its unpressed, the 
mode is off.

Textures On/Off

When this mode is enabled, all textural 
parameters are disabled. This mode performs 
the following procedures to speed up a 
rendering: 

• Objects with properties like transparency, 
reflection, and bumpy textures are 
rendered in flat opaque shades

• Fog, Haze and Clouds are disabled

• Any item with a procedural texture is 
rendered with a color drawn from the 
ambient color channel in the Materials 
Composer

• Any item with a simple color texture is 
rendered in that color. 

The Textures On/Off mode works in any mode. 

To enable Textures On/Off Mode:

1 Click the Textures On/Off button in the 
Render Controls. 

When the button appears depressed, the 
mode is enabled. When its unpressed, the 
mode is off.

Rendering a Scene
Once you’ve selected any rendering options 
you want to use and chosen a rendering mode, 
you’re ready to start rendering. You render your 
entire image using the Render Controls, or, if 
you’ve rendered your image at least once, use 
the Plop Render controls to render areas of 
your image.

Using the Render Controls

The Render Controls let you start a rendering 
of your image. There are controls for starting a 
rendering, resuming a rendering, and starting 
two types of fast renders. 

To start a rendering of the entire scene:

1 Click the Render All button.

If you have already rendered any portion of 
your scene, it is cleared before the 
rendering begins. 

You can interrupt any rendering in 
progress by clicking the mouse. 

To resume a rendering:

• Click the Resume Render control or press 
Command/Ctrl-R.

Use the render controls to control the rendering of your 
scene.

Textures On/Off
Fast Preview Mode Resume Render

Clear and Rende r

Render All
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If you’re rendering only a selected area 
using the Plop Render controls, the 
rendering resumes only in the selection. 

To clear a selection and start a rendering:

• Click the Clear& Render control or press 
Command/Ctrl+Option/Alt-R.

This control clears the contents of any 
marqueed region, and starts a render of the 
selected region. Refer to plop-rendering 
below for more on rendering regions. 

Plop-Render Mode 

If you’ve rendered your image at least once, you 
can use the Plop-Render controls to render 
specific areas of your image. You can use this 
mode to quickly see the results of repositioning 
and transformation operations.

Plop-render mode is enabled by default, but 
can be turned off using the Display palette.

To enable/disable Plop-Render Mode:

• Click the Plop-Render On/Off toggle in 
the Display palette. 

When the small rectangle inside the icon 
(which represents an active Plop-Renderer) 
is red, Plop-Render mode is on. When it is 
white, the mode is off.

To render an area of your scene:

1 Make sure Plop-Render mode is enabled.

2 Switch to Bitmap display mode by clicking 
the display mode icon on the right side of 
the Bryce window.

3 Drag a marquee around an area of your 
image.

The selection is outlined in a thin white 
line and is separated from the rest of the 
image by a drop shadow.

4 Click the top button that appears beside 
the selection.

You can interrupt the rendering by clicking 
the mouse.

To resume a render:

• Click the second button that appears 
beside the selection.

To scale the selected area to fill the working 
window:

1 Make sure Plop-Render mode is enabled.

2 Switch to Bitmap display mode by clicking 
the display mode icon on the right side of 
the Bryce window.

Use Plop-Render mode to render specific areas of your 
image.
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3 Drag a marquee around an area of your 
image.

The selection is outlined in a thin white 
line and is separated from the rest of the 
image by a drop shadow.

4 Click the triangle icon below the render 
buttons and choose Zoom to Selection 
from the menu.

The command centers the selected portion 
of your wireframe scene and scales it up to 
fit your window. This is a pan & zoom 
operation, and therefore does not affect 
your camera position. 

RaySpray

You can also paint an area of your scene to 
render it. Use RaySpray to preview a specific 
area of your scene. If you render the entire 
scene after doing a RaySpray render of a 
specific section, that area will not be re-
rendered.

• RaySpray controls include 5 circular and 5 
square spray nozzles. While in RaySpray 
mode, use the 1 through 5 keys to select 
the circular spray sizes, and the 6 through 
0 keys to select the square nozzles.

To render using RaySpray:

1 Click the RaySpray tool on the Advanced 
Display palette. 

2 Use the tool to paint over the area of your 
scene that you want to render. 

3 Adjust the brush size to more easily paint a 
larger or smaller area.

You can also render a portion of your wireframe 
or rendered image to quickly see any 
modifications made to your scene. You can 
render from Wireframe mode or from Render 
mode. RaySpray from Wireframe mode is a 
preview render that is lost when you press the 
Escape key.

RaySpray from Render mode is a true render 
and can be continued by using Resume Render.

To render from Wireframe mode:

1 Click the RaySpray tool on the Display 
palette.

2 Click and move the cursor around the 
wireframe area you want to render.

3 Press the RaySpray tool again or press the 
Escape key to dismiss this render and 
return to Wireframe mode. This doesn’t 
affecting any previous render.

To render from Render Mode:

1 Press the Escape key to switch from 
Wireframe to Render mode.

2 Click the RaySpray tool on the Display 
palette.

3 Click and move the cursor around the area 
you want to render.

4 Click the RaySpray tool to put the tool 
away and remain in render mode. Press 
Escape again to return to Wireframe mode 
yet not lose your paint rendered area.

5 If you Resume Render your scene, Bryce 
continues to render the un-rendered 
portions of your scene.

The RatSray tool.
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Rendering a Movie
Rendering an animation is a lot like rendering a 
still image. Each frame in the animation is 
processed exactly like a still image. You can use 
the same rendering options you used to render 
still images for movies.

Besides the standard still image rendering 
options, there are several options you can set 
for movie files: you can choose a file type, a 
compression option, and a range of frames to 
render. You set movie rendering options using 
the Render Movie dialog.

The Render Movie dialog

This dialog contains all the options you’ll need 
to render your scene as a movie.

Name 

This control lets you set a name and location 
for the rendered movie. The default name and 
destination is the same as the scene file.

File Type 

This control lets you choose the type of movie 
file you want to produce. 

• On the Mac you can render a scene as a 
QuickTime (MOV) file, or as sequenced 
frame images. 

• On the PC you can render your scene as a 
MOV, AVI file, or as sequences frame files.

Compression

This menu lets you access all the available 
compressors. The items listed in this menu 
depends on the compressors you have on your 
system. Refer to the documentation that came 
with the compressor or your system software 
for instructions on using a specific compressor.

Render Range

These options let you choose a range of frames 
to render as the final movie. You can choose to 
render all the frames in your animation, a 
specific range of frames, or only the frames 
within the Working Area of your animations 
timeline. Refer to “Setting Up the Working 
Area” on page 360 for more on the Working 
Area.

To start the rendering of a movie:

1 Choose File> Render Movie. The Render 
Movie dialog appears.

2 Enter destination and name for the movie.

3 Choose a file format for the movie.

4 Choose a compression option from the 
menu.

5 Enable a render range option.

The Render Movie dialog lets you set options for rendering 
your scene as a movie file.
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If you choose Frames, enter a start and end 
frame number for the range.

6 Click the OK icon. Bryce starts rendering 
each frame in the movie.

Batch Rendering
Batch Rendering lets you render a number of 
files at the same time. This way, instead of 
rendering each scene as you create it, you can 
set up a number of scenes, save them and then 
render them all at once at a convenient time

To perform a batch render:

1 Save a number of scenes to a folder.

2 Drag all the files on the Bryce application.

Bryce opens the file, renders it, saves it and 
then opens and renders the next file. You 
can render any number of files this way.

Fast Render Strategies
There are several techniques you can use to 
speed up the rendering process. These 
techniques are most useful when rendering 
animations, where you may have a large 
number of images to render.

You can greatly increase the speed of a render 
just by using the Preview Render modes. Below 
is a table showing the time it takes to a render a 
scene, containing complex materials and lights, 
using normal rendering and then using the 
preview modes.

Patch Rendering

Using the Plop-Render mode, you can do a 
patch render of image. Patch rendering involves 
the rendering of background and flat elements 
using normal rendering and then using the 
Plop-Render controls to render areas that 
contain more complex elements.

There are two thing you should remember 
when using patch rendering:

• Make sure you use Clear & Render when 
you make changes with a partially rendered 
image. If you stop a rendering, make 
changes and then click Resume Render, 
you’ll end up with noise instead of an 
image. 

• If you changed elements that don’t affect a 
large area of your scene, you don’t have to 
render the entire scene again. For example, 
if you render a scene with a floating 
sphere, and then delete it, you don’t need 
to re-render the scene, only the area where 
the sphere was. 

To patch render your image:

1 Start a render as normal. 

2 Let the rendering proceed for two or three 
passes and then click the mouse.

Render Option % of standard 
time

Full Render 100%

Fast Render 41.7%

Textures Off 35.4%

Fast Render w/
Textures Off

8.3%

Fast, Textures Off, 
AntiAliasing Off

2.1%
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3 Switch to Bitmap display mode.

4 Drag a marquee around key portions of 
your scene and then render those areas 
using the Plop-Render controls. 

You can also speed up rendering using these 
techniques:

• Limit the number of lights.

• Keep objects near the background simple.

• Limit the number of volume materials you 
apply.

• Limit the number of transparent and 
reflective objects.

• Limit the number of frames per second to 
15, which is adequate for QuickTime 
movies. Video uses 30 fps and film 24 fps. 

• Divide animations into smaller files and 
eliminate objects that won’t be seen on-
screen.

• Turn off AntiAliasing when previewing 
animations.

Working with Rendered 
Images
Once your scene is rendered, it becomes a 2D 
image that you can save as different formats 
and edit in other 2D image applications. 

In Bryce, the 2D image is used as the Bitmap 
display mode. You can use the bitmap as guide 
for move objects, or as a preview of your final 
image.

Scaling Your Image

The Pan and Zoom tools work independently in 
wireframe display mode and in bitmap display 
mode. So if you use the Zoom tool to scale your 
wireframe scene down, your rendered image 
remains unchanged. 

You can then use the same tools and commands 
to scale your rendered image up or down, 
independent of the scale of your wireframe 
scene. If the image is scaled up sufficiently, you 
can use the Pan tool to pan through the 
enlarged image.

Refer to “Panning” on page 27 and “Zooming 
In and Out” on page 26 for more on the Pan 
and Zoom tools.
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17  

Using Bryce 
with Other 
Applications

Overview
This chapter describes how Bryce works with 
other applications, the file formats that Bryce 
supports for both import and export, how to 
use Bryce to create web-based applications, 
and how you can communicate with other 
Bryce users on the web. 

The effects you add to a rendered image are 
considered post production. Post production 
includes things like compositing, filtering and 
retouching the image in an image-editing 
application. Post-production can also include 
exporting to other applications. These aspects 
of post production are also covered in this 
chapter.

When you’re working with animations, post 
production can include all of the still image 
operations, or it can include more advanced 
editing, like combining clips and adding 
sound effects.



Working with Other 
Applications
Bryce allows you to import images and objects 
from other applications. You can also export 
images and objects to many of those same file 
formats. To learn more about the file formats 
listed here, refer to the MetaCreations web site 
for details.

Importing Images

Choose File menu > Open Image and select 
from one of the following image types:

• Bitmap (.bmp)

• Enhanced Metafile (.emf)

• Flashpix (.fpx)

• CompuServe GIF (.gif)

• JPEG (.ipg)

• Photoshop (.psd)

• Targa (.tga)

• TIFF (.tif)

• PICT (Mac only)

Exporting Images

You can export all of the formats listed above 
except for the Enhanced Metafile format.

Use one of the following commands to export 
files. If you need to conserve memory or plan to 
create a QTVR Panorama movie, you’ll want to 
use the Render to Disk option.

• Choose File menu > Save As, then select a 
file type from the list. Not all file types are 
supported.

• Choose File menu > Export Image, then 
select a file type from the list. Bryce uses 

plug-in filters for both the Export Image 
and Render to Disk options.

• Choose File menu > Render to Disk. This 
is the best choice if you have created a very 
large image, because it lets you set the dpi 
resolution and saves memory.

Export Image and Render to Disk allow you to 
export the following additional formats:

• HTML pages (.htm)

• QTVR Panorama Movies (.mov)

To learn more about QTVR, see “QuickTime 
VR Panorama Movies” on page 425.

Importing and Exporting 
Objects

Bryce can import objects created in the follow-
ing file formats. To learn more details about 
importing and exporting these file formats, 
check the MetaCreations web site.

• TrueSpace (.COB) Versions up to 4.0 are 
supported. Material properties are 
supported.

• VideoScape (.VSA) All versions are fully 
supported. 

• VRML1 (.WRL) Imports all properties 
relevant to Bryce, including camera, light, 
and surface and material textures.

• LightWave (.LWO or.LWS) Both objects 
and scenes are supported. The camera, 
lights, and all objects (with material 
information) are imported.

• Heightfield (.HF) Used to import 
descriptions of heightfields (terrains).

• USGS DEM (.DEM) All forms of DEM files 
are supported.
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• USGS SDTS (.DDF) This format is the new 
USGS format which will replace DEM 
files. 

• Portable Greyscale Map (.PGM) Used to 
import descriptions of heightfields 
(terrains).

Bryce can export your final rendered object to 
the file formats listed below. The information 
includes vertices, smoothed normals, UVs (tex-
ture coordinates), and the texture maps. 

Some of the formats have their own limitations. 
For example, DXF doesn’t support smooth nor-
mals or UVs. If the file format doesn’t support 
texture embedding, each texture map is written 
as a separate image at the same location speci-
fied for the mesh file. The names of the images 
will start with the name you specified for the 
mesh file and include the name of the material. 
If UV information can’t be written, two texture 
maps are exported: one for the top part, and 
one for the bottom.

When you export to a 2D format such as DEM 
or PGM, all the possible texture maps are gen-
erated.

• RayDream Studio (.RDS)

• USGS DEM (.DEM)

• AutoCAD (.DXF)

• Portable Greyscale Map (.PGM)

• VRML1 (.WRL)

• Heightfield (.HF)

• Infini-D 4.0 (.ID4)

• LightWave (.LWO or.LWS)

• Wavefront (.OBJ)

To export an image:

1 Render your scene.

2 Choose File menu> Export Image. The 
export dialog appears.

3 Choose a format for your image and click 
OK.

Post Production
Bryce is a 3D application that creates land-
scapes, it is not an image-editing program. As 
such, you won’t find any useful image-enhanc-
ing capabilities you’ll find in an image editor. 
For post production operations you’ll need to 
use applications like Painter®, Corel PHOTO-
PAINT® or Adobe Photoshop®. You can use 
these applications to adjust colors, contrast or 
brightness. You can even paint in elements that 
were not in the original scene.

Bryce’s rendered images can be saved in for-
mats compatible with almost any image-editing 
application.

Compositing

Compositing is the process of pasting one 
image into another. For example, if you create a 
farm scene in Bryce and then create a mask for 
that scene, you could paste it into a scanned 
image of a tornado. With a little creativity you 
can make the farm appear as though it were 
about to be eaten by the storm.
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The shape of the foreground image is taken 
from a black and white image that contains the 
shape of your scene. This image is called a 
mask. You can generate a mask in Bryce by 
using the Mask Render mode. 

To render a scene as a mask:

1 Click the triangle next to the Render 
controls and choose Mask Render from the 
menu.

2 Choose File menu> Export and choose 
either BMP/PICT.

Using Painter

The following compositing procedure uses 
Painter as a post production application. The 
steps for Adobe Photoshop would be almost 
the same.

To composite using Painter:

1 Render the scene normally using 
Perspective Render mode.

2 Save the image in a convenient location.

3 Render the scene again, this time using 
Mask Render mode.

4 Save the mask image to the same location.

5 Open the Perspective Render image in 
Painter (or another image-editing 
application).

6 Choose Select menu> Load Selection.

7 In the dialog, select the Mask Render 
image. Click OK.

Painter selects the objects in your scene.

8 Choose Edit menu> Copy.

9 Open the background image (the image 
you want to paste your Bryce scene into.)

10 Choose Edit menu> Paste.

The selection is pasted into the image as a 
floater.

11 Position the floater where you want it.

Using compositing, you can take the scene you created in 
Bryce....

...render it as a mask, using Mask Render mode...

...and then use the image as a selection mask in a 2D 
image-editor. Once selected, you can place your Bryce 
scene into a scanned image.
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Refer to the documentation that came with your 
image-editing application for more information 
on working with masks.

Adding Depth

Bryce’s Distance Render produces an image 
that can be used as a distance mask in most 
image-editing applications. The Distance Ren-
der image contains grayscale representations of 
all the images in your scene. Objects closer to 
the camera appear black, while those furthest 
away appear white. The objects in between are 
various shades of gray depending on their dis-
tance from the camera. 

This grayscale information can be used to cre-
ate photographic depth of field effects. For 
example, if you take an image that has a light-
house in the foreground and a fishing village in 
the background and render it using Distance 
render mode, you can take the image into 
Adobe Photoshop® and create an image where 
the lighthouse is in sharp focus while the vil-
lage is blurred.

To render a scene as a distance mask:

1 Click the triangle next to the Render 
controls and choose Distance Render from 
the menu.

2 Choose File menu> Export and choose 
PICT.

Using Photoshop

The following procedure uses Adobe Photo-
shop® as a post production application. The 
steps for Painter would be almost the same.

You can add depth to your scene by taking a scene you 
created in Bryce....

...rendering it as a distance mask, using Distance Render 
mode...

and using an image-editing application to place the 
distance mask into the original image’s alpha channel. 
Once the Distance render is in the alpha channel you can 
apply filters to create photographic depth of field.
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To create depth of field using Photoshop:

1 Render the scene normally using 
Perspective Render mode.

2 Save the image in a convenient location.

3 Render the scene again, this time using 
Mask Render mode.

4 Save the mask image to the same location.

5 Open the Perspective Render image and 
the Distance Render in Photoshop.

6 Place the Distance Render image into the 
alpha channel of the Perspective image.

7 Load the alpha channel as a selection.

8 Apply Gausian Blur.

Objects close to you will appear sharp 
while objects farther away will become 
progressively more out of focus.

• You can also invert the selection and 
apply Motion Blur to the image. In this 
case, objects in the foreground would 
be motion blurred, and the background 
would be sharp, as if you took a picture 
from a moving car.

• If you take the Distance Rendered 
alpha channel and, in Photoshop’s 
Curves dialog, remap the gray values, 
you could determine very specifically 
which objects in your scene are in focus 
and which are not. Just remap black 

input to lighter output, and the gray 
value of the desired focal object to 
black. 

Printing Images
You can print rendered images directly from 
Bryce. If you need color separations, you’ll have 
to use an image-editing or pre-press applica-
tion.

You can specify printing options such as print 
quality, number of copies, print grayscale, 
image type (vector wireframe or rendered 
image), printer driver or postscript, as well as 
printer options such as intensity, halftoning, 
bleed control, and color matching. You can also 
preview a job before sending it to the printer.

To print an image:

1 Choose File menu> Print, or press 
Command-P/Ctrl+P. The print dialog 
appears.

2 Choose the options you want to use.

3 You can select any of the four optional 
drivers or print either your rendered image 
or your wireframe document. 

You can change the focus of images by remapping the gray 
values in the alpha channel of your image.
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Using Bryce on the Web
If your computer is connected to the Internet, 
you can access the Internet while using 
Bryce 4. You can talk with other Bryce users, 
visit the MetaCreations site, or view the latest 
technical support information.

Internet Connection

You must have an Internet connection and a 
browser package to use the web-based features 
of Bryce. If you have an account with an ISP 
(Internet service provider), such as EarthLink, 
AOL, or other provider, you are ready to go. 
Otherwise, you will need an Internet account 
with a provider, as well as a modem hooked to a 
phone line. Once you have a connection, you 
can start using Bryce’s Internet-based features 
such as BryceTalk. 

If you have an e-mail only account with a pro-
vider such as Juno, you will not be able to use 
all of the web-based features of Bryce.

Using a Browser

The two most common browsers are Internet 
Explorer and Netscape Navigator. It is highly 
recommended that version 4.0 or greater be 
used for either browser, in order to take advan-
tage of interactive HTML features. 

PC Users

If your computer is running Windows 95, Win-
dows 98, or Windows NT 4.0 or later, you 
should already have Internet Explorer installed. 
If not, you’ll need to install it. Once you have 
an account with an ISP, you can start using the 
web-based features of Bryce.

Macintosh Users

Once you have an account with an Internet 
provider, and a browser software package 
installed, you can start using the Internet-based 
features of Bryce.

Accessing the Web

Bryce now has a “Links” menu that will launch 
your default browser and take you to the one of 
the Bryce-related web links in your links list. 
You can update this links list to add your own 
links and delete any default links you may not 
need to use.

In addition, you can also export both still files 
to the web using the Export Image or Render to 
Disk options on the File menu. You can export 
animations through the Render Animation fea-
ture.

To select a web link: 

1 Go to the Links Menu. 

2 Click a web link. 

3 Bryce communicates with your browser to 
access the desired link.

Modifying a Web Links Menu 

You can modify your web links menu using a 
text editor to edit the file called: Bryce 4 Links. 
It is a simple ASCII file that contains one line 
per link. Each line contains the name of the 
link, surrounded by quotes, a separating 
comma, and the url in quotes.
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To add or delete web links 

1 Open a text editor, such as WordPad, Note 
Pad, or SimpleText. 

2 Find the file entitled “Bryce 4 Links.” 

Note that each line of the file contains the 
name of the link, in quotes, followed by the 
url, also in quotes. 

3 Delete the entire line for any links you 
want to remove from your list. 

4 Enter the name of any new link, a comma, 
and any amount of space, followed by the 
url of the new link in quotes. 

5 If you want to add a dividing line to your 
menu, place an underline in quotes in both 
the link label and url. 

6 Save the file. 

Your menu should now reflect your new links.

Create HTML Images 

Use Bryce to get your Bryce images on the web! 
Bryce will export an HTML page with your ren-
dered image, along with any hotspot links asso-
ciated with the objects in your Bryce scene.

With the HTML dialog, you can set your web 
page title, the server directory for the page 
(either your local hard disk for editing or the 
web site it is going on directly), the name of the 
JPEG file for the image, your e-mail address, 
and the Background URL (leave this blank if 
you wish to not have one). 

Also, in the dialog are two slider settings you 
can adjust—one for the level of JPEG compres-
sion, and the other for how precise you wish 
the hotspot polygons to be. Bryce will then gen-
erate the HTML page and the JPEG image file 
for you, ready to be brought straight onto the 
web.

To create an HTML page: 

1 Edit the attributes of the objects in the 
scene you want to be hotspot links.

2 Select the Linking Tab, and enter the URL 
into the web Link box.

3 Select all the objects in the scene to be 
hotspot links.

4 Render the scene.

5 Select either File menu->Export Image or 
>Render To Disk

6 Select HTML files (.htm) as the type of file 
to export/render to disk and name the file.

7 Fill in the settings in the HTML dialog.

Your image is exported in JPEG format.

Realmovie Animations 

The RealMovie format is a new way of viewing 
streamable movies through the internet. Bryce 
RealMovie (.RM) movies are streamable using 
any possible throughput, so they are ready to go 
with RealMovie servers. 

To create a RealMovie animation:

1 Create an animation in Bryce.

2 Select File menu > Render Animation.

3 Select RealMovie as the Output Module 
Format.

4 Set the filename to save as and go!

QuickTime Movies 

Bryce creates pre-flattened QuickTime moves 
that are ready to go wherever you wish to take 
them, be it the internet or your friend's com-
puter. 
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To create a QuickTime movie:

1 Create an animation in Bryce.

2 Select File menu > Render Animation.

3 Select QuickTime Movie.

4 Click Edit to adjust the details of the 
animation.

5 Set the filename to Save As and go!

QuickTime VR Panorama Movies

Bryce can now generate QuickTime VR Pan-
orama Movies directly. Panorama movies are 
movies from which you can interactively swing 
your viewing angle around 360 degrees. 

This type of movie is created from a single 360 
degree Panorama image. You can generate a 
QTVR movie from Export Image or Render To 
Disk. For it to look right, you must follow all 
the setup steps as described in “QuickTime 
VR” on page 429. Briefly, you must:

• Change the aspect ratio of the document to 
13:4 by clicking the “QTVR Panorama” 
option in the Document Setup dialog.

• Select 360 Panorama in the options given 
by clicking on the triangle next to the 
render controls. 

When you use Render To Disk, you can option-
ally select 90deg counterclockwise rotation for 
QTVR, to save memory. 

Using BryceTalk
Using BryceTalk, you can do the following:

• Set up your BryceTalk account

• Start or end a BryceTalk session

• Change rooms, start a new room, or close a 
room

• Participate in discussions in multiple 
rooms

Communicating with Bryce 
Users

While using Bryce, you can communicate with 
other Bryce users. (Using BryceTalk you can 
exchange messages with other people in real 
time. This means that you could be typing mes-
sages from Chicago to someone who is still 
awake in Paris.) However, you must be a regis-
tered Bryce user in order to send and receive 
messages. If you haven’t registered already, this 
is an excellent time to do so.

You can ask questions, share ideas and tips 
about using Bryce, and meet other Bryce users. 
Who knows, you may find your long lost Uncle 
John communicating here. 
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Setting up BryceTalk

The first time you use BryceTalk, you need to 
register and set up your BryceTalk account. 
After that, you can sign on, using your nick-
name and password, then start communicating 
with a focused community of other Bryce 4 
users.

To set up BryceTalk:

1 From anywhere within Bryce, click the Talk 
text button to start the BryceTalk 
application. If this is the first time using 
BryceTalk, select the New Account button.

2 Follow the instructions on the web page to 
set up your BryceTalk account.

3 Provide your name and serial number 
when requested.

4 Select a nickname. This is the name that 
other users will see when you are signed 
on.

5 Select a password that you will remember.

6 Once you have finished setting up 
BryceTalk, you can go back to the sign on 
screen and open BryceTalk for the first 
time.

To start a BryceTalk session:

1 From anywhere within Bryce, click the Talk 
text button.

2 Type your nickname and password when 
prompted. You are placed in the BryceTalk 
Lobby. A welcome message tells you which 

A BryceTalk session. 

The login screen. 

Switch to other rooms.

Search for other 
users by name
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other Bryce users are currently 
communicating in that room.

3 You can communicate in the BryceTalk 
Lobby, go to other rooms, or start a new 
room.

To restore a BryceTalk session:

1 Click anywhere in the Bryce window to 
return to Bryce, or press Shift+T. 

2 Click Talk again to restore the BryceTalk 
session.

To end a BryceTalk session:

1 If desired, tell the other users good-bye.

2 Press Cmd+Q (Macintosh) or Ctrl+Q or 
Alt+F4 (Windows).

Communicating with Other 
Bryce Users

You can join any conversation in any room. 
You’ll notice that a conversation looks like a 
movie script, so it is easy to tell who is talking. 
Use the scroll bar to review any part of the con-
versation once it gets too long to fit in the win-
dow. Other Bryce users may be communicating 
in the BryceTalk Lobby, or they may have 
started a separate room to discuss a specific 
subject. 

At any time, you can find out who is logged on, 
search for a friend’s nickname, join discussions 
in other rooms, or start your own discussion 
room. Unlike being at a real party, you can even 
participate in discussions in several rooms at 
once!

To communicate with other users:

1 Type your message in the lower section of 
the BryceTalk window. You can edit your 
message until you are satisfied with the 
results.

2 Press Enter to send your message once you 
have finished composing. 

To find out who is logged on:

• Click the People icon, and a list of the 
users in that room is displayed.

To search for a nickname:

1 Click the People icon to display the list of 
nicknames.

2 Click the Search button and type the 
nickname you are seeking.

To change rooms, you can:

• Click the room buttons to go to different 
rooms.

• In the room list, double-click the room to 
which you want to go.

• Press Ctrl+Tab to cycle through the rooms 
you are in.
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A highlighted room button indicates that activ-
ity has happened in a particular room since you 
last looked at it. When you see a highlighted 
room button, you can go back to that room to 
view the discussion. As you switch rooms, you 
participate in each room. You can also close any 
room (on your computer) by clicking the close 
window control. 

To start a new room:

1 Click the New Room button in the room 
list to create a new room.

2 Type a meaningful title for your room such 
as “creating natural sunsets.” You can use 
up to 32 characters including spaces and 
punctuation in your room title.

3 Press Return or 

4 Enter, and you are placed in your new 
room.

Other users will see a new room added to their 
list and can choose to join it.

Tips: If you are new to using the Internet, these 
tips will help you get started:

• Don’t type in all capital letters. Use upper 
and lower case. Typing in all caps is 
considered yelling.

• If you are uncertain how to proceed, try 
lurking. Listen without posting a question 
or responding. Sometimes someone else 
will ask your question. This is a good way 
to get used to the BryceTalk room and to 
learn how to interact with others on the 
Internet.

• Have fun! This is a communication forum 
for you, a Bryce user. You’ll meet other fun 
people like yourself.

• Be respectful. Avoid offensive language or 
subject matter. This is a public forum and 
users of any age may be listening.

• Be discreet. Don’t reveal intimate 
information about yourself over the 
Internet. As you would in any public place, 
be reserved with strangers.
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A  

QuickTime VR

QuickTime VR allows you to take a 360° pan-
oramic image, and make it into a VR Movie; 
this unique movie will translate the 2D pan-
oramic representation of your 3D world, and 
allow point and click navigation through the 
world. You can look up, down and around your 
rendered scene as though you were a camera 
on a tripod.

Further, QuickTime VR lets you create 
“Nodes,” or hotspots in the movie where you 
can click and go to another linked movie. This 
means you can look around a landscape, and 
seeing an interesting rock formation in the 
distance, click on it to view the entire land-
scape from that new vantage point.

These nodes can also contain “Object Movies;” 
another specialized technology from Apple 
that allows you to click and drag to, in effect, 
“pick up” any object in the VR movie and 
examine it from all sides, as if you literally 
picked it up and turned it around and around 
in your hands.



Creating QuickTime VR 
Panoramas
The process of creating a panorama involves 
completing a few easy steps.

To create QuickTime VR panoramas:

1 Choose Default in the Document Setup 
dialog. 

2 Click on the uppermost Views Memory Dot 
in the control palette, to make sure your 
camera is level.

3 Set up your scene.

The important thing to remember is that 
for a successful 360° scene, you need 
interesting objects all around your camera. 
The best way to work on this is to go to the 
Top View, and position objects all the way 
around the camera. 

4 Keep the Nano-Preview in Camera View 
mode to check your view while you are 
working in Top View. 

5 Drag the tip of the camera around in the 
Working Window to check the scene the 
view of your scene from all directions.

6 Switch back to Camera View and do a 
quick test render, once you have a good 
distribution of objects in a visually 
interesting scene.

7 After the render, make any required 
position changes.

8 Choose File> Document Setup and select 
QTVR Panorama. 

This aspect ratio is optimized for use with 
Apple's Make QTVR Panorama tool, 
though many aspects will work. 

The preferred aspect is 13:4. Width must 
be divisible by 96, and height must be 

divisible by 4. The QTVR Panorama option 
makes sure your image meets these criteria.

9 Click the triangle icon next to the Render 
controls and choose Select 360° Panorama 
from the menu.

10 Click the Render button to do a quick test 
render. 

The panoramic render mode necessarily 
introduces some distortion into your 
image, and this may change the way you 
want your objects to appear. 

11 Make any position changes you like.

When you do a panoramic render, your wire-
frame scene will bear little resemblance to the 
rendered scene. This is why you should work on 
your scene in standard Default mode, and 
switching to Panoramic rendering after every-
thing is set up.

12 Choose File menu >Render To Disk. The 
Render to Disk dialog appears.

13 Leave the default settings. 

The Output Size in Pixels was set by the 
QTVR Panorama option in the Document 
Setup dialog. 

The Print Resolution defaults to 72dpi, 
which is the only acceptable setting for the 
screen-resolution VR movies; and the 
Output Size in Inches is extra information. 
You can, however, use these features to 
your benefit if you need to print out a 2D 
version of your VR scene.

14 Click the OK icon.

15 In the Save dialog, choose QuickTime VR, 
then click the Save button.

16 Specify the location and file name for your 
rendered QuickTime VR panorama.
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To export a QuickTime VR Panorama:

1 Follow the steps above through step 11.

2 Click the Render button if you made any 
changes after your test render.

3 When the rendering is done, choose File 
menu > Export Image and choose 
QuickTime VR from the list. 

4 Specify a location for the saved panorama, 
then click Save.

Further VR Exploration

This is a quick way to get started with simple, 
single-node QTVR movie-making. To create 
movies with other embedded nodes, or to get 
deeper into the world of QuickTime VR, con-
tact Apple Computer via the World Wide Web 
or any normal channel, and ask them for fur-
ther information.
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B  
Glossary

2D projection Your 3D scene must be inter-
preted as a 2D projection; that’s how it is 
translated to your 2D screen! Pretend your 3D 
scene is a drawing on a (2D) piece of paper, 
which is in front of your camera lens; you have 
control over the right/left up/down position of 
the paper (Pan controls), and over the scale of 
the drawing (Zoom/Scale tools). 2D Projection 
values are an important factor in defining a 
View for your scene.

3D transformation This is a term that refers to 
any operation relating to the size, rotation, and 
position of any object. There are in fact other 
types of 3D transformations that are possible 
in 3D space, such as deformations, sweeps, 
and lathing; but Bryce is not a modeler, and 
supports only the basic three: size, rotation, 
and position.

3DMF Apple’s 3D MetaFile format for 
exchanging 3D geometry between applica-
tions.

absolute coordinates Values which express an 
absolute location, rotation, or size, whether 
they are location coordinates, degrees of rota-
tion, or units of measure.



additive mode A color blending algorithm 
which adds the brightness value of colors from 
one item to the brightness values of another.

algorithm A finite step-by-step problem-solv-
ing procedure.

aliasing A visual artifact caused by low resolu-
tion sampling that can cause hard edges or 
areas of high frequency in an image to look 
jagged (often referred to as “jaggies”). See “anti-
aliasing.” 

alpha channel A separate grayscale channel 
accompanying any PICT/BMP file that can 
determine which areas of the PICT/BMP will be 
visible in the final image and which will not. 
Typically, white areas in the alpha channel 
describe the areas in the corresponding image 
that will be visible, while black areas in the 
alpha channel describe the areas in the corre-
sponding image that will not be visible. Also 
referred to as a mask. In the absence of an 
alpha channel, Bryce can use the luminance 
values of any 2D PICT or 3D solid texture as 
alpha information.

altitude A measurement of height. In Bryce, 
many textures will change their behavior based 
on altitude. 

ambient Light that has no point of origin or 
specific direction, and is presumed to strike 
every point on every object with equal intensity. 
Since it is not affected by other environmental 
light, it tends to affect objects in shadow, and 
can make objects visible even with no specific 
light source.

amplitude In Bryce, this refers to the intensity 
of the cloud definition. Increasing the ampli-
tude will make cloud contours harder, while 
decreasing it will result in softer-edged, more 
diffuse cloud formations.

antialiasing The process of eliminating alias-
ing by higher resolution sampling, so that hard 
but jagged edges appear smooth and clean. 

aspect ratio The relationship between the 
width and height of your document, expressed 
in pixels as a width to height ratio.

auto-update A feature in Bryce’s Sky & Fog 
palette and Nano-preview which will automati-
cally update your changes into your rendered 
scene or Nano-preview, respectively.

banking Camera rotation around its Z axis; 
kind of a left/right tilt. Also known as roll, it 
creates the illusion that your horizon is tilted.

batch rendering A process that will allow you 
to automate the rendering of multiple scenes. 
Just drag and drop a group of scene files on the 
Bryce application icon, and Bryce will do the 
rest.

bitmap Literally, a “map of bits.” Your screen 
is comprised of pixels, and each one of those 
pixels expresses a level of color, whether it is 
one bit (black and white) or 24-bit (millions of 
colors). Your image, when rendered, can be 
thought of as a pixel-by-pixel map of color, 
hence the term “Bitmap”.

boolean rendering A rendering process 
wherein either the space taken up by “negative” 
objects is subtracted from “positive” objects, 
yielding an object with portions removed; or 
two or more objects are combined to form a 
composite object combining the mass and 
dimensions of all contributing objects.

boolean A fancy word that is used to describe 
a system where there are two possible states: 
On/Off, Yes/No, 0/1, True/False, and so on. With 
respect to Bryce rendering, a Boolean attribute 
such as Negative or Intersect will determine 
whether a particular part of a group of objects 
will be Rendered/Not Rendered.
434 Glossary 



bryce units of measure An arbitrary system of 
measurement for 3D objects in Bryce 3D. Most 
Bryce objects when they are created are a 
default size of 2048x2048x2048 Bryce units.

bump mapping A process that interprets 
changes in an object’s surface luminance or 
color values and, without actually affecting the 
object’s geometry, expresses them as perturba-
tions on the object’s surface.

camera space A method for representing 
objects in 3D space. It uses a set of Cartesian 
coordinates which are relative to your camera.

camera A metaphorical “tool” for viewing 
areas in a scene. The metaphor refers to the 
conical projection of the scene onto a 2 dimen-
sional plane along a specific direction.

center scaling The ability to perform resizing 
or rotating operations on an object based on 
the object’s center, rather than an alternate 
point, such as its base.

CMYK color A well known subtractive color 
standard widely used in the print industry. 
CMY color models blend Cyan, Magenta, and 
Yellow to approximate colors for print; almost 
always used with a fourth ink, black (K), to com-
pensate for ink impurities.

conversion The process of changing an object 
of one type into an object of another type. Use 
the little arrow in the Edit palette...

deformation A special form of 3D transforma-
tion which will deform an object’s geometry, 
creating bulges, twists, bends, and more. Bryce 
3D does not support this kind of transforma-
tion; but you can certainly import deformed 
objects from other modeling applications via 
Bryce’s Import DXF and 3DMF feature.

depth cueing The effect we use to create the 
appearance that wireframes far away are dim-

mer than wireframes closer to the camera. This 
effect is adjustable.

derivative objects Most primitives available in 
the Create palette also have a few derivative 
objects as well. For instance, the Sphere is 
accompanied by an Ellipsoid and a Squashed 
Sphere; both are considered to be Spheres by 
Bryce, but they have had some post-processing 
applied to change their sizes. 

diffuse Light that is evenly reflected from an 
object’s surface, visible regardless of the angle 
from which it is viewed. Diffuse is associated 
with matte objects.

document resolution The actual size of your 
working document area, expressed in pixels. 
When your Render Resolution is set to 1:1, the 
Render resolution is the same.

DXF Originally developed for use with 
AutoCad™, this is the most common 3D file 
exchange format.

edit Any action performed on an object after 
its initial creation. Includes moving, resizing, 
rotating, copying, assigning textures, pasting, 
and more.

family A kind of logical association, assigning 
a Family attribute to a set of objects allows you 
to select and display sets of objects based on an 
assignable wireframe color and associated fam-
ily name. This way, objects which share some 
characteristic such as distance, structure, mate-
rial, or other, can be easily seen, selected, 
soloed, and so on.

field of view Field of View values describe the 
range, from 1 to 180°, which your camera is 
allowed to take in.

frequency A measurement of the number of 
times certain textural characteristics repeat 
themselves within a fixed area.
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gel A texture or picture which is applied to a 
light and treated as a transparency or slide, 
enabling the light to project colors, textures, or 
images onto objects in your scene.

grayscale-to-height mapping A process that 
interprets a grayscale range from black to white 
and expresses that range as height, from low to 
high.

group Grouping, a kind of spatial association, 
allows a set of objects to be treated as one. To 
achieve Boolean rendering effects, objects must 
be grouped.

HLS color An alternative color model: Hue, 
Lightness, and Saturation.

HSV color An alternative color model: Hue, 
Saturation, and Value.

illumination In Bryce 3D, any property or 
characteristic related to how an object responds 
to light. This includes Ambient, Color, Diffuse, 
Reflectivity, Refraction, Specular, and Transmi-
tivity.

image resolution Since Bryce renders bitmaps 
at 72dpi, the only image resolution you need to 
determine is the height to width ratio of your 
image.

infinite plane A two dimensional surface that 
extends infinitely along the X and Z axes. Bryce 
3D’s Ground, Cloud, and Water Planes are all 
infinite planes, though they exhibit different 
textural properties and are placed in the scene 
at different altitudes.

landing Dropping an object straight down 
onto the object directly beneath it. Usually 
used to “land” an object on the ground.

link to view A Bryce feature which locks the 
sun’s position to the camera position. This way 
you can use the sun control to set your sun 

position, and you will not lose that position if 
you move the camera.

location An object’s position in 3D space. 
Synonymous with position and offset.

mapping The process of interpreting data 
input of one kind and expressing it as another. 
See Bump Mapping, Grayscale-To-Height Map-
ping, Pict Mapping, and Texture Mapping.

marquee selection Marquee is a noun which 
refers to a tool, in many applications, which will 
create a selection area; it can also be used to 
refer to the selection itself. Bryce has no mar-
quee tool per se, but you can click and drag in 
the wireframe window to marquee a selection 
(here the term is used as a verb), and you can 
click and drag in the rendered image to mar-
quee a selection for discrete rendering.

material In Bryce 3D, the sum of up to four 
textural elements, either 3D procedural or 2D 
picture-based, used to drive various effect 
channels, plus post processing, used as a sur-
face property for Bryce objects.

materials channel The rows in the Materials 
Grid, grouped as Light, Effect, and Color; can 
be driven independently or by Texture Compo-
nents.

materials grid The gameboard-like area in the 
Materials Lab where Texture Components drive 
parameters in the various Channels in the Grid 
to make a Material.

matrix The term is used only in the Bryce Edit 
menu, for the Copy/Paste Matrix commands. 
When you use these commands, you are copy-
ing and pasting an object’s position, rotation, 
and size; you are not copying size, rotation, or 
position alone, but the matrix of all coordi-
nates, hence the name.
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memory dots A feature created by MetaCre-
ations, and used in many MetaCreations prod-
ucts, it is available in the Control palette for use 
with Views, and in the Sky & Fog palette. This 
feature allows you to simply click on a Memory 
Dot to save the state of the parameters to which 
it pertains.

mesh Sometimes known as polyhedron. Used 
in reference to imported geometry as well as 
Bryce’s internally created Stone objects. Simi-
lar to Polygon, but polygonal faces have been 
diagonally split, or triangulated. 

nano-editor The Nano Editor is a small ver-
sion of your wireframe window, which you can 
use to edit your scene quickly.

nano-preview A small preview of an object or 
scene. The Nano-preview window is at the top 
of the Control Palette.

object space A method for representing 
objects in 3D space. It uses a set of Cartesian 
coordinates which are relative to a given object.

object type Though Bryce creates and imports 
many kinds of objects, for the purpose of selec-
tions and conversions it must sort these objects 
into types. These types can be clearly seen in 
the Conversion option and in the Edit palette. 
Cubes and their derivatives are all of the Cube 
type; Cloud, Water, and Ground planes are all 
of the Infinite Plane type; Pict objects and 2D 
Faces are all of the 2D Face type; all imported 
objects are of the mesh type.

offset An object’s position in 3D space. Syn-
onymous with position and location.

opacity The degree to which light cannot pass 
through an object. In Bryce, the term primarily 
refers to the opaque portions of alpha-chan-
nels.

orientation An object’s orientation in 3D 
space, expressed in degrees; synonymous with 
rotation.

orthogonal A special projection of your scene 
which has no perspective distortion. Kind of a 
perspective-free drafting board view, used for 
precise alignments. All Views with the excep-
tion of the Camera View are Orthogonal. The 
term can be used interchangably with the term 
orthographic.

output resolution Available in the Export Ren-
der dialog, you can set the print resolution of 
the resulting rendered image expressed in dots 
per inch. 

parallel light A light which cast rays that are 
perfectly parallel to one another.

patch rendering A technique you can use in 
Bryce 3D: select a specific area, or patch, of 
your image for further rendering. Useful to 
examine areas for detail before doing a final 
render, or for re-rendering specific areas after 
making a change, thereby avoiding having to re-
render your entire image.

pict mapping A process that interprets a 2-
dimensional Pict and expresses it as the surface 
of a 3-dimensional object, according to a speci-
fied algorithm.

pitch Camera rotation around its X axis; kind 
of a tilt forward or back.

plop-render Just a cute name for our way of 
representing a marqueed selection of your ren-
dered image. Selections appear to “plop” for-
ward, with attendant drop shadows and 
rendering controls. This feature can be 
enabled, disabled, or hidden, as you wish.

polygon All 3D objects in Bryce 3D are built 
from multiple-sided (in Bryce, we use 4 sides) 
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geometric surfaces, and are therefore inher-
ently polygonal in nature.

primary rays The quantity of virtual rays of 
light that are initially "shot" into the Bryce 
scene. 

primitive A basic geometric form, such as a 
cube or sphere, used as a basis for constructing 
compound 3D objects such as buildings, rocket 
ships, or snowmen.

primitives Like primary colors, Primitives are 
Bryce’s primary objects. Spheres, cubes, cylin-
ders, pyramids, cones, disks, squares, and 
toruses are all primitives. 

procedural objects Procedural objects are 
object that require special constructions or 
“procedures” to create them. Procedures can 
include operations such as preassignment of 
materials, randomization of internal parameters 
or assignment of light properties. For example, 
terrains.

radial light A light which casts rays equally in 
all directions.

ray hits The total number of times all rays 
strike objects in your scene. Note: The total of 
Ray Hits and Misses is not equal to the total of 
Primary and Shadow rays because secondary 
rays are not quantified in the Render Report.

ray misses. The total number of rays that are 
fired, but strike no objects in your scene. Note: 
The total of Ray Hits and Misses is not equal to 
the total of Primary and Shadow rays because 
secondary rays are not quantified in the Render 
Report.

raytracing An image synthesis technique by 
which a virtual beam of light is projected from a 
virtual camera into a 3D scene in order to eval-
uate shading and visibility. The virtual beam 
may be absorbed, reflected, or otherwise 

affected to some degree by every object it 
strikes. For instance, if it hits your sky, then a 
blue sky color ends up on that portion of your 
virtual “film”, your image. In this way, a final 
color is determined for each pixel in your 
image.

reflectivity The degree to which an object 
bounces light back from its surfaces.

refraction As a light wave passes from air 
through another medium such as water or thick 
glass, it seems to bend or turn to a certain 
degree. This phenomenon is known as refrac-
tion, and the degree to which light bends or 
turns in these situations is controlled by the 
Refraction channel in the Materials Lab.

relative coordinates Values which express 
location, orientation, or size relative to the cur-
rent location, orientation or size. 

render The complex process of building a 2-
dimensional bitmapped image from all the 
information contained in your 3-dimensional 
wireframe scene.

render resolution The size of your rendered 
image, expressed in pixels, or as a multiple of 
your Document Resolution. The implication 
here is that your rendered image can be larger 
or smaller than your Document Resolution.

replicate While Duplicate will create a copy of 
your selected object, Replicate will create a 
copy of the object and the last 3D transforma-
tions applied. If you create an object, move it 
up a bit and rotate it a bit, selecting Replicate 
will create a copy, move it and rotate it for you; 
Multi-replicate will do the same with multiple 
copies in one step. 

roll Camera rotation around its Z axis; kind of 
a left/right tilt. Also known as banking, it cre-
ates the illusion that your horizon is tilted.
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rotation An object’s rotation in 3D space, 
expressed in degrees; synonymous with orien-
tation.

scale Values that express the space an object 
occupies; synonymous with Size, though Size 
implies an absolute space.

scene a) The complete content of your Bryce 
world; b) The two-dimensional screen projec-
tion of your 3D scene; c) The file that Bryce 
saves, containing all information regarding your 
landscape.

secondary rays When a primary virtual light 
ray strikes an object, if that object is reflective 
or transparent, another secondary ray is fired 
from that location (either bounced, if reflective, 
or bent, if transparent/refracted) to continue 
through the scene. This process is repeated up 
to six times, to find a home for the ray, and 
therefore a final color for a pixel in your scene. 
Secondary rays are not quantified in the Ren-
der Report.

shadow rays Once a primary or secondary vir-
tual light ray has found a final resting place, it 
must determine whether or not to create a 
shadow behind the object. To do so, another ray 
is fired from that location, and this is a shadow 
ray.

size Values that express the space an object 
occupies; synonymous with Scale, though Scale 
implies a relative size.

sky dome A secondary environmental ambient 
light, used to create a color cast in a scene 
where there is little visible global light.

smoothing Imported objects consist of polyhe-
dral faces, which, when rendered, appear quite 
chunky. This is not, in most cases, desirable. 
Use the smoothing command to eliminate this 
chunkiness. You can set a threshold angle for 
smoothing as well. 

snap to A special form of 3D Transformation 
changes the selected object’s position based on 
the Snap To. command you select. These com-
mands are located in the Edit palette, in the 
Alignment Options menu. 

solid texture A three-dimensional mathemati-
cal description of an object’s textural character-
istics. Often referred to as procedural texture.

specular The “highlight” of any object with a 
shiny surface; light that reflects non-uniformly 
in specific directions depending on the surface 
roughness. “Specular highlight” refers to the 
point where specular reflection is most pro-
nounced.

spotlight A light which casts rays in a cone 
shaped spread; often used top create the classic 
“Hollywood spotlight” effect.

square spotlight Similar to the SpotLight, but 
casts rays in a pyramid-shaped spread; think of 
it as a slide projector.

symmetrical lattice A procedural Bryce Terrain 
object which has another Terrain mirrored at 
the base.

terrain An object used in Bryce as the basis 
for mountains, islands, plateaus, and other 
landscape objects.

terrain canvas The area in the Terrain Editor 
onto which you paint and apply effects. Terrain 
data can be rendered at many levels of detail, 
from 16x16 to 1024x1024. This resolution does 
not refer to the wireframe that is used to repre-
sent the terrain, but instead to the grayscale 
data used to determine the internal level of 
detail used to generate the terrain. Terrains 
with lower resolutions will appear chunky, and 
will render very quickly; use these for terrains 
that are far in the background or where detail is 
not so important. Terrains with higher resolu-
tions will show increasing levels of detail, and 
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will take much longer to render; use these for 
foreground terrains, or in other cases where 
detail is important.

terrain resolution Terrain geometry can be 
rendered at several levels of detail. At very low 
settings, you may see geometric “facets” in your 
terrains, even with “smooth surfaces” selected. 
In this case, increase your terrain resolution. 
Low resolution rendering is often best for items 
in the far background, where detail is not so 
important.

texture component a part of an object’s mate-
rial. Texture Components, which can either be a 
2D Picture or 3D Texture.

texture mapping A process of applying detail 
to a surface without actually affecting the 
object’s geometry. Values from the texture can 
determine or affect any surface characteristic, 
including color, reflectivity, transparency, or 
bumpiness.

torus A Bryce primitive that looks like a 
donut.

transparency The measure of an object’s abil-
ity to transmit light through its surfaces. Also 
referred to as transmitivity.

triangulation The process of splitting up geo-
metric faces into triangles for greater flexibility.

unity The state a Bryce object is in when it is 
first created, or just after the Unity button has 
been pressed; positioned within a “cube” of 
fixed size in an invisible 3D grid, with no rota-
tion applied.

view The sum of camera position in 3D space, 
plus 2D Projection pan and scale values.

wireframe A mesh representation of a 3D 
object.

wireframe resolution Your onscreen wire-
frame objects can be displayed at various levels 
of detail; this display resolution can be set dis-
creetly for static, selected, and moving wire-
frames. This resolution has no relevance to 
document, render, or output resolution.

world space A method for representing 
objects in 3D space. It uses a fixed, or absolute, 
set of arbitrarily determined Cartesian coordi-
nates.

yaw Camera rotation around its Y axis; kind of 
turning to look right or left.
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MetaCreations License Agreement
By using this software you are agreeing and indicating your 
acceptance of these terms and conditions. If you do not agree 
with them you should return the software to the dealer from 
whom you purchased the product and your money will be 
refunded. If the dealer from whom you purchased this 
package fails to refund your money, contact MetaCreations 
Corp. immediately at the address below.  MetaCreations Corp. 
(hereinafter referred to as Company), a Delaware-based 
Corporation, provides the computer software (hereinafter 
referred to as Program) contained on the medium in this 
package and licenses its use. You assume full responsibility for 
the selection of the Program to achieve your intended results 
and for the installation, use and results obtained from the 
Program.

License

A. In consideration of the payment of a license fee, you are 
granted a personal, non-transferable and non-exclusive license 
to use the Program under the terms stated in this Agreement. 
You own the diskette or other physical media on which the 
Program is provided under the terms of this Agreement, but 
all title and ownership of the Program and enclosed related 
documentation (hereinafter referred to as Documentation), 
and all other rights not expressly granted to you under this 
Agreement, remain with the Company.

B. The Program may be used by you only on a single computer. 
Therefore, you must treat this software just like a book. With 
the exception of Item D below, "just like a book" means that 
this software may be used by any number of people and may 
be freely moved from one computer location to another, so 
long as there is no possibility of it being used at one location 
while the same copy is at the same time being used at another 
location. Just as the same copy of a book cannot be read by 
two different people in two different places at the same time, 
neither can the same copy of software be used by two different 
people in two different places at the same time. Site licenses 
for multiple single users are available. Contact MetaCreations 
Corp. for details.  

C. You and your employees and agents are required to protect 
the confidentiality of the Program. You may not distribute or 
otherwise make the Program or Documentation available to 
any third party.

D. You may not copy or reproduce the Program or 
Documentation for any purpose except to make one (1) 
archival copy of the Program, in machine readable or printed 
form, for backup purposes only in support of your use of the 
Program on a single computer. You must reproduce and 
include the Company copyright notice on the backup copy of 
the Program.

E. Any portion of the Program merged into or used in 
conjunction with another program will continue to be the 
property of the Company and subject to the terms and 
conditions of this Agreement. You must reproduce and include 
Company's copyright notice on any portion merged in or used 
in conjunction with another program.

F. You may not sublease, assign or otherwise transfer the 
Program or this license to any other person without the prior 
written consent of Company.

G. You acknowledge that you are receiving a LIMITED 
LICENSE TO USE the Program and Documentation and that 
the Company retains title to the Program and Documentation. 
You acknowledge that Company has a valuable proprietary 
interest in the Program and Documentation. You may not use, 
copy, modify or transfer the Program or Documentation or any 
copy, modification or merged portion in whole or in part 
except as expressly provided for in this Agreement. If you 
transfer possession of any copy, modification or merged 
portion of the Program or Documentation to another party, 
your license is automatically terminated.

H. If you have purchased a NETWORK version of the 
software, this License Agreement applies to the installation of 
the software onto a single file server.  It may not be copied 
onto multiple systems. Each node connected to the file server 
must also have its own node copy of the software that becomes 
a license for that specific user.

Term

This license granted to you is effective until terminated. You 
may terminate it at any time by returning the Program and 
Documentation to Company together with all copies, 
modifications and merged portions in any form. The license 
will also terminate upon conditions set forth elsewhere in this 
Agreement, or if you fail to comply with any term or condition 
of this Agreement. You agree upon such termination to return 
the Program and Documentation to Company together with 
all copies, modifications and merged portion in any form. 
Upon termination, Company can also enforce any rights 
provided by law. The provision of this Agreement which 
protects the proprietary rights of Company will continue in 
force after termination. Termination of this license, either 
voluntary or involuntary, does not entitle you to a refund of 
your purchase cost except as provided elsewhere in this 
License Agreement.

Limited Warranty

Company warrants, as the sole warranty, that the medium on 
which the Program is furnished will be free from defects in 
materials and workmanship under normal use and conditions 
for a period of ninety (90) days from the date of delivery to you 
as evidenced by a copy of your receipt. No distributor, dealer 
or any other entity or person is authorized to expand or alter 
either this warranty or this Agreement. Any such 
representations will not bind the Company. Company does not 
warrant that the functions contained in the Program will meet 
your requirements or that the operation of the Program will be 
uninterrupted or error-free. Except as stated above in this 
section, the Program and Documentation are provided as-is 
without warranty of any kind either expressed or implied, 
including but not limited to the implied warranties of 
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merchantability and fitness for a particular purpose. You 
assume entire risk as it applies to the quality and performance 
of the Program and Documentation. Should the Program 
prove defective you (and not Company, authorized Company 
Distributor or dealer) assume the entire cost of all necessary 
servicing repair or correction. This warranty gives you specific 
legal rights and you may also have other rights which vary 
from state to state. Some states do not allow the exclusion of 
implied warranties, so the above exclusion may not apply to 
you.

Limitation of Remedies

Company's entire liability and remedy will be:

A. The replacement of any medium not meeting Company's 
'Limited Warranty' explained above and which is returned to 
Company or an authorized Company distributor or dealer with 
a copy of your receipt; or

B. If Company is unable to deliver a replacement medium 
which conforms to the warranty provided under this 
Agreement, you may terminate this Agreement by returning 
the Program and Documentation to Company, authorized 
Company Distributor, or dealer from whom you obtained the 
Program and your license fee will be refunded.

Product Returns

If you must ship the Program and Documentation to an 
authorized Company Distributor, dealer or to Company, you 
must prepay shipping and either insure the Program and 
Documentation or assume all risk of loss or damage in transit. 
To replace a defective medium during the ninety (90) day 
warranty period, if you are returning the medium to Company, 
please send us your name and address, the defective medium 
and a copy of your receipt at the address provided below. In no 
event will Company be liable to you for any damages, direct, 
indirect, incidental or consequential, including damages for 
any lost profits, lost savings or other incidental or 
consequential damages arising out of the use or inability to use 
such Program and Documentation, even if Company has been 
advised of the possibility of such damages or for any claim by 
any other party. Some states do not allow the limitation or 
exclusion of liability for incidental or consequential damages 
so the above limitation or exclusion may not apply to you. In 
no event will Company liability for damages to you or any 
other person ever exceed the amount of the license fee paid by 
you to use the Program regardless of the form of the claim.

US Government Restricted Rights

The Program and Documentation are provided with restricted 
rights. Use, duplication or disclosure by the US Government is 
subject to restrictions as set forth in subdivision (b) (3) (ii) of 
the Rights in Technical Data and Computer Software Clause at 
(252) 227-7013. Contractor/Manufacturer is MetaCreations 
Corp., 6303 Carpinteria Avenue, Carpinteria, CA 93013.

General

This Agreement is governed by the laws of the state of 
California (except federal law governs copyrights and register 
trademark(s)). If any provision of this Agreement is deemed 
invalid by any court having jurisdiction, that particular 
provision will be deemed deleted and will not affect the 
validity of any other provision of this Agreement. Should you 
have any questions concerning this Agreement, you may 
contact MetaCreations Corp. at this address:

MetaCreations Corp.

6303 Carpinteria Avenue

Carpinteria, CA 93013

(805) 566-6200 phone

(805) 566-6385 fax

©1999 MetaCreations Corp. All rights reserved.  
MetaCreations and Bryce are registered trademarks and the 
MetaCreations logo is a trademark of MetaCreations 
Corporation.  All other product names mentioned in the 
Program, manual or other documentation are used for 
identification purposes only and may be trademarks or 
registered trademarks of their respective companies. 
Registered and unregistered trademarks used herein are the 
exclusive property of their respective owners. MetaCreations 
Corp. makes no claim to any such marks, nor willingly or 
knowingly misused or misapplied such marks. 
442 License


	Welcome to Bryce 4
	What’s New in Bryce
	New Sky Lab
	New Import/Export
	Terrain Enhancements
	Using Bryce on the Web
	Interactive Movie Previewing
	Enhanced Rendering
	Enhanced Screen Resolution
	Light Editor Enhancements
	New Material Lab features
	Picture Editor Enhancements
	Preset Enhancements

	About Your User Guide
	Conventions

	Technical Support
	Creative Support


	Bryce Overview
	What is Bryce?
	Application Overview
	The Bryce Window
	The Working Window
	The Editors
	The Bryce Preset Libraries
	The Menu Bar


	Bryce Basics
	Overview
	Setting Application Preferences
	Setting Up the Bryce Window
	Setting Up the Working Window

	Using the Bryce Interface
	Displaying Text Information
	Displaying/Hiding Palettes
	Displaying Submenus and Pop- up Dialogs

	Working with Documents
	Creating an Empty Scene
	Opening an Existing File

	Working in a Scene
	Displaying Your Scene
	Using the Movie Preview
	Viewing Your Scene
	Selecting Objects
	Editing Your Scene’s Contents
	Undoing Operations
	The Marker Pen

	Saving and Closing
	Saving Files
	Closing


	Animation in Bryce
	Animation Overview
	The Animation Process

	Animation Tools
	Animation Controls
	Using the Movie Preview
	The Advanced Motion Lab

	Animation Features
	Time Mapping Curves
	Animating Transformations
	Animating Materials
	Animating Terrains
	Animating Skies

	Managing Your Project
	Storyboarding
	Simplifying Your Scenes
	Rendering Without Compression

	Motion and Timing Principles

	Tutorial
	Welcome
	Getting Started
	Lesson 1: Setting Up a New Document
	Lesson 2: Positioning the Camera

	Arranging Objects in the Scene
	The Basic Tutorial

	Adding Objects
	The Create Palette
	The Edit Palette
	The Sky and Fog Palette

	Creating the Sky
	Creating a Body of Water
	The Advanced Tutorial
	Part 1: Creating and Importing Objects
	Creating the Interior Scene

	Creating the Roof
	Building the Walls
	Group and Grow the Entire Building.
	Sphere on a Pedestal
	Part 2: Animate the Scene:
	Pre-Production
	Animate the Camera
	Fine-Tuning Your Animation
	Final Comments

	Creating Objects
	Overview
	Objects in the Scene
	Object Preview

	Primitives vs. Procedural Objects
	Object Placement

	The Create Palette
	The Object Attributes Dialog
	Naming Objects

	Creating Infinite Planes
	Water
	Ground
	Cloud
	Infinite Slabs

	Creating Stones
	Creating Symmetrical Lattices
	Creating Primitives
	Creating a Pict Object
	Alpha Channels and Pict Objects

	Working with Pictures
	The Picture Library
	Picture Lists

	Importing Objects
	Creating Boolean Objects
	Boolean Operations

	Creating Geometric Paths
	Using the Presets Object Library
	Adding and Deleting Preset Categories and Objects
	Importing and Exporting Preset Objects


	Creating Skies
	Environments and Bryce
	The Sky�&�Fog Palette
	Working with the Sky�&�Fog palette

	Working with Sky Modes
	Setting Sky Attributes
	Shadows in Your Scene
	Ambient Color

	Adding Fog and Haze
	Fog
	Haze

	Clouds in Bryce
	Adding Clouds

	Working with the Sun
	Positioning the Sun

	Working with the Moon
	Positioning the Moon
	Moon Phases
	Moon Brightness and Sharpness

	Adding Environmental Effects
	Sun/Moon Rings
	Sun/Moon Horizon Illusion
	Rainbows
	Star Fields
	Volumetric World

	Using the Preset Skies Library
	Adding and Deleting Preset Skies
	Importing and Exporting Preset Skies


	Terrains
	What is a Terrain?
	The Terrain Editor
	Features of the Terrain Editor
	Working in the Terrain Editor

	Creating Terrains
	Elevation Tools

	Painting Terrains
	Setting Up the Paintbrush
	Brush Behaviors

	Filtering Terrains
	How Filtering Works
	The Filtering Tab
	Working in the Filtering Tab

	Using Creation Models
	Creating Terrains Using Pictures
	The Pictures Tab
	Working in the Pictures Tab

	Adding Color to Terrains
	Clipping Terrains
	Saving Terrains
	Exporting Terrains
	Features of the Export Terrain Lab
	Preview Options
	Types of Tessellations
	Exporting to MetaStream
	Handling Image Maps
	Tips for Speeding Up the Terrain Editor on Slower Machines


	Materials
	Material Structure
	Understanding Surface Material Channels
	Understanding Volume Material Channels
	Understanding Material Components

	Surface Material Channels
	Diffusion
	Diffuse Color
	Ambience
	Ambient Color
	Specularity
	Specular Color
	Specular Halo
	Metallicity
	Bump Height
	Transparency
	Transparent Color
	Refraction
	Reflection

	Volume Material Channels
	Volume Color
	Base Density
	Edge Softness
	Fuzzy Factor
	Quality/Speed

	Material Components
	Color Components
	Value Components
	Texture Components

	Using the Pictures Editor
	Texture Mapping Modes
	Transforming Textures
	Combining Components

	Shading Modes
	Surface Material Shading Modes
	Volume Material Shading Modes
	Shading Mode Modifiers

	The Materials Lab
	A Quick Tour of the Materials Lab

	Working in the Materials Lab
	Building Materials

	Material Presets
	Using the Preset Materials Library
	Importing and Exporting Preset Materials
	Animating Materials
	Speeding Up Materials


	Textures
	Textures and Materials
	Texture Structure
	Understanding Component Structure

	Component Output
	Assigning Output Types

	Component Elements
	Color
	Noise
	Phase
	Filtering

	Combining Components
	Blend Modes
	Global Changes

	The Deep Texture Editor
	A Quick Tour: The Deep Texture Editor

	Working in the Deep Texture Editor
	Building Textures
	Using Drag and Drop in the Editor
	Changing Component Preview
	Randomizing Textures
	Undoing Changes
	Saving Textures

	Tips for Speeding Up Textures

	Arranging Objects
	Arranging Objects in a Scene
	Bryce and 3D Space
	World Space
	Object Space
	Camera Space
	Bryce Units

	Coordinate Systems
	Absolute Coordinates
	Object Space Coordinates
	Relative Coordinates

	Transforming Objects
	Transformation Tools
	Object Origin Points
	Nano-Edit Mode

	Resizing Objects
	Using the Resize tool
	Numerical Resizing
	Interactive Resizing

	Rotating Objects
	Using the Rotate tool
	Numerical Rotation
	Interactive Rotation

	Positioning Objects
	Using the Reposition Tool
	Numerical Repositioning
	Interactive Repositioning
	Nudging Objects

	Aligning Objects
	Using the Grid
	Using the Align Tool
	Snap To Options
	Anchor and Non-Anchor Based Aligning
	Aligning Numerically

	Randomizing Objects
	Using the Randomize Tool

	Object Hierarchies
	Grouping vs. Linking
	Hierarchical Structure
	Viewing Object Hierarchies
	Linking Objects
	Grouping Objects
	Families


	Editing Objects
	Overview
	Restoring Objects
	Editing Object Attributes
	Object Attributes Dialog
	Object Attribute Icons
	Editing Object Names
	Editing Boolean Attributes
	Editing Display Quality Attributes
	Editing Transformation Attributes
	Editing Link Attributes
	Editing Animation Attributes

	Editing Toruses
	Editing Imported Meshes and Stones
	Converting Objects

	Camera and Lights
	The View of Your Scene and Lighting in Bryce
	The View of Your Scene
	Lights
	Setting Up the View of Your Scene
	Camera View
	Director’s View
	Orthogonal Views

	Positioning the View of Your Scene
	Camera Modes
	Using the Trackball
	Using the Camera Controls
	Banking Controls
	Field of View
	Positioning the Camera Numerically
	Manually Positioning the Camera
	Aiming the Camera
	Saving Camera Positions

	Setting Up Lights
	Creating Direct Light Sources
	Editing Light Attributes
	Creating Visible Lights
	Applying Gels
	Positioning Lights
	Linking and Tracking with Lights


	Animating
	Key Event Animation and Bryce
	Animation and Motion Paths
	Animatable Properties

	Creating Animations
	Setting Up an Animation
	Working with the Timeline
	Recording Key Events
	Previewing Animations
	Adding and Deleting Key Frames

	Advanced Motion Lab
	Viewing Object Hierarchies
	Editing Property Timelines in the Sequencer
	Time Mapping Curves
	Using Presets
	Previewing the Animation

	Motion Paths
	Editing Motion Paths
	Motion Path Modifiers
	Moving the Path
	Aligning Objects to the Path


	Animating Techniques
	Introduction
	Tracking Objects
	Animating the Camera
	Using the Orthogonal Views
	Using Director’s View
	Displaying the Camera’s Trajectory
	Linking and Tracking with the Camera
	Creating Camera Orbits

	Animating Materials
	Animating Material Channel Values
	Animating Texture Components
	Animating Between Materials
	Previewing Material Animations

	Animating Skies
	Animating Sky & Fog settings
	Animating Clouds
	Animating Environmental Effects
	Animating Sun or Moon Position

	Animating Terrains
	Animating Terrain Geometry
	Animating Terrain Filtering
	Animating Terrain Clipping
	Previewing Terrain Animations


	Rendering
	What is Rendering?
	The Rendering Procedure

	Setting Up a Render
	Setting Render Options
	Render Modes

	Rendering a Scene
	Using the Render Controls
	Plop-Render Mode
	RaySpray

	Rendering a Movie
	The Render Movie dialog

	Batch Rendering
	Fast Render Strategies
	Working with Rendered Images

	Using Bryce with Other Applications
	Overview
	Working with Other Applications
	Importing Images
	Exporting Images
	Importing and Exporting Objects

	Post Production
	Compositing
	Adding Depth

	Printing Images
	Using Bryce on the Web
	Internet Connection
	Using a Browser
	Accessing the Web
	Create HTML Images
	Realmovie Animations
	QuickTime Movies
	QuickTime VR Panorama Movies

	Using BryceTalk
	Communicating with Bryce Users
	Setting up BryceTalk
	Communicating with Other Bryce Users


	QuickTime VR
	Creating QuickTime VR Panoramas
	Further VR Exploration


	Glossary

